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CHAPTER 1

Introduction

1.1

GEOPAK

is a comprehensive software package that covers every project phase from
conceptualization to final quantities and construction stakeout.
MicroStation graphic environment providing true interactive design.

The software works within the
For example, a horizontal

alignment can be created graphically, it can be calculated with the coordinate geometry component of
GEOPAK or some interactive combination of the two. Dynamic on-screen design provides immediate
interpretation of plan view geometrics for making design choices through visualization.

Using GEOPAK will help ensure consistency and accuracy of design work and generate a significant
time savings in the overall effort of producing construction plans.

File Names

GEOPAK uses and/or creates files during the design process. Several of the more common files are
detailed in the table below.

job###.gpk

This binary file is created when the user starts a coordinate geometry
(COGO) session for the first time or created through Project Manager.
The file may be appended to during the design process. All coordinate
geometry elements are stored in this file. Multiple users can access this
file at the same time, and only one file should be created for each project.
The "###" is the only variable in this filename. It represents a job number
(up to 3 alphanumeric characters) unique to a project and is defined by the
user upon creation.

fname##t.ioc
Example:
align999.ijd

ASCIl input file for loading data during a COGO session.  "###"
Represents the job number and "oc" is the operator code (users initials).
Filename characters are limited to 5 characters plus the 3 job number
character designation as indicated with the example.

fname##t.ooc

ASCII output file created by GEOPAK during a COGO session. Variables

Example: are the same as defined above. Filename characters are limited to 5

align999.0jd characters plus the 3 job number character designation as indicated with
the example.

fname.inp Any ASCII input file for running GEOPAK processes. Name is user

Example: desxs.inp

defined with an .INP extension.

fname.dat A binary file that contains string and point information to be used for digital
terrain model construction.
fname.tin A binary file containing triangular surfaces also known as the digital terrain

model (DTM).

Project-name.prj

Binary file resulting from the creation of a new project.

GEOPAK 2004 Edition
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1.2 Accessing GEOPAK

GEOPAK is started upon entering a MicroStation File. To verify that GEOPAK is active, scan the
MicroStation menu bar where the Applications menu appears. Simply select Applications >
GEOPAK Road. When each GEOPAK tool is selected, the corresponding dialog box(es) will appear.

| Applications Window Help
| GEOPAK
GEOPAK DRAINAGE
GEOPAK LANDSCAPE

GEOPAK ROAD GEOPAK ROAD Tools

.3

GEOPAK SITE Project M.

GEOPAK SURVEY » Aitive Chan il
4

GEOPAK WATER SEWER GEOPAK B Attributes
GEOPAK 3PC AdHoc Attribute Manager

4
4
3
4

User Preferences

Geometry *
Design & Computation Manager

Quantity Manager

Plans Preparation 3
DTM Tools

3D Tools 4
Cross Sections »
Liilities 4
Help

About GEOPAK

To close a dialog box, the following options are available:

e Click the X in the upper right corner of the dialog box
e Select the File > Exit option
e Orclick Cancel on the dialog box

Use one of the above options that appear in the dialog box.

Exiting the MicroStation file automatically closes all GEOPAK dialog boxes.

1.3 User Preferences

When a user begins Geopak for the first time or after Geopak has been reloaded, there are certain
User Preferences the user needs to set. The User Preferences dialog box can be accessed from
Applications > Geopak Road > User Preferences. The following dialog box appears.
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gGEOPM{ User Preferences !El E
Urit Spstem: | English vI Dutput Accuracy
Distance: | 99,1234 hd I

Coordinates:  ME vI
Station: | 9+39[3).12 vI
Direction: _Bearing vI =
Angle Seconds: | 979912 vI

Station: [ 12+34 -|

working Directony: | gl
Feature Preferences...

COGO Preferences. ..

[T Show this dialog at GEOPAE startup

Cancel |

Most of the settings in this dialog box can be defined when a project is created within Project
Manager (See Chapter 2).

The Working Directory identifies where the data files for a particular project can be found. If a user
does not want to work within a specific project, the field may be left blank, and Geopak uses the
directory wherein the open MicroStation file is located.

By clicking the Feature Preferences button, the following dialog box is invoked.

Feature Database
’V SMD File: [ atvoad!standards\geopak WD 0T -2 smd Elﬂ

V| &pply Best Match Feature Flot Scale: I 100.0000

[T Use Shared Cells
! Cancel |

This defines the default file utilized for representation of coordinate geometry and survey elements
when visualization is utilized during an active coordinate geometry session as well as the scale in
which these elements will be displayed.

By pressing the COGO Preferences button, the following dialog box is invoked.

Job [GPK] Open Mode: | _Qusny "I
Job [GPKIDiectory: [ Q@
COGO Input File Directan: I— EI
COGO Output File Directary: I— EI

™| Redefinition of Elements
[ Force Redefinition Off Upon COGOD Activation

Cancel |

The Job (GPK) Directory field specifies the location of the GPK file. Since multiple people can read
and write the GPK file simultaneously, it is possible to have this file on a server or in a shared folder.
If any of the above directory fields are blank, they will default to the Working Directory set in the
GEOPAK User preferences dialog box.
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LAB 1: User Preferences

Define Design Preferences
Step 1. Execute C:\data\geo\vdot\road 1\LAB1.EXE.
Note: Make sure you accept the path and unzip the files to C:\.
Step 2. Open the MicroStation file C:\data\geo\vdot\road1\d17682des.dgn

Step 3. Access the GEOPAK User Preferences dialog box from the Applications pulldown.
Applications > GEOPAK Road > User Preferences.

The User Preferences dialog box appears as shown.

5 GEOPAK User Preferences [_To] x]
Unit Spstem: | English vI Qutput .-’?‘«ccuracy
Distance: | 93,1234 hd I
Coordinates: | ME vI
Station: | 9+39(9].12 vI
Direction: | Bearing vI
Angle Seconds: | 979'9.12 vI

Statior: | 12434 -|

working Directony: | gl

Feature Preferences...

LCOGO Preferences...

[T} Shaw this dislog at GEOPAK startup

Cancel |

Step 4. Click the Feature Preferences button and set the Plot Scale to 100 as shown and toggle
on Apply Best Match Feature.

Feature Database
’7 SMD File: | atvroad]bstandards\geopak WD 0 T-g.5md Elﬂ

V| &pply Best Match Feature Flot Scale: I 100.0000
[T} Use Shared Cells

Cancel |

Step 5. Click OK.

Step 6. On the GEOPAK User Preferences dialog box, click OK.

Step 7. Exit Microstation.
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CHAPTER 2

Project Manager

2.1 Introduction

Objectives

Learn how to set up a project using Project Manager.
Learn how to utilize Project Manager as a workflow guide.
Learn how to access GEOPAK dialog boxes from the Project Manager.

Menu Bar Application

Applications > GEOPAK Road > Project Manager

Road Tool Frame

Project Manager %]

05 I

Project Manager is a GEOPAK tool that associates a project with its respective coordinate geometry
job number, users, working directories and project files. Project Manager provides the user with an
easy workflow system that keeps records of processes run throughout the design of a project.

2.2 Accessing Project Manager

To access Project Manager, select Applications > £ Project Manager HEEBR
GEOPAK Road > Project Manager or click the Project Projects Directory Admin
Manager icon. The adjacent dialog box appears. C\datageohvdothmadth

The current directory is displayed at the top of the dialog

box. This may be modified by traversing to a different Etpiects: | |Directores: |
directory in the Directories list box. Project files (.prj) are g
displayed in the projects list box. IC]

Filter: |“.|:uri Type  Project |

(]

The remainder of the Project Manager dialog box displays
information after a project has been selected from the
Projects list box. At the bottom of the dialog box are the
OK and Cancel buttons. To exit Project Manager, click
the Cancel button. To continue in the Project Manager
process, click the OK button.

2.3 Project Manager Menu Bar

Job Murber:

Description:

[E:]

Cancel |

There are three options on the Menu Bar: Projects, Directory and Admin. Each of these choices

has tools contained in the pull down.

2.3.1 Project Tools

There are four options under the Projects pull down, New, Edit, Delete and Exit as shown below.

GEOPAK 2004 Edition
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_I'EE;E? Directory  Admin
m-:lala\geo'wdot\mad'l Y
Edit... =i Tepe F'm'ectl
Delete... ; —
= |  Directories: |
] [1
Exit [standards]
[C:]
0]
[E:]
Job Humber:
Description:
Cancel I

The New menu option is used to create a new project. The .prj file is stored in the directory shown in
the Directory path at the top of the Project Manager dialog box. When the New menu option is
selected, the following Create New Project dialog box appears.

Z5 Create New Project [_[O] x|

Project Narne: |

whorking Directory: | Select...l
Job Humber: | |
o TRHIREL SHit Preferences |

Project Description:

Cancel |

The Project Name can be any number of alphanumeric characters. The Working Directory
specifies the location of the project data files and may be manually entered. In lieu of typing, the
Select button may be clicked and the appropriate directory selected.

The Working Directory can be left blank if it is desired to have all of the MicroStation and GEOPAK
files in a single directory.

The next field is for keying in the COGO Job Number or the Select button may be clicked and the
appropriate COGO job number selected.
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Next, the Preferences button should be clicked, invoking the Project Preferences dialog box.

& GEOPAK User Preferences [ 0] x]

Unit Spstem: | English vI Qutput .-’?‘«ccuracy
Distance: | 93,1234 VI
Coordinates: | ME vI

S : Statior: | 9+33(31.12 vI
Direction: | Bearing vI E>
) Angle Seconds: | 979912 vI
Station: | 12+34 Vl

working Directony: | gl

Feature Preferences...

LCOGO Preferences...

[T} Shaw this dislog at GEOPAK startup

Cancel |

The user may click on COGO Preferences, then set the particular parameters for each project as well
as the directories for the COGO job number, COGO input files and COGO output files. By setting
these parameters for each project, the user can open a design file in one directory and then open
another design file in a different directory and still access the correct .gpk file and also save Cogo
input and output files to the proper directory. The user simply chooses the project and all parameters
are automatically set. After all the information is entered, the OK button is clicked or if the user
wishes to abort, the Cancel button may be clicked.

' NOTE: If these fields are left blank, the project working directory is used.

Shown below is a sample project that includes a project description, which may be keyed in at the
bottom of the Create New Project dialog box or added later by accessing it from the Edit menu.

#5 Project Info Edit 10 %]

Project Mame:  17E82.prj

whorking Directory: | Select...l
Job Murmnber: I 101
ﬂl Preferences |

Project Description:

GEOPRAK ROAD 1 Courze Project

Cancel |

The Edit option on the pull down menu is used to change any settings associated with the currently
selected project.

The Delete option on the pull down menu is used to delete any project that has been stored. The
user highlights the project in the Projects list box and selects Delete.

The Exit option on the pull down menu closes the Project Manager and writes the settings to a
resource file.
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2.3.2 Directory Tools

There are two options under the Directory pull down, Create New Directory and Current Working
Directory as shown.

Projects Adrin

Create New Directary...

g Project Manager

Fit Current Working Directory

The Create New Directory option creates a new directory on your computer within the current
directory. If the Current Working Directory option is chosen, the directory path in Project Manager
is changed to that directory.

2.3.3 Administration Tools

The Administration menu option is used to set a password on a project, if desired.

_————
g Project Manager

Projects  Directary

c:\data\gm

2.4 Project Users Dialog Box

Once a project is highlighted and OK is selected, the Project Users dialog box appears.

Project Users: 17682 prj I

Users
Froject Users: User Info
Full M arme:
OF Code;
Drescription;

LCancel |

This dialog box has three sections: Project Users, User Info and Description. The Project Users
list displays a list of users that have been created to work with any project that resides in the current
projects home directory. The names shown in Project Users will be the user id’s of the people
working on that project as specified in the Start Job dialog box. Within the User Info group box, the
Full Name field further identifies the user, and displays the full name of the user that is currently
selected. The OP Code field displays the Geopak Operator Code of the currently selected user. The
Geopak Operator Code is used for all coordinate geometry operations during this session. The
Operator Code, along with the Job Number will be utilized whenever a COGO input or output file is
created by the software. The Operator Code is typically the user’s initials. The Description field
displays the description of the currently selected user.

Four tools are supported on the Project Users pulldown as depicted in the exploded view below.
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Pmiecl Uzers: 17682 prj i

T s

Edit... - Usger Info

Lelete... Full Warme:

Pazzword

Eail OF Code;
Description:

ak. Cancel |

New The New pull down menu option creates new users. This option will create
users only for the selected project.

Edit Enables the user to change any of the parameters of the currently selected
user. (Note: The User cannot be changed.) This changes the user
information for the current project only.

Delete Deletes the highlighted user.

Password Creates or modifies a password for the selected user. If the selected user
already has a password, the user will be prompted to enter the current
password before continuing.

Exit Closes the User Dialog box and returns back to the Project Manager dialog box.

GEOPAK 2004 Edition
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2.5 Road Project Dialog Box

After a minimum of one user has been defined, click the OK button in the lower left corner of the

Project Users dialog box or double click on a Project User, which opens the Project Manager dialog
box.

£ Road Project: 17682.pij ]
File Bemember Optiong

Wworking Directory Uger: WDOT  Job#: 101 O

¥ whorking Aligrment Influsnce Runs - :
Defire | Port Viewer I

Working Alignment  Untitled

E sizting | |
Giround s _ Ewxisting Ground Exigting Ground Wertical
Diraws Pattern . : :
Crozs Sectionz Profile Aligriment
Coordinate |
Geametry | |
Calculate Supereleyvation Fropozed a0
Superelevation | Shapes | Crozz Section: | — Modelz
Horizontal
Alignment |
Plan Wiew J L Earthwark Clo;shs etctlcun
Desgign el
Flan Yiew Tabular
[uantities Summaries | |

Plan & Prafile Lirnitz of Reparts & XS
Sheets Conztruction Quantities

The top of the dialog box displays the Working Directory, Working Alignment (if defined), User
and GEOPAK Job Number. In addition, a toggle for Working Alignment Influence Runs is also
supported. The bottom portion of the dialog box displays the various processes supported during the

design process. The small square in the upper right corner will condense the dialog box as depicted
in the graphic below.

£ Road Project: 17682 pij [ x]
{ File Remember Dptions

Warking Directory User ¥DOT  Job#t 101 L
¥ Working &lignment Influence Runs

Cefi Port i
wWorking Alignment  Untitled emel al |eweri
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2.5.1

2.5.2

Road Project Dialog Menu Bar

|_ Fle
‘ a

There are two pull down menu bar options: File and Remember. When the File option is
selected, Close and Exit are supported.

If the Close option is selected, the user is returned to the Applications dialog box. If Exit
is selected the user is exited from the Project Manager.

When the Remember option is selected, the user can instruct the software to
remember the Project, User, or Road in subsequent sessions. For example,
if all three toggles are activated, and the Project Manager is completely
closed (all dialog boxes), the invocation of the Project Manager immediately
invokes the Road Project dialog box (flow chart) and utilizes the project
name, user name, etc., which were active when the Remember toggles were
selected.

If only the Project and User toggles are activated, the user is returned to the Project dialog box in
later sessions. If only the Project toggle is activated, the user is returned to the Project Users dialog
box in subsequent sessions. This option is particularly useful when numerous users are working on
one project.

When the Auto Sink option is enabled, the Road Project flow chart |
sinks behind all open views when any tool is selected from the flow ‘ Fiie: Hementier: | DiNions

chart. Once the tool is closed, the Road Project flow chart will be |_WD,king Ditectary
brought to the top of the view window. -

Working Alignment

The concept of a working alignment enables the designer to organize a project and to access project
information without continually typing the required information. On a simple project, only one working
alignment may be needed. However, on a more complicated project, an unlimited number of working
alignments may be defined. With each working alignment, the designer can define associated data,
i.e., name of cross section and plan view files, element symbology, etc. The designer can easily
change from one working alignment to another by highlighting the desired alignment listed in the
Select dialog box. Once the working alignment is selected, all previously stored data is utilized in
subsequent processing. Three tools relating to working alignments are located at the top of the Road
Project dialog box:

e Select Button
e Define button
e Working Alignment Influence Runs (toggle on left side of dialog box)

£ Road Project: 17682 pij [ x|

{ File Remember Options
working Directory Uzer ¥DOT  Job#: 101 [l

¥ working &lignment Influence Funs
Wwiorking dlignment  Untitled

Select: Drefine | Part iewer |

The Port Viewer (covered in detail in Chapter 13) is a tool that enables the user to view and
manipulate all three major aspects of a road design simultaneously, even though they are located
in different files. The Port Viewer tool is only available while working within the Project Manager
application.
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2.5.2.1 Select Option
[Sclect Working Algoment |

Bun

M arme Time
Untitled

Degcription

Untitled |7

Cancel |

When the Select button is clicked, the Select Working Alignment dialog box appears as depicted to
the right. If no working alignments have been defined, UNTITLED appears in the Run List box. If
working alignments have been defined, they are listed with the last run time. The description of the
working alignment can be seen in the bottom of the dialog box when each Name is highlighted. To
select a previously defined working alignment, highlight the run from the list, then click the OK button
at the bottom of the dialog box. Double clicking on the Name also selects a previous working
alignment for subsequent processing. Clicking the Cancel button will close the Select Run dialog

box without any File selection. Several Run options are supported as depicted in the exploded view
below.

Select Working Alignment I

" Hew... .
| Time
Copp... 03709719
Modify...
Delete
Description
Untitled |7
Cancel |
These are detailed in the table below.
New Create a new working alignment
Copy Copy a run from an existing Project, a User in the same project or Run
created by the current user.
Modify Change the name of the existing working alignment.
Delete Delete an existing working alignment.
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2.5.2.2 Define Option

Once a Run has been selected, clicking the Define button invokes the dialog box depicted below.

Pattem
Shapes

Prafile Wiew
Location

Crogs Section View
Ewigting Ground
Propozed Finizh Grade

DTM

Begin Station:

End Station;

ok |

Cahicel |

Dezign File: I
Chain: I

Select |

The information that can be associated with a working alignment is listed in the left portion of the

dialog box.

As each option is chosen, the right side of the dialog box will change to reflect the

information needed as can be seen in the dialog box to the right after Profile View was selected.

All information entered in these fields can be used in subsequent processes run from Project
Manager. In the beginning of a project, much of this information will not be known, but as the user
goes through the design process, it can be added to the working alignment definitions.

For example, as soon as a chain has been stored in COGO, the user can enter that information in the
Plan View fields on the right side of the dialog box. For a more complete explanation of each option
shown, please see the GEOPAK Manual or On-Line Help.

2.6

Project Manager Process

Z5 Road Project: 17682 prj [ x]
File Remember Options
Working Directory User ¥DOT  Job#: 101 |
¥ Wworking Alignment Influsnce Funs - - - :
; . g iSelect! Define | Part Wigwer I
Wiorking Alignment  Untitled
Ewigting | |
Giround R T | Ewisting Ground E xisting Ground Wertical
Tam e Cross Sections Prafile Alignment
Coordinate |
Geometmy | |
Calculate Superelevation Propozed 3D
_ Superelevation | Shapes | Crosz Sections | Models
Harizontal

Alighment

Design

Plan & Profile
Sheets

-
Plan Wiew

_l_—

Plak Wiew
[Quantities

L Crozs Section
E arthwwork, S hests
T abuilar
Summaries | |
Lirnitz of Reports & =5
Construction Quantities
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The primary Project Manager dialog box is depicted above. The advantage of utilizing the Project
Manager rather than selecting functions directly from the Road menu is that pertinent information
stored within the Project Manager is automatically displayed within the invoked dialog box.
Therefore, job numbers, chain names, stationing, file names and data associated with the project do
not have to be typed in each time a dialog box is utilized. However, if the user chooses to change the
fields, they have that option.

Many of the Project Manager processes function identically to their corresponding dialog boxes
invocation from the Road menu. However, some of the procedures invoke the Select Run dialog box
prior to invoking the actual dialog box. The Select Run dialog box enables the user to set up different
options to use in alternative design choices or different typicals.

2.7 Online Help

More information can be found under Applications > GEOPAK Road > Help > Command
Reference > Project Manager.
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LAB 2:

Project Manager

Introduction

Step 1.
Step 2.

Step 3.

Step 4.

Step 5.

Execute C:\data\geo\VDOT\road1\LAB2.EXE.
Open the MicroStation file C:\data\geo\VDOT\road1\d17682dtm.dgn

Invoke the Road Tools tool frame from the MicroStation menu bar by selecting
Applications > GEOPAK Road > GEOPAK Road Tools.

Road x|
.—’ /a)g:
iep i(%i

Ry

|

* @P

Access Project Manager using the Project Manager icon from the Road Tools tool frame.

b

From the right side of the Project Manager dialog box, in the Directories list box, ensure
that the project directory is set to:

C:\data\geo\VDOT\road1

' You can navigate quickly to your current working directory by
using the pulldown Directory > Current Working Directory.

Select the Projects > New pulldown and create a new project as defined in the table
below:

Project name: 17682

Working Directory:

Job Number: 101

Project Description: GEOPAK Road 1 Course Project
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Atfter filling out the dialog box as shown below, click Preferences.

5 Creaie New Project HE B

Project Mame: | 17682

wharking Directang: | Select...l
Job Murmnber: I 101
ﬂl Preferences |

Froject Description:
GEOFAK. ROAD 1 Courze Project

Cancel |

Step 6. Set the project preferences as shown in the dialog box below. Click OK when complete.

5 GEOPAK User Preferences [_ O] x|

Unit Spstem: | English vI Qutput .-’?‘«ccuracy
Distance: | 9312 vI
Coordinates: | ME vI

S : Statior: | 9+33(31.12 vI
Direction: | Bearing vI E>
) Angle Seconds: | 979912 vI
Station: | 12+34 Vl

working Directony: | gl

Feature Preferences...
LCOGO Preferences...

[T} Shaw this dislog at GEOPAK startup

Cancel |

Step 7. After exiting the Preferences dialog box, you will return to the Create New Project dialog
box. If everything here is satisfactory, click the OK button. An Alert message is

displayed stating that Job 101 was not found in the Working Directory in which you
defined.

. C:Adata\geowdotwoad 1%ob 101 .gpk not found.

Create Job 101 in directory
C:Adata\geo\wdotroad 147

Click Yes to automatically create this job file.
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Step 8. The main Project Manager dialog box is now displayed and the project has been created

and ready to be accessed. To access the project, select the project by single clicking on

name of the project in the dialog box. The project is highlighted as shown in the dialog
box with all pertinent information displayed.

Projects  Directory  Admin
C:\datageotwdotroadlh

Filker: I".pri Type  Project I

Directories:
[
[standards]
]

0]
[E:]

Job Mumber: 101 it Syztern: Englizh

Dezcription:
GEOPAK ROAD 1 Course Project

Cancel |

Click OK to invoke the Project Users dialog box as shown in Step 9.

Step 9. Create a new user by selecting Users > New from the Project User pull down menu bar.

Complete the New User dialog box with the name and operator code as shown.

Project Users: 17682 prj

[ Users
Delete._ Full Marme: Mo W
Passiond OF Code: Full Name: [Virginia DOT
i OF Code: [vd
Description: Dezcription:

LCancel |

Cancel |
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Step 10.  After populating the dialog box click OK. When prompted to define a password for this
user, click No.
Q Do you wish to define a password for this user?
Yes
Step 11. At this point double click the user and you will now see the main Workflow dialog box.
| 2 Road Project: 17682.prj [ x]
File Remember Options
Working Directory User ¥DOT  Job#: 101 L
¥ Wworking Alignment Influsnce Funs e T | T I
Wiorking Alignment  Untitled ok e or Ve
Ewigting | |
Giround Diesii B | Ewisting Ground E xisting Ground Wertical
Tam e Cross Sections Prafile Alignment
Coordinate |
Geometmy | |
Calculate Superelevation Propozed 3D
Superelevation Shapes Crosz Sections | Models

Harizontal
Alighment |
Plar g J " Earthwork CrogilSetc tioy

Design | | eets

Plak Wiew T abuilar
[Quantities Summaries | |

Plan & Profile Lirnitz of Reports & =5

Sheets Construction Quantities

Step 12.

Step 13.

Lastly, use the Remember option to have Project Manager remember our Project and

User. Enable the AutoSink option.

Exit Microstation.

§=ull

To create a project, contact the AES Help Desk.
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CHAPTER 3

Digital Terrain Model

3.1 Introduction

Objectives Learn how to display and analyze DTMs for use in roadway design.
Project Manager Existing Ground

Tools D.xl

Menu Bar Application GEOPAK Road > DTM Tools

A Digital Terrain Model (DTM) represents the topography of a project in the form of a triangulated
network. The DTM can be drawn in a 2D or 3D file, and then rotated to see the existing surface of
the project area.

Digital Terrain Models can be generated from various sources including MicroStation Elements,
survey data, photogrammetry data, GEOPAK cross-sections, and geometry data.

Triangulation is a mathematical process applied to ground points and vertices along longitudinal
features to create planar surfaces. The result of triangulation is the creation of triangles connecting
these points. These triangles are included in the GEOPAK TIN file from which existing ground profiles
and existing ground cross sections can be generated.

3.2 Accessing

Clicking the Existing Ground button from the Road Project: Road1.prj dialog box [DTM H|

within Project Manager invokes the tool frame shown to the right. All of the DTM Tﬂ e
tools can be accessed from the tool frame or from the DTM menu that can be ~
accessed from the top/left icon on the tool frame. 5 T/_\,
B. [z

FDTM -0 x| & B
Settings BExract Build Edit Drape Lload Reports Analysis Utilities Al
HAS
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3.3 Load DTM Features

Tool

Menu Bar

Load > DTM Feature

Load is the process by which we can visualize the DTM data, TIN model, lattice model, and contours.
By selecting the Load DTM Feature icon, the following dialog box appears.

Fle

£ Load DTM Features

Load File: | Data 'Il

r Dizplay Preferences

Load: | Extent "I [T Dizplay Only

Ql

["| Graphic Group

Feature | Leval | Color |'weight| Style | Display |«
Spots Defal 0 0 0 OF |
Break Lines Drefault 1 a 0 OFF ot
Extd. Caontours Default 2 a 1} QOFF
\Voids Default 3 0 0 OFF v
Islands Default 4 0 0 OFF T il
Holes Default 5 0 0 OFF |-
[——— 55

The user can choose to load the DTM data (.dat), the TIN file (TIN), or the Lattice file (.Iat). Each of
these files can be loaded for the model extents, within a fence, or selected view.

Activating the Display Only toggle enables the user to view the elements without writing them to the
MicroStation file (temporary display). Conversely, deactivating the toggle writes the DTM features to
the MicroStation design file at the defined symbology. These elements can be placed as a graphic
group when Display Only is deactivated.

o 122

£

Activates the display of all Features.

Turns off the Display of all Features.

o
J
v
K

Feature | Level | Color [\wWeight! Stle | Display |«
Trianglez Lewvel 1 2 i} i] oM
TIM Hull Lewvel 30 a 0 a am
Contours . . . . oM

b ajor Lines Lewel 10 4 3 i oM

b ajor Label Lewel 10 ] 3 1] oM

Minor Lines Level 9 1 1 o oM v

Turns on only the selected Feature. This can also be accomplished by activating the toggle
(below the list box) or double-clicking on an item that is turned off within the list box.

Will turn off only the selected item. This can also be accomplished by activating the toggle
(below the list box) or double-clicking on an item that is turned on within the list box.
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3.4 Analysis Tools

Tools

Analysis

]| @ |

=]
Ot

H

=]
O 4150|424

Menu Bar

Analysis > Height

Analysis > Profile

Analysis > Volumes
Analysis > Elevation Differences
Analysis > Slope Area
Analysis > Themes
Analysis > Drainage Tools
Analysis > Visibility
Analysis > Trace Slope Path
Analysis > DTM Camera
Analysis > Trench Volumes

The Analysis tools allow the user to visually analyze the digital terrain model utilizing numerous tools
as a profile analysis, thematic analysis, drainage flow patterns, and visual portions on the model from
any given location.

Height
Profile

Volumes

Elevation
Differences
Slope Area

Themes

Drainage

Visibility

Trace Slope Path
DTM Camera

Trench Volumes

To determine the height and other associated data dynamically based on user-defined
data points within the model.

View a profile based on a user defined MicroStation element.

To compute the volume between two TIN models, the volume between a TIN model and
a plane, or the cut and fill totals between two TIN models while applying a
shrinkage/swell factors.

Will display the elevation difference, or the amount of cut and fill between two TIN
models, or a TIN model and a plane of constant elevation.

The Slope Area tool displays the horizontal area and actual slope area (area following
the terrain of the Model).

Displays the digital terrain model based on different user definable themes such as
elevation ranges, slope percentage, slope degree, or aspect.

Displays and analyzes drainage patterns within a TIN model. Tools include delineating
watersheds, drawing flow arrows, determining upstream and downstream traces, finding
high and low points, and ridge and sump lines.

Based on a user-defined point of origin, GEOPAK visually displays which triangles can
and cannot be seen, or what is visible between two points.

Traces a path along a TIN file using a user specified slope and method.
Provides a drive-thru navigation tool along the DTM.

Utilizes a TIN file (and optional offset) to compute trench and bedding volumes.
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Lab 3: Digital Terrain Modeling

3.1 Accessing DTM Tool via Project Manager
Step 1. Execute C:\data\geo\VDOT\road1\LAB3.EXE.
Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682dtm.dgn.

Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 3. Select the Existing Ground tool from the Project Manager Road dialog box.
Step 4. Create a new run ground1.

Now Fundame |
Fun Hame; Igmuncﬂ

Description |Exizting Ground from Surveys

Copy...
Maodify...
Lelete

Cahicel |

Step 5. After creating the run, select the run by highlighting the name of the run in the dialog list
box and click OK.

Select Run
Bun
M arne Tirne |

Lntitled 12/, 04 13:52:35

ground]

Description

Existing Ground from Surveys

Cancel |

This invokes the DTM Tool Frame shown below.

DTM x|
B
25 s,
fiid

| rhan
L Y
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3.4 Load DTM Features

Step 1. Select the Load DTM
Features icon from the tool
frame to invoke the
following dialog box.

Step 2. Change the Load File
option to TIN.

Step 3. Select the TIN file
‘SURVEY.TIN' by clicking
the Files button.

Step 4. Enable the toggles for
Graphic Group but leave
the Display Only disabled.

Step 5.

Z5 Load DTM Features
Fle

LoadFile: | Data_ | |

r Display Preferences

Ql

Load: | Extent 'I ™ Display Only

[ Graphic Group

Feature | Lewvel | Color ["wieight| Style | Display |«
Spots Detault 0 0 0 OFF )
Break Lines Default 1 a I} QOFF 9
Extd.Contaurs Default 2 ] a QOFF

"oids Drefault 3 a I} OFF ¥
Islands Default 4 0o o oF = ¢
Hales Default 5 0 0 OF v

———— O

Select the Triangles Feature by highlighting in the list box. Notice that initially the display

is set to OFF. You can control the display of an item three ways:

Use the “lightbulb” icons to the right of the dialog box

Double-click on an item

Use the “display” toggle in the lower right corner of the dialog box

Set the Triangles display to ON. At this point your dialog box should resemble the

following:

£ Load DTM Features
Hle

Load File: | TIN vI | survey.tin

r Dizplay Freferences

Load: | Extent 'I ™ Display Only

[ Graphic Group

Feature Lewvel
iah Default
TIM Hull Default

1 0 1]

GEOPAK 2004 Edition
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Step 6. Double click the sample graphics box indicated below to invoke the Set Feature dialog
box. Set the display symbology for the Triangles as indicated below then click OK.

GEOPAK 5et Feature I

Cahicel

Feature Level Color [weight] Stls | Display |« Symbiclogy
Level JLewsl1 JE3|
Color: JET 2 =l
Style: | i] =]
weight: | 0 =]
-
2]

Step 7. Select the Tin Hull (the boundary of the surface model) feature. Set the Tin Hull display
to ON. Invoke the Set Feature dialog box as per Step 6 and set the symbology as
follows; Level = 30, Color = 0, Weight = 0, Style = 0. The dialog box should now
appear as below.

Feature | Level | Color ['weight! Style | Display |+
Triangles Lewvel 1 2 1] 0 ar

<l

TIM Hull Level 30 a a 0 oM itl
Contours - - - - QOFF

Maios Lines Drafanlt QFF v

Step 8. Click Load and review the results. When complete, toggle OFF the triangles and tin hull.
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Step 9. Select the Contours feature. Activate the Display feature.
Verify that On is set in the Display field.

Step 10. Complete the bottom of the dialog box as indicated below. To complete the Minimum and
Maximum Z, Click the Read button, which will review the active TIN file and determine
these values.

Enable the Display Only toggle since we only want to “preview” our contours but not
actually write them to the design file.

£5 Load DTM Features [ O] x]
Fle
Load File: | TIM "I | surveg tin &I Load |

r Display Preferences

Load: | Extent "I W] Dizplay Only ["| Graphic Group

Feature | Level | Colar ['wieight! Style | Display |«
Triangles Level 1 2 0 0 OF |
TIN Hull Level 30 0 0 1] OFF | | T

td ajor Lines Default 3 0 1] OFF ¥
F ajor Label Default 4 ] a OFF il
tinar Lines Default ] a I} QOFF LI

Minar Interval: I'I.EIEIEI Major Interval: IE.DEIEI
Sroath: | Three Paint "I Reqiztration: | 0.000 birimum Area: ID.DDD

Flange vI Minimum Z: |388.418 b asimum Z: |135.845 Read |

Step 11. Activate the Display of the Contour Lines and Labels and set the symbology as
indicated below:

Level | Color | Weight | Style | Font | TH/TW Distance
Major Lines 10 4 3 0
Major Labels 10 5 3 0 0 TH=3, TW=3 200
Minor Lines 9 1 1 0

The contour symbology standards should be the same as Survey’s and are documented
in CAICE_2000.doc.

§ =ul

Step 12.  Click the Load button to initiate the process.

Step 13. Close the Load DTM Features dialog box and Save Settings.
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3.5 Analysis Tools

We will review several analysis tools in the following exercises. These include the height, themes

and profiles tools.

3.5.1 Height Tool

=]
| @ [0 [22 4t 55 A | 2]

Step 1. Select the Height icon from the tool frame to invoke the following dialog box.

& Height / Slope =10 x|

TIM Files [ surves.tin gl
Mode : | Elevation vI V| Display Orily

r Optiohs
[T} Show Contour: _I
[T Shaw Triangle: _I
] Sk Flows Arrow: _I

r Cursor Point Walues

Step 2. Activate the Show Contour and Show Flow Arrow
toggles. The color may be altered to your choice of
colors from the active color table on the Height dialog
box. The weight of the contour line and arrow are
controlled by the active Microstation settings.

Step 3. Click the Start button and scan the surface model
with the cursor to display the values for xyz and the
slope on the model at the cursor point.

Step 4. Close the Height dialog box.

£ Height / Slope 0] x|

TIM File: | surves.tin gl
Maode : | Elevation "I W] Display Only

r Options
¥ Show Contour: _I
[T Shaw Triangle: J
W] Show Flow Arow: .

r Curzor Paint Values
X 2718¥ 1 57
Y : 338069.04
Z:2105.49
Slope : 9.72%
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3.5.2 Themes Tool

=== Analysis

: x|
et @ [0 [ 4t 83 | 2]

il

Step 1. Select the Themes icon from the Analysis tool box to invoke the dialog box depicted
below.

Step 2. Ensure that all graphic elements are Fit in o= —— T | ]

View 1. :
PRy
Step 3. We will determine the Elevation Range first =
for the TIN File 'SURVEY.TIN'. (This is the . _
first icon on the dialog box). TIN File: | survey.fin =
. . ™ Humbs fG'dP't:l;:,i.‘-
Step 4. Activate the Display Only toggle and the —Displ:ym o EIETerE
Fill toggle. ] Displey Orip —
[T Load Within Fence
™| 5Set Graphic Group
I+ Fil
r Options
[™ Planarize at Elevation:
[ Paolygonize Results
Step 5. Next, click the Set Range button to access the following dialog box.
g Hevation Range !Elm
File
Rahge: | Auto Bange Increment "l
r Auto Range Optiong
Range Increment; |D.EIEIEI
binirnum E lewation: ID.DDD 1958418 I
b awirnurn Elevwation: ID.DDD 2135.845 |
Set Range | Create Legend |
Lo High Color Active |
]
B
[0.000 [0.000 HEn

As shown on the right of the Minimum and Maximum Elevation Fields, the values for the
active TIN elevations are listed. By clicking these buttons individually, the elevation fields
will automatically be populated.

Step 6. Set the Range option to Auto Range Increment.
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Step 7. Set the Auto Range Options as shown below:

= Auto B ange Options

Range Increment; | b.000
Mirimumn Elewation: I 1335 000 1988418 I
k awirunn E lewation: i 2140.000 2135.845 I

Set Range | Create Legend |

Step 8. Click the Set Range button to populate the list box on the bottom portion of the dialog
box.

Selection of any list of elevations will populate the fields at the bottom.

Color Active

5000 150000 o ves
YES

1335.000 2000.000

x|

2 YES
2000.000 005000 3 YES
2005.000 010000 4 YES <]
| EEE I EEEI R

Utilizing the buttons on the right side of the list box will permit additional ranges to be
included in the list, modifications to be made to elevation ranges (or the color display of
this range), or deleting a particular elevation range.

Step 9. Close the Elevation Range dialog box (select the X in the upper right hand corner of the
dialog box).

Step 10. Click the Process button to initiate the display of the Elevation Ranges for the surface
model.

Step 11.  Close the Themes dialog box and Save Settings.
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3.5.3 Profile Tool

i)

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

" Fg a
=t ﬁ ;E:E

2|5l al20

Select the Profile icon from the Analysis toolbox to invoke the following dialog box.

] Frofile | Preferences |

Tupe | Feature

| Lewvel

| Color ['wieight| Style | Esxtract |

Create Legend |

TIM File | survey. tin 3'

4] [E

Use the Selection tab to identify your surface model (TIN File) which you will generate a
profile from, and the symbology for your profile.

Select the Tin File “SURVEY.TIN” by using the Files button.

Double-click on the
symbology box (field
to the right of the
Files push button) to
set the symbology

representing the
ground surface
profile. You may
choose any

symbology you wish.
Once the symbology
has been set, click
OK.

Click the Add List
Item icon (top icon
next to the list box)
to add the feature to
the collection box.

& Profile H= B
Hle
n] F'n:ufile] Pleferencesl

Type | Feature | Leval | Color weight] Stule | Estract |

TIH surves tin Lewel 1 g i 3 On a
&
~Add List tem
|

TIM File [ survey tin 3! [ ]
Create Legend |
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Step 6. Select the Profile Tab.

Step 7. Click the Place Element button to cut your actual profile at any desired area by just
placing two data points (i.e. a line) or a series of data points (i.e. a line-string) across your
surface model at any location.

Z5 Profile

Fle

Selection | Profile ] Freferences |

Select Elementl

Flace Profile | Curve Stroking: [0.000

r Extracted Profile Wiew

Step 8. You can use the Preferences tab to set up a grid for your profile if desired.

Step 9. Close the Profile dialog box and remove the DTM Tools tool frame.
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3.6 Working Alignment

Before leaving this exercise, let's go ahead and begin to set the stage for further design via the
Project Manager by defining the Working Alignment. You will usually create a Working Alignment
for each alignment on your project, but because of time constraints we’ll only do it for alignment
MAINLINE on our sample project.

To do this, we'll need to use the Select and Define buttons on the Project Manager Workflow dialog
box. The Project Manager workflow dialog box should still be active (we ‘sank’ it earlier in the lab).
Access the dialog box by selecting Window > Road Project: 17682.prj from the MicroStation menu
bar.

Step 1. Click the Select button to create a new Working Alignment. This will be very similar to
creating a run as we did earlier in this exercise. The Working Alignment is the active
chain that we are designing for.

i Select Working Alignment i

_|-Em

Dezcription
Untitled

Cancel ]

Step 2. Create a new Working Alignment called MAINLINE as shown below and click OK.

e R e ]

Run Marne: IMAINLINE

Description

Cancel |
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Step 3. After creating the run, select the run by highlighting it in the dialog box and clicking OK.

Select Working Alignment I

Dezcription

Cancel |

Step 4. You will now return to the main Workflow dialog box. Click the Define button to access
the Working Alignment Definition dialog box.

Step 5. Select the DTM item in the list box and complete the DTM definitions as shown below:
# Working Alignment Definition: MAINLINE [_To] ]

Plan Wigw Exizting Ground TIM: Isurvey.tin File |
Fattem : i : File: |
Sl Portview TIM: | survey.tin

Profile Yiew Partview Horizontal S cale: I'I
Location

Crogs Section View Portview Yertical S cale: I‘I
E sizting Ground
Froposzed Finish Grade

DT

Cancel |

Step 6. Click OK to exit the Working Alignment Definition dialog box.

Step 7. Exit MicroStation.
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CHAPTER 4

Coordinate Geometry

4.1 Introduction

Objectives

Learn to set up and access the coordinate geometry database file. Become
proficient in using GEOPAK Coordinate Geometry.

Project Manager

Coordinate Geometry

Tool

Al

Herizental & Vertical Geometry =]

“hlE s ] by

Menu Bar Application

GEOPAK Road > Geometry > Coordinate Geometry

The Coordinate Geometry database file (*.GPK file) is comprised of stored geometric elements such

as points, lines, curves, spirals, chains, parcels and profiles.

When COGO calculations are

completed, the results are stored in the binary database file, which is then utilized throughout the
design process with many other applications.

4.2 Accessing COGO

When Coordinate Geometry is started, the Start-Up Dialog box appears.

[Coordrete Geomery ]
Project Mame: |1F"582—
Job Mumber: rTDT—S__I
Operator Code: ITd_
Subject: I—

Carcel |

The fields in the Start-Up dialog box are detailed below.

Project Name

Job Number

Operator Code

Subject

Name displayed on reports. This is an optional entry, with a maximum of
60 alphanumeric characters. If Project Manager is active, this field is
populated automatically.

Identifies coordinate geometry database file and is a required field. The job
number is a maximum of three alphanumeric characters. If Project
Manager is active, this field populated automatically. This field is required.

Unique 2-character code which enables multiple users access to database
file. The user’s initials are suggested. Note this field is not required for
single user access, but highly recommended. If Project Manager is active,
this field is populated automatically.

Description of coordinate geometry work (could relate to the project) with a
maximum of 48 alphanumeric characters.
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This field is optional.

After the dialog box is populated, and the OK button is clicked, the main coordinate geometry dialog
box is invoked.

4.3 Coordinate Geometry

£ Coordinate Geometry Job: 101 Operator: vd M= 3

File Edit Element View 'I_'Dols User
g!ug]&l_lzl_lﬁﬂﬂ_l'“ H(d‘f)

Disable Yisualization vIIDFF[Feature x| Browss| a1z w]gesiz  w| «|

________________________________ ~ -

®

The coordinate geometry dialog box is made up of three separate display areas:

Tool Bar (1) consisting of drop down options and icons. The display of specific icons is
customizable.

e COGO Key-in (2) this field enables manual entry of COGO commands. The drop down
button allows for a history of commands to be reviewed.

e Output Display Window (3) shows the results generated by the commands.
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4.3.1 File Commands

rﬂ? Edit Element View Tools User
sewss 1] +].&l A & | &l ] & 2] A ] ] v ] ] ] e
File Restore

————— Jn v|[OFF Feature) |v] Browse | sa12  w]gtmatz  w|| <« | <] > ] »]

i Import 4

E Export 4 ‘J

Exit

The File commands (as displayed in the exploded view above) are detailed in the table below.

File Utility This option opens another dialog box that contains a group of file utilities that will be
explained later

File Restore Loads an ASCII file of GEOPAK commands into the display window. Note no processing
occurs. The file must be named j10lovd.inp, where 101 is the current job number and
vd is the operator code.

Import Imports horizontal and vertical alignments and points from RDS and SDMS format into the
GEOPAK .gpk file.

Export Exports GEOPAK points, chains and profiles into formats for use in various data
collectors.

Exit Closes the COGO dialog box and ends the coordinate geometry session. A prompt to

save the session appears. Yes saves the audit trail, No exits without saving, Cancel
returns to the COGO session. Whether you pick Yes or No everything you did is still
saved in the .gpk file.

GEOPAK 2004 Edition Coordinate Geometry 4-3



GEOPAK®

4.3.2 File Utility

The File Utility option invokes the following dialog box.

Load

Append

Catalog

Delete

Output

Print Input File
Print Output File

Save

Allow Commands
to be Added

File Wkility [ x| I

File Mame | Subject l

b Load I [T Allow Commands to be Added
s
LCatalog
— Delete
Dutput
Print Input File
Brint Qutput File
Save

When selected, a menu appears listing all saved input files. Highlight a file, then click
the OK button. The input lines from the highlighted file are now displayed in the
display window for viewing, editing, or processing.

This command is for input files only. A new input file is created by copying the
contents of an existing input file to the end of the current input file. The Save
command must be used in order to store this new file.

When selected, a menu appears listing all saved input files (under the current
operator code) in the project directory. This is for reference only no action is taken.

When selected, a menu appears listing all saved input files. Highlight a file, then click
the OK button to remove this file from your project directory. Although the file is
deleted, the elements stored as a result of processing the commands are not deleted.

Writes an ASCIl file of the current display for reviewing and / or printing.
(Fname999.00c, where 999 is the current job number and oc is the operator code).

Sends your input file to the printer.
Sends your output file to the printer.

Saves the current audit trail to a file. (Fname999.ioc, where 999 is the current job
number and oc is the operator code.).

When this is toggled on, COGO commands are added to a previously loaded file.
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4.3.3 Edit Commands

; I EdzearEl_ementHﬂ.El ii jerﬁl @uﬁl EJ _| Bl J @ il ﬂ_lr' Redefine

Delete

____Dis?_l I__nsert IIDFF[Feature J Browsel 9312 v| q9g.12 v| << < _I >>|
Modify |
Read Al
Type All
Line Range
Editar

The Edit commands (as displayed in the exploded view above) are detailed in the table below.

Clear Empties the memory of the current audit trail without saving and initializes the line
numbers to begin a new sequence of commands. Note this does not clear the display
window.

Delete Deletes input commands in the input buffer by line number (or range of line numbers) and
re-sequences the line numbers for the remaining commands.

Editor Opens the GEOPAK COGO Command Editor, which enables the user to edit the current
input file.

Insert Adds a command line to the current input buffer before a specified line number;

subsequent command lines shift down and line numbering is automatically re-sequenced.

Modify Changes a fragment in a command line. The modified command line is not processed
until a Read command is performed.

Read All Processes the specified lines in the audit trail. This may be done for the entire file (All) or
by specifying a range of line numbers (Line Range).

Type All Displays the content of the audit trail, (All) or a portion of the audit trail by specifying a
range of line numbers (Line Range).

Line Range Allows you to specify a beginning line number and ending line number. This range of lines
can then be either “read” into COGO or just typed/listed in the display window.

Editor Opens the COGO Command Editor, which enables the user to edit the current input file.
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4.3.4 Element Commands

The mainstay of GEOPAK Coordinate Geometry are the various element commands. Tools are
supported for storing, stationing, adding additional data, deleting, etc. GEOPAK supports a wide
variety of elements: points, curves, spirals, chains or alignments, parcels, and profiles. Each
element is detailed below.

4.3.4.1 Element > Point

[ Coordncte Geometry Job: 101 Operatorvd —____________________MEE

File Edit |—Iement View Tools User

=/,

Dizable Vig

Point

Uity 5![ | gl I | Sl |@ ,_P.?l «d‘,,il ||— Redefine
Lifia N " 1+zzd)
= Cel
ave | o e |31z vl agaiz  w] «| <] 2] ]
3= =

Elevation

Spiral

Profle >

Chain » Eguate
Parcel » | Station

Transformation
Compare Points to TIN
Set Elevation From TIN

One of the most utilized sets of COGO tools are the point commands, as detailed in the table below.

Utility

Cell

Copy

Elevation
Equate

Station

Opens the Point Utility dialog box where the following options are available.
Delete - Deletes a point number (or range of numbers) from the database file.

Print - Displays the selected point numbers x, y, z coordinates, station value and other
stored information in the display output window.

Display - Visualizes the selected point numbers currently stored in the GPK file
(Temporary Visualization or Permanent Visualization must be turned on).

Assigns a cell name to a previously stored point. This point and associated cell can
then be plotted later through D&C Manager.

Copies points or a point range to a new point humber or range within the same
GEOPAK database file

Assigns an elevation to a previously stored point
Stores a new point with the same values as a previously stored point

Adds a station to a previously stored point.
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Store Stores a point by key-in coordinates or by |-
selecting a location graphically. A station, PontName [ ]
elevation, point code, cell, feature, or '

description can be optionally stored with the [ Auto Increment

point Coordinates
Horthing: l DP |

E azting: I

i R R R

Transformation Performs coordinate transformations based on user-defined control pairings

Compare Points Utilizing a set of COGO points (with elevations) compares the COGO elevation to the

to TIN TIN elevation and completes statistical analysis for "goodness of fit."
Set Elevation Utilizing this command, GEOPAK adds or updates an elevation to a previously defined
from TIN point, based on a TIN model.

4.3.4.2 Element > Curve

| £ Coordinate Geometry Job: 101 Operator- vd HEIH

File Edit Element View Tools User

< = A& e ol e

Digable Yix QJI"-;'E P Utlhty _I Bmwse 9512 ¥ | aga12 Vl << < | ¥ |
' -
Spiral Copy _I
Chain »  Data
Parcel k| Segment
Profile » | Station

By End Points

Concentric

The Curve commands (as displayed above) are detailed in the table below.

Utility Opens the Curve Utility dialog box were the following options are available.
Reverse — Reverses a previously stored curves direction.
Delete - Deletes a curve (or range of curves) from the database file.

Print - Displays the selected curves X, y, z coordinates, station value and other stored
information in the display output window.

Visualize - Visualizes the selected curves currently stored in the GPK file (Temporary
Visualization or Permanent Visualization must be turned on).
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Copy

Data

Segment

Station

Store

Copies a specified curve to another curve name.

Calculates the geometric parameters of a curve, displaying values for Delta, Degree,
Tangent, Length and Radius.

Defines new curves by dividing a stored curve into segments.

By identifying a curve and a control point on the curve (PC, PI, or PT), a station value may
be assigned.

Provides various options for defining and storing lines and curves such as Store Curve
By Tangents as shown below.

Siore Curve By Tangents HE

Curve name: [ [T Station P vI I
r Back Tangent r~ Element r dhead Tangent
%vl Fadius 'I A v|
P I N
DE: |
4.3.4.3 Element > Spiral
Cominale Geomeiry Job: 101 Operator- vd !El

File Edit Element View Tools User

Point » o 9
RE > 4] @{Jd&!_lgl_lﬁilj_l'“ Bl
: v Line
Dizable Viz Cobve i OFF [Featurs] _I Bmwse 3312 "l 3793912 Vl << [ _I >>|
L o El
Chain b | Copy

Parcel 4
Profile 4

The Spiral commands (as displayed in the exploded view above) are detailed in the table below.

Utility

Opens the Spiral Utility dialog box where the following options are available.
Delete - Deletes a spiral (or range of spirals) from the database file.

List/Print - Displays the selected spirals X, y, z coordinates, station value and other
stored information in the display output window.

Visualize - Visualizes the selected spirals currently stored in the GPK file (Temporary
Visualization or Permanent Visualization must be turned on).
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Copy Copies a specified spiral to another spiral name.
Store Provides various options for defining and storing spirals.
| £ Store Spiral Combinations By Tangents MER|
Spiral Mame: I Tupe:  SCS 'l ] | Station TS ”-‘l I
r Back Tangent r Element r Ahead T angent
= Entry Length vI I —
% F adius 'I I A |
B I— Exit Length 'I | i I—
DB: |
4.3.4.4 Element > Chain
Ly T i ——— ME |

File Edit Element View Toolz User

=|E

Curwve

.4l

“@Ud@J@J@ﬂﬂJ”me

p IEEERE v| b

o]

3
b
, [OFF Featue] ~| Browse || 3312
b

- Spiral
T -
3
Parcel Layout Offset
Station

Profile 4
Station Equation

Offset Chain

Transition Chain

The Chain (GEOPAK alignment) commands (as displayed in the exploded view above) are detailed

in the table below.

Utility

Area - Calculates the area of a closed chain.

Opens the Chain Utility dialog box where the following options are available.

Delete - Deletes a chain (or range of chains) from the database file.

Print - Displays the name of each element in the selected chains.

Describe - Displays the alignment data of each element in the selected chains.

Visualize - Visualizes the selected spirals currently stored in the GPK file (Temporary
Visualization or Permanent Visualization must be turned on).

Layout Offset

Project points onto a chain or compute offset distance and direction between two chains

at each control point or at user defined intervals of a specified station range.

Station

Provides a method for stationing or re-stationing a chain.
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Station Equation  Provides a method for applying a station equation to a chain.

Store Provides three options for storing a chain in the database file, From Elements, Store
Offset Chain and Store Transition Chain. The Store Chain From Elements dialog
box is shown below. (Chain name can be between 1-9 alphanumeric characters)

E Store Chain From Hemenis !m
Chain Name: I—” r Element Selection —————————
Begin Station vI I‘— Element Type: | Paint vI

Element List: Faint Mame;

<add| |

Store Chain 1
4.3.4.5 Element > Parcel
Comﬁndeﬁemnelry Job: 101 Operator- vd [_ (O] x|
File Edit El_ement_ View Tools User
Point v e
= i 7 P | @Uﬁiﬂzl_lgl_l@ilJ_]r Eigpie
-Disable\a"is.f ;urve . OFF [Feature] _I Browsel 99,12 v| q9g.12 v| << < _I » |
Spiral r LI
Chain. r
s
Profile ¥ Store
Subdivide
Editor

The Parcel commands (as displayed in the exploded view above) are detailed in the table below.

Utility Opens the Parcel Utility dialog box where the following options are available.
Delete - Deletes a parcel (or range of parcels) from the database file.
Print - Displays the elements of composition, the area of tract stored, taken and remaining.

Describe - Displays the elements of composition, the area of tract stored, taken and remaining
and a point, bearing, distance description of the specified tract.

Visualize - Visualizes the selected parcels currently stored in the GPK file (Temporary
Visualization or Permanent Visualization must be turned on).

Store Stores a parcel by adding points, curves and spirals.
Subdivide  Divides a parcel into individual lots.

Editor Edits a parcel.
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4.3.4.6 Parcel Commands (Manual Entry)

Several parcel commands are supported only by manual entry and have no associated dialog boxes.

Store Taken Store the portion of a parcel taken by entering point and curve names in either a
clockwise or counterclockwise direction.

Store Store easements by entering point and curve names in either a clockwise or

Easement counterclockwise direction.

Own Parcel Stores the names of the owners associated with previously stored parcels.

Make Legal Creates a metes and bounds description and writes it to a user named text file. See also

Legal Description Editor for the ability to create detailed and customizable legal
descriptions.

4.3.4.7 Element > Profile

| £ Coordinate Geometry Job: 101 Operator- vd !EII:I

File Edit |—El_ement_ View Tools User

Point v I I | P i | | ‘o
El Eu:un i I (e M d el | 5! |® s—F‘.“l p-l II" Redefine
. “| Line
Dizable Wist Cobve i OFF [Featurs] _J Brnwse 3312 Vl 3793912 "l << [ _I i |
Spiral 3 _"J
Chain 3
Parcel 3

Profile Utility

Elevation
Offset
Restation

The Profile commands (as displayed in the exploded view above) are detailed in the table below.
Note additional commands are supported as keyin only commands.

Utility Opens the Profile Utility dialog box where the following options are available.
Delete - Deletes a profile (or range of profiles) from the database file.
Print - Displays the data of the selected profile from the database file.

Elevation  Provides three options for reporting elevations along a selected profile, Station, Even Station,
Incremental Stations.

Offset Stores a new profile within a specified Station Range at a defined vertical offset from the original
profile.

Restation Creates a new profile with different stationing from a previously stored profile.
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4.3.5 View Commands

ECoortindeGmnetry Job: 101 Operator: vd
File Edit Element | View  Toolz User

I kJ@{JzIwIJBIJﬁiIJ_I'"

Dizable Yisualization l_ Redefine

||_ Visualization 4

Format

owse | 9312 wl[grganz ][« || <] > ][> ]

[V coco key-n
Command Output »

Error Alert

The View commands (as displayed in the exploded view above) are detailed in the table below.

Icons Enables the user to customize icons, which appear in the tool bar.

Redefine Displays the Redefine box on the tool bar.

Visualization Displays the visualization items on the tool bar.

Format Displays the format items (i.e. number of decimals, station format, etc.) on the tool bar.

COGO Key-in Displays the COGO Key-in box for entering commands in the dialog box.

Command Displays the Command Output Window in the dialog box, and controls options for the
Output Command Output Window. The Command output window can also be saved to a text
file in lieu of using the File > Output command.

Error Alert Enables the user to activate a beep and/or restore a minimized COGO dialog box when
an error occurs.

4.3.6 Tools Commands

Roadway Intersections

Cul-de-sacs

gCoon:indeGemnelry Job: 101 Operator: vd !Elm
File Edit Element View |'I_'|:n:||s User
FEEE EFEEEEI T
: Inverse
Disable Visuglizaton ¥ |[ 1 EEEAERd K | < _| »> |
Locate
OGO Key-n: 3 hd
........................ v || R hd
Best Fit
Translation and Rotation
Map Check

Redraw Visualized Elements
Clear Visualized Elements (Temporary)
Clear Visualized Elements {All)

The Tools commands are detailed in the table below.
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Navigator
Inverse

Locate

Intersect

Best Fit
Translation and Rotation
Map Check

Roadway Intersections

Invokes the COGO Navigator. See Section 4.4.

Calculates the distance and direction between points.

Stores a point or series of points not by specifying coordinates, but based on
a previously stored point using several methods. To locate a point by
distance and bearing, use the Tools > Locate > Traverse as depicted in the
dialog box below.

g Locate Traverse

Locate Point ; |

™| Elevation On
[T} Side Shat Mode

r Station Paint
Mame : I Equatel

r~ Direction

 Direction E |

™| Offset Distance : | 0000000
r Distance
Slope Distance | [0.000000 L+]
Zenith Angle : I 9000 00.00 Rod Height : | 0.0QQ000

Stores a point at the intersection of any two COGO elements.

& Intersect Tool |
Locate Point I
[ Auto Increment By I’
r Intersect Element
Paint |
Line
To Paint I A
Offset 201
’7 T Gt Curve
Chiain
r "with Element
Paint I Point to Point I
To Point I
Offzet
( 7] Dittancs
Intersect |

Calculates a best-fit chain through a set of points.
Moves, rotates, and scales a data set.
Edits a parcel.

Calculates data for the intersection of two COGO elements, usually chains.

GEOPAK 2004 Edition
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Cul-de-sacs Calculates data for a cul-de-sac.
Redraw Visualized Re-syncs the visualized COGO elements in the MicroStation file with the
Elements coordinate geometry data.

Clear Visualized Elements Removes all temporary visualized elements from the view.
(Temporary)

Clear Visualized Elements Clears all temporary and permanent visualized elements from the
(AID Microstation file.

4.3.7 User Preferences

| £ Coordinate Geometry Job: 101 Operator- vd H=E

File Edit Element Wew Tools User

FEPERrL— = e

Dizable Yisualization ""DFF[Feature J Browse Redefinition of Elements :’J <<| <| >I >>|

Visualization 4

=

Coordinate Display »

Angle Display 4

The User Preferences (as displayed in the exploded view above) are detailed in the table below.

Dialog Allows access to COGO Preferences dialog box.

Redefinition of Elements Toggles the Redefine option on/off. If Redefine is on, COGO data can be
redefined/overwritten.

Visualization Enables the elements to be displayed in the MicroStation file permanently,
temporarily, or not at all.

Coordinate Display Toggles between displaying NE or XY coordinates.

Angle Display Toggles between displaying Bearing or Azimuth.
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4.4 COGO Navigator
Feature / Function View, edit and display COGO elements.
Tools S_F"g
COGO Menu Bar Tools > Navigator

The COGO Navigator is a tool utilized to easily view and edit COGO data. Store, delete, edit, print
elements, plus visualization and selection set commands are easily accessible via the Navigator. The
Navigator can be accessed by the pull down menu COGO > Tools > Navigator or by the Navigator

icon. The following dialog box opens.

Select  Tools

| 2 Navigator(101) mEH|

Element :  Paint ] I

M arme

| Feature

From the Navigator, points, curves, spirals, chains, survey chains, parcels, and profiles (all COGO
elements contained in the coordinate geometry database file; *.gpk) can be added, deleted, modified,

identified, visualized, printed, or selected.

GEOPAK

2004 Edition
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4.4.1 Navigator > Select Tools

A variety of selection tools can be invoked via the Select pulldown, as depicted in the exploded view

below.

| £ Navigator(101) HER|

|_Se|ect Tools

Select Al 3'

Invert Selection

Clear Selection

Selection Set j

Fit View (Selection Set)

Show Selected Elements Cnly
Show All Elements

The Select tools are detailed in the table below.

Select All

Invert Selection

Clear Selection

Selection Set

Fit View (Selection Set)

Show Selected Elements
Only

Show All Elements

Selects all data items of a certain type. (i.e. all points)

Selects all items not previously selected, and unselects all items previously
selected.

Unselects all items.

Allows the user to create a selection set that meets particular criteria.
Same as using the Selection Set icon

Fits the selected items to the active MicroStation window.

Only the items in the selection set are displayed in the MicroStation
window.

All items in database file are displayed in the MicroStation window.
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4.4.2 Navigator > Tools

A variety of tools can be invoked via the Tools pulldown, as depicted in the exploded view below.
Many can also be invoked via the shortcut icons displayed at the top of the Navigator.

Add Element
Delete Element

X

Edit Element

Identify Element
id
Print/Describe Element

Edit Element Feature

Visualize Element

&)

Unvisualize Element
Visualize All

Redraw Visualized
Elements

Clear Visualized
Elements (Temporary)

Clear Visualized

| £ Navigator(101) !El

Select | Tools

Element

Add Element
Delete Element
Edit Element

MHame Identify Element
Print/Describe Element
Edit Element Feature

Visualize Element

Unvisualize Element

Visualize Al 4
Redraw Visualized Elements

Clear Visualized Elements {Temporary)

Clear Visualized Elements [All})

Settings...

Enables the selected type of element to be stored. When selected, the

appropriate Store Element dialog box is invoked.

Deletes the highlighted element.

Invokes the appropriate Store Element dialog box, populated with the
associated data of the selected element for editing.

When clicked and a COGO element is graphically selected, the element is
highlighted in the display field. If the selected element is not the displayed
element type (i.e., curve or point), the element type is also changed.

Displays the selected element’s data.

Changes the feature code of the element.

Displays the selected elements according to their feature code or default
symbology.

Removes display of selected elements.

Displays all of the elements of a certain type, or all elements.

Re-syncs the coordinate geometry data with the data displayed in the
MicroStation file.

Clears only temporary visualized elements from the view.

Clears all visualized elements from the MicroStation file.

GEOPAK 2004 Edition
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Elements (All)

Settings

Enables the user to define certain actions and behaviors of the Navigator.

Settings

r Selection Set

¥ Alert Prior to Clearing Selection Set

r~ Single Click Action

[T Highlight Yisualized Element
[T window Center Visualized Element

r Double Click &ction

Action ;| Edit Element VI

r Second Click Action on Feature

¥ Edit Element Feature

r~ Yiew Options
Fairt: | &l Poirts vI
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LAB 4. Coordinate Geometry

4.1 Accessing COGO

Step 1. Execute C:\data\geo\VDOT\road1\LAB4.EXE.
Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn.

Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 3. Select the Coordinate Geometry icon from the Road Project: 17682.prj workflow dialog
box.

The following COGO dialog box opens.

| Coordinate Geometry Job- 101 Operator- vd !EI[!I

[T eV ar e R

Disable Visuslization ¥ |[OFF [Feature] | =] Browse | 3312 | 33912 v| << _|_| >>|

G Fen T =

This dialog box is completely re-sizable, so you can position it where you're most
comfortable.
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4.2 Store Geometry

Our course project has 4 alignments. We'll store two of them using Coordinate Geometry. The first
alignment will be called MAINLINE and is shown below:

POT - D500
N 339730601
E 27 17900042

PI - D501
N 339017686
Curve ML-1 E 2718473611 e
Radius = 1100
PI - D502 Curve ML-2
N 338391813 O\ Radius = 2350
E 2718789759
POT - D503
N 337950539
E 2719189327
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4.2.1 Store Points

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Select the visualization option Permanent Visualization on the main COGO dialog box.

Access the Store Point dialog box by pressing the Store Point icon

E

or using the Element > Point > Store pulldown.

Paint MName; I
7] &uto Increment
Coordinates
Morthing: l op
E asting: I
r —
i_ P 2l !— ke I
r
I_;'_!:'.

To store point D500, manually enter the point number and coordinates as indicated in the
dialog box below. Activate the Auto Increment toggle, which will automatically
increment the point number by 1 for subsequent Store Point commands.

Z5 Store Point [ %] I
Prairit M arne: I D&00

[T Auta Increment
Coordinates

Marthing: 1339?30. B0 oF
E asting; I 2717300.042

——
—

Bl S

Press the Store Point button to store the point into the COGO database.

Continue storing points D501-D503 by utilizing the coordinates shown on the alignment
diagram. When complete, exit the Store Point dialog box by pressing the “X” in the upper
right hand corner.

GEOPAK 2004 Edition
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Note that the following point naming conventions should be followed:
Design — All points should begin with D (e.g. D501, D502, etc.).
Hydraulic — All points should begin with H (e.g. H501, H502, etc.)
Survey — All points should begin with S (e.g. S501, S502, etc.)

Traffic — All points should begin with T (e.g. T501, T502, etc.)

Right of Way — All points should begin with R (e.g. R501, R502, etc.)
Environmental — All points should begin with E (e.g. E501, E502, etc.)
Utilities - All points should begin with U (e.g. U501, U502, etc.)

§ =ub

4.2.2 Store Curves

Step 1. Access the Store Curve from Tangents dialog box by pressing the Store Curve from
Tangents icon

or select Elements > Curve > Store > By Tangents from the COGO menu bar.

Step 2. To store Curve ML-1, complete the dialog box as shown below and press Store Curve.
' NOTE: Pressing the “picture” buttons allows you to select from multiple
methods of defining the Back and Ahead Tangents

Slore Curve By Tangents !E
Curve name; IML-1 [ | Station PC VI I

r Element ——————————  Ahead Tangent

r Back Tangent -

//'/-\'l Radius | ﬂ]

[T100.00

Pl: [D500 P4 D502
0E: [D500 To D50
DB: D500 To D501
Step 3. To store Curve ML-2, complete the dialog box as shown below and press Store Curve.
' NOTE: Visualized points may be selected to complete any field that
requires defined points or directions.
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SloreCu'\reByTEngeds !Em
Curve name: [ML2 [T Station PC vI I

r Back Tangent
- -
% Fadius V! A |
|2350.EIEI
Pl: |DED2
DB: |DED1 T D50:

- Element ——————— ~ Ahead Tangent

DB: D501 To D502

Step 4. Dismiss the Store Curve from Tangents dialog box by pressing the “X” in the upper right
hand corner.

4.2.3 Store Chain

Step 1. Invoke the Store Chain From Elements dialog box by pressing the Store Chain From
Elements icon

=

or select Element > Chain > Store > From Elements from the COGO menu bar.

Step 2. Fill in the dialog box as shown below.
F Store Chain From Hements I
Chain Name: [MAINLINE [ Eleistt Shlections—————

Eegin Station ¥ | [200+0000 Element Type: Point 7|

Element List: Paint Name:

DAO0 CUR ML CUR ML-2 D503 < f-\dd| I

[ Siore Chain 1

' NOTE: You can enter the elements manually or select the visualized
elements graphically in order to fill in the dialog box.

Step 3. Press Store Chain and dismiss the Store Chain dialog box. The chain MAINLINE should
be visualized in the design file.
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4.2.4 Describe Chain

From the COGO dialog window, let's preview the geometry of the chain we just stored.

Step 1. Select the COGO Navigator icon | 2 Navigator(101) !Elﬂ

Select Tools
B
. . Element:  Chain  |[Prrt/Describe Blemert
or use the Tools > Navigator option on the
COGO menu bar to access the COGO Navigator i

DEFALILT CHAIM

dialog box.

Step 2. Set the element option to Chain and highlight the
chain MAINLINE.

Step 3. Press the “Print/Describe Element” icon.

Step 4. The chain geometry output will be displayed in the main COGO window.

| 2 Coondinaie Geometry Job: 101 QJeuT:lor. vd !EI[:!
Fle Edit Hement WView Tools User

R A | +|.4 ] a7 @UEIEJ_IEI_IQEIE_IV e
{ Permanent Yisualization vE|DFF [Feature) _I Browsel 9312 v| 373912 Vl << _Iil

COGO Keyir: [DESCRIBE CHAIN MAINLINE .LI
o® 1 DESCREIBE CHAIN MAINLINE £

Chain MATHLIWNE contains:
D500 CUR ML-1 CUR ML-2 D503

Beginning chain HAINLINE de=scripticn
Feature: DEFAULT CHAIN

Point DEOO i) 339.730.60 E 2.717.900.04 Sta 200+00.00
Course from D500 to PC ML-1 S5 38* 49' 05.11" E Dist 799.21

Curwe Data

e —— 3k
Curwve ML-1
Feature: DEFAULT CHAIN
FP.I. Station 209415 .00 H 339,017 69 E 2.718,473.61
Delta = 12+ 01' 05.95" (RT)
Degres = B g s SR
Tangent = 115.79
Length = 230.74
Radius = 1.100.00
External = .08 ;I

Step 5. Dismiss the COGO Navigator dialog box by clicking the “X” in the upper right hand
corner.
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4.2.5 Create Input and Output Files

In the following steps we will save an input trail of our commands and an output file with the
computations of chain MAINLINE.

Step 1. Access the File Utility dialog by pressing the File Utility icon

=

or by selecting File > File Utility. The dialog box below should appear.

File Utility AEER

File Mame | Subject |

Load vI ™| &llow Commatds to be Added

Step 2. On the File Utility dialog box, set the option button to Save.

File tility BEER

File Name | Subject !
ml CHAIM MAIMLINE

Save * | Name: |ML Subject; |Chain b ainlire

Step 3. Enter “ML" for the Name and “Chain MAINLINE” for the Subject then click Apply. The
saved file will be called ‘ML101.ivd’
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Step 4. To save an output file with the actual results of the computations, set the option button to
Output on the File Utility dialog.

File Utility AEER

File Mame | Subject |
ml Chain MAIMLINE

Output | Qutput File: [MC

Step 5. Output File should be set to “ML”. Click Apply. The saved file will be called
‘ML101.ovd’.

Step 6. Dismiss the File Utility dialog by clicking the X in the upper right hand corner.

Step 7. Dismiss the COGO dialog by clicking the X in the upper right hand corner.
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4.3 Working Alignment

Now that we have our alignment, we have another piece of information for the Working Alignment

definition.
Step 1.
Step 2.

Step 3.

Step 4.

Access the Project Manager Road workflow dialog box.

Click the Define button to access the Working Alignment Definition dialog box.

Highlight the Plan View option and use the File and Select buttons to populate the
Design File and Chain fields as shown:

Fattern
Shapes
Profile Yiew
Location
Crozs Section Yiew
Exizting Ground
Propozed Finizh Grade
DTH

Cancel I

Wm‘l-:ing Alignment Definition: MAINLINE [_ (1] ] |

Select I

Degign File: I d14d1 7E82des. dgn
Chair: IMAINLINE
Begin Station;  200+00.00

End Station:  222+06.84

Click OK.
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CHAPTER 5

Horizontal Alignment Tools

5.1 Introduction

Objectives

Create and store horizontal chains using MicroStation elements.

Project Manager

Horizontal Alignment

Tool

\ﬁél

Horizontal & Vertical Geometry

2o R A 8

Menu Bar Application

GEOPAK Road > Geometry > Layout Alignments Horizontal

The Horizontal Layout Tools enable the user to create or modify horizontal geometry (using
numerous tools) including placing spirals, curves, tapers, specified bearings and curves, complex
ramp loops and connectors, and all to user-defined parameters.

' NOTE: When Horizontal Alignment Generator is invoked, a session of COGO will be
started automatically.

Once Horizontal Alignment Generator is selected, the dialog box below appears.

EHmiznntal Alignment Generator il
File Design Tablez Tools

When User > Preferences is selected the User Preferences dialog box below appears and allows
the user to set certain preferences.

[BPeferences = HEE)|

Element Symbology r”

COGO Element Manmes M
Curve Design Tables

- r

-

Line Element ; =
Curve Element : =

Spiral Element ; =

Spiral Degign Tables

Turning Paths Construction Line ;

Phalionment. Label Scale: [T.00

Geametry Settings

Dipnamic [ncrements Grouping: | Mone vI
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The Design Tables option allows the user to set up Design Tables for Symmetrical 3 Centered
Curves, Asymmetrical 3 Centered Curves, Symmetrical Taper Curves, Asymmetrical Taper Curves,
and Spiral Curves. These files are stored in an ASCII format.

F{ Horizontal Alignment G... - |5] x|

File EsignTables Tools

Symmetrical 3 Centered Curve
Asymmetrical 3 Centered Curve
Symmetrical Taper Curve
Asymmetrical Taper Curve
Spiral Curve

The Tools option allows the user to open the Main dialog box or any of the dialog boxes needed do
store a Horizontal Alignment.

F2{Horizontal Alignment G... - |1][x]

File Design Tables | Tools

Main

Lines [ Curves

Curve Combinations
Spiral Combinations
Complex Transitions

Alignment

Manipulate

Values within the dialog boxes dynamically change simultaneously with dynamic graphic
modifications.

Spiral and compound curve commands do not support dynamic manipulation.

=l
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5.2 Lines/ Curves Tools

Lines / Curves =]

A AR =

The Place Line / Curves Commands are detailed in the table below.

/ Store Line By 2 Points

The store line by two points command requires two new points and a new line. The command
draws the line and the new points.
Store Tangent Line

The Store Tangent Line tool stores a line and its two endpoints in the coordinate geometry
database.

Store Curve By 3 Points
The Store Circular Curve by Three Points tool stores a circular curve (using chord definition).

4

Store Curve By Center

This tool enables the user to store a circular curve by defining the center point, radius, and
sweep angle.

2 [2

Store Tangent Curve Unconstrained

The Store an Unconstrained Tangent Curve tool places a curve through a specified point
tangent to the specified curve or line.

A

Place Simple Curve

This tool enables the user to store a circular curve. Options include offsets, truncate, and the
ability to modify once the first curve is displayed.

|

a Place Simple Transition

This tool enables the user to draw a transition element between two arcs. Options for the
Transition element include: Tangent, Curve, or Spiral. As the Transition option is changed,
the dialog box dynamically changes to reflect the selection.
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5.3 Curve Combinations Tools

Curve Combinations =l

7 AT =

The Curve Combinations Commands are detailed in the table below.

Place Turning Paths

The Place Turning Paths tool draws the turning paths of a variety of vehicles based on the
specified Turning Path Design Table. The Turning Paths Options in the Preferences identifies
the table file in addition to label options. Labels include the Design Vehicle, Turning Angle, and
Turning Radius.

Place Compound Curves

This tool enables the user to draw a compound curve between two elements.

Place Three Centered Curves

This tool enables the user to draw a three-centered curve between two elements. The Design
Vehicles group enables the user to select the desired vehicle, based on the data from files stored
in the User Preferences.

Place Taper Curves

This tool enables the user to draw taper curves between two elements. The Design Vehicles
group enables the user to select the desired vehicle, based on the data from files stored in the
User Preferences.

Place Reverse Curves

This tool enables the user to store reverse curves between two elements. An option is supported
for an intermediate user-defined Tangent Length.

5.4 Spiral Combinations Tools

-

e

ERE

Spiral Combinations |

The Curve Combinations Commands are detailed in the table below.

Place SC Tangent To Line

This tool enables the user to store a spiral / curve combination tangent to a line.

Place ST Tangent To Curve

This tool enables the user to store a spiral / tangent combination tangent to a curve.

Place SC Tangent To Curve

This tool enables the user to store a compound spiral / curve combination tangent to a curve.
Place SCS (Intersecting Elements)

This tool enables the user to store a spiral / curve combination tangent to a line. The Design
Table enables the user to select the desired Design Speed / Lanes and Degree based on the
data from files stored in the User Preferences.

Place STS (Disjoint Curves)
This tool enables the user to store a spiral tangent spiral combination tangent between two
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elements.
£ ‘*-l Place SCS (Disjoint Curves)

This tool stores a spiral curve spiral combination between two curves. Note the tool also works
with overlapping curves. The Design Table enables the user to select the desired Design Speed
/ Lanes and Degree or Radius based on the data from files stored in the User Preferences.

5.5 Complex Transitions Tools

Comp.. =]

o T

} L

The Complex Transitions Commands are detailed in the table below.

Place Complex Ramp
This versatile tool enables the user to draw simple to complex ramp geometry.
Place Ramp Connector

This versatile tool enables the user to draw simple to complex ramp connectors, with a variety
of options.

5.6 Alignment Tools
Alignment x|

ia

The Alignment Commands are detailed in the table below.

?‘H Place Dynamic Alignment

The first Alignment tool is placing a dynamic alignment. You initially select and accept a
beginning element. By moving the cursor, the length of curve and dynamic ahead element
change. Continue placing data points to create curves and intermediate tangents. At any time
during the process, the Entry Radius may be changed. Any subsequent curves are placed with
the revised Radius.

l@'j Place Pl Alignment

The PI Alignment tool enables the user to create or modify chains in a table format. The various
fields can be manually changed, new points added, etc.

g Store Chain

The second Alignment tool is storing a chain comprised of graphical elements. This works
similar to Automatic Create Complex Chain, while the chains are automatically being stored into
the COGO database file.
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5.6.1 Place Pl Alignment

By selecting the Load DTM Feature icon, the following dialog box appears.

Place Pl Alignment [ _ [O] ]
[MaNLNE ~| k] ; | e
Pl % |PIY | Station | Digtance | Direction | L1 | Radiuz | Ls2
2717900.04 | 33973060 | 200+00.00 0.00 0.00 0.00
915.00 538°49'511"E
271847361 33901769 | 2058+15.00 Qoo 1100.00 0.00
70119 S 26747 BAIE"E
271878976 | 338391.81 | 216+15.34 0.00 2350.00 0.00
595,30 S542°5 37 89" E
271918933 33798054 | 22240634 Q.00 Q.00 0.00

Identify Chain

Graphically defines the chain / alignment. Click, then select one element of the visualized
chain.

Ez

Load Chain to Table
After the chain has been specified, clicking this button loads the chain into the list box.

+ +|
M- Load Graphic Element to Table
= Clicking this button then identifying a graphical element loads the element into the list box.
[ Save Chain
s Saves the chain.
Insert Pl Point
H=
E— Highlight a PI line in the list box, then click.
=i Delete Pl Point
—_— Highlight a PI line in the list box, then click.
% Clear Alignment Table
—_ Clears the list box.
Move Element
—_— Click and dynamically move the highlighted PI point.
7{-:— Modify Curve Radius
_— Click and dynamically modify the highlighted curve.
R Check Overlaps
_ If two curves or spirals are overlapping, the overlap is removed.
Undo
Redo
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5.7 Manipulate Tools

M anipulate x|

A "|| ,/l ><|

The Manipulate Commands are detailed in the table below.

. Move Plan View Element

The Move a Plan View Element enables the user to move / translate an element or to make
copies.

Rotate Plan View Element

| &

The Rotate Plan View Element rotates the selected element about a user-defined point. The
Angle may be manually entered and locked, or dynamically changing.

Extend Plan View Element

The Extend Plan View Element tool can extend or shorten any element.
Delete Element

When using the Delete Element tool, no tool settings dialog box opens.

Select and accept the element to be deleted. The element is removed from the coordinate
geometry database. This tool works with a MicroStation selection set if present. Warning:
there is no undo for this command.

X [
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LAB 5. Horizontal Alignment Tools

5.1 Accessing Horizontal Alignment Tools
Step 1. Execute C:\data\geo\VDOT\road1\LAB5.EXE.
Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn.

Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 3. Select the Horizontal Alignment icon from the Road Project: 17682.prj workflow dialog
box.

Step 4. You will see the following dialog box. Click YES.

e ]

Would you like to activate the default design tables?

Step 5. The Coordinate Geometry dialog box should appear. Ensure that Permanent
Visualization is set, then you can either move the COGO window out of the way or “sink”
it using the Bentley icon.

r- Coordinate Geometiy

= Restoe
Move

Size

Minimize

M aximize

X Cloze Alt+F4

Step 6. You should now see the Horizontal Alignment Generator menu bar.

%Hulizuntal Alignment Generator ﬂ
File Design Tables Tools
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5.2 Store Another Alignment

In this exercise we will store another alignment using the “Place PI Alignment” tool in the Horizontal
Alignment Generator. Use ‘EBL460’ for the chain name. The beginning station of the chain will be

107+00.
POT - D602
N 338939994
£ 2719708661
Curve EBL460-1
Radius = 5000 P/l - DEOI
N 338356.106
E 2719353.365
POT - D6OO
N 337489479

£ 2718598813

Step 1. Use the File > Preferences pulldown to access the Preferences dialog box. Select “COGO
Element Names” then populate the dialog box as shown.

e ([

Element Symbaology

¥ Save az COGO Elements

COGO Element Marmes|
Curve Design Tables

Spiral Deszign Tables ¥ Paint: !"D_E'D‘D_‘
Turning Paths

Pl Alighnent I Line: i

Geometry Settingsz ¥ Curve : W

Diynamic [ncrements
™| Spiral : i

- Beqginning Element Mames
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Step 2. Select “PIl Alignment”. Set the Station Method to “Restation from Beginning Station”. The
dialog box should appear as below.
Cateéor I r Component Mavigation
Elerment Symbology i1 .
COGD Element Mames [ Hilite Component [T Window Center
Curve Design Tables
Spiral Deszign Tables r Constraint Display Settings
Turning Paths

Pl &lignment [T Distance Label: |
Geometry Settingsz [ Direction Label : |

D ic | t it
ANANIEENCIEMEN [ Pl Point Circle : |

Pl Point A adius ; |1EI.DD

Station Method: | Restation from Beginning Station Vl

Step 3. Dismiss the Preferences dialog box by pressing the “X” in the upper corner.
Step 4. Use the Tools > Alignment pulldown to access the following menu bar:
Alignment x|
=, ==
2oy &
Step 5. Select the second of the three icons to access the Place Pl Alignment dialog box. Using the
Inset Pl Point icon, populate the dialog box as shown below:
P'Iace Pl Alignment ! I
! <Select: _ﬂ‘m l
Pl | Pl | Station | Distance | Direction | L1 | Radiuz | Ls2
271859881 | 33748948 | +00.00 0.00 0.00 0.00
114908 M 41" 2 4320°F
2719353.37 | 3383611 +00.00 0.00 5000.00 0.00
£83.49 N 31" 191388 E
+00.00 ./ Jooo . foo0 (o0
Step 6. Click the Save Chain icon.

]

Step 7. Populate the Save Chain dialog box as below the press OK.

Begin Station: I 107+00.00

Cancel |

Save Chain As__.
Chair: | EBL4E0
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The Place PI Alignment dialog box should now appear as below:

Place Pl Alignment mE I

[EBLAED =1 5] e e
Pl |PIY | Statian | Distance | Direction | Badius | Ls2
2718598.81 | 33748948 | 107+00.00 0.00 0.00
1143.08 N 41724320 E
271935337 | 33830611 118+49.09 5000.00 0.00
£83.44 N31°19 1388 E
2719708.66 | 338939.99 | 125+30.53 0.00 0.00
Step 8. Dismiss the Place Pl Alignment and dialog box by pressing the “X” in the upper corner.
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5.2.1 Describe Chain

From the COGO dialog window, let's preview the geometry of the chain we just stored.

Step 1. Select the COGO Navigator icon
Select Tools
. . Element : M‘:
or use the Tools > Navigator option on the Prrt/Descrbe Bemert
COGO menu bar to access the COGO Navigator Name_ =
dialog box EBLeen ] |
J ' HAINLINE DEFAULT_CHAIM

Step 2. Set the element option to Chain and highlight the
chain EBL460.

Step 3. Press the “Print/Describe Element” icon.

Step 4. The chain geometry output will be displayed in the main COGO window.

| 2 Coontinate Geometry Job: 101 Operator- vd !Ell!l

FEFPEPEr L PIAE EEPE e e

{ Permanent Wisualization "EIDFF [Feature) _| Brnwse 9312 vI 999,12 VI <<
COGO Keyir: [DESCRIBE CHAIN EBL4ED

L

< * 14 DESCRIEBE CHAIN EBL460

Chain EEL460 contains:
DEOD CUR EBL460_1 DeO1

Beginning chain EBL460 description

Foint D&OD H 337,489 .48 E 2,718,598.81 Sta 107+00.00
Course from DAEOD to PC EBL460_1 N 41° 02' 43 20" E Dist 723.74
Curwe Data

Curve EBL460_1

P.I. 5Station 118449 .08 H 338.356.11 E 2,719,353.37

Delta = 9 43" 29.31" (LT

Degre= = 1° 08" 45, 30"

Tangent = 425 35

Length = 348 &5

Radius= = 5.000.00

External = 18.08 -]

Step 5. Visualize chain EBL460 using the COGO Navigator.

Step 6. Dismiss the COGO Navigator dialog box by clicking the “X” in the upper right hand
corner.
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5.2.2 Create Input and Output Files

In the following steps we will save an input trail of our commands and an output file with the
computations of chain EBL460.

Step 1. Access the File Utility dialog by pressing the File Utility icon

<

or by selecting File > File Utility. The dialog box below should appear.

File kility HE R

File Mame | Subject |
ml CHAIM MAIMLINE

Load vI [T Allow Commands to be Added

Step 2. On the File Utility dialog box, set the option button to Save.

File kility HE R

File Mame | Subject !
ehl CHAIM EBL4ED
ml CHAIM MAIMLIME

Save vI Mame: |EBL

Subject | Chain EBL4E0

Step 3. Enter “EBL” for the Name and “Chain EBL460" for the Subject then click Apply. The
saved file will be called ‘EBL101.ivd’
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Step 4. To save an output file with the actual results of the computations, set the option button to
Output on the File Utility dialog.
[ £ File Wility HER
File Name | Subject !
ehl Chain EBLAE0
i Chain MAIMLINE

Output | Output File: [EBL

Step 5. Output File should be set to “EBL”. Click Apply. The saved file will be called
‘EBL101.ovd’.

Step 6. Dismiss the File Utility dialog box by clicking the “X” in the upper right hand corner.

Step 7. From the Edit pulldown, select Edit > Clear to ‘clear’ out all the commands that we just
previously typed in.

' This will not remove the stored data from COGO.

GEOPAK 2004 Edition LAB 5: Horizontal Alignment Tools 5-15



GEOPAK®

5.3 Preferences

Step 1. Use the File > Preferences pulldown to access the Preferences dialog box. Select the option
for COGO Element Names and complete the dialog box as shown.

Cateéorg I

Element Symbolagy ¥ Save az COGO Elemernts

COGO Element Manmes

Ciavs Designi Tables - Beginning Element Mames

Spiral Degign Tables M| Pairt - m_'
Turning Paths

Pl Alignment I Line: i

Geametry Settings ¥ Curve : IW‘

Dynamic [ncrements
¥ I Spiral - |

Step 2. Select the Curve Design Tables option. Using the Files button, select the appropriate file for
each option. The files are located in the following directory:

C:\data\geo\vdot\roadl\standards\geopak\

Symmetrical 3 Centered Curve HA_3CenteredCurve_Symmetrical_2001English.tbl
Design Table
Asymmetrical 3 Centered Curve | HA_3CenteredCurve_Asymmetrical_2001English.tbl
Design Table
Symmetrical Tapered Curve HA_TaperCurve_2001English.tbl
Table
Asymmetrical Tapered Curve HA_TaperCurve_Asymmetrical_2001English.tbl
Table
Step 3. Select the Spiral Design Tables option. Using the Files button, select the appropriate file. The

file is located in the following directory:

C:\data\geo\vdot\roadl\standards\geopak\

Spiral Design Table HA_Spiral_Rural_VDOTEnNglish.tbl

Step 4. Dismiss the Preferences dialog box by pressing the “X" in the upper corner.
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5.4 Store a Complex Ramp

Step 1. Use the Tools > Complex Transitions pulldown to access the following menu bar:

Step 2. Select the first of the two icons to access the Place Complex Ramp dialog box and fill out the
dialog box as shown below:

@ Place Complex Famp —_____ MEIE)
r Back Element(z)
¥ Back Dffset: IEWE
O ik T == =

| Curve VI Length 'I IWE R adius : WE

Intermediate Curve Radius - [280.000000 B

r Ahead Element]z]

I7 Curve v| Length v| | 100356 E Radius : |23u oot =

!— Ahead Offset | 12.000000 E
Truncate 4 | None "l "] Loop [Exterior Construction)

Step 3. Chains MAINLINE and EBL460 should be visualized in the design file from our previous
exercise. Use your cursor to ID chain MAINLINE with a datapoint, then issue another
datapoint to accept it.

Next, use your cursor again to ID chain EBL460 with a datapoint.

The ramp will now dynamically visualize.

NOTE: As you move the cursor into any of the 4 quadrants of the intersection of
the two alignments, the ramp will re-calculate and re-visualize in that quadrant.

§=ull

Step 4. Issue a datapoint in the westernmost quadrant to store the ramp as shown in the diagram
below:
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Step 5. Dismiss the Complex Ramp dialog box and review the COGO output window. Notice
that the 3 curves were automatically stored into the COGO database.

[ Coordnate Geometry lob= 101 Operstorvd M=)

FHle Edit Hement View Tools User
R A | + |4 ] @& ‘“@ugl&uﬁ_lﬁ ﬂ_l'“
{ Permanent Yizualization "5 OFF [Feature] J Brnwse 9312 "I 9°9'9.12 "J <<
COGO Key-in: [3PC N 337952.65505445 E 2715956 4905137 DB 195 04544008091 R 230.00000000000 P DEFLECTION 24 593692386152 |« |
% 7 STORE CURVE RAMPA-3 PC N 337962 85905449 E 2718966 4905137 DB 196 04-
544008091 R 230 00000000000 P DEFLECTION 24 999892386152
Curwe Data
H————————— 3k
Curve RAMPA-3
P.I. Station 0+50 93 W 337,913 86 E 2,718,952 40
Delta = 24* B9' B9 g1" (RT)
Degres = 247 B4' 40 35"
Tangent = 50.99
Length = 100 .38
Radius = 230 .00
External = .58
Long Chord = 99 .56
Hid. Ord. = E. 45
F.C. Station 0+00.00 W 337,962,886 E 2,718,966 49
P.T. Station 1400 36 W 337,875 40 E 2,718,918 .91
oo W 338,026.42 E 2,718,745 45
Back =5 16° 02' 43 68" W
Ahead = 5 41° 02' 432.20" W
Chord Bsar = S 28° 32 43.39" W
Curwe RAWNPA-3 =tored -
Step 6. Use the Tools > Alignment pulldown to access the following menu bar:
ngnnent =]
Step 7. Select the third of the three icons to access the Store Chain dialog box. Fill out the
dialog box as shown below:
E Store Chain [ _ o] x|
Id: [RAMPE
Beqin Station: I 10+00.00
i Tranzpose "l
MaHGap:IDDD1DDD
Step 8. With your cursor, issue an initial datapoint to ID the northernmost curve of the ramp.
Issue a second datapoint to accept it.
Step 9. The entire chain will highlight and you'll see some directional arrows. Issue another

datapoint to accept the direction of the chain.
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Step 10.

Dismiss the Store Chain dialog box. Review the output in COGO and notice the chain
RAMPA has been stored into COGO.

[ Coordnate Geometry lob= 101 Operstorvd M=)

EEEPEr RGP EEE = b T

| Parmanent Yisualization "ﬂ OFF [Feature] ;I Browse | 9912 vi 979912 v|i| LI Ll il
COGO Kewire [ STORE CHAIN RakPA CUR RaMPA-1 CUR RAMPA-2 CUR RAMPA-3 STATION 10+00.00 ﬂ
e —————— 3k _AJ

Curve RAMPA-3
P.I. Station 0+50.99 W 337,913 .86 E 2,718,952 .40
Delta = 247 B9' B9 51" (RT)
Degrees = 24° 54' 40 35"
Tangent = 50.99
Length = 100 .38
Radius = 230.00
External = .58
Long Chord = 99 56
Hid. Ord. = 5.45
F.C. 5Station 0+00.00 W 337,982 88 E 2,718,966 .49
P.T. Station 1+00.36 H 337.875.40 E 2,718,918 .91
letiats i 338,026 .43 E 2,718,745 45
Back =5 16° 02' 43.58" W
Ahead =5 41° 02" 43.20" W
Chord Bear =5 28° 32' 43.39" W
Curwe RANPA-3 =tored
L% a STORE CHAIN RAMFPA CUR RAMPA-1 CUR RAMPA-2? CUR RAMPA-3 STATION 10+0-
0.oo
Chain RANPA stored -

Step 11.

Dismiss the Horizontal Alignment Generator dialog box by pressing the “X” in the
upper corner.
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5.4.1 Describe Chain

From the COGO dialog window, let's preview the geometry of the chain we just stored.

Step 1. Select the COGO Navigator icon I —r |
Select Tools
4 :
) ) Elerment: [ Chain + | | Prirt/Describe Elemert
or use the Tools > Navigator option on the
COGO menu bar to access the COGO Navigator E’*éifzgn | Feature |
dialog box. MAINLINE DEFAULT_CHAIN
T
Step 2. Set the element option to Chain and highlight the
chain RAMPA.
Step 3. Press the “Print/Describe Element” icon.
Step 4. The chain geometry output will be displayed in the main COGO window.
[E?Cnmﬂndeﬁemmdw Job: 101 Operator: vd !lE]IE]
Fle Edit Hement View Tools User
RE A ] .4 & *Mugl&l_lgl_lﬁs_wlﬂ_l'“
| Parmanent Yisualization ¥ § OFF [Feature) _I Brnwsel 9312 VI 9°9'9.12 VI <<
COGO Keyir: [DESCRIBE CHAIN RAMPA -]
% 9  DESCRIEE CHAIN RAMPA
Chain RAMPA contains:
CIIR R&MPA-1 CUR RAMPA-2 CUR RAMPA-3
Beginning chain RAMFA description
Curwe Data
__________ : 3
Curve RAMPA-1
P.I. Station 10458 19 H 338,187 46 E 2,718,942 59
Delta = 20° 00 00.17" (RT)
Degres = 177 21° 44 43"
Tangent = B8 .19
Length = 115.19
Radius = 330.00 _I
External = .09
Long Chord = 114 .61
Hid. Ord. = £.01
P.C. Station 10+00.00 H 338,232.582 E 2,718,905, 78
P.T. Station 11415 19 H 338,132 52 E 2,718,961 .76 -l
Step 5. Dismiss the COGO Navigator dialog box by clicking the “X” in the upper right hand

corner.
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5.4.2 Create Input and Output Files

In the following steps we will save an input trail of our commands and an output file with the
computations of chain RAMPA.

Step 1. Access the File Utility dialog by pressing the File Utility icon

<

or by selecting File > File Utility. The dialog box below should appear.

File kility HE R

File Mame | Subject |
ehl CHaIW EBL4ED
ml CHAIM MaIMLIME

Load vI [T Allow Commands to be Added

Step 2. On the File Utility dialog box, set the option button to Save.

File kility HE R

File Mame | Subject l

ebl CHAIM EBL4ED
ml CHAIM MaIMLINE
1anpa CHAIM RAMPA,

Save * | Name: |F!.-’-‘«MF Subject; |Chain Rabd Py

Step 3. Enter “RAMPA” for the Name and “Chain RAMPA” for the Subject then click Apply.
The saved file will be called ‘RAMPA101.ivd’
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Step 4. To save an output file with the actual results of the computations, set the option button to
Output on the File Utility dialog.

File kility HE R

File Mame | Subject |
ebl Chain EBL4E0

ml Chain MalMLINE

1anpa Chain RAMPA,

Output | Output File: [REMPE

Step 5. Output File should be set to “RAMPA”. Click Apply. The saved file will be called
‘RAMPA101.0ovd’.

Step 6. Dismiss the File Utility dialog box by clicking the “X” in the upper right hand corner.
Step 7. Dismiss the COGO dialog box by clicking the “X” in the upper right hand corner.

Step 8. Exit MicroStation.
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CHAPTER 6

Graphical COGO

6.1 Introduction

Objectives

Create and store COGO elements using Graphical Coordinate Geometry
tools

Project Manager

Coordinate Geometry

Tool

2

Horizontal & Vertical Geometry

x|
Al mimidyl Aind B

Menu Bar Application

GEOPAK Road > Geometry > Graphical Coordinate Geometry

Graphical Coordinate Geometry is a tool that allows the user the ability to store coordinate
geometry elements into the COGO database (GPK file) graphically. Points, curves, lines, spirals,
chains, and parcels can be stored, modified, or deleted. The COGO elements can be manipulated by

key-in or a click of the mouse and are stored directly into the COGO database.

' Note: Graphical Coordinate Geometry does not read the exclusive MicroStation
graphics.

L]

' NOTE: When Graphical COGO is invoked, a session of COGO will be started

L automatically.

When Graphical COGO is selected, the main COGO dialog box will appear as below.

GEOPAK 2004 Edition
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6.2 Store Elements

The Store Elements toolbox contains eleven icons.

Store Elements x|

. AAAAN AlAA e

As elements are stored, the visualization parameters in the SMD file (as defined in the user
parameters) are utilized. This assumes that the temporary or permanent visualization is activated. If
no visualization is active, no elements are visualized.

A
&

When a Store Element command is selected, a sub pallet will appear to allow the user to enter data if
necessary as depicted below.

Store Hements =]
B A A Aol A
£ Store Point MEE
Id: |DY00

Coordinates: | Curvilinear V!
Chainld: [MANLCNE =] %
¥ Station: WBE.B_
W Offset:  [oo0
[N Elevaton: [000

The Store Elements commands are detailed in the table below.

Store Point

[+

The Store Point tool enables the user to store points utilizing Cartesian coordinates (x, y, z
or N, E, Z) or Curvilinear (station, offset, elevation).

" Store Equally Spaced Points

%,

The Store Equally Spaced Points stores a user-defined number of points between two
previously defined points or any two data points. A line drawn between the two previously
defined points is not necessary.

Locate Point

The Locate Point command stores a point based on the distance and direction from a
previously defined visualized point.

Store Line From Existing Points

[

The Store Line from Existing Points utilizes two previously stored points to store a line.

Store Line By 2 Points

N,

In contrast to the Store Line by Existing Points, the store line by two points command
requires two new points, rather than existing points. The command stores the line and the
new points, utilizing the "next" available point and line names.
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Store Tangent Line

The Store Line Tangent To Element tool stores a line and its two endpoints in the
coordinate geometry database.

Store Curve By 3 Points

The Store Circular Curve by Three Points tool stores a circular curve (using chord
definition). The stationing is set to 0+00 at the P.C. The Radius can be manually typed in
or defined dynamically.

Store Curve By Center

This tool enables the user to store a circular curve by defining the center point, radius, and
sweep angle.

Store Tangent Curve Constrained

The Store a Constrained Tangent Curve tool places a curve tangent to the specified curve
or line.

Store Tangent Curve Unconstrained

The Store an Unconstrained Tangent Curve tool places a curve through a specified point
tangent to the specified curve or line.

Store Tangent Spiral

The Store Transition Spiral tool quickly places and visually modifies spirals based on an
initial line or curve.

6.3 Modify Elements

CCE(}_é[ Modify Hements =
g (| M P = N P e I T

ST

When a Modify command is selected, a sub pallet will appear to allow the user to enter data if
necessary as depicted below.

Modify Elements JE |

B‘.:::l: Mo T e

T Estension ¥ II 0.0000

[ Mew Segment
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The Modify Elements commands are detailed in the table below.

|—_>.<| Partial Delete

The Partial Delete tool enables the user to delete part of a COGO line or curve, creating
two separate elements.

Extend Plan View Element

The Extend Plan View Element tool can extend or shorten any COGO element.

|: Trim Elements

The Trim Elements tool trims numerous elements to their intersection with another
element.

)( Intersect Elements

The Compute Intersection of Two Element tool stores a new point by trimming or
extending one element to its intersection with another element. Note the two elements
remain intact.

e Extend Element to Intersect

The Lengthen or Shorten an Element tool works functionally the same as its MicroStation
counterpart.

Extend Elements to Intersect

The Lengthen or Shorten Both Elements tool works functionally the same as its
MicroStation counterpart.

Construct Circular Fillet
=

The Construct a Fillet Between Two Elements tool works functionally the same as its
MicroStation counterpart and stores a circular curve between two elements.

_ﬁ Construct Chamfer

The Construct a Chamfer Between Two Elements tool works functionally the same as its
MicroStation counterpart and stores a line between two elements. Both the line and two
new endpoints are stored in coordinate geometry.

| l,j,,gl Cut Element

The Cut Elements into Smaller Elements tool cuts elements into segments.
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6.4 Manipulate Elements

E &

I

COGO || Manipulate He_.. x|

When a Manipulate command is selected, a sub pallet will appear to allow the user to enter data if
necessary as depicted below.

Manipulate Ele... x|

B

=

The Manipulate Elements commands are detailed in the table below.

Move Plan View Element
The Move a Plan View Element enables the user to move an element or to make copies.
Rotate Plan View Element

The Rotate Plan View Element rotates the selected element about a user-defined point.
The Angle may be manually entered and locked, or dynamically changing.

Copy Parallel
The Copy Parallel tool works functionally the same as its MicroStation counterpart.
Delete Element

When using the Delete Element tool, no tool settings dialog box opens.

Select and accept the element to be deleted. The element is removed from the
coordinate geometry database. This tool works with a MicroStation selection set if
present. Warning: there is no undo for this command.
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6.5 Groups

When a Group command is selected, the Tool Settings opens to allow the user to enter data if

necessary as depicted below.
Groups x|
=2

gSlore Chain !B
Id: |F|EDBUD
jor: |1EI+EIEI.DD

3 Transpoze ™|

hd aw Gap: | 0.001000

The Groups Commands are detailed in the table below.

gl Store Chain

The Store Chain command works in the same manner as the MicroStation Automatic
Create Complex Chain with the additional benefit that the chain is automatically stored in
the COGO database.

% Store Parcel

The Store Parcel tool enables the user to store parcels, takings, easements, and other
types of right of way features. It is very similar to the Store Chain tool with many of the
same options.
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LAB 6:

Store a Chain with Graphical COGO

6.1 Create Chain REDBUD Using Graphical COGO

Step 1.

Step 2.

Execute C:\data\geo\VDOT\road1\LABG6.EXE.
Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn.
Access the Saved View (Utilities > Saved Views) named “REDBUD”.

Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

In the following steps, we're going to store a chain (REDBUD) that will look similar to the following:

Step 3.

Step 4.

752

Access Graphical COGO from the Road Tool Palette using the icon shown below

Hornzontal & Vertical Geometry =]

or you can access it using the Applications > Road > Geometry > Graphical
Coordinate Geometry pulldown. The tool frame depicted below will activate.

Ensure that Permanent Visualization is set on the COGO dialog box and then sink it.
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Step 5. Access the Store Point tool in Graphical COGO and fill out the dialog box as shown:

COGO zl|

i¢ [o7o0
Coordinates: | Curvilinear 'I
Chainld: [MAINONE =] I3
¥ Statior: !'Eﬁm_
V| Offset: [ooo
[ Elevation: IEIDD—

After filling out the dialog box, you'll notice the point is visualized (represented by a circle)
in the dgn file. Issue a DP anywhere in the dgn file to accept the location of the point.

Step 6. Access the COGO Window and review the output. Notice that point D700 was stored
into COGO.

o T I S —— !E[I:I

FLCPErRrL NEEEEEEEEr e

i Permanent Yisualization 'ﬁ OFF [Feature] __I Browse I 9912 'I 99912 v| <<
COGO Kewin; ILEIC.{‘«TE D700 0N CHAIM MAIMLIME 5TA 207+23 38 OFFSET 0.00000 _v_I

{* 1 LOCATE D700 OH CHAIN MAINLIWE STA 207423, 38 OFFSET 0.00000

Point D700 N 339,.166.99 E 2,718,353.49 5Sta 207423 38
Point D700 stored

Step 7. Next, access the Locate Point dialog box and fill out as shown:

COGO zi|

\‘J-.\p E»

Note: The directional bearing is N 49 04 17.00 E.

- Locate Point M= 1
8 [E]

¥ Distance: [4852
V| Direction: m-
[T Ofiset: [Gom
"] Slope I'ﬁu"_
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With your cursor, ID point D700 that was visualized in Step 5. Issue a second DP
anywhere in the dgn file to validate the location of point D701. Point D700 and Line L1
will be visualized in the design file and stored into COGO.

NOTE: The correct location for our project is to the northeast of the chain Mainline.

Step 8. Access the Store Tangent Curve Constrained dialog box and fill out as shown:

gﬁtule Tangent Curve Cons.._ [E4

|d: [REDELUD-1
¥ Radius: |12D.DDDD
| _Length = | [115.0500

With your cursor, ID the line that was visualized in the previous step.

Issue a second DP to accept the line.
Issue a third DP to identify the direction of the curve.

Issue a fourth DP to validate the solution and store the curve.

+
+
L7
ﬂr?_Igu
Step 9. Access the Locate Point dialog box once again and fill out as shown:
& Locatc Pore ML A |
I¢: [D702

¥ Distarce; [E9.85
¥ Direction: |N 745 233

[T Difget: | 0.0
[ Slope | 0.og

Note: The directional bearing is N 7 45 23.31 W.
With your cursor, ID the visualized PT point of the curve.

Issue a second DP to validate the solution and store the point.
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Step 10.

Step 11.

gCuortinaeGanmelry Job- 101 Operstor:- vd

Access the Store Chain dialog box and fill out as shown:

Id:IHEDEUD
Beqin Station: | 10+00.00

Dppozing Element; | Transpose '|

MaHGap:IDDD1DDD

With your cursor, ID the visualized line running between points D700 and D701.
Issue a second DP to accept the line.
Issue a third DP to accept the direction of the chain and store it into COGO.

Dismiss the Graphical COGO dialog box. Review the output in COGO and notice the
chain REDBUD has been stored into COGO.

Fle Edit Hement View Tools User

RE A « .4 & MU@JQ_IAI_I@ﬁIEI_IF Beceine

i Permanent Yisualization vﬁEIFF [Feature] ____I Browsel 9912 'I 99912 'l <4 | _I ¥ |

COGO Kewin: |STORE CHAIN REDBUD 0700 CUR REDEUD-1 DY02 STATION 10+00.00 _:_I
Foint D702 W 335,374 B7 E 2.718.421 03

Foint D702 stored

4% 3 STORE POINT D703 H 339305 ,64477290 E 2718430, 4537552

Foint D703 N 339.305.84 E 2,.718.430.45

Foint D703 stored

c® 7 STORE LINE 12z D703 TO D7O2

Line: LZ

Point D703 " 339,305 64 E 2,718,430 .45

Direction @ H A R S e Di=tance: 69 .86

Foint D702 " 339,374.87 E 2,718,421:03

Line 12 stored

(£ a STORE CHAIN REDEUD D700 CUR REEDEUD-1 D702 STATION 10+00. 00

Chain REDEUD stored A
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6.2 Describe Chain

From the COGO dialog window, let’s preview the geometry of the chain we just stored.

& Navigator(101) =10 x|

Select Tools

Element : Cha'”—! Prirt./ Descnbe Elemert

Marme | Feature

EBL4E0

raIMNLIME DEFAULT_CHAIM
RabdPé

REDEUD DEFALILT _CHAIM

Step 1. Select the COGO Navigator icon
cs_ﬁf.
or use the Tools > Navigator option on the
COGO menu bar to access the COGO Navigator
dialog box.
Step 2. Set the element option to Chain and highlight the
chain REDBUD.
Step 3. Press the “Print/Describe Element” icon.
Step 4. The chain geometry output will be displayed in the main COGO window.

Cuon:inateGemnElry Job: 101 Operator: vd
Fle FEdit Hement View Tools User

QA o+l &

i Permanent Yisualization "ﬁDFF[Feature] ____I BIDWSE 9312

*@U@QJ&J@&JJWM&

| g1z v| <<

I |E3 3

COGO Kewin: | DESCRIBE CHAIN REDBUD

L% 9 DESCRIBE CHAIN REDEUD

Chain REDEUD contains.
D700 CUR REDEUD-1 D702

Beginning chain REDBUD descriptiocn
Feature: DEFAULT CHAIN

Point D700 N 339.166.99 E

Course from D700 to PC EEDEUD-1 N 49° 04' 17 00"

Curwe Data

2.718.353.49 Sta

E Dist 48 54 ‘|

L [«

10+400.00

| TTTETETERe *
Curwe REDEUD-1
P.I, Station 11+12 48 H 239,241,32 E 2,718,439 22
Delta = CE* 49 40.31" (LT}
Degres = 477 44' 47 34" |
Step 5. Dismiss the COGO Navigator dialog box by clicking the “X” in the upper right hand

corner.
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6.3 Create Input and Output Files

In the following steps we will save an input trail of our commands and an output file with the

computations of chain REDBUB.

Step 1.

=

Access the File Utility dialog by pressing the File Utility icon

or by selecting File > File Utility. The dialog box below should appear.

Fila Mame | Subject

rampa

Load b I

ebl CHaIM EBL4ED
il CHAIM MAINLINE
CHAIM RaMP

™1 Allow Commards to be Added

Step 2.

File Mame | Subject

rampa

Save vI Mame: |RED

&bl CHAIM EBLABD
ol CHAIN MAIMLINE
CHAIM RaMP
red CHAIM REDEUD

Subject: [Chain REDEUD

Step 3.

saved file will be called ‘RED101.ivd’

Enter “RED” for the Name and “Chain REDBUD” for the Subject then click Apply. The
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Step 4. To save an output file with the actual results of the computations, set the option button to
Output on the File Utility dialog.
|2 File Wility |
File Mame | Subject I
&bl Chain EBLAE0
i Chain MAIMLINE
rampa Chain RAMPA,
red Chain REDBEUD
Output vI Output File: | RED
Step 5. Output File should be set to “RED”. Click Apply. The saved file will be called
‘RED101.ovd’.
Step 6. Dismiss the File Utility dialog box by clicking the “X” in the upper right hand corner.
Step 7. Clear all the visualized elements from the file using the Tools > Clear Visualized

Elements (ALL) pulldown.

Fle Edit

RIE]H 5] +] 4

éPmmmmWwﬂEanﬁDW

COGO Key-in | Output RED

Navigator
Inverse

Cuoranateeenmetry Job: 101 Operator vd E[[ﬂ

Hement View | Tools User

gg@ ﬂ_yﬁli‘r Bedefine

Locate

Intersect

i o

Ahead H 7
Chord Bear H 20

Course from FT REEDED

FPoint D702

Ending chain EELDEUD

Best Fit
Translation and Rotation
Map Check

Roadway Intersections
Cul-de-sacs

Ed
L]

=t 6986

718,421.03 5Sta 12+37.42

Redraw Visualized Hements

Clear Visudlized Hements {Temporary)
Clear Visualized Hements {All)

o % Sawe RED SUE Chain REDEUD

File EED 1= =awved

L% Cutput RED

Output file REED i= =s=tored

Step 8.

Step 9. Exit MicroStation.

Dismiss the COGO dialog box by clicking the “X” in the upper right hand corner.
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CHAPTER 7

Design and Computation Manager

7.1 Introduction

Objectives

Understand the use of the D&C Manager to plot horizontal alignments into
MicroStation.

Understand the format of the hierarchical database and how to use it.

Be able to use the D&C Manager in conjunction with other GEOPAK tools &
MicroStation to draw and manipulate elements.

Project Manager

Plan View Design

Road Tool Frame

&~

Plan View Desi_. x| Plans Preparstion =]

8 el | |l ) | )

Menu Bar Application

GEOPAK Road > Design and Computation Manager
GEOPAK Road > Plans Preparation > DP Station Offset
GEOPAK Road > Plans Preparation > Draw Transition

The Design and Computation Manager (D&C Manager) is a tool that allows the user to standardize
graphics elements for drafting and pay item quantities.

A hierarchical database is used with the Design and Computation Manager. This database stores
information concerning functional classification and display preferences for each feature and item
used in a MicroStation file. This file is commonly referred to as the ddb file (*.ddb).

Categories are used to group and classify the features and items used in creating construction
drawings. In the example below, Road Design and Right of Way are both categories. Categories
are represented with a folder icon.

g Design and Computation Manager M=l E

File Edit Settings Favorites Help

FECTE

swoad]batandardshgeopak WhOT english, ddb

I Road De
23 Survey
7 Right of Way
£ Utiliies
3 Environmental
7 Traffic
1 Geatechnical
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These categories each may contain sub-categories. The sub-categories break down each
classification into more specific items. For example, Traffic may be broken into several additional

categories such as Existing and Proposed.

. Design and Computation Manager !Elm

File Edit Settings Favorites Help

FIECTAE

&3 [hdatalgeotwdotiroadl hstandardsgeopak WD O T englizh. ddb

7 Foad Design

3 Survey

7 Right of Way

£ Utiliies

3 Environmental

I ————
7 Existing
3 Propozed

7 Geotechnical

Within a category, the items that are included are designated according to the process that they will
be used for (as a drafting item indicated by a paintbrush shown in the following diagram):

. Design and Computation Manager !Elm

File Edit Settings Favorites Help

FIECTAE

&3 [hdatalgeo'wdot'road] hstandards geopak WD 0T englizh. ddb
& Foad Design
3 Aligriments L
7 Box Culverts
3 Canstruction Limits
7 Cross Section
3 Curbing
3 Drop Inlets
3 End Sections
3 Endwalls

I

Each entry represents a specific item. The various icons representing the function they will be
utilized for can identify items.

& Paintbrush (draw design elements)
Calculator (quantities calculations)
Ey Report icon (default, pavement design, pavement markings, etc.)
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See calculator icons in diagram below:

. Design and Computation Manager !El I

File Edit Settings Favorites Help

gid
&2 [ hdatahgeotwdothioad]standardshgeopalk WD O Tenglish.ddb |2
[ Road Design |
7 Alignments
3 Box Cubverts
3 Construction Limits
7 Cross Section
I & Curibing
014414 Curb [CG-2]
= 014414 Curb [CG-2) Left
07144714 Curb [CG-2] Right

Ll

The database may also be password protected if desired. This can be used as a security measure to
protect the integrity of the database file and ensure its consistent application within an organization.

7.2 Accessing the Design and Computation Manager

When the Design and Computation Manager is accessed, two dialog boxes are displayed.

. Design and Computation Manager !El I

File Edit Settings Favorites Help

&3 [hdatalgeotwdotiroad] hatandards\geopak WD OTenglish. ddb  [*
& Foad Design
3 Aligriments
7 Box Culverts
3 Canstruction Limits
7 Cross Section
3 Curbing
3 Drop Inlets
3 End Sections
3 Endwalls

Ll

The main D&C Manager dialog box is composed of two distinct areas:

e Across the top are icons for the various modes. The D&C Manager may be configured to
operate in seven different modes: Display, Design, Set, Compute, Shape, Pavement
Marking and Preferences. As various modes are selected, more icons are displayed within
this area.

The Path box displays the name of the attached database file and your current position
within the database structure. It lists the categories, sub-categories and items available for
selection. This hierarchical data structure functions much like a directory. Double clicking
enables the user to move up or down within the database.

A second dialog box appears differently depending on the mode of operation. This dialog box
enables the user to set other options not available on the main dialog box. The dialog box below
appears when you click on the Design Icon.

| 2 BL25 - 25 Scale Baselines M K|
[T Place Influence
I -ddhoe Eatibike tdatch Point Text
] Mew
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7.2.1 File Commands

[Fle | Edit Settin For the GEOPAK designer, the only file command options needed are Open and
New... Exit. The other commands such as Save, Merge and Compress are used by
Open... personnel who maintain the database.

Save
Save As b As mentioned previously, the Password option may be used to password protect
N n the database so a user would not be able to make changes to it.

_Qorrpress
Pazsword
Exit

7.2.2 Edit Commands

As a designer, the most-used Edit commands will be Find, Identify and [Edit | Settings Far
Review Item. ndo

Find — This tool will search the database (from your current location)
for an item or category. If the database is password protected, all other
items will be disabled.

Identify — This tool will allow you to select an element in the design file

to identify which item it matches in the database. Find__.

. . . . . Identify
Review Item — This tool will allow you to review the settings/symbology
for a particular item in the database.

7.2.3 Settings

Display Settings - temporarily changes the display of Settings | Favorites
elements on the screen to one common color, then the Display
user may specify additional elements to be viewed in their Design
original colors. This tool enhances visualization when Compute
working on a complex project. Computation Units
Design Settings - sets the maximum gap tolerance and Dialog
deduction tolerance used in computations and the drawing Criteria Viewer

scale for placing cells.

Compute — This dialog box contains fields and options specific to the Compute process.

Computation Units — This dialog box shows the computational units available for the current system
- English or Metric.

Dialog — This option controls how the level up and level down icons function when clicked when
using D&C Manager in toolbox mode.

Criteria Viewer — This toggle is used when a criteria writer is troubleshooting new 3PC.
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7.2.4 Favorites

Add to Favorites - saves current D&C Manager path for easy recall in the Favorites | Help
future. Add to Favorites
Organize Favorites._ ..

Organize Favorites — allows the organization of previously saved paths.

7.3 Operational Mode - Design

The Design mode enables the user to draw each roadway element or COGO element (and
associated attributes) in the design file based on drafting item parameters.

First, the desired item is highlighted in the main dialog list box, i.e., alignment, edge of pavement, etc.

g Design and Computation Manager M=l E
Fil= Edit Settingz Faworitez Help
SR _FIECRE

3 Median B arrier el
3 Median Strip

[ Mizcellansous Features
GROSHLD Congtruction line for graded shoulder —
FORCESL - Forze Slope Lines
SRAMATCH - Side Road Match Lines ]
a BIKE - Bicycle Trail

& BOE - Back of Entrance
&b STEPS - Steps
dly COWCSLAB - Concrete Slabs, Columng, Signs, & Posts [7]

-
[ |
=

The Place Influence option sets the level, symbology and attribute tags of elements drawn or copied
using MicroStation commands. When the Place Influence toggle is activated, elements are drawn
using the level, symbology and attributes as defined in the GEOPAK database. When Place
Influence is off, elements are drawn using the active level, symbology and attributes of MicroStation.

B0 Boce i MBIE

v Plsiabes
[T Adhoc Attributes ch Poird Te
™| MewElement Only | Draw Plan & Profile
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The Draw Cogo Element button is for drawing COGO elements to a design file. A single click to this
button prompts the user for a job number, then opens a dialog box that enables the user to choose a
COGO item to draw.

¥ Place Influence
[T adhoc Attrbutes
[T Mew Element Only

If an alignment, profile or parcel item is chosen, the Draw Cogo Element button changes to Draw
Plan and Profile.

W Place Influsrice
[ Adhoc Attibutes
[T Mew Element Only

If Match Point Text is selected the active MicroStation settings are set to match the drafting
preferences symbology for points of the selected item.

W Place Influsrice
[ Adhoc Attibutes
[T MewElement Only | Draw Plan & Profile

Adhoc Attributes is used with Place Influence to add Adhoc Attributes to any new element when
that element is drawn.

¥ Place Influence
™| Mew Element Only | Draw Plan & Profile

If New Element Only is selected and an element is modified or moved, it's symbology is not changed
to the selected item.

V¥ Place Influence
[T adhoc Abtibut

Draw Plan & Profile
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From the secondary dialog box that is opened, click the Draw Plan & Profile button to initiate the
drawing of COGO elements into the design file. Clicking this button prompts the user for a job number
(the coordinate geometry database file wherein the COGO elements are stored), and then opens a
dialog box that enables the user to choose a COGO item to draw. Do Not activate the Place

Influence toggle when using Draw Plan & Profile.

' If utilizing the Design & Computation Manager within Project Manager, you are not
prompted for a job number since this is associated with the active project.

Eight operations may be accessed from the Plan
and Profile Draw dialog box: Points, Lines,
Curves, Spirals, Chains, Stationing, Parcels, and
Profiles. Each of these operations dynamically
changes the dialog box to reflect the selection
with the various draw and label features used
when placing a COGO element in a graphics file.

The points and lines dialog boxes have a key-in
field that allows the user to specify the names of
the COGO elements to be drawn. To use the line
operation, the user must use point numbers to
specify the ends of the line. The points/lines are
drawn immediately after you enter their respective
names and press the enter key. To draw more
than one point or line, place a dash in-between
the point numbers. To draw a line without using
consecutive point numbers, use a forward slash
(i.e. 10/11).

£ Plan & Profile Draw [_To]x]

-:Dperatinn
| i ¥ Puoints BL25 - 25 Scale Baselines™ ‘
5 e

Spiralz I Cel

Chaihz ["] Scaled Point [Circle)

Statiohing ™ Scaled Paint Test I

Label Scale |25_

BLZ25 - 25 Scale Baselines” ‘

Keyin Points: |

™ Cel
[T] Scaled Point [Circle)
[T Scaled Paint Text I
r Operation ———
i Lines f BLZ5 - 25 Scale Baselines” |
Kevin Lines: |
Saita i ¥ Line Direction Label

E [ Line Length Labels
||_2 [T Line Labels Only
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The dialog box settings for curves, spirals, chains, | 2 Plan & Profile Draw ]
stationing, parcels, and profiles have a list box
that display the names of all curves, spirals and ~ Operation ——
chains stored in the active coordinate geometry [ | Curves | BL25- 25 Scale Baselines” ‘
database file. Highlighting one of the available Select Cuive
elements initiates further commands to draw the [ERLasn 1| ¥ Curve Label
element into the design file. Each type of item MLT ¥ Cuive Data
has a list of parameters that can be optionally ;‘:ﬁpm [ s Lahels O
plotted. RéMPA-Z [T Place Curve Data By DP

RahPA:3

REDBUD-1

Label Scale I 25

GEOPAK can draw elements to non-active levels. After elements are drawn, it may be

necessary to turn on appropriate levels and use the MicroStation fit command to view the
elements.

§ =l
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7.4 DP Station/Offset

Feature / Function Utilize any station / offset in MicroStation commands requiring a data point.

Tools Plans Preparation

5| Al A » e el

Menu Bar Application GEOPAK Road > Plans Preparation > DP Station Offset

|& pp Station Off=ct  MEI 3|
The DP Station/Offset command works in R 0P Sstins Offct !B

conjunction with MicroStation commands and the Jops [701 QJ

D&C Manager. It can be used as the data point for Chain: [MATNLINE~] ]
any MicroStation command. DP Station/Offset Station: [200+00.00

provides precision placement of elements based on a Offset [
station and offset of a stored chain. Uses for this Tangent + 180 ¥ | ™ Auta Angle
command include precision placement of elements A |
and window functions. ~ g =

7.5 Draw Transition

Feature / Function Draw transition based on a two sets of station / offsets.

Tools Plans Preparation

W il ] 2] [ » | B i) S

Menu Bar Application GEOPAK Road > Plans Preparation > Draw Transition

The Draw Transition tool draws a line/curve based on a beginning station/offset and an ending
station/offset relative to a selected chain. Use of this command includes turn lanes, mailbox
widening, curve widening and lane transitions.

(& vrow Torion WD
Job: W— 3!
Chain: W:J .a%]
Beqin Station: I?D_D:-D—D-D‘D_‘Tl@
Beain Offzet: W_I
End Statiaon: WT@

End Offset: | 12.000000 1

Elements placed with Draw Transition have MicroStation element type curve when the
beginning and ending offsets are different and MicroStation element type line and/or arc
when the beginning and ending offsets are the same.

§=ull
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LAB 7. D&C Manager — Plans Production

7.1 Accessing Design and Computation Manager
Step 1. Execute C:\data\geo\VDOT\road1\LAB7.EXE.
Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn

Step 3. Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 4. Select the icon Plan View Design button from the Road Plan View Des... x|
Project: 17682.prj workflow dialog box, which opens the Plan
View Design toolbox.

7.2 Drawing Alignments

Step 1. Select the Design and Computation Manager icon (as indicated above) to invoke the
Design and Computation Manager shown below. A secondary dialog box will appear to
be used in conjunction with the Design and Computation Manager dialog box.

g Design and Computation Manager =l I
Fil= Edit Settingz Faworitez Help

R G

& [ hdatahgeohwdothioad]standardshgeopalk WD O Tenglish.ddb |2
& Foad Design

£ Alignments

3 Box Cubverts

3 Construction Limits
7 Crozs Section

3 Curbing

7 Drop Inlets

3 End Sections

7 Endwall:

L]

Step 2. Select the item shown in the dialog box below.

g Design and Computation Manager !El I

File Edit Settings Favorites Help

5] id| BIfE ¢° =|%|E0

&2 [ hdatahgeotwdothioad]standardshgeopalk WD O Tenglish.ddb |2
[ Road Design
[ Alignments -

[ Harizartal

= ELZ5 - 25 Scale Bazelines
gn BLAO - B0 Scale Bazelines
& EL100 - 100 Scale Baselines
1 Yertical
7 Box Culverts
3 Construction Limits =1
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Step 3.

Next, select the Draw Plan and Profile
button from the secondary dialog box:

[T Place Influence
I o Sdtribibe
I M Elemant Orby

Match Point Text

Step 4.

Step 5.

Step 6.

Step 7.

Step 8.

Step 9.

Step 10.

Select the Chains operation. Each of
the chains will be displayed in the list
box as shown. Notice that the options
that are to be drawn with the chain are
already activated. Set the Label Scale
to 25.

To draw the chains, click each name in
the list box. Only click once!! Each
time you ID a chain it will be plotted into
the design file.

Change the Operation to Stationing
and modify the dialog settings as shown
in the image to the right.

Annotate each alignment by clicking the
chain names in the list box.

Review the results of Steps five and six.

Notice that we are forcing all the labels
and tic marks to the left. This looks a
little odd for RAMPA, so let's change
that.

Make sure that Graphic Group lock is
ON, then delete the tic marks and
stationing for RAMPA.

Change the options as shown to the
right and re-station RAMPA.

Exit the Plan and Profile Draw dialog
box but remain in D&C Manager.

£ Plan & Profile Draw

r Dperation ——
i Chainz f BLZ5 - 25 Scale Baselines™
Select Chain
EEL4ED ¥/ Line Ditection Label
EELTFI'_,LNE [ Line Length Labels
FEDELD [T Line Labets Only
¥ Curve Label
¥ Curve Data
[ Curve Labels Only
™ Place Curve Diata By DP
[T Spiral Label
V' Spial Data
™ Spiral Labelz Only
[ Place Spiral Data By DP
Label Scale I 25
£ Plan & Profile Draw !ﬁ[ﬂ

r Dperation ——
i Stationing f BLZG - 25 Scale Baselines™
Select Chain to Station
EEL4ED ¥ Tick Marks
EELTFI'_,LNE ¥ Tick Marks Stations
FEDELD ¥ PC#&PT &C5... lahels
™ Pl labels
- Small Ticks

| TicksLT:Labels LT |

" Contral Point Labels

&g Per Preferences I

Large Ticks -
[ Ticks LT Labels LT |

Label Scale i 25
- Small Ticks
Ticks AT; Labels RT |
r Large Ticks

Ticks Eoth: Labels BT |

GEOPAK 2004 Edition
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7.3 Use Special Application to Label PI's and Tangent Lines
Step 1. Do a Fit View to ensure that all alignments are displayed in the view.

Step 2. Select the Design mode then navigate to Road Design > Special Applications >
PITangents - Draw PI's and Tangents on BL'’s.

Fle Edit Settings Favorites Help

B PEIRE

3 Seeding ;l
£3 Sign 1zland
[ Special &pplications
B PITangents - Draw Pl's and Tangents on BL's.
Update LOC - Updates Limits of Construction Trangitions
Curve Widening - Draws Curve Widening in Plan
E'w Label - Earthwork. Test Labels
#5 Sheet Number - Number Cross Section Sheets and R anges
Super Diagrar - Super Elevation Diagran [Profile Wigw)
Prafile Grid - Draws Grid for Roll Plotting
3 Swi
23 Text Scale 25
23 Tewt Scale 50
23 Underdrains
£ whalks
23 Cross Section
23 Survey
23 Right of way -

L

Step 3. Double-Click on the item to kick off the application.

Step 4. Ensure that all alignments are displayed in the view then click OK on the dialog box
below.

Warning: All alignments must be displayed in View 1.

Cancel |

Step 5. Populate the dialog box as below then click OK.

Enter Job Mumber:
[1m

Cancel I

Step 6. Populate the dialog box as below then click OK.

Select Dizplay Scale:

75 -|

Cancel I

7-12 VDOT Road | Training GEOPAK 2004 Edition



GEOPAK”

Step 7.

Step 8.

Step 9.

Step 10.

Step 11.

Step 12.

Populate the dialog box as below then click OK.

Pompt ]
Enter Chain to Label [CAMCEL to Exit):
| MAINLINE

Canicel I

When the dialog box below appears, click OK.

Chain “*MAINLIME* complete. O, to Continue, CANCEL to Exit

Cancel I

Populate the dialog box as below then click OK.

Pompt ]
Enter Chain to Label [CAMCEL to Exit):
| EEL4ED

Canicel I

When the dialog box below appears, click OK.

Chain *EBL4E0* complete, OF. to Continue, CAMCEL to Ext

Canicel I
When the dialog box below appears, click OK.

Enter Mext Chain to Label:
| AP

Canicel !

When the dialog box below appears, click OK.

Chain “RAkPa" complete. OF ta Continue, CAMCEL to Exit

Canicel !

GEOPAK 2004 Edition
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Step 13.  Populate the dialog box as below then click OK.

Enter Mext Chain to Label:
|RECBLD

Canicel I
Step 14. When the dialog box below appears, click Cancel.

Chain *REDBUD* complete, OF to Continue, CAMCEL to Exat

Step 15. Review the PI Labels and Tangent Lines that were placed.
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7.4

Drawing Other Plan View Features

We are going to develop roadway features representing the proposed roadway. The roadway is
made up of 4 distinct sections:

e 4 lane divided highway with depressed median from Sta. 200+00 to Sta. 202+00. Left side of
the roadway will be resurfacing while the right side is new construction.

e 4 lane divided highway with raised median from Sta. 202+00 to Sta. 204+25. Left side of the
roadway will be resurfacing while the right side is new construction.

e 4 lane undivided highway from Sta. 204+25 to Sta. 211+00.
e 2 Lane highway with Entrances and Exit Ramps from Sta. 211+00 to Sta. 220+00.

To perform these tasks, two specific GEOPAK tools will be utilized: D&C Manager to determine
element symbology and Draw Transition to place the elements between specific pairs of stations
and offsets. Because of time constraints, we will not develop the planametrics for the entire project,
but just for a select area.

Step 1. Navigate to the item Road Design > Pavement > 900344 Edge of Pavement.

Step 2. Select the item 900344 Edge of Pavement and then enable Place Influence.
Step 3. If desired, click on the Switch to Toolbox Mode (left most icon) icon on D&C Manager.

' [Pavement |~ & 900344 Edge 0F P=] | | gsalidl [BE 5] B | % 92|&E =

Step 4. Open the Draw Transition tool from the Plan View Design palette. Fill in the values as
shown below then click Apply. This will draw the right edge of pavement between the
given station range.

Drow Trrstion |
Job: W— _Ci!

Chaire: WME— _vj 5&]

Begin Station: WT‘@

Beain Offset; | 33.000000 |1
End Station: !204+DD.EIEI =
Wi

End Offzet: | 33.000000 —

Step 5. Next, modify the dialog box as shown to draw the edge of pavement transitioning from
204+00 to 205+00.

|
Job: W— _%J

Chaire: WME— _vj 5&]

Begin Station; WT‘@

Begin Offzet; | 32.000000 |1
End Station: !2DE+DD.DD [k
[

End Dffset: | 24.000000 _
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Step 6. Draw the additional features shown in the following table. Check that the correct feature
is selected in D&C Manager before continuing. When completed, disable Place
Influence, then close D&C Manager and Draw Transition.

Note: All items shown in the table fall under the category Road Design.

Feature Beg. Station Beg. Offset | End Station | End Offset
Curbing > 012600 Standard. Comb.
Curb & Gutter CG-6 205+00 26.0 211+00 26.0
Walks > 013220 Hydraullc Cement 205400 285 211400 28 5
Conc. Sidewalk 4
Walks > 013220 !—|ydraul|c Cement 205+00 335 211+00 335
Conc. Sidewalk 4

Pavement > 900344 Edge of 211+00 24.0 212+00 12.0
Pavement

Pavement > 900344 Edge of 212400 120 216+00 120
Pavement

Pavement > 900344 Edge of 216400 12.0 217400 24.0
Pavement

Pavement > 900344 Edge of 217+00 24.0 218+08.66 24.0
Pavement

Pavement > 900346 Paved 211+00 34.0 212+00 220
Shoulder

Pavement > 900346 Paved 212400 220 216400 290
Shoulder

Pavement > 900346 Paved 216400 290 217400 34.0
Shoulder

Pavement > 900346 Paved 217400 34.0 218+08.66 34.0
Shoulder

Step 7. Exit MicroStation.
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SESSION 8

Existing Ground Profiles

8.1 Introduction

Objectives Learn to draw and store existing ground profiles extracted from a surface
model.

Project Manager NOTE: This application is not available through Project Manager

Tools Plans Preparation

i | ) e | SR nidndblen]

Menu Bar Application GEOPAK Road > Plan Preparation > Draw Profile

The Draw Profile tool enables the user to draw several profiles from a variety of sources
simultaneously.

e GEOPAK coordinate geometry database wherein the vertical alignment is stored.

e GEOPAK binary TIN file, Site Model or Site Object. The Site Model or Object are created
utilizing GEOPAK Site Modeler software and are stored within the GEOPAK Site project (gsf)
file.

In addition, if the source data is TIN files or site components, the resultant profile may optionally be
stored within the coordinate geometry database.
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8.2 Invoking the Draw Profile Tool

The generation of profiles must be invoked from within the 2D MicroStation design file wherein the
profile is to be drawn. When the tool is selected, the dialog box depicted below opens.

File Edit Update Options

Job Mumber: i1D1 vi ﬁ EI Labal Scak: |0 Q00000
Chair; |< Mane » vl

l COGOD | Proiectinni

The initial entries that are required are the Job Number and Chain name. Once selected, click the
Dialog Profile Cell Control icon (to the right of the Job Number field). This will invoke the Profile
Cell Control window shown below.

Profile Cell Conirol A= ]
Active Chain; |< Hone » VI

Microstation File Station Elevation  H.Scale V. Scale Ga|:l_|

=]
£
X

Select the Active Chain that the new or existing profile is to be stationed along. If no profile cell
exists, click the Place Profile Cell icon along the right side of the window to place a new cell. If
multiple profile cells exist, highlight the desired cell and click the Activate Profile Cell icon.

8.2.1 Update Options

Four update options exist that allow the user the control needed to tell the software what to do if a
profile has been previously drawn in the file and needs updated. The options are toggled off / on by
each selection of the option by clicking the Update Options pulldown. The check to the left of the
option indicates the option is active. Only one option may be active at any given time, therefore, if an
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option is selected, the previous active option is de-activated. The four options are detailed in the

table below.

Delete Existing Elements and

Redraw

Delete Non-Modified Elements

and Redraw

Draw on Top of Existing

Query

8.2.2 Surfaces Tab

When this option is activated, any profiles previously drawn with

this tool are deleted and new ground lines are drawn.

When this option is activated, any profiles previously drawn with

this tool and not modified with any MicroStation commands are
deleted and new ground lines are drawn.

When this option is activated, any previously drawn profiles are

ignored and a new set is drawn, resulting in multiple copies of

each profile.

When activated, the user is prompted each time the Draw button

is pressed.

The Surfaces tab defines the surfaces utilized as source data when drawing profiles. Multiple
surfaces from a variety of sources can be drawn in a single processing. When the tab is selected,
the dialog box dynamically changes as depicted below.

Fle Edit Update Options

dob Mumber: [T01 =] g ﬁ'l
Chair: [MAINONE =]

l COGOD | Proiectinni

Tupe| Name | Display Sethings

| Dr.&l

Label Scale; I 0.000000

[

- Details

TIM File: |
Method:  Triangles ™

r Dizplay Settings

By Level Symbology "l | ———

- Filter Tolerances
Hanzontal: | 0.30

Warlance: i oo i

r Station Limity ——————————

[ Begin [Z00:0000 |«
I End [Z220682 @

Offzsety ——————

Horizontal: I 0.00

0.00

I void |

Each surface to be drawn must be added to the list box. This is accomplished via the action / edit
buttons on the right side of the dialog box. Each surface draws a cross section line string or lines.
When a line is added to the list box, the profile is drawn. Note: clicking on the draw toggle in the list
box deletes or redraws the profile.

GEOPAK 2004 Edition
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To add to the list box, simply select the source data and method, Display Settings, Tolerances and
Offsets, and then add the profile to the list. Once a profile is drawn, it may be updated at any time by
using the Update Profile icon. Refer to the Update Options section to review those options. Any
profile may optionally be stored to the GPK file if desired.

8.2.3 Display Settings

The Display Settings group box specifies the element symbology of the cross section elements being
generated. The symbology may be specified using Level Symbology or a feature selected from a
D&C Manager database.

To use By Level Symbology, set the option to By Level Symbology, then double click on the
graphic. This opens the Set Feature dialog box, wherein the symbology can be specified. Click OK
when completed.

To use By Feature, set the option to By Feature. Next, press the Paintbrush icon, which invokes the
current Design and Computation Manager. Select the desired item, and then press the OK button,
which closes the Design and Computation Manager, and populates the Draw Profile Display Settings
group box.

8.2.4 Filter Tolerances

Both Horizontal and Variance filter tolerances are considered together for each pair of profile
segments. The middle point is deleted if both segment lengths are less than the Horizontal filter
tolerance while the projected distance between the mid-point and the chord between the two end
points is less than the Variance tolerance.

Horizontal Teolerance

Variance

8.2.5 Offsets

Vertical or Horizontal Offsets may be specified in terms of master units (i.e., feet or meters). The
Horizontal Offset is the distance offset from the Chain. Once the horizontal location for the profile is
determined, the data source is utilized to determine the profile. Any Vertical Offset is applied after
the profile is generated from the source data.
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8.2.6 Store Profile to COGO
A=
L

gStnle Profile E
Prafile Hame; Imlgmund Select |

| Stare Profile in GPK
rc

8.2.7 Cogo Tab

When the profile is drawn, it may also be stored in COGO by
pressing this button, which opens the dialog box depicted
below left.

The profile may be stored, or just the input file may be
created. If an input file is created, the Operator Code and
File Name are required. If the dialog box is invoked while in
a 3D file, the user may toggle on the option to create a 3D
profile string. The 3D profile string consists of the circles
denoting every location where the design centerline
intersects topographic elements. If the circles are not
deleted at this time, they can be deleted at any time with a
single application of the MicroStation "Delete Element"
command.

The Cogo Tab is utilized for drawing any profile that has been previously stored into the GPK file.

Vertical Offset: | 0.00

g Draw Profile M= B

Fle Edit Update Options

Job Humber; i1EI1 vi E ﬁl Label Scale; ID.DDDDEIEI
Chair: IM:&INLINE vl
Surfaces I Ul Proiectinn i

I arme | Display Settings | Draw i

s

- Details

Frofile Mame: i< More » vi r

Station Limitg ——————————
I Begin [200-00.00 |
[T End [222:0684 ﬁ.}

r Dizplay Settingz

By Level Sumbology 'I i

To draw a profile, first select the Profile Name to be drawn. The Vertical Offset defaults to a value
of 0, but can be set to any value. This instructs the software to draw the profile at a distance above

or below the elevations in the GPK file.
draw only a portion of the profile.

Station Limits may also be specified to have the software

If the Display Settings are set to By Feature and a feature is

selected, the Options area of the dialog box is un-ghosted. This is where various labeling options for

GEOPAK 2004 Edition
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the profile can be specified. If a value is given for the Strip Grade Increment, elevations will be
placed at that increment along the bottom of the profile.
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8.2.8 Projection Tab

The Projection tab can be used when the chain / profile to be drawn is different than the chain / profile
used to create the profile cell.

File Edit Update Options

Job Mumber; |1D1 vi E El Label Scale: |D.DDDDDD

Chair: [MAINLINE =1

Surfaces | COGO |

Tope | Chain | Profile/Sufa Display Settings | Diraw I

()

- Details*

Type: Egthain—vl = Stationing
Chain: [MAIMLINE -

I End [222+0688 <
Vettical Offset: [T00 [ increr =5

[ POT

nant

™ Begin: [200+0000

- F| Esttaction lom Sufans ————————  Filter Tolerances
TIM File: | g Harizortal: | 0.30
Method:  Triangles W ariance: !_IJ_.'ID

r Dizplay Settings

By Level Symbology | | ee— ﬁ-:"
= r

re: |2 Mo Eniiies _'i;wj

Each projected profile to be drawn must be added to the list box. This is accomplished via the action
/ edit buttons on the right side of the dialog. When a line is added to the list box, the profile is drawn.
Note: Clicking on the draw toggle in the list box deletes or redraws the profile.

GEOPAK 2004 Edition
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8.3 Profile Report

To review a textual report listing stations and elevations of a ground profile, open the GEOPAK
Coordinate Geometry dialog box. A couple of different methods can be used to create this listing for

any profile.

By selecting Element > Profile > Utility then
highlighting a specific profile name and clicking Print.
The results of this command will be displayed in the
Command Output window of the Coordinate
Geometry dialog box. To obtain a hardcopy of this
information, create an output file using the File > File
Utility > Output command and supply a filename of
1-5 characters. Then use the File > File Utility >
Print Output File command to print this to the
default system printer.

The second method utilizes the COGO Navigator tool
to create the Print Profile command. The
advantage to this method is that multiple profiles can
be identified at once and printed to the Command
Output window. Start the COGO Navigator by
clicking Tools > Navigator or selecting the icon from
the COGO dialog box. Change the Element to
Profile then highlight the desired profile(s). Once
selected, click the Print/Describe Element icon on
the Navigator to process the profile(s).

8.4 Drawing Profiles with D&C Manager

File Edit Settings Favorites

As with other COGO elements,
Design and Computation Manager

& oo v WEE
x5

Profile. |
DITCHLTY
EQSL

FAIMLINE

MLGROUMD
RAMPA

Navigator(101) !E[

Select Tools
| N

| A]id

Elemnent : | Profile

M ame | Feature |
DITCHLT1
EOSL

—
MLGROUMD
RatMPA

¥ | |Prirt/Describe Element

Help

will be utilized to draw any type of

profile into a MicroStation file:

existing Ioadway, . proposed &R [Adatahgeowdotyoad] hstandardshoeopak YD 0 Tenglish.ddb || 2]
roadway, utility, special ditch, etc. [ Poad Design

To get started, open D&C Manager E’S'Enmentsl -
then navigate to the desired item for Bv;’:ﬁ;’?ta

plotting of the profile. Upon
selecting an item, click on the Draw
Plan & Profile button on the
supplemental D&C dialog box.

ale "i:s:l.ir'ug Profiles

& PROEXISTHO - B0 Scale Exizting Profiles

gy PROEXISTI00 - 100 Scale Existing Profiles

& PROPR25S - 25 Scale Proposed Profiles 5:1
&y PROPRSON0 - 50 Scale Proposed Profiles 1001
& PROPRIO020 - 100 Scale Proposed Profiles 20:1 -
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The next dialog box that appears is the GEOPAK Draw Plan & Profile window, as depicted below.

| £ Pian & Profile Draw !ﬁm
~ Operation |
Profiles | PROEXISTZS - 26 Scale Existing Pr|
DITCHLTA [T WPl Labelz From WFI
MANLINE Lice |
¥ Huorizontal Axis Labelz

rMLGROUMD
RAMPE W Wertical Az Labelz

[T %.C. Incremental Elevations
[T W.C Parameters

[T Grade Labels | '+ and - I
7 K valus

["] Extemal Length

[T Station Equation | Mo Gaps i
[T WPCA/PT Label

[™ Stopping Sight Distance

Label Scale I 25

If it is not already selected, change the Operation to Profiles. Displayed in the window is a list of
profiles currently stored in the GPK file. Along the right side of the window are labeling options for the
profile that is to be plotted. Configure these as desired before selecting a profile to plot.

e VPI Labels — Labels the station and elevation of the VPI — typically turned off for plotting of
existing profiles.

e Horizontal Axis — Places stations along the bottom of the profile.

e Vertical Axis — Places elevations along the left side of the profile.

e VC Parameters — Labels the length of the vertical curve if applicable.

e VPC/VPT Labels — Annotates the station and elevation of a vertical curves control points.

e Stopping Sight Distance — Places text for crest vertical curves representing the curves
stopping sight distance as defined by AASHTO.

After selecting a profile to plot, the dialog box below opens. Since a profile does not have XY
coordinates, the user must specify a location in the MicroStation file to place the profile and a scale at
which to plot the profile. When using a ratio other than 1:1, the horizontal dimensions of the profile
remain true and the vertical is exaggerated.
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The location can be selected by clicking on the
DP button then specifying a location in the file by
issuing a data point in the view. The coordinates
can also be keyed in to the dialog box. A Profile
Cell can be drawn into the file to represent the
location of the data point and associated
information. This cell can be used in any other
GEOPAK tool that needs to know the location of
the profile. A PGL Chain must be selected before
drawing the profile cell. This chain will be the
chain that the profile is stationed along.

If a value is specified for the Strip Grade
Increment, elevations will be calculated at the
desired interval along the profile and placed just
above the Horizontal Axis Labels (stations).

Click OK to draw the profile.

- MLGROLUND

T |

Beginning Station  200+00 .00
Ending Station 222+06 84
Beqginning Elevation  2,021.53
Ending Elevation  2,099.06
b asirmurn Elesation 2033.06
Finirmum Elesation 201586

Horizontal Scale rﬁﬁl—lﬁr
Wertical Scale rEDIJT
Beginhing Station rﬁﬂ:ﬁ.ﬂﬂ_
Ending Station r222+-_05-m8:1_
Strip Grade Increment !—

DP Station [200+00.00F 1

DP Elewation [1900.00000
DPx [27207068 kroa -
DPY | 337424.0943

~ Profile Cell

PGL Chain [MAINLINE Select |

Draw Cel by | - Identitp Cel |

Cancel |
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LAB 8: Existing Ground Profiles

In this exercise, existing ground profiles will be drawn representing the centerline of chain MAINLINE.

8.1 Draw Existing Ground Centerline Profile
Step 1. Execute C:\data\geo\VDOT\road1\LAB8.EXE.
Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682prof.dgn

Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 3. The file d17682des.dgn should be attached as a reference.

Step 4. Select the Draw Profile tool from the Road Tools palette.

e
@

The dialog box below will open.

Fle Edit Update Options

Job Humber; |1EI1 vi E ﬁl Labal Scake: | 1 QOO0
Chair: |< Mone > vl

l CoGO | Proiectinnl
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Step 5.

Step 6.

Step 7.

Step 8.

Step 9.

Select chain MAINLINE.

Click the Dialog Profile Cell Control icon (to the right of Job Number).

File HEdit Update Options

Job Humber: |1D1 vi Ej El Label Scale; ID.EIEIEIEIEIEI
Chait: |Mﬁ3«INLINE vl

| coGo | Projection |

[Dialog Profile Cell Control |

Set the Active Chain to MAINLINE.

Microstation File Station Elevation  H.Scale V. Scale Ggp_!

X e (2]

Click the Place Profile Cell icon on the right side of the dialog box. This will open the
Place Profile Cell dialog box.

| £ Place Profile Cell A= 1
Station: |2DD+DD.!:IEI
Elevation: |1SDD.EIEI
Horizontal Scals; I 25,000000
Wertical Scale: |

- Cell Hange

Tap Dielta "1 |2ED.DD
Bottam Delta 'I |250.EIEI

Fill the dialog box out as shown above and then DP somewhere to the right of the plan
view reference file in order to place the profile cell into the design file.

Fit the view contents.
Close the Profile Cell Control dialog box.

From the Surfaces tab, select the folder icon in the Details area, then select the
SURVEY.TIN file for the TIN File to cut the profile. Set the Method to Triangles. This
instructs the software to compute elevations at each location that the chain intersects a
triangle leg from the TIN.

- Details®

TIM File: | surveu tin &l
Method: | Trangles 'I
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Step 10. Use By Feature mode in the Display Settings area of the dialog box. Click the
Paintbrush icon and select the item shown below.

~ Dizplay Sethngs —

—
By Feature "J | e—

Feature: |4 Mo Entries » | ﬁ

gsglecl Design & Computation Payitem __. !Elm

File Edit Settings Favorites Help

#]1d]

Cloze |

&2 [ hdatahgeotwdothioad]standardshgeopalk WD O Tenglish.ddb |2
[ Road Design
[ Alignments
3 Harizartal
[ Vertical

& PROE=ISTEO - B0 Scale Exizting Profiles
gy PROEXIST100 - 100 Scale Existing Profiles
& PROPR255 - 25 Scale Proposed Profiles 5:1
&y PROPRS010 - B0 Scale Proposed Profiles 10:1
& PROPR10020 - 100 Scale Proposed Profiles 20:1 =]

Press OK.

Step 11.  Click the Add Surface Settings icon to add the profile to the list box as well as draw the
profile into the Microstation file.

< | coG0 | Projsction |
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8.2 Store Profiles into COGO Database

Step 1. Click the Store Surface in COGO icon.

I S ][

Store Surface in Cogo

This will invoke the Store Profile dialog box.

[ store Profile |
Prafile Mamie: ! miground Select I

¥ Stare Profile in GPE

r W~ Create Input File
Operator Code IVD
File Name: Imlg'l 1 iwd Fileg |
[ Creat

Step 2. Fill out the dialog box as shown above and click Apply. ‘MLG101.ivd’ will be created in
the working directory. This file will contain the COGO commands used to create the
existing ground profile.

Step 3. Dismiss the Store Profile dialog box by clicking the X in the upper right hand corner.

Step 4. Click the Remove Surface icon. This will erase the profile from the DGN file. We will re-
draw the profile shortly.

| co6o | Projection |

Type| Mame | Display Settings | Diraw

TIM  zurvewtin FROE®IST 2

Remove Suface
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8.3 Review Profiles in COGO

Step 1.

Step 2.

Step 3.
Step 4.

Step 5.

Access the coordinate geometry tool. (Press the Coordinate Geometry button on the
workflow dialog box). This will open the Coordinate Geometry dialog box.

Select Element > Profile > Utility from the COGO menu bar to invoke the Profile Utility
dialog box.

(@ rou . WEE
x5

Profile |
HLEROOND

Select the profile ‘MLGROUND’ then click the Print icon.
Review the profile information in the COGO output display window.

Close the Coordinate Geometry dialog box (use X in upper right corner of the dialog box).
When prompted to save the COGO session select NO.
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8.4 Drawing & Labeling the Existing Centerline Profile
Next, we are drawing and labeling the existing profile utilizing the Draw Profile tool's COGO tab.
Step 1. Click the COGO tab and set the Label Scale to 25 in the upper right hand corner.
Step 2. Select Profile Name MLGROUND from the drop down list in the Details area.

Step 3. Under the Display Settings set the option to By Feature. Select the feature shown
below and click OK.

gsglecl Design & Computation Payitem __. !El I

File Edit Settings Favorites Help

#id

Cloze |

&3 Chdatalgeotwdotiroad] hatandards\geopak WD OTenglish. ddb  [*
[ Foad Design
= Aligriments
3 Horizontal
[ Vertical

= FRO B - ale E izting Profiles

& PROE=ISTEO - B0 Scale Exizting Profiles

gy PROEXIST100 - 100 Scale Existing Profiles

& PROPR255 - 25 Scale Proposed Profiles 5:1
&y PROPRS010 - B0 Scale Proposed Profiles 10:1
& PROPR10020 - 100 Scale Proposed Profiles 20:1 =]

Step 4. Click General in the Options area and set the Strip Grade Increment to 50. This will
label the elevations every 50’ along the bottom of the profile area.

- Options
Stip Grade Increment; ! B0.00

W' Horizontal swis Label:

¥ Wertical Auis Labels

[ Station E quation

Step 5. Click the Add Cogo Profile Settings icon to draw the profile. This will draw the existing
ground profile with the proper symbology in addition to labeling the stations and
elevations along the bottom of the profile and the elevations along the left side of the
profile.

Step 6. Dismiss the Draw Profile dialog box by clicking the X in the upper right hand corner.

8-16 VDOT Road I Training GEOPAK 2004 Edition



GEOPAK”

8.4 Project Manager - Define

We are completing the Profile View and Location sections of the Working Alignment Definition in
Project Manager.

Step 1. From the Workflow dialog box of Project Manager, press the Define button.

Step 2. Highlight the Profile View option and populate the dialog box as depicted below.

f

Wulking Alignment Definition: mainline

Plan View Design File: Id1 7862prof.dgn File: |
e Existing Profile: [MLGROUND Select |
il i Fropozed Profile: ! Select
Location F _I

Crozs Section Yiew Begin Station:  200+00.00
Existing Ground )
Proposzed Finish Grade End Station;  222+06.34

DTH
QK I Cancel |

' We have not designed the proposed profile; therefore, we will return to populate this field in
a later exercise.

Step 3. Highlight the Location option. To quickly populate this category within working
alignment, click Identify Cell, then data point on the cell for the centerline profile in the
file and accept.

Note: Your coordinates may be different than those shown below. That is not a problem.

f

Wulking Alignment Definition: mainline

Flan View Harizontal Scale: I 25.0000000000000
Fatteih Vertical Scale: [5.00000000000000
Shapes

Frofile Yiew Station Eguation: Mﬁ_&l
Location e

DP Statior: I2DD 00.00 R 1
Crozs Section View aten -
Exizting Ground DF Elewation: I 1900.00000000000
P d Finish Grad
B A DP: [2720706.4040
By DF

DPY: | 3385423490

Profile Cell
QK. Cancel | | ——— | ————— -
—I _I ’V Drawa Cell at =5 | i[dentify Cell

Step 4. Press the OK button to save the updates and close the dialog box.

Step 5. Exit MicroStation.
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SESSION 9

Vertical Alignment Generators

9.1 Introduction

Objectives

To create and store vertical alignments using the Vertical Alignment
Generator.

Project Manager

Vertical Alignment

Tools

e |y

Horizontal & Vertical Geometry x|

A R

Menu Bar Application

GEOPAK Road > Geometry > Layout Profiles (VPI Based)

GEOPAK Road > Geometry > Layout Profiles (Component Based)

GEOPAK has a variety of tools for generating and storing a proposed profile. Those tools include:

The Vertical Alignment Generator (VPI Based) is a GEOPAK tool that can
graphically create and modify proposed design profiles or modify an existing ground
profile. The designer can generate a profile based on VPI data, design speeds,
stopping sight distances, and K values. These operations may be accomplished
through a dialog box and/or by dynamic manipulation of graphic elements.

The Component Based Vertical Alignment tools provide the user with a myriad of
tools to place, modify and delete profile components. Toolboxes organize tools to
include the placement of tangent lines, a variety of vertical curves. Components
interact with each other to automatically trim vertical curves, connect various
elements, and modify, copy and rotate components. The user also has the option to
store completed profiles in the coordinate geometry database.

A profile may also be created with Coordinate Geometry (COGO) input (key in
commands). In addition, there are VC commands that compute and display vertical
geometry and the parameters associated to aid in the development and generation of
vertical alignments used in conjunction with Store Profile commands. VC commands
define parabolas for various combinations of stations, elevations, grades, slopes and
the rate of vertical curvature (K value), and also define the tangents between two
parabolas or between a parabola and a point.

This chapter focuses on the two graphical based tools - Vertical Alignment Generator and
Component Based Vertical Alignment.

GEOPAK 2004 Edition
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9.2 Vertical Alignment Generator

9.2.1 Accessing
When selecting the Vertical Alignment generator, the first dialog

box that appears is labeled Settings, as depicted here. The Job Number [T
entries in this box set the parameters and define the location Operator Code [0 |

within the design file where the profile components are to be
displayed. All fields must be completed before the design

PGL Chain IM.-’-‘«INLINE Select |

~ Location and Scales

process can begin._ Once the OK button is pushed, the Vertical Harizontal Scale [ 25.000000
Profile Generator dialog box appears. Vertical Seals [E 000000
Note: This tool also utilizes the cell that was drawn in the Reference Station [200+00.00F -
previous exercise by using the ldentify Cell button.. Rieference Elevation [1300.000000

¥ | 27207064040
CF
Y| 33854234300

~ Profile Cell
Draw Cellaty |

Ok | Cancel

9.2.2 Using the Vertical Alignment Generator

This tool enables a user to load a previously stored profile or create a new profile. You will notice the
dynamic changes in the dialog box throughout the vertical alignment design.

£ Profile Generator (K Value Table: Kvalues_1990english ki) 1
Fle Tools User

Station:l o -
Elevation:l o -

Profile Generator (K Value Table: Kvalues_1990english ki)
Hle Tools User

WP 2 WFL3 WPl 4
Bk Grade: [-12.5733 af v Statior: [200+50.00 | Off  * Fd Grade: [E4787 o]
3 |'|5IJ.DEI Inzert Elevation: I2EI1'I.EI2 aff - Ingert k4 I'IEED.EID |
Statior:  202+00.00 Before N After Station: 216+00.00
. Diynanic | Delete | )
Elevation:  2029.88 Elervation; 2095.00

r Wertical Curve

Out of g, 350,00 Summetrical ¥ |550: 27257

| station: Speed: |35 w|L [#0000 HP Station. 20245000  Station. 202+50.00
Elewation: 198587 K: | 55.9029 HF Elevation:  2021.86 Elevation:  2027.86

Prev | 1[4 [ M4 Mem |
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Various design parameters must be defined prior to designing a new profile; which are discussed in
the options supported under the three menu options; File, Tools, and User.

9.2.3.1 File

9.2.3.2 Tools
lzzue D ata Paint |

9.2.3.3 User

Clear - clears the profile display from MicroStation graphics and removes all VPI's
from the dialog box.

Draw - write the graphic elements of the profile to the MicroStation file.

Load - retrieves a previously stored profile from the coordinate geometry database
(-gpk)

Save - stores a new profile or updates (redefines) a previously stored profile under the
same name.

Save As - is used to store the profile or to save a modified profile under a different
name.

EXit - ends the process.

Critical Points - Vertical curves may also be defined by one or two critical points —i.e.
the curve will pass through these points. If mathematically solvable, the vertical curve
will be drawn and the design speed display adjusted to fit the current parameters.

Issue Data Point - Permits the user to type in stations and elevations, issue a data
point that can be part of a MicroStation place line, place a cell or perform other generic
operations. This is useful in displaying visual references within the profile that need to
be considered in design of the vertical profile.

Preferences - sets the rounding parameters for each of the items listed in the dialog box.
Also contains a toggle that will force the dialog box to window center the view on the current

= VP,
g;‘:i”zs K Values - is a table of stopping sight distance K-values for crest and sag conditions for
= various design speeds. These values are based on the AASHTO Green Book.

Settings - recalls the Settings dialog box that first appeared upon initializing Vertical
Layout.

GEOPAK 2004 Edition
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9.2.4 Creating A New Profile

!

The enter/tab key must be used to ensure values are accepted.

A new profile can be created with the following steps:

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Place the first VPI using one of the four supported options.

e Type station and elevation of the VPI into the appropriate fields in the Profile
Generator dialog box.

e Enter station of VPI as precision input (type in value), and allow the elevation to be
defined through dynamic cursor placement on screen.

e Elevation is defined via precision input, and the station is defined through dynamic
cursor placement on screen.

e Both values for the VPI can be established dynamically on screen by clicking on the
Dynamic button and placing a DP in the view at the desired station and elevation.

Define ahead (or back tangent)

Station, elevation, grade and length parameters may be defined via precision input,
dynamic manipulation or a combination of both.

Define remaining VPI's and Grades
A repetition of Step 2 with an option to insert VPI's between two existing VPI’ s.
Define Vertical Curves

Simply define the design speed from the Speed option button and GEOPAK will
reference the K-value table and draw the vertical curve. If a curve overlap occurs, an
overlap message will be displayed in the dialog box along with the overlap length.
Length of Curve or K-value may also be keyed in.

Adjusting Curve Lengths

The vertical curve can be modified by directly keying in either the K-value, curve length or
defining the design speed in the dialog box. You will see the values computed
automatically adjust to reflect the results of any modifications.

Save the Profile

Click File > Save As to name and save the newly created profile. The names of profiles
are any 1-9 alphanumeric characters.
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9.2.5 Precision Placement Options
Options available for creating or modifying vertical curves, VPI's and grade lines:
e OFF - Values change.
ILNcEr:q ¢ INC (Increment) - Ensures that the designated profile parameter will be adjusted as

defined in the Preferences dialog box.

e LCK (Locked) - Forces selected operations to maintain the designated profile
parameters.

9.3 Component Based Vertical Alignment

This tool requires COGO and the active chain control to be active. If a COGO session in not open,
an Alert message is displayed.

9.3.1 Accessing

When the tool is selected, the tool frame illustrated below opens.

The 2x2 tool frame is similar to the MicroStation main tool frame. It is not resizable, but dockable.
Each icon in the tool frame is a tool box that one can "tear off" to become a "tool box." The individual
tool boxes can be docked and resized. There are four tool boxes, with the following titles:

e Place Vertical Alignment Lines

e Place Vertical Alignment Curves

e Profile Tools

e Manipulate Vertical Alignment Elements

9.3.2 Place Vertical Alignment Lines

Place ¥A __.. =]
A

The Place Vertical Alignment Lines tools are detailed in the table below.

/ Create a Profile Line by Two Points

This tool enables the user to place a profile line by defining two points. Optionally the
slope or length of the line may be fixed.

N, Create a Profile Line Tangent to One Element

This tool enables the user to place a profile line tangent to a curve.

T Create a Profile Line Tangent to Two Elements

This tool enables the user to create a Vertical Alignment line tangent to two curves.
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9.3.3. Place Vertical Alignment Curves

Place VA Curves JEd |

The Place Vertical Alignment Curves tools are detailed in the table below.

i Place a Vertical Curve by Three Points
This tool enables the user to place a profile curve by three points.
iy Place a Vertical Curve by High Point

This tool enables the user to place a vertical curve by defining a high point (or in the
case of a sag curve, the low point).

A Place a Vertical Curve Tangent to One Element and Through One Point

This tool enables the user to place a profile curve tangent to one element (line or curve)
and defining a pass through point.

Place a Vertical Curve Tangent to One Element Given High Point

This tool enables the user to place a profile curve tangent to one element and defining a
high point or low point.

f\ Place a Vertical Curve Tangent to Two Elements

This tool enables the user to place a profile curve tangent to two elements (any
combination of lines and curves).

9.3.4 Manipulate Vertical Alignment Elements

M anipulat.._ x|

“\C\“l ‘“{'|| L |

The Manipulate Vertical Alignment Elements tools are detailed in the table below.

. Move a Profile View Element

This tool enables the user to move an element or to make copies. Note the moved or
copied element must remain within the confines of the profile cell and associated delta
top and bottom values.

\{p| Rotate a Profile View Element
This tool rotates the selected tangent about a user-defined point.

Extend a Profile View Element

This tool can extend or shorten any Vertical Alignment element, either tangent or
vertical curve.
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9.3.5 Profile Tools

Profile Tools x|

The Profile Tools are detailed in the table below.

% Store a Vertical Alignment in COGO

This tool enables the user to store graphical profile components (lines and curves) into
coordinate geometry.

Graphical Profile Preferences

=

This tool enables the user to define the preferences utilized within the Component
Based Profile Generator such as the profile element symbologies and the profile name
prefix.

Import Vertical Alignment from COGO

This tool enables the user to import (draw) a previously stored profile from the
coordinate geometry database.

Place Profile Cell Anchor

B ka

This tool enables the user to place the profile required as a prerequisite to any profile
creation. Note the profile cell may be placed by many other applications in GEOPAK,
i.e., D&C Manager, Vertical Alignment Generator, Project Manager and Plan / Profile
Sheets.

ﬁ Profile Cell Control

The Profile Cell Control dialog box enables the user to place or manipulate profile cells
and associated data.

9.4 Active Chain Control

The GEOPAK Active Chain Control is an excellent tool, enabling the user to manage plan, profile,
and cross section views simultaneously. It also allows usage of MicroStation tools to place elements
in any view in accordance with the curvilinear coordinates settings.

The Active Chain Control requires COGO to be running. If the tool is selected without COGO
activated, the Chain list is empty. In addition, the files must be referenced (i.e., plan, cross section,
and profile) before utilizing the tool.

When invoked, the dialog box depicted below opens.

Active Chain Control

=
Chain [OMNEN] id, < ol ) ) S i ] )

First, select the desired chain from the Chain list box at the left end of the tool box, as depicted
below. This list is updated each time a chain is created/deleted or a new GPK file is opened.
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Active Chain Control
Char: BN -] id S
id x W

e Chain Mame

< Mone »
EBL4E0

AP
REDEUD

Four icons are supported to the right of the chain list field and are detailed in the table below.

K 1~ &

=

Graphically select the active chain candidate.

Opens the “Precise Curvilinear Coordinates” dialog box, that allows entering
precise curvilinear coordinates relative to the active chain.

Activates the current Profile system, which is associated to a Profile Cell.
The Profile Cell can stay in the master file or in any of the reference files. If
there are several Profile cells relative to the active chain, it is possible to
designate the active one in the Profile Cell Control dialog box. When the
right button is pressed, a pop-up menu appears :

lg Prafile Cell Cantral |

The first option of the pop-up menu allows placing a Profile cell. The second
option allows getting information about Profile cells that stays in master and
reference files and select the active one if there are several profile cells.

Activates the current Cross Section system. If there are several reference
files containing XS cells relative to the active chain, it is not possible to
activate the Cross Section Representation System. In this case, an alert
dialog box is displayed.

NSRRI

The right side of the toolbox has eight icons, which set each view to plan, profile or cross section
view. By right clicking an icon, any view can be set to any of the 3 possible views. For example, if
there is an active profile cell, setting a view to profile will immediately fit the profile within the limits of

the view.
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LAB 9: Proposed Profiles

9.1 Generate the Proposed Profile

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Execute

C:\data\geo\VDOT\road1\LAB9.EXE.

Open the MicroStation file:

C:\data\geo\VDOT\road1\d17682prof.dgn

Access  Project

Manager. It

should

automatically access the Road workflow dialog
box since we ‘remembered” the options in

Exercise 2.

Select the Vertical Alignment button from the
Road Project: 17682.prj workflow dialog box.

Operator Code IVD

r Location and Scales

Horizontal Scale IW
Yertical Scale IW
Reference Station !m
Reference Elevation IWDDDDD_

¥ | 27207064040
CF
Y| 33854234300

FGL Chain IM.-’-‘«INLINE Select |

r Profile Cell
Draw Cell sty | | IdentiyCell |
OF. | Cancel |

All of the information in the invoked Settings dialog box should be automatically
populated based upon the information we provided in the DEFINE dialog box in Exercise

8.

Press the OK button to commence development of the proposed profile.

Provide the initial VPI Station = 200+00 and the initial VPI Elevation = 2021.53 as shown
in the diagram below. Be sure to press Enter after each entry is made.

i Profile Generator (K Value Table:- Kvalues 1990englizh lovl)
Hle Tools User

Inzert
Before

YR

Statior: [200+00.00 | O =

Elewatiar: |2021.53 Lock *
Dynarnic I
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Step 7. Press the Insert After button and complete the VPI Station and Elevation of the
subsequent VPI's as detailed in the table below.
VPI Station Elevation
2 202+00 2029.88
3 206+50 2011.02
4 216+00 2095.00
5 222+00 2099.00
Step 8. Press the Prev button to return to VPI 2 as shown in the diagram below.
£ Profile Generator (K Value Table: Kvalues_1990english kovi)
Hle Tools User
VP YPI'2 VP13
Bk Grade: [41750 of_ - Statior: [202+0000 | OK ¥ Fd Grade: [-47911 o |
L: [z0000 Insert |  Elevation: [2029.88 o *|  fnset L: [450.00 '
Statior:  200+00.00 Befors 0 ; | After Station: - 206+50.00
) Yharnic Delete | )
Elevation.  2021.53 Elevvation: 2011.02
- Wertical Curve
Summetrical ™ |55D:
Station; Speed; | 7 v’L: I HP Station;  Ma Station:
Elewation: K: | 540.0000 HF Elewation:  M& Eleration:
[ 5 Mest |
Step 9. Enter a symmetrical vertical curve Length of 300. (The K value and Design Speed are
automatically computed.)
| 8 Profile Generator (K Value Table: Kvalues_1990engiish kvi) MEE|
Fle Tools User
YR WPl 2 WP 3
Bk Grade: [4.1750 af - Station: [Z02+00.00 | Of = Fd Grade; [-47911 o]
L 20000 Inzert Elevation: [2029.88 Off - | Insert L: |45EI.DEI |
Station:  200+00.00 Before . After Station: - 206+50.00
, Diynarmic | LDelete | ,
Elewation, 2021.53 Elevation; 2001.02

- Wertical Curve
Symmetical ™ |550: 218.30

Station, 20045000 Speed |30 U [30000 HP Station,  201+39.71 Station:  203+50.00
IElevatiDn: 202362 k: [35.85490 HF Elewation. 202675 Elevation. 202359
Prev | 1[E] L] 35

Step 10.  Using the table below, enter the following vertical curve lengths.
VPI Length
3 400
4 550
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Step 11. When completed, select File > Save As from the Profile Generator to save the profile.
Populate the dialog box as below then click OK. ‘PROP101.ivd’ will be created in the
working directory. This file will contain the COGO commands used to create the
proposed profile.

| Save Profile As
Profie: [MEINOINE | =]
File: |pru:u|:u1IZI‘|.ivd Select |

Cancel !

Step 12.  Exit the profile generator. When prompted to save your profile, answer No since we did
that in Step 10. When prompted to save your Vertical Alignment settings, press Yes.

Step 13. Open Cogo and use the Element > Profile > Utility tool to see a listing of information
about the profile. The Print option will provide elevations at any station or increment of
stations desired.

g[:uuldinale Geometry Job: 101 Operator: vd | _ (O] x|

File  Edit Element “iew Tools ser
LE T U - - W Gl A =] .

& N+rar-" 8ok @ % B @0 o

Dizable Yisualization v"DFF [Feature) EI Elowsel Lditl << |LILI > |

LCOGD Kewin |F'rint Profile MAIMLINE 3

Profile: HAINLIHE el
STATION ELEV GRADE TOTAL L BACK L AHEAD L

VEPI 1 200+00.00 2,021.53

VEC 200+50.00 2,023.62 4.17 K= 35.9 55D = 218.3

High Point 201+99.71 2.026.74

VEI 2 202+00.00 2.029.88 ag0o. o0 150.00 150.00

VET 203+50.00 2.023.59 -4.19

VEC 204+50.00 2.019.40 -4.19 K = 30.7 =

Low Point 205+78 .65 2.016.71

VFI 3 206+50.00 2.011.02 400.00 200.00 200.00

VET 208+50.00 2.028.70 8.84

VEC 213+25.00 2.070.89 8.84 K= &7.3 55D = 299.1

VFI 4 216+00.00 2.095.00 550.00 275.00 275.00

VET 218+75.00 2,096.83 0.67

VEPI 5 222+00.00 2.,099.00 0.67

Step 14.  Dismiss the File Utility dialog by clicking the X in the upper right hand corner.

Step 15. Dismiss the COGO dialog by clicking the X in the upper right hand corner. When
prompted to “Save Session Before Exiting?” click No.
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9.2 Drawing the Proposed Centerline Profile

Next, we are drawing the proposed profile utilizing the Draw Profile tool’'s COGO tab.

Step 1. Open the Draw Profile tool.

Draw Profiles

Step 2. Set Chain to MAINLINE by selecting it from the dropdown list.

r Draw Profile

File Edit Update Optiong

Job Number; i1|:I1 :!

Chair: [ETATNNIN ~ |

Chain Mame l
Surface

< Mare »

MAIMLINE
R&MPA
REDEUD

Step 3. Click the COGO tab and set the Label Scale to 25 in the upper right hand corner.

Step 4. Change the Profile Name to MAINLINE. Set the feature as shown below and click OK.

File Edit Settings Favorites

#id

&3 [hdatalgeotwdotiroadl hstandards geopak WD O T englizh. ddb
[ Foad Design
= Aligriments
3 Horizontal
[ Vertical
&y PROEXIST 25 - 26 Scale Existing Profiles
&y PROEXISTSO - 60 Scale Existing Profiles
&y PROEXIST100 - 100 Scale Existing F'roflles
= FROPRZ255 -

e PROFPRE0T0- 50 Scale F'oposed Profiles 'ID 1
& PROPR10020 - 100 Scale Proposed Profiles 20:1

[
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Step 5.

Step 6.

Step 7.

Step 8.
Step 9.

Step 10.

Under the Options section of the dialog, select General. Populate the dialog box as
below.

~ Options
Strip Grade Increment: W
™! Horizonkal Asis Labels

™| werical &xis Labels

[T Station Equation

Under the Options section of the dialog, select VPI. Populate the dialog box as below.

~ Options

General ¥ WPl Labels FromWFl |
Circle 7|
Ve ¥ Grade Labels '+ and ' VI

Under the Options section of the dialog, select VC. Populate the dialog box as below.

~ Options
General I Incremental Elevations W WPCAPT Label
W MV %.C. Parameters
M ¥ K Walue ¥ External Length
¥ Stopping Sight Distance

Click the Add Cogo Profile Settings icon to draw the proposed profile for the project.
Dismiss the Draw Profile dialog box by clicking the X in the upper right hand corner.

Review the proposed vertical alignment.
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9.3 Update the Project Manager

We are completing the Profile View of the Working Alignment Definition in Project Manager.

Step 1. Press the Define button from the Workflow dialog box of Project Manager,

Step 2. Highlight the Profile View option and populate the Proposed Profile field as depicted

below.

Plan Wiew
Fattem
Shapes

Prafile Wiew
Location

Crozs Section View
Ewigting Ground
Propozed Finizh Grade

DTH

Cancel |

Select |
Select |

Dresign File: I d17E32prof. dgn
E xizting Profile: I MLGROUMD
Proposzed Profile; I raIMNLIME

Step 3. Press the OK button to save the updates and close the dialog box.

Step 4. Exit MicroStation.
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CHAPTER 10

Existing Ground Cross Sections

10.1 Introduction

Objectives

To generate existing ground cross sections based on a horizontal
alignment and the surface model beneath the alignment, and to review the
sections utilizing the Cross Section Navigator tool.

Project Manager

Draw Pattern and Existing Ground Cross Section

Tools

7 & al

Cross Seclions
|5

=

Menu Bar Application

GEOPAK Road > Cross Sections > Draw Pattern by Station Range
GEOPAK Road > Cross Sections > Ground Cross Sections from DTM
GEOPAK Road > Cross Sections > Navigator

The prerequisites to generate existing cross-sections utilizing digital terrain modeling are:

e GEOPAK coordinate geometry database wherein the horizontal alignment is stored.

e GEOPAK binary TIN file, Site Model or Site Object. The Site Model or Object are created
utilizing GEOPAK Site Modeler software and are stored within the GEOPAK Site project (gsf)

file.

e Pattern lines if pattern by design is to be utilized.

The generation of existing ground cross sections must be invoked from within the 2D MicroStation
design file wherein the sections are to be drawn. GEOPAK does not create this MicroStation design
file. The user creates the blank design file utilizing the desired seed file, and then GEOPAK draws

into it.
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10.2 Pattern Lines

Project Manager Draw Pattern

Tools Cross Seclions &=
475 e : enfy o A = s %, ; ==
T AL [ B AR o PN S =

Menu Bar Application GEOPAK Road > Cross Sections > Draw Patterns By Station Range

Pattern lines are graphical lines and/or line strings in a MicroStation design file that define locations at
which the cross sections will be cut.

From the Project Manager you will select Draw Pattern, and create or select an existing run. When
completed, the following Draw Pattern Lines dialog box appears.

e 1|

dobe [T0T Q| Chaine [MAINCHE =1 1]
Beginning Ending
Left Offzet(+]: |2DEI.DD Left Offzet(+]: |2DD.EIEI
Statior: [200+00.00 ﬁ Station: [220+00.00 ﬁ
Right Offzet(+): I 200,00 Right Offzet+); I 200.00
Increment v| iEI.DD [T Skew &ngle |
Level Symbalogy: |[————  [{ Biraw Pattern Lines. ||

Once all of the fields have been completed, and the application is initiated, graphic lines (on the
specified level, color and style) are drawn along the chain. This is a visual representation of the
location of the cross sections to be generated.

Six methods are supported for drawing the pattern lines:

e Increment — starts at the beginning station, and draws a pattern line at the given increment.

e Even - draws pattern lines at stations divisible by the given value.

e Once —draws a pattern line at a given station.

e Critical Points Horizontal — draws a pattern line at each of the critical point (i.e. POT, PC, PT,
etc.) within a chain.

e Critical Points Vertical — Draws a pattern line at each VPC and VPT in addition to the sag and
crest station of vertical curves based on the profile defined in the dialog box.

e Superelevation Transitions - The current design file is scanned for Superelevation shapes
created with the specified chain. A pattern line is drawn at the beginning and end of each
Superelevation shape, ignoring the beginning and ending station fields in the dialog box.
Note the Superelevation shapes cannot be in a reference file.

The pattern lines are drawn into the current MicroStation design file. The user can use the
MicroStation Place SmartLine or Place Line command to draw additional pattern lines at any user
defined location. In addition, MicroStation commands can be utilized to modify pattern lines drawn
via the dialog box to lengthen, shorten, delete, copy, move, etc.

NOTE: This should be completed before the existing ground cross sections are generated.
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10.3 Generating Cross Sections

Project Manager Existing Ground Cross Section - Note a run must be created.

Tools Cross Sections 3
2 s 00 Almlell & 0 B

Menu Bar Application GEOPAK Road > Cross Sections > Draw Cross Sections from Surfaces

Once the pattern lines have been drawn, the cross sections can be generated. Note the Job Number
must be defined in order to populate the Chain list. Once the Chain is defined, the dialog box
unghosts as depicted below.

Fle Edit Update Options
Job Mumber: ﬁm Chair: mﬁ _Draw
" DP Origin
l Surfaces i
r Pattern
By DGH File Vi
Design File: | d17882woark.dgn _CH
M Lewsk | o] 50 ial)
¥ Colors: i4—-_g] ¥ Line [ Line Sting
¥ Styles: ’D—‘_g] Match | Reset |
W "wieights: r2—-£| Display I
r Scale ————————— - Spacing
Horizontal: ﬁ-D-EI_EIW Horizontal: w
Wertical: w Yertical: W
Murnber of %5 by Colurmn: ﬁﬁ_

The rest of the dialog box consists of a menu bar with three listings:

File Standard file utilities to load, or save settings, plus a dialog box exit
option.

Edit Options to Cut, Copy and Paste rows in the surfaces list box. Also,
save and restore settings in the RSC file or clear list of all surfaces.

Update Options: User-defined options on how the software handles the redrawing of
cross sections.

Delete Existing Elements When this option is activated, any existing ground lines previously

and Redraw drawn with this tool are deleted and new ground lines are drawn.

Delete Non-modified When this option is activated, any existing ground lines previously

Elements and Redraw drawn with this tool are deleted and new ground lines are drawn.

Draw on Top of Existing When this option is activated, any previously drawn ground lines are

ignored and a new set is drawn, resulting in two sets of ground lines.
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10.4 Cross Section Navigator

Project Manager Not accessible from within Project Manager
Tools Cross Sections

x|
& edrs ,-w!i».é B ﬁfwﬂﬂ

Menu Bar Application GEOPAK Road > Cross Sections > Navigator

The Cross Section Navigator tool is used to view and traverse between cross-sections. It can also be
used to draw cross-section information.

When the Navigator is invoked, the following dialog box appears.

Cmss Section Navigator - MAINLINE - Scale 1H- 1V

f 2000000 = El fﬂeﬂl 9 |Hl b IFF’l R ol i e I‘{_-Ell Iil

The user can scan through the cross-sections by either choosing the station from the drop down list,
or by using the First Section, Previous Section, Next Section, or Last Section icons (arrowheads).
The Reset Navigator icon window centers the current station to the view.

The Open View Control Dialog Box enables the user to open several windows to
|i| view different portions of the cross section at the same time. The user can view the
whole cross-section in view 1, the left side in view 2, and the right side in view 3, etc.

Cross-section elements can be added or modified using MicroStation tools or GEOPAK cross-section
drawing tools, as detailed in the table below.

DP Offset Elevation Data points at a given offset/elevation, or find the offset/elevation of the
= cursor location.

Tany

— Z5 DP Difset Elevation - MAINLINE
b C
Elevation [HNDMNN | | | Elevaton 0.000 |
Offzet ID.UDD Offset  0.000

DP Delta Distance Draws a line at a given horizontal distance and slope.
Slope
=
et Delta Harizontal Distance I_I_I_II_II_I
Slope [rurcrise I 1.000 I 1.000
XS Active Angle Sets the active angle to the given value. If a MicroStation tool is used with
Tool the active angle option, this value is used.

EE

75 %S Active Angle Tool - MAINLINE [ ]
Typei | Slope funrise]  v| [T000 | - [T000 | Setsa |
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Query

When activated, the user is prompted each time the Draw button is
clicked.

T

) iDelete &l E xisting Elements and Fedraw;
® Delete Mon Modified Elements Only and Redraw
2 Draw On Top of Existing Elements

Cancel |

Two tabs on the dialog box support the input data required to draw cross sections:

XS Cells

Surfaces

Defines the location of cross sections utilizing either pattern by station or
pattern by design. In addition, the scale and spacing are defined within this
tab.

Define the surfaces utilized for drawing cross sections. Note multiple
surfaces may be drawn in a single processing. Source data includes
GEOPAK TIN files, Site Models, or Site Objects.

On the XS Cells tab, the Pattern group box has three choices:

Pattern by Station

Pattern by DGN

In Existing Only

Utilizes Begin and End Station values in addition to an Increment/Even option
and Left and Right Offset fields to determine cross section location. This
works well when no sections are needed that are at odd stations, skewed or
kinked relative to the Chain.

This method utilizes graphical representation and draws one cross section for
each line or line string of the specified parameters. Those parameters include
Design File which is the name of the file that contains the lines and line
strings in addition to their associated symbology.

No user input is required, as this option draws ground lines only for cross
section cells which were previously drawn. Therefore, no other pattern
requirements are needed.

On the Surfaces tab, the (Filter Tolerances group box has two fields: Horizontal and Variance.
Both Horizontal and Variance filter tolerances are considered together for each pair of cross section
segments. The middle point is deleted if both segment lengths are less than the Horizontal filter
tolerance while the projected distance between the mid-point and the chord between the two end
points is less than the Variance tolerance.
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Draw XS Line Draws a cross section line. The length and/or slope can be specified.

=

" iDelta Distance: [0.000

"] _Slope [rurcrise v||1.DDD -[7000

10.5 Summary - Basic Steps to Creating Existing Ground
Cross Sections from a DTM

Step 1.
Step 2.
Step 3.
Step 4.

Step 5.

Requires a horizontal alignment stored in *.GPK file.
Requires an existing triangle file (TIN) from a DTM.
Draw pattern lines.

Process cross sections using Draw CrossSections tool.

Review and modify (if necessary).
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LAB 10: Existing Ground Cross Sections

10.1 Draw Patterns

The first step is drawing MicroStation lines or line strings to define the location of the existing ground
cross-sections.

Step 1.

Step 2.

Step 3.
Step 4.

Step 5.

Step 6.

Step 7.

Execute C:\data\geo\VDOT\road 1\LAB10.EXE.
Open the MicroStation file c:\data\geo\VDOT\road1\d17682work.dgn

Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Select the Draw Pattern button from the Road Project: 17682.prj workflow dialog box.
Create a new run called MAINLINE. Select the newly created run then click OK.

Populate the dialog box as depicted below.

e S |1

dob [T07 | @]  Chain: [MAINDNE =[]
Beginning Ending
Left Offsetf+]: [200.00 Left Offsetf+]: [200.00
Station; |2DEI+EIEI.DD Station; |2D4+25.EIEI
Right Offeet(+); I 200,00 Right Olffzet(+]; I 200,00
Increment Vl i25.DD [T Skew fngle |
Level Symholagy: | [7 B Bt Dires ]

Double click the Level Symbology graphic. Populate the Set Feature dialog box as
below then click OK.

| GEOPAK Set Feature I

r Spmbology
Level |Lewel 50 =]
Calor: m
Sle: | 0 =]
wieight: | 2 ]
Cancel I

Click Draw Pattern Lines to initiate the plotting of the patterns into the design file for the
station range supplied.
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Step 8. Populate the dialog box as depicted below.

_ Pattern Lines 1
Job |1IJ1 _'EZ;_I Chair: |MAINL_INE vilm Prafis [MaRLINES

Beginning Ending

Left Offset(+): |2DD.DD Left Offset(+): |2DD.DD
Station; |2D4+5EI.DD Station; |22D+DD.EIEI
Right Offset(+]: I 200.00 Right Olffset(+]: I 200.00

Increment Vl I25.DD [ Skew Angle |

Level Symbology: (s [ o Pl Ty

Step 9. Double click the Level Symbology graphic. Populate the Set Feature dialog box as
below then click OK.

| GEOPAK Set Feature I

r Sumbology
Level: |Level 50 B3|
Color: 1 4 i |
Sle: | 0 =]
wieight: | 2 ]
Cancel |

Step 10.  Click Draw Pattern Lines to initiate the plotting of the patterns into the design file for the
station range supplied.

Step 11. Review the pattern lines.

Step 12.  Dismiss the Draw Pattern Lines dialog box by clicking the X in the upper right hand
corner. When prompted to “Save Settings” click “Yes”.
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10.2 Update Project Manager

We are completing the Pattern section of the Working Alignment Definition in Project Manager.

Step 1. From the Workflow dialog box of Project Manager, click the Define button.

Step 2. Highlight the Pattern option and populate the dialog box as depicted below. Since we

are in the pattern file, you can use the Select button to accomplish this task rather than
manually typing in the information.

' NOTE: Be sure to use colors 4 and 5.

| £ Working Alignment Definition- MAINLINE = I
Plan View By Design File I
Har. Scale I'I Wer, Scals I1
Profile Yisw Design File: [dT7682work.dan File |
Location
Cross Section Yiew M LeMames [ _!
Existing Ground ) i-_
Propozed Finizh Grade ! Ly Humbers: | 50 E!
DT 7 Colorg: |4-5 _Elj Match |
i swles: [0 _§I_| Dizplay l
W wheights: | 2 .E_I.l Fasat I
Cancel I I Types: |3 E‘

Placement: |

Step 3. Click OK to close the Working Alignment dialog box.
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10.3 Generate Existing Ground Cross Sections

Step 1.
Step 2.
Step 3.

Step 4.

Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsmainline.dgn
Click the Existing Ground Cross Sections button on the Project Manager dialog box.
Create a run called MAINLINE. Select the newly created run then click OK.

Generate the existing ground cross-sections by populating the dialog box as shown on

the following dialog boxes and clicking the Draw button to initiate the routine.

Note: The Display Settings for the existing ground line are set to level 1, color 1, weight 5, style 2.

- Cross Seclions | - Draw Cross Seclions I
Fle HEdit Update Options Fle Edit Update Options
Job Mumber: [T07 =] Chain [MEINONE =] Draw | Job Humber [T07 =]  Chain: [MEINOINE =] Draw |
[ DP Oiigin [ BP O
| Surfaces i #5 Cells I |
- Pattem Tupe | Hame | Diigplay Seftings | Method
Eu DG File vi TIN  surveptine Ly Level 1, Coc 1, Lot 2.0 5 Q
Design File: [ d17682work dgn 3'
M Lewsds | o] #[E0 a|
W Calors: 145—-25 W Line. [T Line Sting
W Stples: !D—-E! fatch Feset | i ] .
. . : TIM File: | survey.tin &l
b wieights: I2 —':Ij ﬂ_ Method: | Triangles ™% Type:  Line "I
- Scale Spacing ~ Dizplay 5 ettings - Filter Tolerances
Harizontal: | 1.000000 Horizantal: I'I_DW By Level Syrmbology vi YTl T] Huarizontal: W
Wertical: r‘m Yertical W sy [+ Mo Entniss : _i_J Warance: W‘I-D_
Humber of #5 by Column; r2“DL_ —
r Text Settings
™ Elgvation |_T et Iy

settings.

=D

NOTE: Do not forget to click the Modify icon to update the symbology

Step 5.

Dismiss the Draw Cross Sections dialog box by clicking the X in the upper right hand

corner. When prompted to “Save Settings” click “Yes”.
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10.4 Review Cross Sections

Cmoss Sections

x|

A 4 N %‘?:_‘? ﬁ i 1 [

Gl 4 .—»’b‘!gé -a-”"l.ﬁ-““' fe i I R al=
Step 1.

Select the Cross Section Navigator tool from the Road Tools tool frame.

| Cross Section Navigator - MAINLINE -

] —| 44| 4 B8] b pb| S E| TR <]

Use the Cross Section Navigator to browse and check your existing cross sections

000000

Step 2.

Step 3. Dismiss the Cross Section Navigator dialog box by clicking the X in the upper right
hand corner when done.

GEOPAK 2004 Edition
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10.5 Update Project Manager

We are completing the Cross Section and Existing Ground sections of the Working Alignment
Definition in Project Manager.

Step 1. Highlight the Cross Section View option and populate the dialog box as depicted below:
Flan View #5 DGM File: |d1 TEE24smainline.d File |
Patterm
Shapes
Profile “iew Chaire  MAINLINE
Location
tic Beqin Station:  200+00.00 R 1
wigting Ground
Proposed Finish Grade End Station:  220+00.00 R 1
DTM
ak. | Cahicel |
Step 2. Highlight the Existing Ground option and populate the dialog box as depicted below
| £ Working Alignment Definition: MAINLINE
Flan Wiew
Pattern I ¢ Plamias i _!
Shapes ™ Ly Mumbers; I1 Ei
Frofile Wiew
Location W Colors: [ ...';IJ
Crozs Section View i Styles: I2 _g! tdatch
E xigting Ground e 5 [T m—
Propozed Finizh Grade = Wweighta: | 4 —EIJ ____D|splay
DTM I Types: [3 E‘ Feset
Flacement, |———
Cancel I
Step 4. Click the OK button to close the dialog box.
Step 5. Upon reviewing the sections, it is desirable to “lock” the elements to prevent accidental
deletion or modification in later steps.
Select Edit > Select All from the MicroStation menu bar. Then select Edit > Lock to
lock the elements.
Step 6. Exit MicroStation.
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CHAPTER 11

Superelevation

11.1 Introduction

Objectives Learn to use GEOPAK Automated Superelevation dialog box and
Autoshape Builder to apply superelevation to a roadway.
Project Manager Calculate Superelevation
Tools
i =
o 4 = £ % t£1 : m.
|@ Superelevation Shape Manager Tools =]
| i s
& Bl Al Hel¥ =
Menu Bar Application GEOPAK Road > Cross Sections >Superelevation Shape Manager Tools

GEOPAK supports a myriad of options for the definition of pavement on proposed cross sections.
They range from a single slope specification emanating from a baseline / profile on each section, to a
complicated multiple roadway, each with its own superelevation transitions.

The most basic is the project where no superelevation transitions are required, i.e., the roadway
slope for all pavement (if any) can be specified as a single value. In this case, the slope can be
defined with the proposed cross-section processing and any additional superelevation work is not
required.

Another option is the definition of superelevation when roadways are constant widths without tapers,
i.e., turn lanes, acceleration and deceleration lanes, etc. In these areas, the automated
superelevation can be utilized, based on a user-defined design speed and considering the geometry
of the specified roadway. After careful review of the data (in ASCIl format) and overriding the
computed values, GEOPAK draws pavement representations as complex shapes into a MicroStation
2D design file.

A third option is the definition of superelevation when roadways are not constant widths, i.e., gore
areas, turn lanes, acceleration and deceleration lanes, etc. In these areas, graphic elements within a
MicroStation 2D design file are utilized to create complex shapes that define the superelevation
transitions.

A combination of these tools can be combined with a project, or even within a single roadway. The
shapeless mode is excellent for rural applications, low volume city streets, frontage roads, etc., while
the automated method quickly generates automated shapes for more complex roadways. Any area,
which cannot be defined via the automated method, can be augmented by the graphical method.

For some users, only simple narrow shapes will be required when designing new roadways or
performing slope correction for reconstruction projects. The proposed cross section criteria will
stretch the pavement out to the true proposed edge of pavement based on finding plan view elements
that represent the EOP.
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11.2 Automated Superelevation (AutoShape Input File Maker)

Project Manager

Calculate superelevation

Tools

Superelevation Shape Manager Tools

= < Gle| He| %I

The GEOPAK Superelevation package enables the user to create, edit, and run an autoshape input
file quickly, basing it on an existing COGO alignment.

A rich set of preferences is available which gives the user complete control over every aspect of the
standardization of the superelevation design process. AASHTO Method V is available as a default,
along with the ability to employ user-defined lookup tables both for e (superelevation rate) and for
runoff length. User-defined equations may also be entered to compute these values. A thorough set
of options is available for resolving the superelevation conflicts of Reverse Curves, Compound
Curves, Broken Back Curves, and Short Curves.

GEOPAK calculates superelevation transition
locations for any alignment stored into the
coordinate geometry database. The main
superelevation dialog box is simple and
straightforward, allowing the user to select
which preference file is to be used for the
current session, as well as enabling the entry
of the typical section lane configuration in the
simple engineering terms of Number of
Lanes, Lane Widths, Median Width (if any),

gMomdai Superelevation - ML1
FHle

Design Speed: |45
Y ~| | End [Z02+00.00 ]

Preference File: |eng|ish ghanc ;I Facility: Divided 'I
& Selection; Irural _v_j L Selection: lrural _:_i

Job m-f" gj

r Station R ange

Chain: [MANLNE =] 03]

Begin: [200+00.00 @

Left | Right
and Cross Slope. More complex lane _ .
configurations may be represented as Froffe: [MEINLINE =1
needed. Tie: | Offzet vI Offzet; [0.0000
Upon computation of the superelevation %Slope | Oifset | Offset | _Dependent | =
parameters (cross slopes and stationing), the =ee 50000 20,0000
; ) ' ! -2.0000 -20.0000 -32.0000 O e
information is stored in an ASCII file, where =
the user may review and modify the i]
transitions, if desired. After reviewing the &
information, the ASCII file is executed from _ :
the Autoshape Builder to generate Create Input File: | mil_shapes.inp ey
superelevatlon Shapes' | Generate Superelevation Tranzitions 1
Job Coordinate geometry database wherein the desired chains and profiles are

Chain

Begin Station

stored.

GEOPAK baseline chain dictating the horizontal geometry for which
superelevation transitions are calculated. This chain is also called the Shape
Cluster Baseline in the Auto Shape input file.

When the chain is defined, GEOPAK populates the Begin Station with the
default beginning of the chain. To compute superelevation for part of a chain,
adjust the station.
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End Station

Design Speed

Preference File
e selection
L selection

Facility

Left / Right tabs

Create Input File

Generate
Superelevation
Transitions
Profile

Tie

Offsets

% Slope

When the chain is defined, GEOPAK populates the End Station with the
default beginning of the chain. To compute superelevation for part of a chain,
adjust the station.

Design speed that determines what Design Speed is to be used either in the
tables or equations for e and length computations.

The Preferences File combo box selects which Preference File is to be used
for this computation. The various Preferences Files which are available in the
combo box are determined by what files have the .sep file extension in the
Preference Files Path on the User Directories dialog box. When it is set, the
available e and length Selection combo boxes are filled in according to the csv
file names as specified in the Preferences File. Those combo boxes
determine which table within the .csv file will be used for computation.

Facility determines whether the roadway cross section is to be divided or
undivided. This option determines two things. For the dialog box, it
determines whether or not the values Profile, Tie (Offset or PGL), and or the
Tie or PGL values may be different. If they are different then two shape
clusters are to be generated, which usually is required for a median. The state
of the Facility option button also determines which Preference is used as found
on the Distribution tab of the Preferences dialog box.

The area enclosed in the Left / Right tabs are for the determination of values
specific to shape clusters.

NOTE: The right and left tabs contain data pertaining to each lane within each
roadway. If the Facility is undivided, then the left tab is for the left lane(s) while
the right tab is for the right lane(s). If the Facility is divided, then the right tab is
for the entire right roadway, while the left tab is for the left roadway.

ASCII file wherein GEOPAK creates the autoshape input file. DO NOT include
the extension, as GEOPAK adds .inp to the field.

Commence automatic superelevation calculations

GEOPAK profile defined as the Shape Cluster Profile in the Auto Shape input
file.

Offset - Horizontal distance from the Profile (PGL) to the Chain.

PGL Chain - Chain stored in the gpk file that the shapes will be computed
from. This chain does not require a profile be stored with it, as the defined
profile will be applied to this chain.

Offsets define the dimension of the shape (usually a lane) by two offset
distances from the baseline. Note that tapers are not supported. Offset
distances are negative if measured to the left. Each lane must have the
same offset on the left as the left adjacent lane and must have the same offset
on the right as the right adjacent lane (no gaps in offsets). Computation may
not proceed if this condition is not met.

Cross slope of each shape in normal crown in percent format. A negative sign
denotes the roadway going downward, while emanating away from the PGL.
A Normal Crown section of 2.0% would, therefore, be entered as —2.0. Lane

GEOPAK 2004 Edition
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Dependent /
Independent

Edit buttons:
Add
Delete
Edit

Quick Entry

Rectify Lanes

offset values are entered in terms of master units, i.e., feet or meters.

One dependent shape, which is based on the profile, is required for each
cluster. Other shapes, drawn not based on the profile, but on adjoining lanes,
are independent. For example, turn lanes are drawn abutting next to the
mainline roadway, so they are independent. However, a lane based on the
profile for its initial elevation, such as one of the through lanes, is profile
dependent.

To add a line to the list box, type in the values in the edit fields, then click the
Add icon. To delete a line, highlight the desired line, then click the Delete icon.
To modify a line, highlight the desired line, (which is then displayed in the edit
fields), change the desired values, then click the Edit icon, which updates the
list box.

Enables the user to populate the shape cluster list boxes quickly while entering
the data using engineering terminology. When clicked, the dialog box depicted
below opens.

: | Divided -|
Mediar width: [38.0000

Lane Widths: |12.EIEIEIEI
Total Mumber of Lanes: |4
Marninal Percent Slope | -2.0000

&I Cahicel |

If Offset values have been entered that create a gap between lanes, the
Rectify Lanes option will remove this gap. Click the Rectify Lanes button

(Bottom tool to the  gn the values will be modified so that any gaps will be removed.

right of the list box)

Selection of the Generate Superelevation Transitions button performs the actual superelevation
computations. Three things happen at this point.
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e First, the superelevation transitions as

computed by GEOPAK are written to
the Autoshape Input File specified by
the user (in the Create Input File field).
Second, the log file is written.
Finally, the Autoshape Input File is
loaded into the text editor running
within MicroStation. This Autoshape
Input File Editor has an icon at the top
that allows the Autoshape Input File to
be run. Autoshape Input files can also
be run from the Autoshape Builder.

STedEdtormishpesp MEH|

Fle Edit Gileria

NECIRBEEREED

“#% Superelevation Settings and Paraneters: &

Project Name: C:xdatasgeo wdot roadl™17682 prj
User: C:~datasgeorvdotsroadlsprojdbs~VDOT
Fun Hame: ML1

Unit Sy=tem iz english.

Created input file "mll_shapes. inp".

Created activity log file "mll_shapes.log”.
Created on Fri, Jan 21, 2005 at 16:32.

U=zing Preference File "english standard”

Using = Selection of "rural"

U=zing Length Selection of "rural”

Using Design Speed of 45.000000.

i

auto shape
job number = 101

auto shape set

shape cluster baseline = MAINLIHE
shape cluster profile = MATINLINE
shape cluster tie = 0.0000

dependent shape
chain « offset
MAINLINE  —8.000000
MAINLINE  —20.000000
filler line station ~ =slope
200+00.000000 —2.noo00
202+00.000000 —2.0000

!Lma:1 iCDIT

11.2.1 Example - Auto Shape ASCII Input File

/* Superelevation Settings and Parameters:

Project Name:
User:

Run Name: MAINLINE
Unit System is english.

C:\data\geo\vdot\roadl\17682.prj
C:\data\geo\vdot\roadl\projdbs\VDOT

Created input file "mainline shapes.inp".
Created activity log file "mainline shapes.log".

Created on Wed, Nov 06,

2002 at 13:

11.

Using Preference File "english standard"

Using e Selection of "rural".
Using Length Selection of "rural"
Using Design Speed of 35.000000.

*/

auto shape

job number = 101

auto shape set

shape cluster baseline = MAINLINE
shape cluster profile = MAINLINE
shape cluster tie = 0.0000
dependent shape
chain / offset
MAINLINE -8.0000
MAINLINE -20.0000
filler line station / slope
200+00.000000 -2.0000
206+46.876488 -2.0000
208+45.876488 4.8000 /* Curve ML-1 */
209+80.032227 4.8000 /* Curve ML-1 */
211+79.032227 -2.0000
213+13.162662 -2.0000
213431.032227 -2.6000 /* Curve ML-2 */
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219+02.785686 -2.6000 /* Curve ML-2 */

219+20.655251 -2.0000
222+06.840000 -2.0000

auto shape set

shape cluster baseline MAINLINE
shape cluster profile MAINLINE
shape cluster tie = 0.0000
independent shape
chain / offset

MATINLINE -20.0000

MAINLINE -32.0000
filler line station / slope

200+00.000000 -2.0000

206+46.876488 -2.0000
208+45.876488 4.8000 /* Curve ML-1 */
209+80.032227 4.8000 /* Curve ML-1 */
211+79.032227 -2.0000
213+413.162662 -2.0000
213+31.032227 -2.6000 /* Curve ML-2 */
219+02.785686 -2.6000 /* Curve ML-2 */
219420.655251 -2.0000
222+06.840000 -2.0000
auto shape set
shape cluster baseline = MAINLINE
shape cluster profile = MAINLINE
shape cluster tie = 0.0000
dependent shape
chain / offset
MATINLINE 8.0000
MAINLINE 20.0000
filler line station / slope
2004+00.000000 -2.0000
207+63.935312 -2.0000
208+45.876488 -4.8000 /* Curve ML-1 */
209+80.032227 -4.8000 /* Curve ML-1 */
210+61.973403 -2.0000
211+94.032227 -2.0000
213+31.032227 2.6000 /* Curve ML-2 */
219+02.785686 2.6000 /* Curve ML-2 */
220439.785686 -2.0000
222+06.840000 -2.0000
auto shape set
shape cluster baseline = MAINLINE
shape cluster profile = MAINLINE
shape cluster tie = 0.0000
independent shape
chain / offset
MAINLINE 20.0000
MAINLINE 32.0000
filler line station / slope
2004+400.000000 -2.0000
207+63.935312 -2.0000
208+45.876488 -4.8000 /* Curve ML-1 */
209+80.032227 -4.8000 /* Curve ML-1 */

210+61.973403 -2.0000
211+94.032227 -2.0000

213+31.032227 2.6000 /* Curve ML-2 */
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219+02.785686 2.6000 /* Curve ML-2 */
220+39.785686 -2.0000
222+06.840000 -2.0000

Plot Parameters
Dependent Shape

lv = 63

co = 6

lc =0

wt = 2
Dependent Text

lv = 63

co = 6
Independent Shape

lv = 63

co =1

lc =0

wt = 2
Independent Text

lv = 63

co =1

Write shapes into dgn = C:\datalgeo\vdot\roadl\dl7682work.dgn

11.3 Draw Shapes into Plan View File

Project Manager None
Tools
|§§ﬂ Superelevation Shape Manager Tools =]
= 2l Gl Al 2
Menu Bar Application GEOPAK Road > Cross Sections >Superelevation Shape Manager Tools

Once the shape input file (fname.inp) has been created and reviewed, the designer can run the input
file to place the superelevation shapes into the specified graphics file. To use the interactive method
to define roadway superelevation (in a .dgn file) the designer pushes the Autoshape Builder icon
from the Superelevation Shape Manager Tools tool bar (or alternately from this same icon within the
Text Editor as described above).

Autozhape Input File: [ mi_1 shapas.inp gl

[T Display Only
Superelevation Shape Level Spmbology
[T Ovaride Input File Level Symbaology

- |

| Ciraw Superelevation Shapes ’

Input File Name of .inp file (fname.inp) created by the Automated superelevation
generation containing the transitions.

Display Only Create the shapes in “Display Only” mode. That is, they are not written to the

GEOPAK 2004 Edition Superelevation 11-7
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design file and a view Update operation eliminates them, as does zoom in, etc.

Override Input This option is used to override the Plot Parameters settings in the Superelevation
File Level Shapes input file.
Symbology

The shapes are placed in a 2D graphics file on level 63 by default. The plot parameters can be
modified in the input file with a text editor prior to building the shapes into the graphics file or with the
User > Symbologies pull down on the Automated Superelevation dialog box.
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11.4 Shape Analysis Tools

Tools

=
=~

Cross Seclions

o - =
. i

=

Superelevation Shape Manager Tools x|

i Ao e[ @

Menu Bar Application

GEOPAK Road > Cross Sections >Superelevation Shape Manager Tools

The tools in the Superelevation Shape Manager Tools toolbox are detailed below.

Auto. Superelevation

Autoshape Builder

A

Shape Maker
Il!a.
Sk
Shape Analyst

<

Shape Profiler

>

Shape Editor

Y

Shape Selector

a2

Shape Properties

®”

Shape To DTM

K

Performs the actual calculations and stores the results in an ASCII file, known
as the autoshape input file.

Processes the autoshape input file and draws corresponding complex shapes in
the specified 2D design file.

Graphical method of drawing irregular superelevation shapes. This method is
utilized for gore areas, turn lanes, etc.

The Shape Analyst tool provides information on any point within a GEOPAK
superelevation shape.

The Shape Profiler tool provides profile information based on user-defined
increments intersecting a GEOPAK superelevation shape.

The Shape Editor tool enables the user to dynamically change parameters on a
previously created shape. This includes filler line stationing, dynamic moving of
shapes, etc.

The Shape Selector tool highlights or selects shapes based on a wide range of
user queries or filters.

The Shape Properties tool provides information on any GEOPAK
superelevation shape. In addition, this shape information can be modified on
individual shapes of selections of shapes.

Provides the option to store a DTM Dat file from the superelevation shapes. In
addition, it can plot the calculated elevations into the design file at a user
specified interval.

GEOPAK 2004 Edition
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11.4.1 Shape Analyst

The Shape Analyst tool is extremely useful, as it provides information on any point within a GEOPAK
superelevation shape.

Job: I1|:I1 3! [T Display Only [~ Cross Section

- Elevation Information -

Chain: [MAINLINE =] PGL Elevation: 2045480
Profile :  MAINLIME FGL Slope ! 5.84 %
Station ETD+_51_1§.IEH_ Crozs Slope: 192 %
Oifset: [-22.43T681 | Longituding Slope . 817 %
Elevation: 2046909 Flow Slope . 839 %

™| Extrapolate Fixed Slope : | {1011 [
By Sta/Offset |

Dynamic |

Before using this tool, the Job Number must be selected. Upon selecting a Job Number, a Chain
must be selected that the shapes are defined relative to. If Display Only is enabled, information like
elevation and a flow arrow are drawn to the view, but they are not written as elements to the active
MicroStation file.

When the Cross Section toggle is not activated and a data point is issued within a shape, the
elevation of the data point and a flow arrow are displayed. When the toggle is activated, a dashed
line is placed through the data point, radial to the shaped cluster baseline. In addition to the elevation
and flow arrow placed at the data point, elevations are displayed where the cross section line
intersects any superelevation shape and cross slopes are labeled for each shape.

The By Sta/Offset button causes the current Station / Offset value to be projected back onto the
shape cluster baseline and the elevation of the projected point is displayed. This option can be
manual entry only and requires no data point on the screen.

The DP button works within a superelevation shape whose X, Y coordinates are utilized to compute
station / offset from the specified shape cluster baseline, which is subsequently utilized in conjunction
with the shape to compute the various slopes and elevations. After the DP button is clicked,
numerous data points can be placed. It is not necessary to click the DP button again. Each
corresponding station / offset is displayed along with the associated output information.

The Dynamic button activates the dynamic mode. As the cursor moves across the screen, any
momentary pause places the elevation and flow arrow in the MicroStation file and computes and
displays the analysis information.

The Extrapolate Fixed Slope toggle is another option supported in the Shape Analyst tool. The
option is utilized when the data point, dynamic point or station / offset is outside of the shape. When
the option is not activated, the data point is projected back to the shape's chain. The elevations at
the edges of the shape are displayed and the slope of the outside shape is projected to the data
point. When the toggle is enabled, the user defined slope is projected from the outer most shape to
the data point to determine an elevation.
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11.4.2 Shape Profiler

The Shape Profiler tool computes elevations along any GEOPAK Shape or MicroStation element at a
user specified interval. The element can be inside or outside of the shapes.

Jok: ml_ 3! [~ Dizplay Only
GraEhic Grade vI
Chain: [MAINCINE =] _Identity Shape |
From Station ; W 2!
To Station W _‘2!
Ever "I I'ID—
Elevatior Along: | Elerment Vi

[T Continuous Extrapalation [~ Complex Chain

The Job field can be populated by key in or using the Select... button. After selecting a GPK file,
click Identify Shape and data point on any shape along the desired Chain. Set the From Station
and To Station fields by keying in values or using the DP buttons.

[ncrement

|ntersect

Even should be selected when it is desired to have the elevations compute at the even station
values. Increment will allow the elevations to be computed starting at the From Station, then adding
the increment value to that station. Intersect is used with an element to compute elevations at all
locations that the element intersects the shape(s).

The Elevation Along toggle can be set to Shape or Element. When set to Shape, elevations will be
computed based on the Even/increment value along both longitudinal edges of the shape. When set
to Element the elevations are computed along the element based on the Even/Increment/Intersect
toggle.

Continuous Extrapolation allows the user to identify multiple longitudinal elements outside of the
shape area and compute elevations by a user defined Slope and one of three methods: Radial to
Baseline, Radial From Element, or Radial to Element.
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LAB 11: Superelevation

As a reminder, our project contains distinct sections:

Section 1 4 lane divided highway with depressed median from Sta. 200+00 to Sta. 202+00.
Left side of the roadway will be resurfacing while the right side is new
construction.

Section 2 4 lane divided highway with raised median from Sta. 202+00 to Sta. 204+25. Left
side of the roadway will be resurfacing while the right side is new construction.

Section 3 4 lane undivided highway from Sta. 204+25 to Sta. 211+00.

Section 4 2 Lane highway with Entrances and Exit Ramps from Sta. 211+00 to Sta. 220+00.

Section 5 Exit Ramp (RampA)

Based on this information, we will need to process the Superelevation separately for each of the
above sections. Each process will create a shape input file that can be run individually.

11.1 Automated Superelevation — Section 1
Step 1. Execute C:\data\geo\VDOT\road1\LAB11.EXE.

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682work.dgn

Step 3. Open Project Manager.

Step 4. Click Calculate Superelevation
button from the Road Project: Fle
17682.prj workflow dialog box. r Station Rarigs ————————
Job: [0 Q) Chair: [MEINCNE =] 03]
Step 5. Crzate |a |?ewor}l(]n C?)IIEd ‘Mth’ Design Speed: [45 | | Begn [200-00.00 2}
an clic . nce the ; , =
ransition ID: | Linea r End: [202+00.00
Automated Superelevation [Lees _~] " — £
dia|og box has been invoked, the Pretererce File: [english stanc ;I Facility: M‘
dialog box on the right will be & Selectior: [ rural _v_j L Selection: [roral _:_i
displayed. Lett | Right
Fill out the upper portion of the Froffe: [MAINLINE =]
dialog box as shown. Tie Dffsst =] Difset; [1.0000
. % Sl | Oiffset | Oiffset | Dependent
Step 6. The profile should be set to s = = == 'gj
MAINLINE for both the Left and |
Right tabs. Z]
Step 7. The Tie option should be set to “
offset and the offset value .
Create Input File: Q
should be set to 0.0 to force the RpE ] al
PGL (Profile Grade Line) to run Generate Superelevation Transitions |
along the centerline of

construction (MAINLINE).
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Step 8. Press the Quick Entry icon as | Right
shown in the image below. :
Prafile: [MAINLNE =]
Tier  Offzat "I Offzat: !D.DDDD
% Slope | Offset | Offset | Dependent i__j
a

Step 9. Fill out the Quick Entry dialog box as shown |

to the right and press OK.
Facility:  Divided vI

Median Width: i1E.DDDD
Lane "Widths: I 12.0000

' NOTE: Quick Entry can be used only if the P R AT
- lane configuration to the left and right sides of Maminal Percent Slops [20000

the baseline are the same.

Cancel |

NOTE: Quick Entry may reset your & Mutomaled Superelevation - ML1

! OFFSET. Please ensure that the Hle
offset for both the left and right Station Ranige
roadways is set to 0. dob 707 & Chair: [MEINLNE =] ]
Dezign Speed; I45 Begin: |EDD+DD.DD _‘Qi
~| | End [202+0000 ﬂ
Step 10.  Provide an Input Filename 5
P p Preterence File: |eng|ish stanc _v_I Facility:  Divided "I
(ml1_shapes.inp) to store the sk g 5l e
computed transitions for this station ERHEEIOn | B x RECBI hs
range. Left | Right
Profile: [MAINLINE =]
The dialog box should appear as
. 9 PP Ties | Offzet vI Offzet; |D.EIEIEIEI
shown:
% Slope | Offzet | Oiffzet | Dependent |
-2.0000 -5.0000 -20.0000 E]
-2.0000 -20.0000 -32.0000 O L‘:]
Create Input File: | ml1_shapes.inp &'
| Generate Superelevation Tranzitions 1
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Step 11.  Click the Generate [ Tex Edtor- m1_shapes.inp M|
Superelevation Hie: Bl {Hinrn
Transitions button to Dl= (|| & |=|@] <~
initiate the Calcuiation Of # Superelevation Settings and Parameters: -
the tl’anSItIOHS for the Eroject Hane: E:tgazatgeotvgottraagitl?68§Bp{%DOT
SR " ata S0 W00 oA o =
Left and Right roadway. Run Hane HL1 ) o
nit Sy=ten i= english
greateg 1n€ut_£ilT "m%;ISh?pT?.iEp". Lo
. (=] activi ] AL T, Shapes. Lo .
Step 12. Review the eaicd chibed, denl S ia
. st Uzing Preference File "english standard’
Computat|0ns W|th|n the gsj_ng % Selicéi?n of "ru:rga%". i
Text Editor dialog box. Joing Dosian Speed of 45 000000
%
auto shape
job number = 101
auto shape =et
zhape cluster baseline = MATIHNLINE
shape cluster profile = MATIHNLINE
shape cluster tie = 0.0000
dependent shape
chain ~ offset
MAINLINE —&.000000
MATNLINE —20.000000
filler line station ~ =lope
200400.000000 -2 0000
202400 .000000 —=2.0000
’Ene:1 iCok1
Step 13.  To build these shapes into the graphics file, click the Autoshape Builder
icon within the Text Editor dialog box. This will automatically draw the gﬂ
shapes into your design file on level 63.
Step 14. Close the Text Editor dialog box as well as the automated superelevation dialog box.
When prompted to Save Superelevation settings, click Yes.
Step 15.  Review the Superelevation shapes created in the design file.
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11.2 Automated Superelevation — Section 2

Step 1. Click the Calculate Superelevation button from the Road Project: 17682.prj workflow

dialog box.
Step 2. Create a new run called ‘ML2’ and
click OK. Once the Automated
Superelevation dialog box has PO oE ERC T ![:{
been invoked, the dialog box on Fle
the right will be displayed. Station Flange ——————————
Jobe [707 | Q] Chain: [MENCNE =] ]
Design Speed: I45 Begin: |2D2+DD.EIEI
Fill out the upper portion of the Trancition I | Lines: ~| | End 2040000 ]
dlalog box as shown. Freterence File: |eng|ish ghanc ;I Facility: Divided vI
Step 3.  The profile from which the shapes il r woban [} Lsseato [l =~
should be computed should be set iLeft | Right
to MAINLINE for both the Left and Frofle: [MAINLNE =]
Right roadway tabs. Tie:  Dffset | Offet: [0.0000
Step 4. The Tie option should be set to % Slope [ Otfset | Offset | Dependent I_@!
offset and the offset value should i‘
be set to 0.0 to force the PGL =
(Profile Grade Line) to run along il
the centerline of construction ¥
MAINLINE).
( ) Create Input Fils: | gl
Generate Superelevation Tranzsitions |
Step 5. Press the Quick Entry icon as shown in the image below.
Left I Right
Profie: [MATNLINE =
Tie:  Offzet vI Offzet; ID.EIEIEIEI
% Slope | Oifzet | Oifzet

| Dependent | __!
=]
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Step 6.

Fill out the Quick Entry dialog box as shown below and press OK.

sy ]
Facility: | Divided "I
b edian width: I1E.DDDD
Lare Widths: l12.DDDD
Total Murnber of Lanes: |4

Maminal Percent Slope I -2.0000

Cancel |

™ L

NOTE: Quick Entry can be used only if the lane configuration to the left and right sides
of the baseline are the same.

NOTE: Quick Entry may reset your OFFSET. Please ensure that the offset for both the
left and right roadways is set to 0.

Step 7.

station range.

The dialog box should appear as shown:

Step 8.

Provide an Input Filename (ml2_shapes.inp) to store the computed transitions for this

Momaad Superelevation - ML2 _I
Ele

Jobe [707 | Q]
Design Speed: i45

Freterence File: |eng|ish ghanc ;I
& Selection; Iurban _:_I

r Station Range

Chain: [MAINCNE =] 5]
Begin: [202+00.00
End: [204+00.00 ]

Facilty: | Divided -]
L Selection: lurban _:_I

Left | Right
Frofile: IM»&INLINE vi'
Tie: Offzet vI Offzat: |D.DDDD
% Slope | Oifzet | Offzet | Dependent |
-2.0000 -8.0000 -20,0000 _@!
-2.0000 -20.0000 -32.0000 O L(!
Create Input File: iml2_lshapes.in|:u ﬂ

| Fenerate Superelevation Transitions |

Click the Generate Superelevation Transitions button to initiate the calculation of the

transitions for the Left and Right roadway.
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Step 9. Review the computations within the Text Editor dialog box.

Fle Edit Giteria

D|=d| 4 |®|8] |~

7% Superelevation Settings and Parameters:

Project Hame: C:hdata~geoc~wdot~roadl=~17682 . pr]
T=er: Z o wdata~geoswdot~roadl~projdbs~VDOT
Fun Hame: HLZ

Tnit Sy=tem i= english.

Created input file "ml2 shapes. inp".

Created activity log file "mlZ2 shapes. log".
Created on Fri, Jan 21, 2005 at 16:17.

U=ing Freference File "english standard"

T=zing = Selection of “"urban'.

T=ing Length Selection of "urban’ =
T=ing Design Speed of 45, 000000

rd

auto shape
job number = 101

auto shape =et

zhape cluster baseline = MAINLIHNE
shape cluster profile = MAINLIHE
shape cluster tie = 0.0000

dependent shape
chain « offset
MATHLINE —8. 000000
HATHLINE —20. 000000
filler line station ~ =lope
202400 . 000000 =2 0ooo
204400000000 —2.0000

[Lime: 1 Col 1

Step 10.  To build these shapes into the graphics file, click the Autoshape Builder
icon within the Text Editor dialog box. This will automatically draw the @
shapes into your design file on level 63.

Step 11. Close the Text Editor dialog box as well as the automated superelevation dialog box.
When prompted to Save Superelevation settings, click Yes.

Step 12.  Review the Superelevation shapes created in the design file.
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11.3 Automated Superelevation — Section 3

Step 1. Click the Calculate Superelevation button from the Road Project: 17682.prj workflow
dialog box.

Step 2. Create a new run called ‘ML3'
and click OK. Once the
Automated Superelevation
dialog box has been invoked, the
dialog box on the right will be
displayed.

& Automaled Superelevation - ML3
File

Station Range

dobe [T QY Chair: [MAINLUNE =] ]
Fill out the upper portion of the Design Speed: [45 Begin: [205+00.00 ]
dialog box as shown. Tiansiion ID: [ Lines ~| | End [ZTT-0000

Freterence File: |english stanc _v_I Facility: | Undivided vI

Step 3. The profile from which the

shapes should be Computed eSeIection:""!"EJ"l‘bm—__VJ L Selection: W_:_I

should be set to MAINLINE for iLeft | Right

both the Left and Right roadway Frofile: [MAMONE =]

tabs. Tie: | Offset -| Oitset [00D00
Step 4. The Tie option should be set to %Slope | Offset | Offset |_Dependent | E

offset and the offset value ~]

should be set to 0.0 to force the -

PGL (Profile Grade Line) to run #l

along the centerline of |

construction (MAINLINE).

Create Input File: | ﬂ

Generate Superelevation Tranzitions |

Step 5. Press the Quick Entry icon as shown in the image below.
| Right
Frofile: [MANLINE =]
Tie:  Offzet vI Offzat: ID.DDDD
% Slope | Oifset | Offset

| Dependent | _!
]

11-18 VDOT Road | Training GEOPAK 2004 Edition



GEOPAK”

Step 6.

Fill out the Quick Entry dialog box as shown below and press OK.

sy ]

Facility: | Undivided "I
ebmichiar itk I ) Q060
Lare Widths: I12.DDDD
Total Murnber of Lanes: |4
Maminal Percent Slope I -2.0000

Cancel |

§ =il

NOTE: Quick Entry can be used only if the lane configuration to the left and right sides
of the baseline are the same.

Step 7.

station range.

The dialog box should appear as shown:

Step 8.

| £ Automated Superelevation - ML3

Freterence File: |eng|ish stanc _v_I
e Selection; Iurban _:_I

File
r Station Bange ———————
Jaob: W— EJ Chain: mm j%j
Design Speed: FII-E— Begin: r@ﬁE-:D?D_D_ _'QI

Facility: | Undivided vI
L Selection: lurban _:_I

Left | Right
Frofile: IM.&lNLlNE 'i.
Tie:  Offzet vI Offzet; |D.EIEIEIEI
% Slope | Offzet | Difset | Dependent |
-2.0000 0.0000 12,0000 E!
20000 120000 | 240000 o X

Craate Input Fils: | ml3_shapes inp

al

| Generate Superelevation Tranzitions 1

transitions for the Left and Right roadway.

Provide an Input Filename (ml3_shapes.inp) to store the computed transitions for this

Click the Generate Superelevation Transitions button to initiate the calculation of the

GEOPAK 2004 Edition
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Step 9.

Step 10.

Step 11.

Step 12.

Review the computations within the Text Editor dialog box.

Hle Edit Giteria

O|=d| ¢[@|@] ||z

7% Superelewvation Settings and Paramsters:

Project Hams: C:hdatasxgeowdot roadl=~17682 pr]
T=er C . ~data~geo~vdot roadl~projdb=-VDOT
Fun Name: HL3

Tnit Sy=tem i= english.

Created input file "ml3 _shapes. inp".

Created activity log file "ml3 _shapes. log".
Created on Fri, Jan 21, 2005 at 16:23.

U=ing Freference File "english standard"

T=zing = Selection of "urban”.

UT=ing Length Selecticn of "urban'

T=ing Design Speed of 45 000000.

rd

auto shape
job number = 101

auto shape =et

zhape cluster baseline = MAINLINE
shape cluster profile = MAINLINE
shape cluster tie = 0.0000

independent shape
chain « off=sst
MATINLINE —24.0000
HATINLINE —-12 0000
filler line station « =lope
205400 0o0o000 =2, 0000
206+47 B76489 =2.0000

208+40.876489 3.7000 % Curve ML-1 =~

M

JLine: 1 Icai

To build these shapes into the graphics file, click the Autoshape Builder
icon within the Text Editor dialog box. This will automatically draw the @

shapes into your design file on level 63.

Close the Text Editor dialog box as well as the automated superelevation dialog box.

When prompted to Save Superelevation settings, click Yes.

Review the Superelevation shapes created in the design file.
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11.4 Automated Superelevation — Section 4

Step 1. Click the Calculate Superelevation button from the Road Project: 17682.prj workflow
dialog box.
Step 2. Create a new run called ‘ML4’
and click OK. Once the
Automated Superelevation dialog
box has been invoked, the dialog Hle
box on the right will be displayed. Station Ratige ——————————
_ _ Job: [0 Q) Chair: [MEINCNE =] 03]
S;gmou:)OTzSuSF;]F())?A;nportlon of the Desion Speed: [45 | | Begin: [20170000 2}
Step 3. The prOf”e from which the shapes Preference File: mj Facility: _Undivided 'I
:z?ij(idMielNﬁ?S]Epl::)erdbO?:’:c:ﬁﬂled Lgfet & Selection; !rural _v_J L Selection: Irural _:_i
and Right roadway tabs. Lo | Fight
Frofie: [MAINLNE =]
Step 4. The Tie option should be set to w PR - Oftet: [G0000
offset and the offset value should il e
be set to 0.0 to force the PGL % Slope | Oiffeet | Offset | Dependent I_@j
(Profile Grade Line) to run along X
the centerline of construction 2]
(MAINLINE). :ﬁi
Create Input File: | &'
Generate Superelevation Transitions |
Step 5. Press the Quick Entry icon as shown in the image below.
Lef | Right
Prafile: [MBINLNE =]
Tie: | Offzet vI Dffzet: ID.EIEIEIEI
% Slope | Offzet | Dffzet | Dependent I_g!
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Step 6. Fill out the Quick Entry dialog box as shown below and press OK.

sy ]
Facility: | Undivided "I
ebmichiar itk I-' Q0an
Lare Widths: l 12.0000
Total Murnber of Lanes: I 2
Maminal Percent Slope I -2.0000

Cancel |

NOTE: Quick Entry can be used only if the lane configuration to the left and right sides
of the baseline are the same.

§ =il

Step 10. Provide an Input Filename (ml4_shapes.inp) to store the computed transitions for this
station range.

The dialog box should appear as shown:

Ele

Station Fange

Jobe [707 | Q] Chain: [MENCNE =] ]

Design Speed: I45 Begin: |211+DD.EIEI
~| | Erd [Zz0+0000 ]
Freterence File: |eng|ish ghanc ;I Facility: | Undivided vI
& Selection; Irural _:J L Selection: lrural _:_I

Left | Right

Frafile: |Mﬁ3«INLINE vi'
Tie: Offzet vI Offzat: |D.DDDD

% Slope | Oifzet | Offzet | Dependent |
-2.0000 0.0000 12,0000 ...g!
X

Create Input File: | ml4_shapes.inp gl

| Generate Superelevation Tranzitions 1

Step 11.  Click the Generate Superelevation Transitions button to initiate the calculation of the
transitions for the Left and Right roadway.
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Step 12.

Review the computations within the Text Editor dialog box.

Here’s where the ability to review your calculations and make changes comes in handy.

Notice that from Sta. 205+00 to Sta. 211+00 we used an Urban Standard, which gave us
a slope of 0.4624% at Sta. 211+00. But notice now we've used a Rural standard from
Sta. 211+00 to Sta. 220+00, which gives us a slope of 1.2037% at Sta. 211+00.

Let's fix this by hand-editing the superelevation calculations and changing the
slope at Sta. 211+00 from 1.2037 to 0.4624 to match the slope coming out of the
urban area.

Important: You must SAVE the file before processing it.

Step 13.

Step 14.

Step 15.

Hle Edit Criteria

D|zg] 4 |®|@)] =]~

7% Superelevation Setting=z and Parameters: el

Project Hame: C:hdata~geo~wdot roadl=~17682 pri
T=er Zwdatargeoswdot~roadl~projdbs~VDOT
Fun Hame: ML4

Tnit Sy=tem i= english.

Created input file "ml4 shapes inp".

Created activity log file "mld shapes . log'.
Created on Fri, Jan 21, 2005 at 16::28.

U=ing Preference File "english standard"

T=zing = Selection of "rural”.

T=ing Length Selection of "rural”

T=ing Design Speed of 45 000000.

rd

auto shape
job number = 101

auto shape =et

zhape cluster baseline

zhape cluster profile

shape clu=ster tie

dependent shape

chain « off=et
MATHLINE —-12.0000
HATHLINE 0.0000

filler line station ~ =lope
211+00. 000000 m <% Curve HL-1 =~

211471:611682 —2.0000
212+86.419170 —2.0000 ~|

JLine: 29 |Cot 25

MATNLINE
MAINLINE
0.0000

To build these shapes into the graphics file, click the Autoshape Builder
icon within the Text Editor dialog box. This will automatically draw the @
shapes into your design file on level 63.

Close the Text Editor dialog box. When prompted to Save Changes, click Yes.

Close the automated superelevation dialog box. When prompted to Save Superelevation
settings, click Yes.

Review the Superelevation shapes created in the design file.
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11.5 Automated Superelevation — Section 5

Step 1. Click the Calculate Superelevation button from the Road Project: 17682.prj workflow
dialog box.

Step 2. Create a new run called
‘RampA’ and click OK.
Once the Automated

Superelevation  dialog | & Automated Supercievation - RampA
box has been invoked, Hle
the dialog box on the [ Station Rarige —————————
right will be displayed. Job: [T0 QY Chaire [FEMPE =] 4]
Dezign Speed: i45 Beqin: |11+12.'|E _‘Qi
Fill out the upper portion *| | ena [ero8
of the dialog box as ' — L - -
shown. Preterence File: |english stanc _v_I Facility: | Undivided "I
e Selection; !lural :j L Selection: lrural _:_i
Step 3. t‘l;]he phrofile frohm |\ghigh et | Right
e shapes shou e _ _
computed should be set Profe: [RAMPA <1
to RAMPA for both the Tie: _Offset vI Dffset; [0.0000
Left and Right roadway % Slope | Offzet | Oiffzet | Dependent |
tabs. A
X
Step 4. The Tie option should be #]
set to offset and the ;{i
offset value should be
set to 0.0 to force the B | =Y
PGL (Profile Grade Line)
to run along chain Generate Superelevation Transitions |
RAMPA.

NOTE: Quick Entry cannot be used this time since the lane configuration for RampA is
not the same on both sides of the baseline.

§=ull
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Step 5. Since Quick Entry cannot be used for the lane configuration, we'll fill out the lane offsets
and slopes manually.

Click the New Lane icon then edit the %Slope and Offset fields as shown below.

Left | Right
Prafile: IF!.&MF'A vl
Tie: | Offzet vI Offset; |D.EIDDD
% Slope | Offzet | Diffzet | Dependent PE'\
-2.0000 0.0000 -12.0000 A\
< N
—'INBW Lane|
#]
Step 6. Provide an Input Filename (rampa_shapes.inp) to store the computed transitions for this
station range.
The dialog box should appear as shown:
Momated Superelevation - RampA ! _I

File

Station Range

Jebe [T QY Chair: [FEMPE =] ]
Design Speed: [45 Begin [11+1216 _'@_'I
*| | Erd [T3-6758

Freterence File: | englizh stanc _v_I Facility: | Undivided vI
e Selection; Irural __VJ L Selection: Ilural _:J

Left | Right
Profile: [REMPA =]
Tie:  Offzet vI Offzet; |D.EIEIEIEI
% Slope | Offzet | Difset | Dependent |
-2.0000 0.0000 12,0000 E!
X
Create Input File: | rampa_shapes.inp 3!

| Generate Superelevation Tranzitions 1

Step 7. Click the Generate Superelevation Transitions button to initiate the calculation of the
transitions for the Left Roadway.
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Step 8.

Step 9.

Step 10.

Step 11.

Review the computations within the Text Editor dialog box.

Fle Edit Giteria

D|=d| 4 |®|8] o~

* Superelewvation Settings and Parameters:

Project Hame: C:hdata~geocswdot>roadl=~17682 . pr]
T=er: C o wdata~geoswwdot~roadl~projdbs~VDOT
Fun Hame: Ramph

Tnit Sy=tem i= english.

Created input file "rampa_shape=s. inp".

Created activity log file "rampa_shapes. log".
Created on Fri, Jan 21, 2005 at 16:48.

U=ing Freference File "english standard"

T=zing = Selection of "rural'.

T=ing Length Selection of "rural’

T=ing Design Speed of 45, 000000,

rd

auto shape
job number = 101

auto shape =est

zhape cluster baseline = RAMFA
shape cluster profile = RAMEA
shape cluster tie = 0.0000

dependent shape

chain ~ offset
RAMEA —12.0000
RAMPA 0.oooo

filler line station ~ =lope

for the given Design Speed of 45.00. =~

% Warning: Curve EAMPA-1 Radiu=s of 330.0000 i= le==s

11+12.160000 8.0000 = Curwve RAMPA-1 *;d
JLine: 1 |Cat 1

To build these shapes into the graphics file, click the Autoshape Builder
icon within the Text Editor dialog box. This will automatically draw the @

shapes into your design file on level 63.

Close the Text Editor dialog box as well as the automated superelevation dialog box.

When prompted to Save Superelevation settings, click Yes.

Review the Superelevation shapes created in the design file.
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11.6 Building Manual Shapes

' NOTE: There are times when the Autoshape Builder cannot be used. These normally occur in
areas of lane transition where standard offsets are not sufficient enough to define the shape.

Step 1. From the MicroStation menu bar select Utilities > Saved Views, access the Saved View
“TRANSL1".

Step 2. Click the Superelevation Shapes button from the Road Project: 17682.prj workflow
dialog box.

NOTE: When building manual shapes, it's desirable to only display the graphics that are
absolutely required to define edges of the shapes. Also note that there may be times you will
need to add graphical elements to the design file (such as lane lines) in order to be able to
build a shape correctly.

9=l

Step 3. Turn off the Reference File Levels 4,7 and 31. Also, turn off the patterns (Level 50) in the
active design file.

Step 4. Create the first slope filler line by filling out the dialog box as shown and pressing Create.
' NOTE: To access the Symbology and Slope Label Set Feature dialog boxes, double click the
sample graphics fields. Populate the Set Feature dialog boxes as shown below.
[GEOPAK Sot Featwe |
r Symbology
Level ILeveI B3 vl
Color; I 0 vl
) WWieight: 2 >
I ~Test Preferences ———
rSymibology Th: [3500
Level: IEEI_ES—E! i I‘E‘gﬁh“—' di| 12-3
HE =
ED'T' & - Ft: [F 0 fontoon |
ble: I_"___'-] PR
Weight —2—;' Decimal; _'I_J
- T | [aE ] Cancel |

i_ Superelevation Shape Maker I
Job Number: |1U1 S\J Tolerance; |U.'IEIEIEI_EID

- Shape Parameters

Baszeline: iMAINLINE vi Clazs: | Dependent 'I
Profile: !MAINLINE vi Transition 1D; |D
Tie gt “ 0.000000 Syrmbology: I

|dentify Shape I Slope Label: | 3

r Filler Lines

Methad: _By Station 'i 204+00.00 DP I
[T Transition Slape: [-2.0 Lhieate

Automatic 'i Fadius: IS.EIDDDD[ L I
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Step 5. Create the second slope filler line by filling out the dialog box as shown and pressing Create.

&perelevdion Shape Maker !E m I

Job Murnber: |'ID_'I ﬂ Tolerance: |D.'_I_IJDD_DD

r Shape Parameters

Bazeline: mm Class: | Dependent "l
Profile: m Tranzition 1D |D—

Tie >|[O000000 | Symbology: [
|dentify Shape I Slope Label: IT

r Filler Lines

b ethod: BE Station "I |2DE+DD aa I

7] Transition  Slope: [-20

Automatic 'I Radius: [5.000000 [ e I

Step 6. Now press the DRAW button and issue a DP inside the lane as shown in the image below.

Step 7. Repeat Steps 4-6, this time issuing a DP for the other inside lane as shown in the image below.
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Step 8. Change the Class and Color in the dialog boxes as shown below.
_ Superelevation Shape Maker !m
Job Mumber: |1D'I SJ Tolerance: |D.1DDDDD
- Shape Parameters
Bazeline: IM.-’-‘«INLINE VI Class: | Independent vI
Prafile: IM.%‘«INLINE vl Transition 1D |D
Tie v” 0.000000 Symbology: | ee— i
|dentify Shape I Slope Label: | 123 GEOPAK Set Feature I
r Spmbology
 Filler Lines Level [Level B3 =]
Method: By Station "I I I Balsi m
[T] Transiion  Slape: [-2.0 Style: | ] =
Wieight: | 2 4|
Autarnatic 'I R adius: IE.EIEIEIEIEI[. Lipa I = I
ance |
Step 9. Repeat Steps 4-6 twice more to create the shapes for the two outside lanes.
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11.7 Draw Superelevation Diagram

In the next steps we’ll draw a Superelevation Diagram on the Profile Cell using a custom 3PC
application. We will run this in two passes. One from Station 205+00 R 1 to 211+00 R 1 and one
from Station 211+00 R 1 to 220+00 R 1.

Step 1.

Step 2.

Step 3.

Open the MicroStation file c:\data\geo\VDOT\road1\d17682prof.dgn

Open Design and Computation Manager. Double click item Road Design > Special
Applications > Super Diagram.

Populate the dialog box as show below. Click OK.

205+00 R1to 211+00R 1

¥DOT Super Elevation Diagram I

Job Number 101 Select I ~ PGL Grid Elevations
PEL Chairn [HBTHLTE Selact i Starting Elevation Station | 205+00.00 R 1
example > 0+00F 1
r Location and Scales ) . .
: Ending Elevation Station | 211+00.00 R 1
Haorizantal Scale |25
. example > 150+00 A 1
Wertical Scale |5
Mo Gap vI Eleration Grid Increment I 50
Reference Station [200+00.000000 R 1 erample:sal
Reference Elevation |1EIDU r Typical Dutside Edge of Pavement Difsets —
* | 2720975.753 DP Left Edge of Pavement Offzet |-24
e |3381 05.81 =
~ Profile Cell Right Edge of Pavement Offzet I 24
dentiy Cel I Mate: If the edge of pavement iz nat at these

P Section Inf » offzets, then the offzet will be labeled.

avement:5echon. liformation ———— For divided, bath affsets shauld be

Shapes Input File I 3 shapes.inp Select | negative or both pozitive.
Marmal Crowin Slape |-2.DD Proposed Design Fils |?EB2des.dgn Select I

For -2.00% Keyin -2 tdust Contain Proposed E/P
Roadway Selection | Undivided Roadway ™ Uit ﬂghsh_"l
CANCEL |

§ =l

NOTE: Use the Identify Cell button to populate the upper left portion of the dialog box.
Shapes Input File = mI3_shapes.inp
Proposed Design File = d17682des.dgn

Step 4.

Click OK when the prompt below appears.

Super Tranzitionz Found -» Process Completed Succeszsfully,

Cahicel I
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Step 5. Double click item Road Design > Special Applications > Super Diagram again.
Step 6. Populate the dialog box as show below. Click OK.

211+00 R1to 220+00 R 1

¥DOT Super Elevation Diagram I

Job Number 101 Select I ~ PGL Grid Elevations
PEL Chairn [HBTHLTE Selact i Starting Elevation Station | 211+00.00 R 1
example > 0+00F 1
r Location and Scales ) . .
: Ending Elevation Station | 220+00.00 R 1
Haorizantal Scale |25
. example > 150+00 A 1
Wertical Scale |5
Mo Gap vI Eleration Grid Increment I 50
Reference Station [200+00.000000 R 1 erample:sal
Reference Elevation |1EIDU r Typical Dutside Edge of Pavement Difsets —
* | 2720975.753 DP Left Edge of Pavement Offzet |-12
Y |3391 05.81 =
~ Profile Cell Right Edge of Pavement Offzet I 12
dentiy Cel I Mate: If the edge of pavement iz nat at these

P Section Inf » offzets, then the offzet will be labeled.

avement:5echon. liformation ————— For divided, bath affsets shauld be

Shapes Input File I 4_zhapes.inp Select | negative or both pozitive.
Mormal Crown Slope | 2.00 Prapozed Design File | 7B82des.dgn _ﬂu

For -2.00% Keyin -2 tdust Contain Proposed E/P
Roadway Selection | Undivided Roadway ™ Uit ﬂghsh_"l
CANCEL |
' NOTE: Use the Identify Cell button to populate the upper left portion of the dialog box.
e Shapes Input File = ml4_shapes.inp

Proposed Design File = d17682des.dgn

Step 7. Click OK when the prompt below appears.

Super Tranzitions Found -» Process Completed Successfully.

GEOPAK 2004 Edition LAB 11: Superelevation 11-31



GEOPAK®

11.8 Update the Project Manager

We are completing the Plan View category of the Working Alignment Definition in Project Manager.

Step 1. From the Workflow dialog box of Project Manager, click the Define button.

Step 2. Highlight the Plan View > Shapes option and populate the Shapes Design file as shown

below:

Flar Wiew
Patterm

Frofile Wiew
Lozation

Crozs Section View
Enisting Ground
Propozed Finizh Grade

DTH

Lok |

Cancel |

Al In DGM I
Degign File: I d17ES2wmork. dgn

Step 3. Click the OK button to save the updates and close the dialog box.

Step 4. Exit MicroStation.
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CHAPTER 12

Proposed Cross Sections

12.1 Overview

Objectives

Use Project Manager to create proposed cross-sections.

Project Manager

Proposed Cross Sections

Menu Bar Application

Only batch processing of Input file is supported.

When the Proposed Cross Sections button in the Road Project Manager is clicked, the Select Run
dialog box is displayed. An existing run may be selected or new run may be started. When
complete, click the OK button, which closes the Select Run dialog box and opens the proposed cross
sections dialog box as depicted below.

' NOTE: This dialog box cannot be accessed outside of the Project Manager.

The left side of the dialog box contains
the list of categories required to process
proposed cross sections. When each
category is selected, the dialog box
changes to reflect the requirement of
each category. For example, when Plot
Parameters is selected, the dialog box
changes to reflect the various plot
parameters and text as depicted on the
following diagram.

Hles

%S DGM File -
Fattem

E sizting Ground

Shapes

Shape Clusters

Define DGEM Wariables
Define Variables
Redefinable “/ariablas _:j

gﬁuposad(:mssSections—MH !B
Hles o
-5 Lines

Eisting Ground ;i | —
Shapes |
Shape Clusters et
Diefine DGN Variables = —
Define Wariables I Line Text | Sanre
denl rlables [T Station Test | S
Plot Farameters
Drainage b [ Baseline Mame Text Sate
~ Flot

[T Pavement Thickness [an

™| Fill Gapz Between Clusters

[T Transition Definition L l

[T Intersect between Clusters

[T Process Clusters as Indicated

[T Remove Skewed Effect

[T Process Only Sections Witk Existing Ground
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12.1.1 XS DGN File

When XS DGN File is selected from the list box, the dialog box dynamically changes as depicted
below. XS DGN File defines the MicroStation file wherein the original ground cross-sections are
located as well as the location for the proposed cross-sections.

gﬁoposedﬁms Sections - ML1 !En
Eles
S DGH File - '
F'atter #5 DGN File Id‘l TEA2xzmainline. dar Files I
E g o Talerance [0.100000
Shapes
Shape Clusters

Define DGN Yariables

Define Y anables
Fiedefinable Y ariables _:j

12.1.2 Pattern

When Pattern is selected, the dialog box changes as illustrated below.

ngposedeSSSEdions—MLi !m
Hiles
5 DG File - 71 Use Warking Alignment Definition
-
Exizting Ground HEEN e
Shapes Chairi [MAINLINE Select |

Shape Clusters .
Define DEN Variables Hariz. Scale |'ID Wert. Scale I 10

Define Variables OGN File | d17682work. dgn File
Redefinable Y anables _:j

- Search Criteria
W Ly Mumbers: |50
W Colorg; [5 2

i 2

Match | Displa_l,l | Resat |

mlald | [

R

This dialog box defines the type of Pattern Lines used on a project — By DGN or By Station — in
addition to other parameters specific to each format.
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Three dialog boxes (Pattern, Existing Ground, and Shapes) support a toggle to Use Working
Alignment Definition. For example, in the Pattern dialog box, if the toggle is not active, the user
must supply all pattern information.

ngposedeSSSEdions—MLi !E
Hiles
5 DEM File - [T Use Warking Alignment Definition
-
Exizting Ground HEEN e
Shapes Chairi [MAINLINE Select |

Shape Clusters
DefiEe DG Vaniahles Horiz. Scale |1D Wert, Scale I 10

[refine Waniables DGM File [d17682work.dgn M
Redefinable ¥ arables _:j - Saarch Criteria
O L Mames: | =
[ Ly Mumbers: |50 i
I Colors: |5 ﬁ
- ' | =
[ vpes | i@l
Match | Displa_l,l | Resat |

However, if the toggle is active when one of these three categories is selected, the data information
part of the dialog box is ghosted and the required information is utilized from the current working
alignment definitions. If the toggle is activated, and the required information is not stored within the
current working alignment, an Alert message is displayed.

Pmposedﬁ'nss%im-ﬂu I
FHles

425 OGN File - ¥ Usze 'wrking Alignment Definition
Fattern

Enisting Ground

Shapes

Shape Clusters

Define DGM Yariables
Define Variables
Redefinable Y anables _:j

T Ly Mames; =
%] Ly Mumbers: 50
= Colors, 45

[+ Stylez: 0 (=]
[ Weights, 2 =
g &

Typez 3
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Working Alignment Definition:- MAINLINE
Plan View BE DBSiEn File |
Haor. Scale l'l “er. Scale I'I
Profile View Design File: [1%d17682wark.dgn |_File I
Location
Cross Section Wiew I LeRanes I _I
Existing Ground - e
Propozed Finish Grade R Ly Numbers: 50 EI
OTH i Colors: [45 EJ Match I
i Shyles: ID— _El_l Digplay |
W weights: |2 _EIJ Reset I
Cancel | W Types: rg—_gl
Placement: I
12.1.3 Existing Ground
gﬁnposazlﬁms%im—ﬂu !E
Hles
45 DIGN File - [T Use working Alignment Defintion
Pattern ; .
E wisting Ground DGN File I M
Shapes - Search Critenia
Shape Clusters r
Define DGN Variables .
Define Variables e
Redefinable Variables _:j I~ [
r [
I~ ]
5 al
Match | Dizplay | Reset I

When the Existing Ground category is selected, the dialog box will appear as shown above. In this
dialog box the user can select the name of the file that contains the existing ground in addition to the
symbology of the existing ground.

12.1.4 Shapes

Hiles
5 DGM File - [T Use Waorking &lignment Definition
Pattern - I
Enisting Ground &llin DN
DGH File Files
Shape Clusters I —i
Define DGM Yariables
Define Variables

Redefinable Y anables _:j

Three Shape definition options are supported:

All'in DGN All shape elements within the specified file are utilized.
By Search Criteria  Only those shapes that match the specified search parameters are utilized.

Shapeless No shapes are utilized; hence, there is no field for a shapes file name or files

button. This option will be used with the first exercise to produce existing
shoulders and pavement on the existing cross sections.
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12.1.5 Shape Clusters

When the Shape Clusters parameter is selected, the dialog box dynamically changes as depicted
below (there should not be any definitions within the dialog box upon the initial invoking of this

parameter):
gﬁoposadﬁmﬁim-ﬂu !B
Files
- Chain Tie/PGL Prafile |
=5 DGEM File .
Pattern —.l:-‘l':EIC—au
Eisting Ground Thick I
Shape

=

Defire DGN Variables : :
Chain Tie 0.00000 | Prof Scan

Defing Varables I “‘_I ! o ! _I
Plat Parameters _:j Add | | Modiy | Delete_l Up | | Daown |
~ Side Slope Condition

Define | Modfy | Delete | Up | Down |
r Criteria File

M arne | Descriphion |
add | Delete | Up | Diown

The user may Add, Delete, or Modify any specified shape cluster. When the Scan button is clicked,
GEOPAK scans the design file and search criteria specified in the Shapes dialog box and lists all
matching clusters. In the instance of shapeless criteria, the user must define each cluster by utilizing
the Select button or typing in the Chain, Tie/PGL and Profile associated with this shape; then click

the Add button.

Proposedess%ions—ML'l [ _ [ x]
Fles
- Chain Tie/FPGL Frofile |
5 DIGM Fil o .
ok i MAINLINE 0000000 MAINLINE Typical |
Eiishing Ground RakPa 0.000000 tAIMLINE Thick I
Shapes
Define DGM Yanables . :
Ch RaMPe T 000000 Praf | MAINLI Scan
Define Variables §il "‘E_! I = o] _I
Plot Parammeters ;j Add b odify I Delete_! Up j Ciovary |
~ Side Slope Condition
Defire | Madify | Delete | Up Down |
r Criteria File
Mame | Dezoription |
Add | Delete | Up | Dawn |
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Note the button labeled Typical. This application enables the designer to relate specific criteria files
from a standardized library to specific typical sections, thereby foregoing the need to pick and choose
which criteria files they need. They simply select the typical section(s) for their project and the criteria
files are retrieved for them automatically from the library.

When the Typical button is pressed, the Typical Section Generator dialog box appears as depicted

below.

Cel
DNFAMT
DRECON
DRROW
EXFEAT

EXPYMT
NLTRRT
RLTNRT
LINLFAT
UNPYMT
URECOM

Deszcription

DIVIDED MEW :

DIIDED RECONSTRUCTION
DR&W RIGHT OF Wy LOCATIONS
DR&W EXISTING FEATURES
DR&W EXISTING PAVEMENT
MEW LEFT RECOM RIGHT
RECOM LEFT MEW RIGHT
LOCAL UNDIVIDED MEW FWMT
UNDIIDED MEW PAWEMENT
UNDIIDED RECONSTRUCTION

Job Mumber: 101

r Template
Template Degigned toWwork with; 2 Shape Clusters

Apply to Left Roadway ']

- Range

Apply to Whole Chain Vj

[oP]

r [MAINLINE | [ Select...|

Apply ]

Degcription

[OP]

The user must simply select the typical section from the left, then press Apply. For a divided
roadway with a left and right Profile Grade Line, the user would apply the selected typical once to the
left roadway and then once again to the right roadway. You can also apply the typical to the entire
length of the alignment or only a portion of the alignment by changing the Apply to Whole Chain
toggle to Apply to Station Range and specifying a beginning and ending station for the typical.
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Shape Clusters

Define DGN Variables Chain [MANL | Tie | [00000N Prof [MAINLT) | Scan |

Define Variablesz
Redefinable Variables || | Add | | Modiy | [ Delete | | Up | | Down |

r Side Slope Condition
Offzat Minuz BT
Offset Plus LT A
D efine I F odify | Delete | Up | Drotn |
r Criteria File
M arne: | Dezcrption =
varablez.x User defined variables: _|
rezurfacing. « Find exizting edaes of pavement.
shoulder.x Mon-Local Shoulder File. _:J
Add I Delete | Up I D ey I

gﬁopoﬂ:iﬁmk:tim-llu !E
Hles
= =] [Chain Tie/PGL  Profle | —
Patterm - —-—ﬂ—-J'l'lp
Exizting Ground Thick i
Shapes

12.1.6 Define DGN Variables

- ML1
45 DGN File «| [Variable DGN__ |
Pattern EQF [N DGM d17682des dan
Existing Ground EAISTING PAVEMENT IM OGN £17682.dan
Shapes P&VED SHOULDER IM DGM d17682des dan
Shape Clusters GRADED SHOULDER IM DG d17682wark.dan
D efine DGEN Variables EXISTING SHOULDER IN DGN 517682
[refine Wariables ; = —
Fiedefinable Yariables _:j By fil | Al I I
Yarigble Mame 1 EXISTING SHOULDER IN DGN DDB Featurs =]
DGH File I C:A\datahgeohwdothroadlhs1 7682 dgn File |
DDE File: | C:\datahgeotwdotiroad]hstandardshGEOPAKWDOT englist File: |
Feature:; / Road Design / Pavement / EXSHLD Select |

Description: - Existing Shoulder Lines

Add

The Define DGN Variables option allows the user to define how to locate MicroStation elements
used by the criteria files. Define DGN Variables can be determined from the element symbology, or

from the symbology and attributes assigned in the D&C Manager database.

Variables that are

previously defined in the criteria will show up in the list. If the Select button is unghosted, variables
remain undefined and must be defined before processing the sections. Click Select to see a list of
undefined variables, assign a value, then click Add.
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12.1.7 Define Variables

gﬁoposedﬁnss%im—ﬂu !E
Hles
45 DGM File a| |Marisble Walue B
Pattern IMITS [E OR M) E Il
Exizting Ground CROSS SECTION PLOTTIMG SCALE 10
Shapes HakE OF FLAM FILE d17632des.d
Shape Clusters MHaME OF PROFILE FILE d17EEZpraf.c
Diefine DG Yariables MHakE OF FROPOSED RIGHT OF Wy d1 ?BSZdBS.d_:i

Define Wariablas

Redefinable Wariables _:j By file 2l vl Select I

Wariable Mame !

Walue I

Add | bodify |

Define Variables enable the user to enter job specific values for certain variables. (i.e. pavement
thickness, ditch width, backslope, etc.) The user can select the variable from the list, then enter the

new value and click the Modify button. The values of these variables are constant for all of the cross
sections within a specific run.

12.1.8 Redefinable Variables

Hles

5 DGN File - _;i
Patterm L

Ewizting Ground _d Intermediate] Thickness

Shapes _d_Intermediate 2T hickness

Shape Clusters _d BaselThicknesz

Diefine OGN Yariables _d_BaseZThickness

Define W ariables _d_SubbazelThickness j

Fiedefinable Wariahles

Redefine -
IIIlx __________________________________ xll,l

/* Pavement Surface Layer Thickness */ il
£ inor mm f

L 5 |

Redefinable Variables are variables that are made available to the designer for those features of the
design that may need to vary from project to project or over the course of a single project. This
category will not appear until a typical has been selected that utilizes redefinable variables. For each

variable name highlighted in the Variable list box, the corresponding description and value will be
displayed in the Redefine list box.

To modify the value of a variable, first highlight the name of the variable, then click Edit. This will
open the Redefinable Variables Editor window. Note that this window is resizable.
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#5 Redefinable Variables Editor [_ O] x|

£ Pavement Surface Layer Thickness */
£ inor mm i

if [Sta »=0+00 R 1] then

d SurfaceThicknesz =12

—_— -

Save | Cancel |

12.1.9 Plot Parameters

Hiles

-5 Lines
Eisting Ground ;i
Shapes

Shape Clusters
Define DGEM Y anables

- Teut

Define Yariables [ Line Text | Aanie
rlables [ Statio Text | Sagre
Drainage b "] Baseline Name Text Sanire
r Plat

[T Pavement Thickness |

™| Fill Gapz Between Clusters

™1 Transition Defirition _____!

] Intersect between Clusters

[T Process Clusters as Indicated

" Remove Skewed Effect

[T Process Only Sections Witk Existing Ground

Plot Parameters enables the user to determine how the data from the superelevation shapes are
going to appear. XS Lines determine the symbology of the pavement surface. Text plots various
pieces of text relating to the cross section. The elevation of the PGL of each shape cluster is
automatically plotted. Enable the Line Text toggle to define this symbology for the PGL text. The
Plot group box enables the user to control different aspects relating to the cross sections and criteria
files as detailed below.

Pavement Thickness draws the bottom of shaped pavement for all clusters. If the Thick button was
utilized in the shape clusters dialog box, this should be disabled.

Fill Gaps Between Clusters draws a line between two shape clusters if the criteria does not fill
between them.

Transition Definition defines the use of parabolic superelevation transitions.

Intersect Between Clusters extends or trims elements in a median to create a finished, clean
appearance.

Process Clusters as Indicated forces the criteria to process the clusters as they are listed in the
Shape Clusters dialog box. If this option is turned off, the clusters are processed left to right.
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Remove Skew Effect forces GEOPAK to correct itself back to the pattern line if a skewed element is
encountered in the processing of the criteria files.

Process Only Sections With Existing Ground - If only one group (color) is indicated in the input file
for the existing ground in each run, the program loads into memory only the ground lines of the
specified color, and processes only those sections. The time reduction may vary depending on the
specific conditions of the job and type of machine.

12.2 Files

Under Files, the options are Run, Save Settings, Export... and Exit. To process the
cross sections, click the Run button, which invokes the Process Cross Section dialog | IFE

box. Save Settings simply saves the current settings to the run. When the File > | X
Export option is selected, the user may save the dialog box information in an ASCII Save Seftings
input file for review or subsequent processing. The File > Exit option enables the Export..
user to exit the Proposed Cross Sections dialog box. The software also prompts the E it
user with an Alert box if the settings should be saved before exiting. Clicking the Yes

button saves the current dialog box settings, No does not save the settings, but both

buttons exit to the Project Manager.

12.3 Processing

When File > Run is chosen, the dialog box below appears.

ngpnsed Crozs Section m

Screen Only |

[ Pause On Each Section

[T Criteria Wiew Apply |

" Log File

The output can be displayed on the Screen Only, or written to a Log File and displayed to the
screen. The Pause On Each Section option enables the user to view each section as it is drawn.
Criteria View displays each step in the criteria file. This is primarily for debugging purposes.

12.4 Criteria Files

One of the most powerful and flexible features of GEOPAK is the use of criteria in generating
proposed cross sections. Within criteria, design conditions can be evaluated and complicated design
decisions executed in response to these design conditions. The flexibility of criteria allows the
designer to make the design as basic or as complex as the project requires. Numerous baselines
can interrelate as ditches and medians are drawn between roadways and ramps. Sophisticated
drainage details can also be drawn with criteria. The list is endless.

Cross section criteria are used to draw cross section features outside of the mosaic of superelevation
shapes typically representing pavement. Operationally, the software constructs the cross section
features derived from the mosaic of shapes first. Then, the software constructs the remaining
portions of the cross section through the application of criteria emanating out from the outer edges of
the mosaic of shapes.
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LAB 12: Proposed Cross Sections

12.1 Existing Pavement

In this first section, a new run will be created and used to draw the existing pavement onto the cross
sections.

Step 1. Execute C:\data\geo\VDOT\road1\LAB12.EXE.
Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsmainline.dgn

Step 3. Open Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 4. Choose Proposed Cross Sections from the Project Manager dialog box and create a
run called Exbase. Then double-click Exbase and the following dialog box will appear.

ngpnsed Cross Sections - Exbase m

Files

<5 DGHN File |2
Pattern

Exizting Ground
Shapes

Shape Clusters
Define DGEN Variables
Define Wariablasz —

Plot Pararmeters -
Step 5. Complete the following items in the dialog box.
XS DGN File This filename should be defined as d17682xsmainline.dgn
Pattern Use Working Alignment Definition

Existing Ground Use Working Alignment Definition

Shapes Set the Shape Option to Shapeless.
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Step 6.

Next, select the Shape Clusters category to invoke the following dialog box.

ngpused Crozs Sections - Exbase [ x|
Files
T TENE] — Ehain Tie/PGL Profile
ile sl
Pattem _I
Esizting Ground
Shapes _I
Shape Clusters
Define DG Yariables . ;
Select
Define Yarisbles n Chain | Tie | [0.00000] Prof | Selec I
Plot Parameters =1 | add | | Madiv | [ Delete | | Up | | Down |

r Side Slope Condition

r Criteria File

First, we will define the Chain, Tie and Profile for the

shapes.

Step 7.

Step 8.

Step 9.

Click the Select button to invoke the following
dialog box.

For the Chain option, highlight the chain
MAINLINE and click Apply.

Change the option to Profile and select the
profile MAINLINE and click Apply.

When the chain and profile have been
selected, click the Done button.

EBL4ED
MAIMLIME
RAMPA
REDELD

Apply | Done |

Z& Chain/Profile Sel... [E]
i Profile vI

DITEHLT
MaIMLINE
MLGROLND
RAMPA

Apply Daone
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Step 10. Next, provide a Tie distance of 0 in the Tie field and click the Add button to include this
shape cluster in the list box as shown below:

gl’-‘mpused Crozz Sections - Exbase m
Filez
OGN ] 7 _Ehain Tie/PGL Frofile
ile |- o STATITETS .
Pattarm rAAINLIME MAIMLINE Typical I
Eizting Ground Thick
Shapes _I
Lemne DAL endbles Chain [MANLT | Tie | [00000C Prof [MAINDT | Select |
Define Wariablasz -
Plat Parameters =] Add I h odify I Delete | Up | Do |

~ Side Slope Condition

Define

r Criteria File

Step 11.  Highlight the shape cluster that was just defined in the list box and click the Typical
button.

' Note: The Typical button will not be available until a shape cluster has been selected
from the list box.

If the following dialog box appears, click OK.

et ]

The template you zelected requires at least
@ one SHAPE in order to process, But the
Froject Manager is zet to SHAPELESS Mode
OF. to Continwe, CAMCEL to Abort

Cancel |
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Cell Deszcription

DRLMWRU RECOM LT MEW RT ULT DES
CDRRNWLI WEW LT RECOM RT IND DES
DRRWNLU WEw LT RECOMN RT ULT DES
DRROW DRAW RIGHT OF Wiy LOCATIONS
ENTR EMTRAMCES

EXFEAT EXISTING FEATURES

ING PAWEMENT

ROOTHMT ROOT MAT

UNPYT  UWDIMIDED MEW PAVEMEMT
UNPYTL UNDIVIDED LOCAL MEW PVMT

Job Mumber: 107

TING GROUMND

r Template
Template Degigrned to ok with;

Mo Shape Clusters

Description i

~ Hange
Apply to Whole Chain

|

| LoF]
-

l [Select. |

I LA

Applp I

Step 12.
length of the project.

Step 13.

Select Typical EXPVMT. This typical will be used to draw the existing pavement for the

Click Description. This will open WordPad to show a complete description of what the

typical will draw, all variables and their definition, in addition to any special notes or

considerations.

After reviewing the description file, dismiss/exit the description file.

Click APPLY.
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Step 14.

Next we will need to define variables found in this criteria file.

Click the Define Variables category. Modify the NAME OF SURVEY FILE variable as
shown in the dialog box below.

Highlight the Variable you wish to change.

Change the name in the Value field and press Modify.

Shapes

Shape Clusters
Define DG Wariables
[ efine ' ariables

Fedefinable Y ariables

raME OF SURVEY FILE

Byfile | 2l 'l

Yariable Marme :  NAME OF SURYEY FILE

& Proposed Cross Sections -Esbase [
Files

%5 DGN File [+] Mariable Walug

Pattern UMITS [E OR M) E

Ewisting Ground CROSS SECTION PLOTTIMNG SCALE

10

Walue | 217682 dan

Add

§ =il

NOTE: Although there is an option on the dialog for Define DGN Variables, this will never

be used.

Step 15.  Select the Redefinable Variables category. Review the values for each variable.

Shape Clusters
Define DGEN Variables
Define Wariablasz

R edefinable Varia

_=_DrawExShoulder
_d_E=ShoulderT hicknessz

gl’-‘mpused Crozs Sections - Exbase ]
Filez
45 DG File [«] Variable
Pattern d_E=SurfaceT hick|
E xizting Ground _d_ExBazeThicknessz
Shapes _d_ExSubbazeThickness

Fedefine

IIIlx ____________________________ xll,l

/# Existing Surface Thickness =/
£ inor mm i

II.IH ____________________________ Hll,l

Edit |

GEOPAK 2004 Edition
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Step 16.  Select the Plot Parameters category. Double click the sample graphics box under XS
Lines. Setthe symbology as below then click OK.
Pmposedessﬁdions—Elbase I
" Fles |GEOPAK Set Feature |
— r#S Lines
Existing Graund ;! — ~ Sumbalagy
Shapes | |
Shape Clusters et Lexel iLEVEl 2
Disfine DGN Variables e Color: LI 0
Diefine Wariables Il Line Text | Sante Sle: | 0

Redefinable VY ariables

Plat Fara
Drainage

Step 17.

"] Station Text

| Sanse

Wity | e—

| Sowcre

[T Baseline Mame Text

Cancel

\_ Ll Ll 4]

are toggled off.

Step 18.

Under the Text section, ensure that Line Text, Station Text, and Baseline Name Text

Toggle off all the options in the Plot section. The dialog box should appear as below.

g Proposed Cross Sections - Exbase ! m I
Files
-5 Lines
Existing Ground _;I |7
Shapes
Shape Clusters et
Diefine DG Y ariables =
Define Yariables | Line Test | Sarire
Redefinable '/ ariables ; I
Plot Parameters I Station Text | i
Drainage L 7] Bassline Name Test Sanire
~ Flot

[T Pavement Thickness [0
Fill G apz Between Chasters

Process Clusters as Indicated

Tranzition Definition

Intersect between Chusters

Remove Skewed Effect

Process Only Sections 'With E sizting Ground

At this point we are ready to process the existing pavement for the chain MAINLINE.

Step 19.
> Run.

From the Proposed Cross Sections dialog box, select Files > Save Settings, then Files

The following dialog box is invoked where you may define where you want to see the
computed cross section information, in an output file or on the screen only.

ngpnsed Cross Section E

" Log File

Screen Only I

7| Criteria View

Apply |
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Step 20. Select Screen Only and activate the Pause on Each Section toggle to view the first
design section once it has been drawn. The dialog should appear as below. Click

Apply.

ngpnsed Cross Section B

" Log File

Scresn Only I

¥ Pauze On E ach Section
™| Criteria View

NOTE: When errors occur, change the Screen Only to Log File, the click Apply to
generate the log file. Use the GEOPAK Editor to open the log file to determine the

problem
&

The error usually occurs at the end of the file. However, the error may be in the line(s)
prior the error message.

§=ull

Step 21. When processing is complete, click Exit to return to the Process Cross Sections dialog
box.

Step 22.  Close the Proposed Cross Sections dialog box by using the “X” on the upper right of the
dialog box or by using the Files > Exit pulldown.

When prompted to Save Settings, answer Yes.

Step 23.  Use Cross Section Navigator to review the existing base as drawn.
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12.2 Right of Way and Easements

In this next section, a new run will be created and used to label the Right of Way and Easements on

the cross sections.

Step 1. Choose Proposed Cross Sections from the Project Manager dialog box and create a
run called RW. Then double-click RW and the following dialog box will appear.
gl’-‘mpused Cross Sections - BW [ x|
Filez
45 DGM File =
Patterm
Enisting Ground
Shapes
Shape Clusters
Define DGEM Yaniables
Deefire Variables =
Plot Parameters -
Step 2. As before, complete the following items in the dialog box.
XS DGN File This filename should be defined as d17682xsmainline.dgn
Pattern Use Working Alignment Definition
Existing Ground Use Working Alignment Definition
Shapes Set the Shape Option to Shapeless.
Step 3. Next, select the Shape Clusters category to invoke the following dialog box.
ngpnsed Crozs Sections - RwW m
Files
T TEN ] — Chain Tie/PGL Frofile
L= —] "
Pattern MI
Existing Ground Thick
Shapes _I
[Shape Clusters
Define DGEM Y aniables : :
peri el Chain | Tie | [0:00000 Prof | Select |
RedsfinableVariables  [+] | Add | | Modiy | | Delete | | Up | | Down |
~ Side Slope Condition
Define | F odify | Delete | Up | D owan |
r Criteria File
Add Delete Up Do
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First, we will define the Chain, Tie and Profile for the Select]_Chain ¥ |
shapes. EBL4RD

MAIMLIME
RakPA
REDBLD

Step 4. Click the Select button to invoke the following
dialog box.

Step 5. For the Chain option, highlight the chain
MAINLINE and click Apply.

Apply | Dohe |

Step 6. Change the option to Profile and select the iSelect | Profile |
profile MAINLINE and click Apply. DITCHLTI
MAINLINE
When the chain and profile have been gkaFF"EUND
selected, click the Done button.
Step 7. Next, provide a Tie distance of 0 in the Tie
field and click the Add button to include this
shape cluster in the list box as shown below:
Apply | Done
Files
S OGNl - Chain Tie/PGL Profile
ile: . TS AAIN | I i
oen, MAINLINE MAINLINE Typical |
Erizting Ground Thick.
Shapes _l
[5hape Clusters
Define DGM Yariables ’ s
bl || chain [M&INLT| _Tie | [0.00000 Prof [MAINLI| _Select |
Plot Parameters =] | Add | | Modfy | [ Delete | | Up | | Down |
- Side Slope Condition
Define | tadify | Delete Up | Down |
r Criteria File
Add I Delete I Up I D owin I

Step 8. Highlight the shape cluster that was just defined in the list box and click the Typical
button.
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' Note: The Typical button will not be available until a shape cluster has been selected
from the list box.

If the following dialog box appears, click OK.

The template you zelected requires at least
@ one SHAPE in order to process, But the
Froject Manager is zet to SHAPELESS Mode
OF. to Continwe, CAMCEL to Abort

Cancel

Al LT Eg
WO LT EE

T LT

EXIST I NG
FROPOSED
TEMPORARY E
PERMANENT EASEMENT
UTILITY EASEMENTS

Cel | Description N fornol tJDb Humber. 101
DRLMRI RECOM LT MEW RT IND DES [ ! empiate
DRLNRU RECOM LT NEW RT ULT DES Template Designed to'work with: 1 Shape Cluster
DRRAMLI MEW LT RECOM BT IND DES . T T S
DRRMLU  MNEW LT RECOM RT IULT DES ; | [ Descrpion |
D RROW ) ; - Range
Apply towhale Chan ¥ |
EXFEAT  EXISTING FEATURES BB IO ShAn
EXPWMT  DR&wW EXISTING PAVEMENT e wel |
ROOTMT  ROOT MAT -

Step 9. Select Typical DRROW. This typical will be used to label the right of way and easements
for the length of the project.

Step 10.  Press Apply. When you see the following dialog box, always press Yes to All.

Criteria File: “'expozed_redefinable_variable_english.«"
Euist.

Do wou wish to ovenwrite’?

Yes
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Step 11.

Next we will need to define variables found in this criteria file.

Click the Define Variables category.

Modify the variables as shown in the table below:

Name of Proposed R/W File
Name of Existing R/W File

d17682des.dgn
s17682.dgn

NOTE: Although there is an option on the dialog for Define DGN Variables, this will never

be used.
[
Step 12.  Select the Redefinable Variables category. Review the values for each variable.
Filez
45 DGN File &] oiveneile
Fattern :_| g
Eisting Ground _s_DrawE xiztRightOfw ay
Shapes _s_DrawPermanentE asement
Shape Clusters _=_DrawTempararyE azement
Define DGEM Wariables _s_DrawsS anitaryS ewerE azement
Diefine Variables _z_DrawElecticalE azement i
Redefine
£ o
#* Draw Propozed Right of 'Aay Location 2
/% must use a ™ before and & ™ after value ®/
5 pesarno =
Edit |
Step 13.  Select the Plot Parameters category. Double click the sample graphics box under XS

Lines. Setthe symbology as below then click OK.

gﬁwmdﬁmﬁim—ﬂw !E
_Flles 0000000000 | GEOPAK Set Fealure |
— r#5 Linesz

E sisting Ground ;I | ~ Symbology
Shapss i Level: |Level 2 =]
Shape Clugters et O
Define DN Variables Color: [L1 D B3
Define Yanables ™ Line Text | S Style: | ] =
Redefinable Yariables [ Station Tedt |— Weight: [=———— 5 =1
Flot Paramnsters ¥
Drainage i [ Baseline Name Test | Satire Cancel I
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Step 14.

Step 15.

Under the Text section, ensure that Line Text, Station Text, and Baseline Name Text
are toggled off.

Toggle off all the options in the Plot section. The dialog box should appear as below.

PmpoaedessSedions—Hw I
Files
%5 Li
Existing Ground _;I nes |7
Shapes

Shape Clusters Ton
Define DGN Variables o
Define Wariables [ Line Text |
Redefinable '/ ariables [ Siation Test |

™| Baseline Mame Text Samite

Plot Parameters
Drainage -

_.FI

o

Pawvement Thickness [0
Fill G apz Between Chasters
Tranzition Definition _____!
Intersect between Clusters
Pracess Clusters as Indicated

Remove Skewed Effect

JOaaOn;nm

Process Only Sections \With Esizting Ground

At this point we are ready to process the r/w and easements for the chain MAINLINE.

Step 16.

Step 17.

Step 18.

From the Proposed Cross Sections dialog box, select Files > Save Settings, then Files
> Run.

The following dialog box is invoked where you may define where you want to see the
computed cross section information, in an output file or on the screen only.

ngpnsed Crozs Section E
Log File

’V Screen Only I
i

[T Criteria Wiew Apply |

Select Screen Only and activate the Pause on Each Section toggle to view the first
design section once it has been drawn. The dialog should appear as below. Click
Apply.

gl’-‘mpused Crozs Section [ x|

" Log File

Scresn Only I

¥ Pause On Each Section
[T Criteria Wiew

When processing is complete, click Exit to return to the Process Cross Sections dialog
box.
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Step 19. Close the Proposed Cross Sections dialog box by using the “X” on the upper right of the
dialog box or by using the Files > Exit pulldown.

When prompted to Save Settings, answer Yes.
Step 20. Use Cross Section Navigator to review the right of way and easements as drawn.

Step 21.  Before moving on to the next section, lock all the elements in the design file by using the
Microstation pulldowns

Edit > Select All

Edit > Lock
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12.3 Proposed Cross Sections (Sta. 200+00 to Sta. 204+25)

In this set of steps, a new run will be created and used to generate the proposed cross sections.

Step 1. Choose Proposed Cross Sections from the Project Manager dialog box and create a
run called ML1. You may enter this station range in the description if you wish.
Step 2. Complete the following items in the dialog box.
XS DGN File This filename should be automatically defined as

d17682xsmainline.dgn.
Pattern See dialog box below

Existing Ground Use Working Alignment Definition

Shapes Use Working Alignment Definition
| Cross Sections - ML1 I
Hiles
5 DEM File - [T Use Warking Alignment Definition
:
Exizting Ground Ly OGN Fi
Shapes Chairi [MENLINE Sslect |

Shape Clusters
DefiEe OGN Variables Horiz. Scale |1D Wert. Scale I 10

[refine Waniables DGM File [d17682work.dgn File |
Redefinable Y anables _:j

- Search Criteria

[¥! Ly Mumbers: |50

]

[

I Colors: |5 j
=]

|

[ St |
L

Match | Displa_l,l | Resat

Step 3. Click Shape Clusters to define shape clusters, side slope conditions and criteria files.

Step 4. Click the Scan button to have the software scan the d17682work.dgn file for all of the
shape clusters.

g List of Clusters E
Chain Tie/PGL Prafile

MaIMLINE  0.000000 MaIMLINE
AP 0.0a0000 RabPa

Cloze |

Select Chain MAINLINE.

On the Proposed Cross Sections dialog box, click Add to add the this cluster to the
shape cluster list box

Click Close to close the List of Clusters window.
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Step 5.

Step 6.

Propozed Crosz Sections - ML1 [ x|

Files

5 DGM Fila
Patterm

Existing Ground
Shapes

Define DGN Wariables
Define WVariables
Plot Parameters

- Side Slope Condition -

Prcfile
MAINLINE

Chain

Tie/PGL

MAINLINE

Tupical
Thick.

Chain [MAINLT| | Tie | [0.00000 Prof [MAINLT| | Scan

add | | Modiy | [ Delete | | Up | | Down |

Define

r Criteria File

Highlight the shape cluster option and click the Typical button.

Select the typical DRLNRU. Set the option in the Template window area to Apply to

Left Roadway. Setthe Range option to Apply to Whole Chain. Click Apply.

|

Cell

Dezcription

DRCSTI
DRCSTU
DRLMFEI
CRLMREL
DRRAMLI
DRRNLU
DRROW
ENTR
EXFEAT
EXPYMT

DIVIDED RECOM IMD DES

DIVIDED RECOM ULT DES

RECOM LT MEW RT IND DES
RECOM LT NEW RT ULT DES
MEW LT RECOM RT IND DES

MEW LT RECON RT ULT DES
DR&W RIGHT OF Wwiay' LOCATIONS
ENTRANCES

EXISTIMG FEATURES

DR&W EXISTING PAVEMENT

Job Mumber: 101
(=] r Template
| Template Degigned to Work with: 2 Shape Clusters

Description

Apply to Left Foadway V]

Range

Apply ta Wwhale Chain "]

GEOPAK 2004 Edition

LAB 12: Proposed Cross Sections 12-25



GEOPAK®

Click Yes to All when prompted to overwrite criteria files.

Criteria File: ""expozed redefinable_variable_english.«"'
Ewist.

Cro pou wizh o ovenwnite’Y

Step 7. Your dialog box should look like the following:

ngpused Crozs Sections - ML1 [ x|

Files

Eviclra G r Chain Tie/PGL Profile

wisting Groun e .
Shapes rAIMLIME Typical |
Shape Thick_|
Define DGN Wariables

Define Wariablex

Riedefinable Meliohigs Chain [MANL| | Tie | [0.00000 Prof [MAINLT| |_Scan |

Plat Parameters
Dirainage Add I I odify I Delete I Up I Down |

- Side Slope Condition

et s
Offzet Minus RT

Define | tadify | Delete Up | Down |
r Criteria File
varables.x User defined variables.
resurfacing. = Find existing edges of pavement.
shoulder.® Mon-Local Shoulder File.
Add I Delete I Up I D owin I

Step 8. With the shape cluster still highlighted, click the Typical button again.

Step 9. Leave everything the same, but set the option in the Template window area to Apply to
Right Roadway. Click Apply.
Template
Template Designed towiork with: 2 Shape Clusters

12-26 VDOT Road | Training GEOPAK 2004 Edition



GEOPAK”

Click Yes to All when prompted to overwrite criteria files.

Ewist.

Cro pou wizh o ovenwnite’Y

Criteria File: ""expozed redefinable_variable_english.«"'

Step 10.  Your dialog box should update with 2 additional Side Slope conditions:

Files

ngpused Cross Sections - ML1 [ x|

— — Chain
Esizting Ground =]
Shapes

MAIMLINE

Define DGM Wariablas
Define Variables

Hedanlc an-bics Chain [MAINL | Tie | [O00000 Prof [MANLT | Scan |

Flot Parameters

Tie/PGL Frafile

MAIMLINE

Thick |

Drainage =] _4dd | _Modiy | | Delste | | Up | | Down |
r Side Slope Condition
Offzet Minus AT
Offset Plus LT
Offset Plus AT
Define | F odify | Delete | Up | D owan |
r Criteria File
pavement. Pavement File,
zhoulder Maon-Local Shoulder File.
glopes.x Slopes File.
Add | Delete | Up | D o |

Step 11.  Select the Define Variables category. Modify the following variables as shown:

Name of Plan File

d17682des.dgn

Name of Profile File

d17682prof.dgn

Name of Proposed RW File

d17682des.dgn

Name of Existing RW File

s17682.dgn

Name of Survey File

s17682.dgn

Name of Working File

d17682work.dgn

Name of Cross-Section File

d17682xsmainline.dgn

GEOPAK 2004 Edition
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Step 12.  Select the Plot Parameters category. Double click the sample graphics box under XS
Lines. Setthe symbology as below then click OK.
!_ Proposed Cross Sections - ML1 I [=] I

Hles | GEOPAK Set Feature I
— 5 Lines

gl:lstlng Gratnd _:j |— ~ Symbology
apes - -

Shape Clasters —— Level: |Level 2 |

Define DGN Yaiiables = Color. JLJ 0 =]

Define Yariables I Line Text | Sarire Style: | i =]

denl rlables [ Station Test | Saive Wight, |— 3|

Flot Parameters

Drainage X [T Baseline Mame Text | Satire tancal I

Step 13.

Step 14.

Step 15.

Under the Text section, ensure that Line Text, Station Text, and Baseline Name Text

are toggled off.

Toggle off all the options in the Plot section. The dialog box should appear as below.

gﬁoposedﬁmsﬁim-llu !m
Hles
- x5 Lines
Exizting Ground ;i |—
——

Shapes
Shape Clusters et
Diefine DGN Variables = —_—
Diefine Variables [ Line Text | Sanre
denl rlables [7] Station Text | Sania
Plat Farameters
Drainage b ™| Baseline Mame Text Savte
~ Plat

[T Pavement Thickness [0

™| Fill Gapz Between Clusters

[T Transition Definition L I

[T Intersect between Clusters

[T Process Clusters a3 Indicated

™| Remove Skewed Effect

™! Process Only Sections With E sisting Ground

At this point we are ready to process the proposed cross sections from

Sta. 200+00.00 to Sta. 204+25.00 for the chain MAINLINE.

Click Files > Save Settings then click Files > Run.

Select Screen Only and activate the Pause on Each Section toggle to view the first

design section once it has been drawn. The dialog should appear as below. Click

Apply.

ngpnsed Cross Section E

" Log File

Screen Only I

¥ Pauze On E ach Section
™| Criteria View
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Step 16.  When processing is complete, click Exit to return to the Process Cross Sections dialog
box.

Step 17.  Close the Proposed Cross Sections dialog box by using the “X” on the upper right of the
dialog box or by using the Files > Exit pulldown.

When prompted to Save Settings, answer Yes.

Step 18.  Use Cross Section Navigator to review the proposed cross sections as drawn.

' Note: At this point the sections will not be correct because we ran them with the default
- values. We’'ll come back in subsequent sections and use our variables to modify our
design.

Step 19. Before moving on to the next section, let's turn off certain levels to make our sections
more readable.

Turn OFF the following levels:

51 Elevation Labels
52 Offset Labels
53 Existing Pavement Labels
55 Warning Text Labels
56 Feature Labels
Step 20.  File > Save Settings
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12.4 Proposed Cross Sections (Sta. 204+50 to Sta. 220+00)

Step 1. Choose Proposed Cross Sections from the Project Manager dialog box and create a
run called ML2. You may enter this station range in the description if you wish.

Step 2. Complete the following items in the dialog box.

XS DGN File This filename should be automatically defined as
d17682xsmainline.dgn.

Pattern See dialog box below

Existing Ground Use Working Alignment Definition

Shapes Use Working Alignment Definition
PmposadessSedions—MLZ I
Hiles
5 DG File - 71 Use Warking Alignment Definition
:
Exizting Ground By OGN Fis
Shapes Chair [MAINLINE Select |

Shape Clusters .
Define DEN Variables Hariz. Scale |'ID Wert. Scale I 10

Define Variables DGM File | d17682work.dan
Redefinable Variables _:j

- Search Criteria
W Ly Mumbers: |50
W Colors: [4 @

O o] =
C Tepes| =

t atch | Displa}l | Reset I

Elofs | [

Step 3. Click Shape Clusters to define shape clusters, side slope conditions and criteria files.
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Step 4. Click the Scan button to have the software scan the d17682work.dgn file for all of the
shape clusters.
Chain TiedPGL Prafile
MAINLINE 0000000 MAINLINE
RaMPa 0000000  RaMPa
Close |
Select Chain MAINLINE.
On the Proposed Cross Sections dialog box, click Add to add the this cluster to the
shape cluster list box
Next, Select Chain RAMPA.
On the Proposed Cross Sections dialog box, click Add to add the this cluster to the
shape cluster list box
Click Close to close the List of Clusters window.
Filez
S DN = Chain Tie/PGL Profile
b = ™ [MAIMLINE  0.000000  MAINLINE Typical_|
2t RaMP4 0000000  RAMPA
Existing Ground Thick
Shapes LI
Shape Clusters
Define DGM Variabl . .
D:f:::\-“aliabl:s”a | Chain [R&MFZ | Tie | [0.00000 Frof [F&MFE| | Scan |
Redefinable Variables itdd: M odify | Delete | Up | Diown I
~ Side Slope Condition
Define | F odify | Delete | Up | D owan |
r Criteria File
Add | Delete | Up | D o |
Step 5. Highlight the shape cluster entry for chain MAINLINE and click the Typical button.
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Step 6.

Step 7.

Select the typical UNPVT. Set the Range option to Apply to Whole Chain.

Click Apply.

Typical Sections

Cell

Description

DRAMLU
DRROW
ENTR
EXFEAT
EXPMT
ROOTMT
LINFT
URPYTL
LURCST
URCSTL

MEW LT RECOM RT ULT DES 1=

DR&w RIGHT OF Wway' LOCATIONS
EMTRAMCES

EXISTIMNG FEATURES

DR&w EXISTING PAVEMEMNT
ROOT MAT

UNDIIDED h

UNDINIDED LOCAL NEW FYMT
UNDMIDED RECOMSTRUCTION
UNDIVIDED LOCAL RECON I~

Job Mumber: 107

r~ Template

Template Desigrned to Work with:

|~ Range

1

] Description
Apply to Whole Chain ']
[DE] LoP]
r [MAINLINE | Select... ]

Apply

Click Yes to All when prompted to overwrite criteria files.

| 8 Aert

]|

Criteria File: “'expozed_redefinable_variable_english.«"

Euist.

Cro pou wizh o ovenwnite’Y

Yes

Highlight the shape cluster entry for chain RAMPA and click the Typical button.
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Step 8. Select the typical UNPVT. Set the Range option to Apply to Whole Chain.
Click Apply. Click Yes to All when prompted to overwrite criteria files.

Criteria File: “'expozed_redefinable_variable_english.«"
Euist.

Do wou wish to ovenwrite’?

ez | No |
Step 9. Select the Define Variables category. Modify the following variables as shown:
Name of Plan File d17682des.dgn
Name of Profile File d17682prof.dgn
Name of Proposed RW File d17682des.dgn
Name of Existing RW File s17682.dgn
Name of Survey File s17682.dgn
Name of Working File d17682work.dgn
Name of Cross-Section File d17682xsmainline.dgn

Step 10.  Select the Plot Parameters category. Double click the sample graphics box under XS
Lines. Setthe symbology as below then click OK.

Pmpmedﬁms%im—MLZ !Em
Fies [GOPAK 5o Fomure |
s Lines o — ——

Esigting Ground _Aj |7 =S

Shapes p— _ =

Shape Clusters — Level [Level 2 B3
Define DGM Yarables e e — Color LT 0 |
Define Yanables ™ Lire Text | Sanpie Style: | i =]
Redefinable Yariables [ Station T |— Waight: [=—5 =
Flot Parameters Sanra

Drainage " Baseline Mame Text | Satire Cancel l

Step 11.  Under the Text section, ensure that Line Text, Station Text, and Baseline Name Text
are toggled off.
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Step 12.

Step 13.

Step 14.

Step 15.

Step 16.

Step 17.

Toggle off all the options in the Plot section. The dialog box should appear as below.

PmposadessSections—MLZ I
Hiles
®SLi
Eisting Ground ;i nes |7
Shapes

Shape Clusters et
Diefine DGEM Yariables = ——
Diefine Variables [ Line Text | Sanre

| Saoie

Redefinable '/ ariables [ Siation Text

Plot Parameters

Drainage x [T Baseline Mame Text Saiie

~F

[=x

Pavement Thickness |
Fill Gapz Between Clusters
Tranzition Definition _____!
Intersect between Clusters
Process Clusters as Indicated

Remove Skewed Effect

o e

Process Only Sections With Exizting Ground

At this point we are ready to process the proposed cross sections from
Sta. 204+50.00 to Sta. 220+00.00 for the chain MAINLINE.
Click Files > Save Settings then click Files > Run.

Select Screen Only and activate the Pause on Each Section toggle to view the first
design section once it has been drawn. The dialog should appear as below. Click

Apply.

gl’-‘mpused Crozs Section [ x|

Scresn Only I

¥ Pauze On Each Section
[T Criteria Wiew

" Log File

When processing is complete, click Exit to return to the Process Cross Sections dialog
box.

Close the Proposed Cross Sections box by using the “X” on the upper right of the dialog
box or by using the Files > Exit pulldown.

When prompted to Save Settings, answer Yes.
Use Cross Section Navigator to review the proposed cross sections as drawn.

Before moving on to the next section, delete all of the proposed xsections. We’'ll re-run
them again in the next section. You can do this easily by doing the following:

Edit > Select All

Press the Delete icon.
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12.5 Variables

In this section we’ll learn how to use our variables to modify the x-sections.

12.5.1 Pavement Variables

Step 1. Choose Proposed Cross Sections from the Project Manager dialog box and access
the previously created run called ML1.
Step 2. Select the Redefinable Variables category to display all of the redefinable variables for
the run.
gl’-‘mpused Cross Sections - ML1 [ x|
Filez
5 DGN Fils [«] arisble
Patterm d_SurfaceThickness
Exizting Ground _d_Intermediate] T hickness
Shapes _d_Intermediate2T hickness
Shape Clusters _d_BazelThickness
Define DGM Yaniables || |3 Base2Thickness
Diefine Wariables _d_Subbase1 Thickness
Redefinable ' ariables
Fedefine
ll.lx __________________________________ xll,l
/* Pavement Surface Laver Thickness =/
£ inor mm =
ll.lx __________________________________ xll,l
Edit |
Step 3. Let's change the variable _d_SurfaceThickness from 12 to 3. In order to change a

variable, follow these steps:
Highlight the variable _d_SurfaceThickness.

Click the Edit button to access the Redefinable Variable Editor.

| £ Redefinable Variables Editor
FE 2 */
7% Pavement Surface Layer Thickness =/
A% in or mm */
Ve *®.

if (Sta »= 0+00 R 1) then
_d_SurfaceThickne=ss = 3
¥
s#if (Sta = P??HPY R 1) and (Sta <= ???4+7? R 1) then

_d SurfaceThickne=ss = 12
T

Cancel |

Change the value of _d_SurfaceThickness to 3 then click Save.
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Step 4. Modify these additional variables as shown:

Step 5. Click Files > Save Settings then click Files > Run.

_d_IntermediatelThickness

_d_BaselThickness

_d_SubbaselThickness

_d_OverlaySurfaceThickness

_d_OverlaylntermediateThickness

_d_OverlayBaseThickness

_d_MillingDepth

_d_ShoulderSurfaceThickness

_s_ExtendSubbasel

Plw (v iw|lw| w|lo|w|w

Step 6. When processing is complete, click Exit to return to the Process Cross Sections dialog

box.

Step 7. Close the Proposed Cross Sections box by using the “X” on the upper right of the dialog
box or by using the Files > Exit pulldown.

When prompted to Save Settings, answer Yes.

Step 8. Use Cross Section Navigator to review the proposed cross sections as drawn.
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12.5.2 Slope Variables

12.5.2.1 Special Ditches

Step 1. Choose Proposed Cross Sections and access the previously created run called ML2.

Step 2. Select the Define Variables category and change the variable for Left Special Ditch
Profile to “ditchltl” as shown:

&Proposed Cross Sections -ML2 |
Files

S DGH File =] Warable Walue

Patterm MAME OF WORKING FILE d17EE2wmark. i

E wisting Ground MAME OF CROSS-SECTIOM FILE d17ES2xemair

Shapes LEFT SPECIAL DITCH PROFILE ditchi

Shape Clusters RIGHT SPECIAL DITCH PROFILE nione

Define DGM Yariables || |LEFT DITCH ALIGMMENT none

Fedefinable Variables  [+] By fle M __l

Yariable Mame :  LEFT SPECIAL DITCH PROFILE

Walue | ditchl

Add | | Modiy |

This is a special ditch profile that runs from Sta. 214+75 to Sta. 217+00.

12.5.2.2 Erosion Control Ditches & Berms

Step 1. Under the Redefinable Variables category, select s DrawErosCtrIDitchFillLeft as
shown in the dialog box below.

gl’-‘mpused Cross Sections - ML2 ]
Filez
%S DGN File [«]  Watisble
Patterm _d_RockWallSlope
Ewizting Ground z_DrawErozChriDitchFillleft
Shapes = DrawErozChriDitchFillRight
Shape Clusters _s DrawErozChiDitchCutLeft
Define DGM Yariables || _z_DrawErosChiDitchCutRight
Diefine Wariables _d_ErosChiDitchiOffzetLeft
Fedefinable VW ariables
Redefine
T =/
/% Diraw Left Erosion Control Ditek i Fill #4
M mustuze a ™ before and a ™ after value =/
£ pezorno i

Step 2. Click the Edit button to access the Redefinable Variables Editor.
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The dialog box should appear as below.

& Redefinable Variables Editor []
-
#% Draw Left Erosion Control Ditch in Fill *
S nust use a ~ before and a * after valus */
S ¥ye= Or no *
A% *./

if (Sta »= 0400 R 1) then

_= DrawvErosCtrlDitchFillleft = “no”
i
/%1f (Sta >= 777477 R 1) and (Sta <= 777477 R 1) then
1
_= DrawvErosCtrlDitchFillleft = “yes"
Tes

Cancel

Step 3. Change the station range as shown to specify a certain area where we want to draw an
erosion control ditch.

NOTE: Be sure to remove the comments (/* */) from around the command
containing the new station range.

The dialog box should appear as below. Click Save.

| £ Redefinable Variables Editor []
P 2 *.
#% Draw Left Erosion Control Ditch in Fill */
S nu=t use a ” before and a " after value %/
o= yes or no ®/
Pl * .7
if (Sta »= 0+00 R 1) then
{
_= DrawvErosCtrlDitchFillleft = "no”
i
if (Sta s= 211425 R 1) and (Sta ¢= 212450 R 1) then
1
_& DrawErocsCtrlDitchFillleft = “yes”
+

Cancel

Important: When you change a variable in the editor by specifying a station range,
remember that you are responsible to make sure that any station to be processed has an
assigned value for the variable.

§=ull
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Step 4.

Make the same change to the variable _s DrawBermFillLeft and click Save.

T ——"——

[x]

S

7

P
SE
Ve
%

Draw Left Berm in Fill
nu=st usze a ”
yEs or no

before and a

*
after valus =~
*
* .7

if

(Sta »= 0400 R 1) then

{
_= DrawvBernFillleft = "no”
i
if (Sta s= 211425 R 1) and (Sta ¢= 212450 R 1) then
1
_= DrawBermFillleft = “yes”
+

Cancel

12.5.2.3 Force Slope Tie Inside RW

Step 1.

Under the Redefinable Variables category, select s ForceSlopelnsideRWLeft and

make the changes as shown in the dialog box below.

Force the cross sections to draw a front slope inside the Right Of Way on the left side

from Sta. 212+75 R 1 to Sta. 213+75 R 1.

NOTE:
containing the new station range.

# Redelinable Variables Editor

Be sure to remove the comments (/* */) from around the command

S *.
<% Force Left Slope Inzide Right of Way Line %/
o= must use a © before and a * after value =/
e 3 vES OF no *®/
g 2.4
if (Sta = 0400 R L) then

L

_s ForceSlopelnsideRWLeft = “no”

¥
if (Sta »= 212475 R 1) and (Sta <= 213+75 E 1) then

1

_= ForceSlopelnsideRWleit = “yes”

}

Cancel
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12.5.2.4 Force Cut and Fill Slopes

Step 1.

Step 2.

Step 3.

Under the Redefinable Variables category, select _d_ForcedCutSlopeRight.

Force the cross sections to use a Cut slope of 2:1 on the right side from

Sta. 205+75 R 1 to Sta. 208+50 R 1.

NOTE: Be sure to remove the comments (/* */) from around the command

containing the new station range.

if (Sta »= 0400 R 1) then
d_ForcedCutSlopeRight = 0
if (Sta »= 205475 R 1) and (Sta <= 208450 R 1) then
d_ForcedCutSlopeRight = 2

el e el e

Cancel

S %
<% Force Right Cut Slope *
A If turned on, this variable will cause =~
SE the ditch to HOT be drawn. */
SE Tze 0 to turn off */
P d Specify Run (X) only */
IE X1 */
s* *

Under the Redefinable Variables category, select _d_ForcedFillSlopeRight.

Force the cross sections to use a Fill slope of 2:1 on the right side from

Sta. 205+75 R 1 to Sta. 208+50 R 1.

NOTE: Be sure to remove the comments (/* */) from around the command

containing the new station range.

Fed Specify Run (X} only =~
SE i1 /
P rs
if (Sta »= 0400 R 1) then

*,
*,

d_ForcedFillSlopeRight = 0
if (Sta »= 205475 R 1) and (Sta <= 208450 R 1) then

d_ForcedFillSlopeRight = 0

ol e el e

Cancel

| £ Redefinable Variables Editor
S 7
% Forced Right Fill Slopes =/
SE Tze 0 to turn off */

Click Files > Save Settings then click Files > Run.
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Step 4. When processing is complete, click Exit to return to the Process Cross Sections dialog
box.

Step 5. Close the Proposed Cross Sections dialog box by using the “X” on the upper right of the
dialog box or by using the Files > Exit pulldown.

When prompted to Save Settings, answer Yes.

Step 6. Use Cross Section Navigator to review the station ranges denoted for the variables to
make sure the changes were picked up.
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12.6 Rootmat

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Open the MicroStation file c:\data\geo\VDOT\road1\d17682work.dgn.

Turn off levels 50 and 63. Review the design file and notice the elements on level 13.
These elements were drawn via D&C Manager and reflect the following:

Road Design > Ground Cover > WLFR (Wood Left Field Right)

Road Designh > Ground Cover > WOOD (Woodlands Throughout)

Road Design > Ground Cover > FLWR (Field Left Wood Right)

Open the MicroStation file ¢c:\data\geo\VDOT\road1\d17682xsmainline.dgn.

Choose Proposed Cross Sections from the Project Manager dialog box and create a
new run called ROOTMAT.

Complete the following items in the dialog box.

XS DGN File This filename should be automatically defined as
d17682xsmainline.dgn.

Pattern Use Working Alignment Definition

Existing Ground Use Working Alignment Definition

Shapes Shapeless

Fill out the shape cluster category as shown and click the Typical button.

ngpused Cross Sections - rootmat m
Files
e DN = Chain TiedPGL Profile
ile T YT .
Pattem A MLINE taAIMLIKE Tupical |

Exizting Ground Thick, |

Shapes

Shape Clusters

Define DGH Variables . 3

Diefine Yariables Chair I talMLl | Tie I I 0.00000 Prof I MAINLI | | Select |
Plot Parameters Add I b oddify I Delete | Up | Dawn |

r Side Slope Condition

Define Modfy | [ Deletel Up Dawn |
r Criteria File
Add | Delete | Up | Drown |
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Step 7.

Step 8.

Step 9.

Step 10.

Step 11.

Select the rootmat typical (ROOTMT) as shown and click Apply.

Cell Diescription Job Mumber: 101
DRECON DIVIDED RECONSTRUCTION [<]  Template : -
DREOW DRA&W RIGHT OF way LOCATIONS [ Template Dezigned to 'Work, with: Mo Shape Clusters
EXFEAT DRéMW EXISTING FEATURES | .
EXPYMT DR&W EXISTING PAVEMENT _Desoipion |
MLTRRT NEW LEFT RECON RIGHT - Range
RLTNRT RECON LEFT NEW RIGHT "
[ROOTMT DRaw ROOTMAT NS ——
UNLPWT  LOCAL UNDIVIDED NEW PyMT | ErrE | S |
UNPYMT UNDIVIDED NEW PAVEMENT
URECON UMDIMIDED RECOMSTRUCTION [ [ I [Select.. |
Apply !

Select the Define Variables category. Modify the following variables as shown:

Name of Working File

d17682work.dgn

Name of Survey File

S17682.dgn

Name of Cross-Section File

d17682xsmainline.dgn

Review the Redefinable Variables.

Select the Plot Parameters category. Double click the sample graphics box under XS

Lines. Setthe symbology as below then click OK.

(& Proposcd Coes Seciors FOOTAN————— WBIE]|

_ Hles | GEOPAK Set Feature |
— r#5 Lines

E wizting Ground ;i |7 r Symbology
Shapes L Level |Level 2 =]
Shape Clusters Test
Disfine DGN Variables [Te Color: JL1 0 ]
Define Yariables [ Line Text | Satvre Sle: | i e
Redefinable '/ ariables [ Siatin T i |—i \Wight; [— =]
Plot Parameters .
Drainage i [ Baseline Mame Text | Saide Cancel

are toggled off.

Under the Text section, ensure that Line Text, Station Text, and Baseline Name Text
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Step 12.

Step 13.

Step 14.

Step 15.

Step 16.

Toggle off all the options in the Plot section. The dialog box should appear as below.

| Proposed Cross Sections - RODTMAT M= |
Hiles
-5 Li
Eisting Ground ;i nes |7
Shapes

Shape Clusters et
Diefine DGEM Yariables = ——
Diefine Variables [ Line Text | Sanre
Redefinable '/ ariables [ Siation Text |

Plot Parameters

Drainage x [T Baseline Mame Text Saitie

~F

[=x

Pavement Thickness [an
Fill Gapz Between Clusters
Tranzition Definition ____I
Intersect between Clusters
Process Clusters as Indicated

Remove Skewed Effect

o e

Process Only Sections With Exizting Ground

At this point we are ready to process the ROOTMAT cross sections.
Click Files > Save Settings then click Files > Run.

When processing is complete, click Exit to return to the Process Cross Sections dialog
box.

Close the Proposed Cross Sections dialog box by using the “X” on the upper right of the
dialog box or by using the Files > Exit pulldown.

When prompted to Save Settings, answer Yes.

Use Cross Section Navigator to review the cross sections.
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12.7 Working Alignment

Now that we have the information for our proposed xsections, we need to update our Working
Alignment Definition in Project Manager.

Step 1. From the Workflow dialog box of Project Manager, click the Define button.

Step 2. Highlight the Proposed Finish Grade option and populate the dialog box as depicted

below.
| & Working Alignment Definition- MAINLINE [_ D] I

Plan View
Pattern [ v bames | _]
Shapes ¥ L« Numbers: [2-13 g

Prafile Wiew
Lacation i Colors: I 0:235 E.I

Crozs Section View i Styles; I 07 El fatch
E xisting Ground . ohts [075 3
Proposed Finish Grade W e El ke

OTH i Types: [3 E‘ Reset

Cancel I

Step 3. Click OK to save your changes and exit the dialog box.

Step 4. Exit MicroStation.
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CHAPTER 13

Port Viewer

13.1 Introduction

Objectives Learn how to utilize the Port Viewer.
Project Manager Port Viewer
Menu Bar Application None

The Port Viewer is a tool that enables the user to view and manipulate all three major aspects of a
road design simultaneously, even though they are located in different files. The Port Viewer tool is
only available while working within the Project Manager application. These applicable views for
design display include:

e Plan view layout
e Profile
e Cross sections

Cdata\geo\vdot\road 1\d 17682des _dgn (2D - V8 DGN) - MicroStation V8 2004 Edition

Fle Edit Hement Settings Tools LUtilities Workspace Applications Window Help
B ] R
|=[a] 8] s[=le] -~ & 2] a-&l-c- kel

FZ{Plan View (6) (Active) o [=1}E

]

#5 Station vI

203+ F1
]
off [aoooo [
Elew Imﬂﬁ_r
Active | Plan Yiew 'I

_se || e |

= > olols

24 Profile View (7)

LS

L P R | : [= 7] [ ||

I B[ b= || B
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13.2 Accessing the Port Viewer

Prior to starting the Port Viewer the working alignment must be set up to include the plan view
drawing file, centerline chain, profile name and location (optional), cross-section view file(optional),
and digital terrain model information(optional)..

To access the Port Viewer tool, click the Port Viewer button on the Project Manager workflow
dialog box. Note this is the only location from which the Port View can be accessed, as there is no
GEOPAK Road tool supported for it.

13.3 Port Viewer Dialog Box Settings
(& Port Viewer |

Wiew  Opliong
Sta. [21475.00R [T
#5 Station VI
214+75.00F 1
<] <E] >
ok [ooooo
Elew IWI’
Active | Plan View vI

[ et J[ 0P ]

The Port Viewer dialog box allows the user to manipulate the design views in several different ways.

13.3.1 Station Settings

The user is able to manually enter the chain station that they want to view the plan, profile or cross
section design file. The cross hairs in the plan and profile views will move to the active station, and
the section view will display the cross-section nearest that station.

13.3.2 Traverse Buttons

The “VCR” buttons (forward and backward arrowheads) allow the user to navigate station by station
(>,<), or to the beginning or ending station (<<,>>).

13.3.3 Offset Control

The Offset option will control the location of the locator circle in the plan view and the vertical cross
hair in the cross-section and profile view.

13.3.4 Elevation Control

The Elevation option will control the location of the horizontal cross hairs in the profile and cross-
section views.
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13.3.5 Active Ground Setting

Ewwuq

|| Yiew Options

Sta. [214+75.00R - [

H5DTH

If the TIN file is defined in the Working Alignment definition, the DTM view can be substituted for the
cross-section view. The DTM view cuts a section on the fly at the location of the cross hairs in the
plan view.

& Por viewer 1

Wiew  Options

sta. [Z14+7500R
25 DTM_ |

G
ot [Oooo0 [ f

| Elev [15000000 [

Active | X5 View V!

13.3.6 Active View Settings

The Active option defines the view that controls the manipulation of the other two views.

(RN [ EN JUS— | —

oif, [0.0000 r
[Faooooon T

Prafile Wiew
— X5 View

13.3.7 Set Button

Once the Active View is selected, the user can click the Set button. This will allow the user to move
the cursor to the Active View and move the cross hairs. As the user moves the cursor along the
Active View, the other two views will be updated according to the placement of the cursor in the
Active View.

13.3.8 DP Button

The DP button enables the user to issue a data point for a MicroStation command. For example, if
the user wanted to draw a line at the given station and offset listed in the Port Viewer dialog box,
they would select the line tool, and click the DP button. This would begin drawing a line at the given
station and offset.
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13.4 Port Viewer Menu Options

13.4.1 View

The View pulldown from the Port Viewer menu bar allows the user to fit one or all of the views, or to
select the Active View.

The Fit option will fit the entire horizontal alignment when selecting Plan View, the entire profile when
selecting Profile View, or the current cross section when selecting XS View.

The Active option set the active design file to be the one that contains either the Plan, Profile or
Cross Section data and reference the others. This is useful if you need to alter a section yet you are
in the Plan View. Since the Cross Section file is referenced, you cannot modify the section. However
if you make the XS View ‘active’, then the port viewer will open the Cross Section file as defined in
the Working Alignment dialog box, and reference the Plan and Profile views.

[ ror viower ]

Options M Options
I
Ak ¥ Prafile View [7]

A5 Wiew (8]

BN
T = Profile View [7]
214475, p %S View [3)

214475 )
| BTET o]
of. [ooooo o [oooon |
Elev [19000000 T Elev [T9000000 |
Active | XS View V! Active X5 View Vi
Set I DF I Set I DF I

13.4.2 Options

The Options menu controls which cross hairs to display, as well as the & Port Viewer I
symbology of the DTM section view. T Ctions |
Sta. |- B
!
r Plan [ {Show Stations only at =5 cell
¥ Station ¥ Difset Circle ; : " ; el el
Offset Circle Size [T.00 || [ Marker Display << ][]
¥ o Center Window _I Evl Evl (. iD.DDDD I
~ Profile r Dynamic-to-Cursor Sensitivity — Elew ! 13000000 r
¥ Elevation ¥ Station 20% of view Active | %5 View V!
: 1%] ] 100%
[ Auto Center Window el I oP I
r X5
W Elevation W Difeet
DT Lett |'|5D.UU Right I'IED.DD Apply |
_I Evl E'I Cloze |

Group boxes are supported for Plan, Profile and XS display options.

Three toggles are located in the Plan group box: Station, Offset Circle, and Auto Center Window.
When the Station toggle is activated, the pattern line is displayed on the screen. When the Offset
Circle toggle is activated, a circle of the size specified in the Offset Circle is placed at the Station and
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Offset specified in the Port Viewer dialog box. When the Auto Center Window toggle is activated, the
Station and Offset specified in the Port viewer dialog box is centered in the Plan window.

The Profile group box has three toggles: Elevation, Station and Auto Center Window. When the
Elevation toggle is activated, a horizontal line at the Marker Display element symbology is displayed
in the Profile View at the Elevation specified in the Port Viewer. When the Station toggle is activated,
a vertical line, also at the Marker Display element symbology, is displayed on the Profile view at the
Station specified at the top of the Port Viewer dialog box. When the Auto Center Window toggle is
activated, the Station and Elevation specified in the Port viewer dialog box is centered in the Profile
window.

The XS group box has two toggles: Elevation and Offset. When the Elevation toggle is activated, a
horizontal line at the Marker Display element symbology is displayed in the XS View at the Elevation
displayed in the Port Viewer. When the Offset toggle is activated, a vertical line, also at the Marker
Display element symbology, is displayed in the XS view at the offset specified in the Port Viewer
dialog box. The XS Group box also contains parameters for the XS DTM Left and Right specified in
terms of master units. The XS DTM Left and Right parameters are the horizontal distances from the
specified alignment which define the limits of the cross section or DTM display line, similar to a cross
section pattern line.

The Dynamic to Cursor Sensitivity determines how close the MicroStation cursor must get to the
data point cross hairs (dynamic cursor) before they begin to follow the MicroStation cursor
dynamically in the Set mode. This is to prevent the cross hairs from jumping over to the MicroStation
cursor until it is within a certain distance from them. This distance is set as a percentage of the
diagonal size of a given view. When the dialog box settings are complete, clicking the Apply button
automatically updates the screen and revises the displays.

The Marker Display group box contains the element symbology of the marker lines.

After the desired settings have been completed, click the Apply button in the lower right corner to
automatically close the dialog box and apply all settings.

GEOPAK 2004 Edition Port Viewer 13-5



GEOPAK®

LAB 13: Port Viewer

Step 1.

Step 2.

Step 3.

Step 4.

Execute c:\data\geo\VDOT\road1\LAB13.EXE.

Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn

Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Use the Select button to make sure that you've got MAINLINE selected as your Working
Alignment.

Select the Port Viewer button.

Z5 Road Project: 17682 pirj

File  Bemember Options

whorking Directory

W) “wWorking Alignment Influence Funs
whorking Alighment  MAIMLINE

User. ¥YDOT  Job#: 101 [l

Select | Define |

Enisting
Ground

Coordinate
Geamatry

Esizting Ground

Harizantal
Alignment

|
Flak Wiew

Dresign

|

E sizting Ground Wertical
Prafile Alignment

lreisi S Crozs Sections
I
Calculate Supereleyation Froposzed
Superelevation | Shapes Crozs Sectionz

D
| Models

Flat & Prafile

Sheets

Plan Wiew
Quantities

Tabular
Summaries

— Earthuworl:

Cross Section
Sheets

Lirnitz of Reparts & XS5
Cohstruction [uantities
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Step 5. The Port Viewer dialog box is displayed as shown below.

£ C\data\geo\wvdot\rad 1\d 17682des dan (2D - V8 DGN) - MicroStation V8 2004 Edition

i Fle Edit Hement Settings Tools LUilities Workspace Applications Window Help

| AHR - ame =
Dlzlal 8] s[z[e] o~ @ 2] |5 -alel
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_‘...

W F24Plan View (6) (Active)
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| +D \?D

EE

| j} O}

E@ - 20040000 1
== L]
B %, o, [T.0000 E
[+ ] 1t Elev [T000000 1 WY
?:E.IL EActwe Planiew ‘i :""
| S ot

==

FZXS View (8) =131

FZ4Profile View (7)

A

I
& B[

& | ] =[5 aa] 5] A o] ] 4

& |+ =[S at] ] A o] ] 4

Step 6. Use the VCR buttons to scroll through the design, profile and cross sections.
Step 7. Dismiss the Port Viewer dialog box by pushing the “x” in the upper right hand corner.

Step 8. Exit MicroStation.
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CHAPTER 14

Earthwork

14.1 Introduction

Objectives

Learn the procedures for calculating earthwork quantities with GEOPAK
Learn how to use Project Manager to set up and process an earthwork run.

Project Manager

Earthwork

Menu Bar Application

None, except batch processing of an input file.

GEOPAK forms graphical earthwork shapes in a (MicroStation) cross section design file to represent
the end areas used to calculate volumes by the end-area method. These shapes are created when
the designer processes an earthwork run in which the existing ground, finished grade, base, etc. are
identified by level, color, weight and type.

14.2 Accessing

To access the necessary dialog boxes needed to create and process an earthwork run, select
Project Manager > Earthwork. Once the run is chosen or selected, the following dialog box

appears.

| & Earthwrork - MAINLINE LoD

Hiles

%5 DGM File
Soil Types
Ew Shapes
Cutput Format
Add/Sub Val
Centroid Adj
Skip Areas
Sheet Quant,

The left side of the dialog box contains the list of parameters required to compute earthwork. When
each parameter is selected, the dialog box changes the key-in fields to reflect the selection. For
example, when EW Shapes is selected, the dialog box changes as illustrated below.

Hiles

<5 DGEM File ¥ Draw Earttwork Shapes
Soil Types
E' Shapes ;

Output Format |
4dd/5ub Vol
Centroid Adj
Skip Areas ¥ Stratify Shape Colar

Sheet Quant,

- Parameters

GEOPAK 2004 Edition
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14.3 Earthwork Dialog Box

In XS DGN File the user can specify the file hame in which to find the cross-sections. Tolerance
specifies the maximum distances between two elements (in a cross section) to be considered as
adjoining. Vertical Search Distance specifies the distance above and below the cross-section to
look for elements pertaining to that cross-section. Baseline specifies the GEOPAK COGO chain the

cross-sections are based from. Begin/End Station specifies the beginning and ending stations to
perform the earthwork calculations.

!

As noted in section 12.1.1, it is important that the Tolerance value be set to 0.01 to
ensure proper cross section and earthwork processing.

SemimocwanNe o AEE|

Hiles

S DIGM File ®S DGM File | d17682xsmainling. dgn Select I

Soil Types

E'/ Shapes Tolerance I 0.0 0000

Dutput Format Vertical Search Distance [ 200.00

AddsSub ol By

Centroid Adj Baseline I hAAIMLIME

Skip Areas : .

Sheet Quant, Begin Station | 200+00.00 R
End Station I 220+00.00 R 1

The Soil Types dialog box requires the user to define the symbology and shrinkage/swell factors to

be used.

Soil Types

| 2 Earthwork - MAINLINE I
Fles
S DGN File Soil Type ltems [

E'w Shapes Er:lstin Unzuitablel
DOutput Format Esigting Unzuitable
Add/Sub Vol Propozed Finizh Grade
Centroid Adj Ewcavation Limit
Skip Areas
2hoe Hoant r Search Criteria
Class [Eietig Brodnd I W UsewWarking dlignment Definition
Soil Type | Earth MLy Names -J
r Multiplication Factars —————— [Z] Lv Mumbers: 1 :1
Roadway Excavation I 1.000000 ~ Colors: 1 =
_— = Styles: 2 [
Subszail Exzavation I 1. 000000 e Weights: & .
Fil [Tooooon || | P Types: 3 =
l Dizplay I tagt _l
Add | Delete | Modify |
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The user must first select the Class of the soil type, displayed in the

exploded view below and detailed in the table. ' Exsting Suitable

Existing Ground

Proposed Finish Grade

Existing Suitable

Existing Unsuitable

Proposed Undercut

Excavation Limit

Enisting Unzuitable
Propozed Finizh Grade
Propozed Undercut
E=cavation Limit

Identifies the surface of the existing ground. This classification is required to
calculate earthwork. It also defines the default excavation material.

Surface of the proposed roadway. This classification is required to calculate
earthwork and defines the default fill material.

Material between excavation limits that is to be removed only when it
encroaches on the proposed design. For example, if the proposed design is in
fill, therefore above the existing suitable, it is not removed.

Material between excavation limits that is to be removed in all circumstances.

Proposed layers that are not part of the finish grade, i.e. pavement layers,
shoulder layers.

Pairs of vertical lines drawn in the cross-sections to demarcate the limits of
removal for any existing suitable or unsuitable material. Can also be used to
isolate earthwork computations between any pair of lines

Once the Classification is chosen, a Soil Type, the element symbology of the material, and the
shrinkage/swell factors need to be entered. A Classification, except Existing Ground, can be listed
multiple times. The Soil Type determines how the cut and fill are calculated. For example, a user
creates an earthwork run with a classification of Existing Ground with a soil type of Existing,
classification of Proposed Finish Grade with a soil type of Suitable_Grading, and a classification of
Proposed Undercut with a soil type of Pavement. The output from the run would look as follows.

Material Name
Station

287+00
SUITABLE_GRADING
Excavation

Fill

EXISTING
Excavation

Fill

End Areas Unadjusted Adjusted Mult Mass
Volumes Volumes Factor Ordinate

(square (cubic (cubic

) ) )

0.00 0 0 1.00
12.32 336 336 1.00 2887
25.88 654 654 1.00

0.00 0 0 1.00 3541

In the same example, if both classifications of Existing Ground and Proposed Finish Grade had the
soil type of Suitable_Grading, then the output would look as follows.

Material Name
Station

287+00
SUITABLE_GRADING
Excavation

Fill

End Areas Unadjusted Adjusted Mult Mass
Volumes Volumes Factor Ordinate
(square (cubic (cubic
) ft) ft)
25.88 654 654 1.00
12.32 336 336 1.00 3541

GEOPAK 2004 Edition
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As can be seen from the above examples, when the soil types for the Existing Ground and Proposed
Finish Grade classifications were named differently, both soil types appeared in the output. When the
soil types for the Existing Ground and Proposed Finish Grade classifications were named the same,
the quantities for each classification were combined into one soil type. By paying close attention to
the soil types, the user can specify when material can be re-used and exactly where a specific soil
type should be placed.

Once the Classification and Soil Type are chosen, the user can select the Element Symbology to
define that particular Soil Type and the Multiplication Factors for the Soil Type. The Match button
can be used to select the Element Symbology. Once the Match button is selected, the user can
select the elements in the MicroStation view. The symbology of that element will be added to the
symbology list used to define the Soil Type.

EW Shapes enables the earthwork shapes to be drawn and the associated symbology. The colors
of the earthwork shapes can be stratified, so that cut and fill or each soil type is different.

| £ Earthwork - MAINLINE |

Hiles

<5 DGEM File ¥ Draw Earttwork Shapes
Soil Types

E'w Shapes

Output Format |

4dd/5ub Vol
Centroid Adj
Skip Areas ¥ Stratify Shape Colar
Sheet Quant,

- Parameters
dpes 5

Output Format enables the user to specify any additional columns for the report in addition to what
combination of earthwork classifications to show in the earthwork report. Users also can control the
number of decimal places for end area calculations. Calc Only Between Exc. Limits instructs the
software to calculate quantities between each pair of excavation limits as defined in the soil types
category.

| & Earthwork - MAINLINE HEE
Fles
5 OGN File [T Accum &diust Wolume Colurn
Sail Types ™ Aceurn Unadiust Yolume Column
E'W Shapez

[T Calc Only Between Exc Limits

Output Format
4dd/Sub Val WV EndéreaDec Places | 1 I
Centroid Adj ]
Skip Areas E_Hcavation
Sheet Quant, Fil

= 2]

With this command, any combination of the three classifications of excavation volumes can be
formulated. For example, if the user desires to combine all three into an earthwork listing of simply
cut and fill, press the < or > arrows until the desired option is displayed. Options include:

e Common Exc, Subgrade Exc, Subsoil Exc, and Fill

e Excavation (Common and Subgrade), Subsoil Exc, and Fill
e Excavation (Common and Subsoil), Subgrade Exc, and Fill
e Excavation (Subgrade and Subsoil), Common Exc, and Fill
e Excavation (all types) and Fill

14-4 VDOT Road | Training
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Add/Sub Volumes allows the user to enter volumes to be added or subtracted from the total
earthwork calculated from the available sections. The user can specify whether to add excavation or
fill, the soil type, the station, and the volume to be added.

| £ Earthwork - MAINLINE !ﬁ[ﬂ
Hles

%S OGN File 7] Process &dd/Subbract Wolumes

Soil Tepes 7 :

E'w Shapes Clazs Sail Type Station Walume

Cutput Format

4 dd/Sub

Centroid Adj

Skip Areas

Sheet Quant,
Saill Type  Earth i E'w' Operation | Cammon Exc i Add I
Station | .&I
YVolume: | .Ml’.'_l

Centroid Adjustment - Earthwork volumes are calculated by averaging end areas and then
multiplying these averaged areas by the distance between two successive cross sections as
measured along the baseline. If the bulk of the cross section areas are located predominantly to
either the left or the right of the baseline, as in a detour, an error occurs in the volume calculations for
all non-tangential portions of the baseline. This error can be negligible or substantial depending on
the degree of baseline curvature as well as the degree to which cross section areas are offset about
the baseline.

These types of errors can be optionally accounted for via specification of the Centroid Adjustment.

(@ ook MANUNE MBI

Hiles

<5 DGHN File
Saill Tvpes
Ew Shapes
Output Forrmat
Add/Sub Vol

[T Centroid Adjustment

Centroid Adj
Skip fueas
Sheet Quant,

Skip Areas enable the user to specify an area in which to not calculate earthwork volumes.

| & Earthwork - MAINLINE !lﬂ
Eles
35 OGN File [T Process Skip Areas
Soil Tupes -
EWw Shapes Begin Sta End Sta
DOutput Format
AddsSub Vol
Centroid &dj
Skip Areas
Sheet Quant,
Begin Station |
End Station i
sdd | | Delete | | Modiy |
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Sheet Quantities allows a user to write an earthwork quantity file to be used when plotting the cross-
section sheets. The name of the ASCII file can be chosen or entered. The user then selects the
columns in which to place the quantity, the number of decimal places, the total column width, the soil
type, the earthwork operation, and the type of quantity. This information is written to the ASCII file,
and can be used to plot the quantities on the cross-section sheets.

| & Earthwork - MAINLINE !I:{
Hiles
%S DGM File ¥ Wiite Sheet Quantities File
Soil Types : S alact
EW Shapes ASCIH File [ earth.tat Seled I
Dutput Farmat Calurmn ij Decimal Places _D_l Total Quantity Length 10 I
Add/Sub Vol
Centroid Adj | Col. Soil Type E' Operation Quantity Type +- __I
Skip Areas 1 Earth Cornrmon Exc End &rea +
Sheet Guant. 1 Rootkdat Cut  Commaon Exc End Area +
1 Footkat_Fill  Cormon Exc End Area +
2 Earth Fill End frea +
E arth i Common Exc I End fuea | __+]
add | Delete | Modify |

From the Files menu, the Run option processes all parameters that have been set in the Earthwork
dialog box. The Save Settings option saves all information in the Earthwork dialog box to the
current run. The Export option saves the parameters in the Earthwork dialog box box as an ASCII
input file. The Exit option exits the Earthwork dialog box.

Save Settings

Export...
E it

After all necessary information has been entered, the user has two options. The preferred method of
running the earthwork is to select the Run option. The following dialog box appears and the user
may proceed by entering a log file name, choosing the Pause On Each Section option and then

selecting the Apply button. The second method is to export the information as an ASCII input file,
then use the Process Cross Sections tool.

R S |

" Log File

Lag File I [ ternp log

7| Pause On Each Section
O

The earthwork quantities are written to the bottom of the log file and can be reviewed in any standard

ASCII text editor. Therefore it is recommended that the user create a log file of a user-selected name
for printing or reviewing at a later time.
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LAB 14: Earthwork

14.1 Basic Earthwork Computations
Step 1. Execute C:\data\geo\VDOT\road1\LAB14.EXE.
Step 2. Open the MicroStation file: c:\data\geo\VDOT\road1\d17682xsmainline.dgn.

Step 3. Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 4. Click Earthwork from the Project Manager dialog box and create a new run named
MAINLINE. Open the new run.

| 22 Earthwork - MAINLINE [C]0] 1

Hles

%S DGEM File
Soil Tepes
E Shapes
Output Format
Add/Sub Vol
Centroid Adj
Skip Areas
Sheet Quant,

Step 5. Populate the XS DGN File section of the dialog box as shown below:

SemimocwanNe o AEE|

Hiles

S DIGM File ®S DGM File | d17682xsmainling. dgn Select I
Soil Types

E'/ Shapes Tolerance | 0.0 0000

Dutput Format Vertical Search Distance [ 200.00

AddsSub ol By

Centroid Adj Baseline | hAAIMLIME

Skip Areas : .

Sheet Quant, Begin Station | 200+00.00 R

End Station | 220+00.00 R 1
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Step 6. In the Soil Types section of the dialog box, create the following classifications and saoil
types utilizing the parameters detailed in the table below.
| £ Earthwork - MAINLINE _I
Fles
<5 DGH File | SolTipeltems |
Soil Types E sizting Ground
E'w Shapes E sizting Unsuitablel
DOutput Format Esigting Unzuitable
Add/Sub Vol Propozed Finizh Grade
Centroid Adj Ewcavation Limit
Skip Areas
2hoe Hoant r Search Criteria
Class [Eietig Brodnd l W UsewWarking dlignment Definition
Soil Type | Earth MLy Names -J
r Multiplication Factars —————— [Z] Lv Mumbers: 1 :|
Roadway Excavation I1,|:|I:||:||:||:||:| ~ Colors: 1
_ 7 Siyles: 2 [
Subszail Exzavation |1,|:||:||:|IZIEIEI I Wei:hetz: 5 j
Fil [Tooooon || | P Types: 3 =
I Dizplay I _l
Add | Delete | Modify |
Class Soil Type Search Criteria
Existing Ground Earth Working Alignment Definition
Proposed Finish Grade Earth Working Alignment Definition
Existing Unsuitable RootMat_Cut LV=29, WT=8, LC=0, CO=3, TYPE=Line
Existing Unsuitable RootMat_Fill LV=29, WT=8, LC=0, CO=7, TYPE=Line
Excavation Limit None LV=25, WT=0, LC=0, CO=55, TYPE=Line

You can manually define the symbologies using the settings in the Search Criteria portion
of the dialog box. When using these settings, there are also three additional buttons to
help you.

Match Prompts you to identify an element. Once you do, it will fill in the symbology
settings with the symbology of the identified element.

Display/Undisplay Highlights all elements in the design file matching the set symbology.

Reset Clears all symbology settings.
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Step 7. In the EW Shapes section of the dialog box, toggle on Draw Earthwork Shapes and
Stratify Shape Color. Double click the Parameters sample graphics box to access the
Set Features dialog box. Populate the Set Features dialog box with the parameters as
shown below then click OK.

| £ Earthwork - MAINLINE _|
Fles | GEOPAK Set Feature I
% OGN File V| Diaw Earthwork Shapes — Syrbioloay
Soil Tupes - Parameters Level [Lewvel 50 =]
E' Shapes | —— i.ﬁ
Output Farmat [ ‘ Colar. 1 =
add/Sub val Style: | 0 JEd |
Centroid &dj s =
Skip Areas ¥ Stratify Shape Color weight: | £ =
Sheet Quiart, Cancel |
Step 8. Change the Output Format as shown below.
| £ Earthwork - MAINLINE I
Fles
% DGH File [T Aecum &diust Yolume Calumn
Sail Types ™ Aceurn Unadiust Yolume Column
E'W Shapez

[T Calc Only Between Exc Limits

Dutput Format

4dd/Sub Val ¥ EndtreaDec Places 1 I
Centroid Adj
Skip Areas E_Hcavation
Shest Quant, Fil
A O

NOTE: Use the arrows (< or >) to change the format to Excavation and Fill.

Step 9. In the Sheet Quantities section, toggle on the Write Sheet Quantities File. Name the file
temp.txt. Add the following columns to the file with Decimal Places = 0 and Total
Quantity Length = 10:

Col. Soil Type EW Operation Quantity Type +/-
1 Earth Common Exc End Area +
1 RootMat_Cut Common Exc End Area +
1 RootMat_Fill Common Exc. End Area +
2 Earth Fill End Area +
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Step 10.

Step 11.
Step 12.

Step 13.

Step 14.

| & Earthwork - MAINLINE !I:{
Hiles
%S DGM File ¥ Wiite Sheet Quantities File
Soil Types : S alact
EW Shapes ASCIH File [ earth.tat Seled I
Dutput Farmat Column 1_] Decimal Places _DJ Total Quantity Length 10 I
Add/Sub Vol
Centraid Adj Col. Soil Tupe E' Dperation Quantity Type +/- __I
Skip Areas 1 Earth Cormmon Exc End &rea +
Sheet Guant. 1 Rootkdat Cut  Commaon Exc End Area +
1 Footkat_Fill  Cormon Exc End Area +
2 Earth Fill End frea +
E arth i Common Exc I End fuea | __+j
add | Delete | Modify |

Using the Files > Run pulldown, run the earthwork for the proposed cross sections.

Place your output into a log file as shown in the dialog box below and Pause on Each
Section.

g E arthwork [ x|
Log File
’7 LogFie | [eathlon

¥ Pause On Each Section

-

Review the file earth.log using the GEOPAK editor.

Exit the Earthwork dialog box and save your run.

Review your cross sections using XS Navigator. Notice that GEOPAK has placed shapes
onto your cross sections representative of the calculated earthwork areas. These shape
areas can be measured to verify earthwork areas if desired.

Exit MicroStation.
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CHAPTER 15

Cross Section Sheets

15.1 Introduction

Objectives Learn the procedures for laying out cross section sheets.
Project Manager Cross Section Sheets
Menu Bar Application None, except batch processing of an input file.

The GEOPAK sheet layout component provides an automated tool to draw cross section data in a
format suitable for producing hard-copy cross section construction drawings. The input includes
specifying sheet layout parameters as well as the graphic design file where the cross sections were
originally created by GEOPAK. The output is a MicroStation design file of the cross sections. Each
cross section is displayed as a reference file and labels such as baseline, station, offsets and
elevation are added. There are several advantages to using sheet input:

e The cross sections will be sorted in numeric order for the specified baseline.
e The cross sections will be spaced closer together.

e The original cross section file is left intact and any modifications to the cross sections will be
automatically displayed in the sheet file due to the use of reference files.

e The cross sections are placed into "sheet format" according to user specified criteria.

The parameters for each sheet are defined in a Sheet Library. In order to lay out sheets, a Sheet
Library must be attached to the current session. The name of the currently attached Sheet Library is
shown in the title bar. Sheet Libraries have an extension of xssl. An unlimited number of different
sheets can be stored within one library. When the user begins the sheet process, he selects the
desired sheet layout from the attached library, which loads the associated parameters.

If a different Sheet Library is needed, it can be attached via the menu items File > Sheet Library >
Attach. Detailed information on the set-up of the Sheet Library can be found in the online help
section entitled "Sheet Library Set-up."
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15.2 Accessing The Cross Section Sheet Layout Tool

The Cross Section Sheet tool can be accessed by selecting Applications > GEOPAK ROAD >
Cross Sections > Cross Section Sheet Composition. It can also be invoked from Project
Manager by clicking the Cross Section Sheets button or by selecting the Cross Section Sheet

Composition icon from the GEOPAK ROAD tool frame.

Once the Cross Section Sheet Composition tool is selected, the dialog below appears.

Hle

Active Cross Section Sheet: [«shast =] Layout Sheets |

5 DG File
Sheet DGH File

Sheet Dimenzions £ Cell
5 Search Criteria
Shest Stack Onentation
Sheet Stack Colurins
targing and Spacing
Station Labels

Offset Labels -]

#5 DGN File: | d17682xsmainline.dan
%5 Baseline: mm

Begin Station; W
End Station: W

i et |

Ql

5.2.1 File Menu

File > Sheet Library

TooL DESCRIPTION

New Create a new Sheet Library.

Attach Attach a Sheet Library.

Save Saves a Sheet Library.

Save As Save a Sheet Library as a new name.
File > Sheet

TooL DESCRIPTION

New Create a new Sheet in a Sheet Library.

Delete Delete a Sheet in a Sheet Library.

Copy Copy a Sheet in a Sheet Library.

Update Update a Sheet in a Sheet Library.
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File > Load V7 Input File

This option gives the user the ability to load an ASCII input file that was created in previous versions
of GEOPAK.

File > Save Settings

Saves all dialog settings in Project Manager.
File > Layout Sheets

Layout cross-sections into sheet format.

File > Exit

Exit the Cross Section Sheet Composition application.

15.3 Cross Section Sheets Dialog

The left side of the dialog contains the list of parameters required to compute earthwork. When each
parameter is selected, the dialog changes, as do the key-in fields to reflect the selected parameter.

XS DGN File — Tells the software where to locate the cross sections. The Chain and stationing will
be filled out automatically if defined via the project manager. By default, the software will find all
elements within the confines of the cross section cell.

FHle

&ctive Crosz Section Sheet, [sheet x| | Layout Sheets |

5 DG File
Sheet DGH File

Sheet Dimensions £ Cell
5 Search Criteria
Shest Stack Orientation
Sheet Stack Colurins
targing and Spacing
Station Labels

Offset Labels =]

#5 DGN File: | d17682xsmainline.dan _C_{:J
=5 Bageline: mm
Begin Station; W

End Station: W

e i el |
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Sheet DGN File - Specifies which file the cross section sheets will be placed in. Also allows you to
set the horizontal and vertical scale at which they are to be laid out and the coordinate location in the
MicroStation Design file at which the sheets will be placed. If Detach Existing Sheets before
Processing is toggled on, then all elements in the file are removed and existing reference files are
detached before processing.

FHle
&ctive Crosz Section Sheet, [sheet x| | Layout Sheets |

=5 DGN File “|  Sheet DGN File: [d17682xshest don Ql
Sheet DG File ] ; :

S heet Dimensions ¢ Cell Horizontal Scale: I 10.00

%5 Search Criteria Yertical Scale: |1EI.DD

Shest Stack Orientation

Sheet Stack Colurins Sheet Flacement Point

targing and Spacing : !—

Station Labels Lawier Left ¥ [mu]: | 10000 000000 P

Offset Labels ;j Lewer Left 'y frau): | 10000.000000

E | ¥ Detach Existing Sheets before Processing

E ; Attachment: | Al Sheets In Active Model -|

I :

sl !

Attachemnt: All Sheets In Active Model — All sheets are placed in the active model
One Sheet Per Model — Each sheet is placed in a separate model

One Sheet Per Model / Display All — Each sheet is placed in a separate model and
all sheet are attached to the active model

¥ Dietach Existing Shieets before Processing
b Al Sheets In Active Madel
One Sheet Per Model
Ore Sheet Per Model / Dizplay Al
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Sheet Dimensions/Cell — Sheet Dimensions defines the Sheet Height and Sheet Width to be used
for the cross section sheet. When Place Sheet Cell is toggled on, the application will place a sheet
border cell from the specified cell library. A scale can be applied and the sheet cells can be placed
as Shared Cells. Sheet Offset from Cell Origin is the X and Y offset from the sheet border cell

origin.

Sheet Dime

5 Search Criteria
Shest Stack Orientation

Sheet Stack Colurins

targing and Spacing

Station Labels

Offset Labels =]

£5 Cross Section Sheet Composition: VDOTENG xssl [_109] —|
FHle
&ctive Crosz Section Sheet, [sheet x| | Layout Sheets |
5 DGM File a| r SheetDimensions
Shest DN Fis width: [35.00 Height: [2300

¥ Place Sheet Cell

Library: | sheet2000,cel

Ql

Mame: |=zect

Scale |'I.DD

= Sheet Offset from Cell Origin

™| Place as Shared Cell

% Offset: [2.00 ¥ Offzet: [1.08 ' ﬂ]

r Sheet Cell Placement

Flace Sheet Cell in %5 Sheet File "I

There are two options for Sheet Cell Placement. The sheet border cell can be placed in the sheet
file with the cross section reference files as shown above. It can also be placed once in a reference
file then the sheet cell file is attached to the file that contains the cross section reference files as
many times as it is needed. This option is shown below.

 Sheet Cell Placement

Place Sheet Cell Once in a Refersnce Fila

|

Sheet Cell Reference File:

| #sborder.dgn

al

GEOPAK 2004 Edition
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XS Search Criteria — Indicates the search criteria (symbology) for the data to be used as input to the
sheet layout software. If you need to look farther than that (i.e. outside of the cell), you can use the
Lower and Upper Range Limit values to extend beyond the cell limits. The Horizontal Search will
look outside the limits of the Sheet Dimensions.

Cmas Section Sheet Composition: VDOTENG xssl —I

FHle
&ctive Crosz Section Sheet, [sheet x| | Layout Sheets |
5 DGM File - r ®5 Element Search Criteria
Sheet DGM File I Ly Mames [ (@
Sheet Dimensions £ Cell =
h ¥ Ly Numbers: [1-13 _CI_]
Sheet Stack Orientation B sz [ J
Sheet Stack Coluring - i |
t arging and Spacing s __I
Station Labelz | | J
Offzet Label: ;J r — _l

tatch | Diizplay | Reset

~ Wertical Range
5 ULigy = ?; ' Lower Limit: [0.00
it ‘ Upper Limit: [000

Sheet Stack Orientation — Determines whether you want the sheets to be stacked vertically or
horizontally. Also allows you to set the maximum number of sheets you want placed per column in
the file as well as the Horizontal and Vertical spacing between sheets.

Cmsﬁ Section Sheet Composition: VDOTENG xss! 1

Hie
Active Cross Section Sheet: [«shast =] Layout Sheets |
?ﬁ DGSGF;JEF] 2~ Sheet Stack Orientation; | VYertical 'i
et e i .
Sheet Dimersions / Call Hornzontal Spacing: | 2300
5 Search Criteria Wertical Spacing: |35.DD

nicptaten MHumber of Sheets per Column; | i

Shest Stack Colurits

targing and Spacing

Station Labels

Offset Labels -]
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Sheet Stack Columns — Determines whether you want a single stack or a double stack of cross
sections per sheet. Baseline X Offset defines the distance from the left-hand edge of the sheet to the
zero offset position (i.e. baseline) of the cross sections. If you select Double Stack, you can give an
offset value, which is the distance of the second stack from the left hand edge of the sheet. There
are also options for Triple and Quadruple stacking.

- Section Sheet Composition: VDOTENG xssl —I

Sheet Dimensions £ Cell

5 Search Criteria

Shest Stack Orientation
alumins

targing and Spacing
Station Labels
Offzet Labels

® Single Stack
1 Double Stack
7 Triple Stack ol 3 Lt Edgs
) Quadruple Stack ©

FHle
&ctive Crosz Section Sheet, [sheet
=5 DIGN File -
Sheet DGM File

Bazaling x

x| | Layout Sheets |

Offzet: | 16.00

Margins and Spacing — Cross Section Clip Limits defines the clipping limits from the left hand edge
of the sheet. To the left of the Left Clip X Offset remains clear space and to the right of the Right Clip
X Offset remains clear space. All minimum spacing requirements as well as the maximum allowable
vertical size of any cross section is also set here.

=
Hie
Active Cross Section Sheet: [«shast =] Layout Sheets |
S DIGN File - - Crogs Section Clip Limits
Sheet DGN File 8 :
Shest Dimensions ¢ Cel Mirimum Spacing From Top: I 350
5 Search Criteria Miririum Spacing Fram Battar; | 1.50
Sheet Stack Onientation -
S het Stack Columps Left Clip ¥ Dffzet; i 1.00
I arging and Spacing Right Clip 5 Offzet: I .00
Station Labels
Offset Labels -]
tinimurn Spacing Between Sections: l 1.00
T i, 7ea Spacig T Wi Yertical Size: [B0.00

:_q: L8] |!.‘.:.,:

EI . L' Ll = é‘f
[ e Balfon Serc |

E é’l'mmxsspecmﬁ%i
W lEr IE: |
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Station Labels — Allows you to define the station label locations and plot parameters.

£5 Cross Section Sheet Composition: VDOTENG xssl

[ Cross Section Sheet Composition: VDOTENGxssl MBI |

FHle
&ctive Crosz Section Sheet, [sheet x| | Layout Sheets |

=5 DN File i ¥ Label Stations

Sheet DGH File

Sheet Dimenzions / Cell Flat Parameters: | E.es

5 Search Criteria

Sheet Stack Orientation ¥ Station Label ¥ Offset 1: I 16.00

Sheet Stack Colurins

targing and Spacing [l Stalion Label Diset 2 I 104

Station Labels
Offzet Labels

Station Label v Oifzet; i 0o

Offset Labels — Allows you to define the offset label positions, increments and plot parameters.

Hie

Cmsﬁ Section Sheet Composition: VDOTENG xss! 1

Active Cross Section Sheet: [«shast

=5 DGN File
Sheet DGN File
Sheet Dimenzions £ Cell

s

¥ Label Difsets

Flot Parameters; | b
5 Search Criteria
Shest Stack Orientation W Offsstlabely Offset1: [080
Shest Stack Colurits
targing and Spacing [ Difzest Label i Difset 2 I
Station Labels
Offset Increment [rmu) | 50,00

=] | Lapout Shests |

15-8 VDOT Road | Training
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Elevation Labels — Allows you to control the elevation label locations, increment and plot
parameters. Add Top Elevation Label - Activating this toggle adds another elevation label above the

current labels placed within the elevation labels parameters.

placed (one on each side of the section), the top elevation is added to both.

If two sets of elevations labels are

Add Bottom Elevation Label - Activating this toggle adds another elevation label below the single
label placed within the elevation labels parameters. If two sets of elevations labels are placed (one
on each side of the section), the bottom elevation is added to both.

Hie

Active Cross Section Sheet: [«shast

|

Sheet Stack Orientation
Sheet Stack Columns
targing and Spacing
Station Labels

Offzet Labels

E arthwwork, Quantity Labels
Sheet Labels
Diigital InkerPlot -

¥ Label Elevations
Flat Parameters: |
¥ Elevation Label % Offzet 1: [1.50
¥ Elevation Label ¥ Dffzet 22 [ 30,50
Eleatian |ncrerment [rmu): m_DD__

[ Add Top Elevation Label

[ &dd Battom Elevation Label

=] | Lapout Shests |

Earthwork Quantity Labels — The user can define the ASCII file that contains the earthwork quantity
information, as well as set the symbology and location of the earthwork quantity labels. This will use
the information gathered during the earthwork run to place the earthwork quantity labels on the cross

section sheets.

FHle

Sheet Stack Orientation ﬂ
Sheet Stack Colurins

Marging and Spacing

Station Labels

Offzet Labels

Elevation Labels

¢ Quantity Labels
Sheet Labels
Diigital InterPlot -

&ctive Crosz Section Sheet, [sheet

¥ Label Earthwork Quantities

x| | Layout Sheets |

E arthwork Cluantity File:

IO [¥0Offset_ |'vOffset | Display | Piat |
1 115 0.00 Sample
2 205 0.00

| earth bt

GEOPAK 2004 Edition
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Sheet Labels — Allows the placement of numerous labels. There are three sets of labels that can be

placed where the labels change from sheet to sheet.

These labels include Sheet Number, Begin

Station, and End Station. Any number of custom labels can also be placed. These labels would be
something that does not change from sheet to sheet such as Project Number, Designer, etc. A list of
labels can be created and each label can have it's on symbology. Location of the labels is controlled
by the DP Origin and DP Label Justification Point buttons. The DP Origin button locates the origin of
the sheet cell and the DP Label Justification Point button sets the X and Y Offset from the sheet cell

origin for the placement of the label.

FHle

&ctive Crosz Section Sheet, [sheet x| | Layout Sheets |
Sheet Stack Orientation |+ MNarne| Label # |3 Offset | ¥ Difsd Display | Flat |
SheeltStack Eolumns Pro, (0123012839, (1.9.  Sample E]
Margins and Spacing Proj.. | 0123-01.. 300.0.. |193. Sample
Station Labels Sh. 1 3164, 195 Sample e
Offzet lLabels BS. 1 52 |19,  Sample
Elevation Labels Rte... | 123 2831 198, Sample
E aithwiork Quantity L abels Beq.. |BeginS. 2554 1200 Sampls
Sheet Labels End.. | EndSta.. | 2554, (1200 Sample
! Ir _________ s - Name: [ Type: iSheetNumber 'I
: | I
v sreer pas | 1| % Difset: [0.000000 Y Offset: [0.000000 |
T i i
| e I DF Origin
o[ ; (| —I
i J _____ dl §
' : Label: |

Display: | Samals

Digital InterPlot — Allows the creation of the Digital InterPlot Plot Set during the Layout Sheets

process.

Hie

Active Cross Section Sheet: [«shast

|

Sheet Stack Orientation
Sheet Stack Columns
targing and Spacing
Station Labels

Offzet Labels

Elervation Labels

E arthwwork, Quantity Labels

¥ Create Digital InterPlot Plot Set

=] | Lapout Shests |

IP5 File: | C:\data\geohwdothroad] Suntitled.ips

QUE

! Sheet Type: | Cross Section

Open InterPlot Organizer |

=]

Sheet Labels
Ciigital [nkerPlot
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15.4 Generating Sheets

From the Files menu, the Layout Sheets option will process all [Pl rmie
parameters that have been set in the Cross Section Sheets dialog |[Hie

box. There is also a Layout Sheets button on the main dialog. Sheet Library r
Sheet r

Load V7 Input Fle.._
Save Settings

Layout Sheets
Exit
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LAB 15: Cross Section Sheets

15.1 Cross Section Sheet Layout
Step 1. Execute C:\data\geo\VDOT\road1\LAB15.EXE.
Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsmainline.dgn

Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 3. Select the Cross Section Sheets button from the Road Project: 17682.prj workflow
dialog box.

Step 4. Create a new run called MAINLINE.

Step 5. Select File > Sheet Library > Attach. Select C:\data\geo\VDOT\road1\VDOTENG.xssl
then click Open if the Windows File Open dialog is used or OK if the MicroStation File
Open dialog is used.

XS DGN File should already be populated with d17682xsmainline.dgn since this was set in the
Working Alignment definition of Project Manager.

| Section Sheet Composition: VDOTENG xss! I
Hie
&ctive Crosz Section Sheet, [sheet x| | Layout Sheets |

%5 DGN File
Sheet DGH File

Sheet Dimensions £ Cell
5 Search Criteria
Sheet Stack Orientation
Shest Stack Colurits
targing and Spacing
Station Labels

Offset Labels =]

#5 DGN File: | d17682xsmainline. dgn 3}
®5 Baseline; Mﬁm
Begin Station; W

End Station; W

_____________

We will be using “xsheet” as the sheet name for our Cross Section Sheet layout.
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Step 6.

Click Select Sheet DGN File and select the sheet design file d17682xsheet.dgn.

Toggle on “Detach Existing Sheets before Processing”.

FHle

Cmas Section Sheet Composition: VDOTENG xssl —I

5 DGN File -

Sheet DG File

Sheet Dimensions £ Cell

5 Search Criteria

Shest Stack Orientation

Sheet Stack Colurins

targing and Spacing

Station Labels

Offset Labels =]

&ctive Crosz Section Sheet, [sheet

Horizontal Scale: I 10.00

x| | Layout Sheets |
Ql

Sheet DGM File: | d17682xsheet dan

Yertical Scale: | 10.00

Sheet Flacement Point

Lawier Left ¥ [mu]: ! 10000000000 P
Lower Left ™y [mu]: | 10000.000000

@
[

e e e

¥ Detach Existing Sheets before Processing

Attachment: | All Sheets [n Active Model "l

Step 7.

Select Earthwork Quantity Labels. Click Select Earthwork Data File and select the

earth.txt file created in the previous chapter.

Hie

Cmas Section Sheet Composition: VDOTENG xss! 1

Active Cross Section Sheet: [«shast

Sheet Stack Orientation
Sheet Stack Columns
targing and Spacing
Station Labels
Offzet Labels
Elervation Labels

¢ Quantity Labels

Sheet Labels
Diigital InkerPlot -

.;' ¥ Label Earthwaork Quantities

=] | Lapout Shests |

ID_[¥Ofiset [ Offset | Displaw | Flot |
1 [115 0,00 Sample
2 |08 0.00

E arthwork, Quantity File:
| earth.tat

GEOPAK 2004 Edition
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Step 8.

Step 9.

Step 10.

Step 11.

Step 12.

Step 13.

Turn off level 50 then select File > Save Settings from the MicroStation pulldown menu.

Process the cross sections onto the sheets using either the File > Layout Sheets
pulldown or by clicking the Layout Sheets button on the Cross Section Sheet
Composition dialog box.

Dismiss the Cross Section Sheet Composition dialog box by pushing the “x” in the
upper right hand corner.

When prompted to Save Settings, click Yes.

When the Cross Section Sheet Layout process is completed, you will be in the sheet file.
Review your work.

Exit MicroStation.
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CHAPTER 16

XS Reports & Limits of Construction

16.1 XS Reports

Objectives Create various cross-section reports:

- for plan use (design elements and quantities)

- as input for other programs and/or applications of GEOPAK
- for construction layouts.

Create and draw construction limits in the plan view file.

Project Manager Reports and XS Quantities
Limits of Construction

Tools Cross Sedclions
o

=l

Menu Bar Application GEOPAK Road > Cross-sections > Cross-section Reports
GEOPAK Road > Cross-sections > Construction Limits

Llzer

The GEOPAK Cross-section Report Utility can extract up to sixteen
different reports from original and design cross-sections. For each report iBlue & Hed Top

generated, the user must set the parameters of the existing and/or design Bl ging |
cross-sections. GEOPAK also provides an option to make custom
headers for each of the reports via the User pull down menu. ﬂl

| DThinput |
16.1.1 Custom Header %{
HEC R&s |

From the XS Report dialog box, select User > Preferences. A Report Ruadisl Staking |
Header dialog box will appear with all options ghosted out. To activate the T |
individual fields simply toggle on the box next to the desired field. Once

you have completed the dialog box, the information will be saved as an Seedng |
.hdr file. This allows for the creation of a separate header for each type of Slope Stake |
report. The tolerance field determines the maximum gap allowed between GG |

cross-section elements.
W5PRO |
5 List |

[T Hilite
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gﬂepult Header [ x|

File

¥ Mumber Page

Tolerance IEI.D1 Qo000
Radiuz of Dizplay Circle: I 4.000000

[ Adijust Output File E stension Accarding to Fepart

16.1.2 Blue and Red Top

Based on the dialog box settings, GEOPAK determines the offset and elevation of a slope and its
breakpoints. Blue refers to the top of pavement and Red is the top of subgrade. The user must
determine this by indicating text and level, color, weight and style for each surface.

16.1.3 Clearing

The Clearing Report is useful for obtaining clearing and grubbing quantities. For each station,
GEOPAK will list the clearing distance on each side of the chain and the width of any exception. You
can obtain the results in the appropriate units. Toggle boxes for Cut Slope Rounding, Additional
Clearing in Cut and Fill, and Minimum Clearing Width are provided for increased control over the
output.

GEOPAK can also generate quantity sub-totals based on the value specified in Sub Every.

To use the Except Width option, you must have an existing ASCII file that includes the Beginning
and Ending Station and Exception Width.

Once everything is set, you can output the information to an ASCII file

16.1.4 Closure

The Closure Report provides information on the intersection point between the user defined
proposed finish grade and existing ground. In addition to the ASCII report, the designer may instruct
GEOPAK to close any gap either by drawing a vertical line between the endpoint of the proposed
finish element and the existing ground or extending the slope of the last proposed element to
intersect existing ground. The procedure will not extend existing ground. The Closure Report can
be accessed within any MicroStation cross-section file by selecting Closure from the main XS
Reports dialog box.

16.1.5 DTM Input

This process generates XYZ coordinates from cross-section elements and places this information
into an ASCII file for use by the DTM portion of GEOPAK. To use this dialog box simply enter the
.gpk job number, chain name and station range. GEOPAK will read the cross-section elements
based on level, weight, color and style.
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16.1.6 DTM Proposed 3D

This report is similar to DTM Input except that you can set both original and proposed cross-sections
at the same time. This report also differs in that it makes break lines across the cross-sections.

16.1.7 HEC -2

This process reads cross-section elements and formats the information in an ASCII text file suitable
for use in the HEC-2 hydraulic program.

16.1.8 HEC RAS

This process reads cross-section elements and formats the information in an ASCII text file suitable
for use in the HEC RAS hydraulic program.

16.1.9 Multi-Line

This report is useful in creating cross-sections for staged construction. Begin by entering the job
number, chain name and station limits. Primary cross-section element parameters must be
completed before secondary element parameters. This is important due to the order in which
GEOPAK reads the information. Once all the parameters have been entered, the new cross-sections
may be drawn to the design file or you may choose the display only option. An ASCII text file will be
generated.

16.1.10 Profile Grade

The Profile Grade Report is one of the most versatile reports available. It prints existing ground and
design grade elevations and low point elevations for each cross-section. Additionally, this report has
the ability to search either for the low points or any text string that you specify and create horizontal
and vertical alignments and store them directly into the .gpk. Horizontal alignments created from this
report will have no curves.

16.1.11 Radial Staking

The Radial Staking Report is a specialized report created for the U.S. Federal Highway
Administration (FHWA).

16.1.12 RT 40

The RT 40 Report produces RDS based RT40 data. To use this dialog box simply fill in the job chain
name, stationing range and the parameters of the cross-section elements you wish to use.

16.1.13 Seeding
Other than the usual entries, the user must enter the parameters of the elements to be seeded.

This dialog box includes slope and subtotal options as well as a way to limit the number of segments
read (By-Pass Segments). The user may also establish additional seeding specifications
(Additional Distance).
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Once all of the settings are complete, the report will produce seed or sod quantities written to an
ASCII output file for use in plan quantities.

16.1.14 Slope Stake

The Slope Stake Report is a special format report developed for the FHWA. This report generates
offsets, elevations and superelevation information for each cross-section. To generate this report fill
in the usual cross-section parameters plus Subgrade and Hub Staking information. When complete,
push Apply and the report is written into an ASCI| file.

16.1.15 Staking Detail

The Staking Detail Report determines the tie down point between the proposed finished grade and
the existing ground. GEOPAK will list the right and left offset, elevation, and slope of the finish grade
and superelevation rate for each cross-section. To create this report, fill in the project information
and desired cross-section elements’ parameters. Once complete, you have the choice between two
formats, a FHWA ASCII report or a Montana DOT report (includes ditch elevations).

16.1.16 WSPRO

This report takes the cross-section elements and turns them into an ASCII file for use as input in the
WSPRO hydraulic analysis program.

16.1.17 XS List

This report creates a listing of elevations and offsets for each cross-section element according to
user-defined parameters. You have the option of creating either an original cross-section list or a
design cross-section list. These reports are very similar to RDS cross-section lists.
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16.2 Limits of Construction

Project Manager Limits of Construction. Note a run must be created.

Tools Cross Sections

...\..II =

=

Menu Bar Application GEOPAK Road > Cross-sections > Cross-section Reports

GEOPAK Road > Cross-sections > Construction Limits

When the Limits of Construction dialog box in invoked,
the Limits of Construction dialog box opens.

The user must specify the Job number, the chain name, and
the file containing the plan view information. The Existing
Ground and the Proposed Finish Grade sections should
be filled by the run if Project Manager is utilized.

The Parameters button opens the dialog box below. The
symbology for the cut, fill, and transition construction limits
can be set in this dialog box.

r Cut = Fill ~ Tranzition —‘

"] Place Construction Limit | Offset From CL VI
Parameters I

Job I 101 CurSta  200+00.008 1
Chain |M.~’-‘n.INLINE j Tolerance iD.?EDEIEI[
BegSta  200+00.00F 1 | 200+00.00 R 1
EndSta  220+00.00F 1 [220+00.00 R 1
Plan Dgn | d17682des.dgn Filers I

Existing Ground Line 1«@“.] Diizplay |

Proposed Finish Grade e *"l Diispilay |
Parameters | Radius of Display [5.000000
Tie Dovan Option - All Tie Downs 'I
Apply i |

The Place Construction Limit toggle allows the user to place various text strings along the
construction limits. Selecting the Parameters button, and making the desired changes in the dialog
box shown on the next page will set the symbology for these text strings.

™| Place Constuction Limit

Elewation
Depth From CL
Prefiss/Suffix

The Radius of Display field is the size of the display circle when GEOPAK is scanning the cross-

sections.

GEOPAK 2004 Edition
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The last option in the main Limits of Construction dialog box is the Tie Down Option. There are
two Tie Down Options. If the All Tie Down option is set, all tie downs within a section are plotted.
(I.e. wide medians, outer roadways, ramps, etc. may have tie downs in between the limits of the main
roadway, and the outer roadway or ramp.) If the Outer Tie Down option is selected, then only the

outmost tie downs are plotted.

Cut Prefix i Suiffi i
Fill Frefis I Suiffi |

Left |

&

H@ht| ¢

RT Orientation | Relative ¥ ’D.DDDDD[

LT Orientation | Relative V! !_D.D_DDDD[
RT Offzet l1D.DDDD[ LT Offzet |‘ID.DDDD[

Cancel |

Once the Apply button is clicked, the limits of construction and the optional text are drawn into the
plan view file at the specified symbology.
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LAB 16:

Cross-section Reports,Driveway Profiles, and
Limits of Construction

16.1 Cross-section Reports

Step 1.
Step 2.
Step 3.
Step 4.

Step 5.

Step 6.

Co—

Execute C:\data\geo\VDOT\road 1\LAB16.EXE.

Open c:\data\geo\vdot\road1\d17682xsmainline.dgn.

Access Project Manager.

Select Reports and XS Quantities.

From the XS Reports dialog box; select the User > Preferences

dialog box.

L1olx]

Clearing I r
Closure | I
DTH Input |
DTk Prop 3D |
HEC-2 I

ucr Dac I

! Mumber Page

Tolerance I 0,007 000

R adius of Display Circle; I 4, 000000

™| &djust Dutput File Extension According to Report

Set the tolerance to .001.

Dismiss the Report Header dialog box.

From the XS Reports dialog box, select the Profile Grade report.

User

fHiue & Fed Top!

Clearing |
Closure |
DT Input |
DT Prop 3D |
HEC-2 |
HEC R&S |
Multi-Line |
Prafile Grade |
Radial Staking |
RT40 |
Seeding |
Slope Stake |
Staking Detail |
WSPRO |
#5 List |

] Hiite

We are going to use this report to create a Chain and Profile along our left edge of shoulder. We'll
use this information later to help in the creation of our driveway profiles.

GEOPAK 2004 Edition
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Step 7. Fill out the Profile Grade dialog box as shown. The symbology settings for Existing
Ground Line and Proposed Finish Grade should be set correctly from the Working
Alignment Definition from Project Manager. To add the Text Search information to the
collection box, push the ADD button. (Store Text: EOSLOUT)
| & Profile Grade Report ![:l
File
Job [707 CurSta  Z00+0000R 1
Chain [MEINOINE | | =]
BegSta 200+00.00R 1 [Z00+00.00 R 1
EndSta  220+00.00F 1 [Zz0-0000F 1
Existing Ground Line ..mu_l Display |
Proposed Finish Grade “ﬁﬁ-\b_] Display |
Search Text 'I ™ Pause on Each XS
- Text
Tent | Chain | Prafile | Preference
eozlout eodl Tent Alig E!
X
Store Test: |eo_slcuut Sta Test Alignment VI
¥ Store Prof [eosl ¥ Stots Chain [eosl
Beginning Point Humber ! Da000
A5CN File [eos0T ivd File |
Apply 1
W Ly Mumbers: I'I | r- Lv Mumbers: I2 13
7 Colors; |1 1 7 Colors; |EI-255
I Styles: i2 [l i Styles: iEI."" [l
M weights [B fa ¥ weights: [0
Match I i Reset | Match I i Reset |
Step 8. Click Apply. After processing is complete, dismiss the Profile Grade Report dialog box.
Step 9. Access COGO.
Step 10.  Access COGO Navigator using the icon

e
i

or use the Tools > Navigator pulldown.
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Step 11.  Use the Chain option to see a list of the stored chains.

Notice EOSL has been stored.

Step 12. Use the Profile option to see a list of the stored
profiles. Notice EOSL has been stored

Step 13.  Exit COGO.

Step 14. From the XS Reports dialog box, select the DTM
Input report.

We’'ll use this report to create a proposed model (dtm) from our
cross-sections. We'll also use this information later in the creation
of our driveway profiles.

Step 15.  Fill out the DTM Input dialog box as shown and click
Apply.

Jab [0 Cur5ta 200+00.00 R 1

Chain [MAINCINE | | = |

Select Tools

| % ||
Element : | Chain Vi

Mamie | Feature |
EBL4E0 DEFAULT_CHAIN

| DEFAULT CHAIN
MAIMLINE | DEFAULT CHAIM
RaMP DEFALLT_CHAIM
REDBUD

(& Navigaiorio) M|

Select Tools
NEREIEER
Element : | Profils Vi

M areie: | Feature |
DITCHLT

EOSL |

tAaIMLINE

MLGROUMD

RabPa

BegSta  200+00.00F 1 | EEg
[Zz0onon R 1

EndSta  220+00.00F 1

X5 Elements

[T Pause on Each ¥5

Dizplan

&5C1 File | proposed.dat

Apply

E?Caﬂdde Hements !. E I
< _I

r- L Mumbers: I2 4

7 Colors; I 0-255

I Styles: [0-7 |
M weights [05
Match I Reset |

§ =ul

Note: The levels for XS Elements should only refer to 2-4. These are the levels that
make up the top of Finish Grade.

Note that in Step 15 we only created a .dat file. This is an ascii file that is used to create
the DTM. We’'ll create the dtm in the next section.

Step 16.

After processing is complete, dismiss the DTM Input dialog box.

Step 17.  Also dismiss the XS Reports dialog box.

GEOPAK 2004 Edition LAB 16: Cross-section Reports,Driveway Profiles, and Limits of Construction 16-9



GEOPAK®

16.2 Driveway Profiles

Step 1. Before beginning the process to create the driveway profiles, we’ll need to create the
proposed DTM.

Select the Existing Ground button from the Road Project: 17682.prj workflow dialog
box.

Step 2. Select the previously created run ‘groundl’ and press OK.

Step 3. Select the Build Triangles icon from the DTM Tool Palette.

DTH x|
Bl W
e
_,_Pufl T v
E’-]Builcl Triangles|
SEEFIT Pl
el
A2
Step 4. Fill out the Build Triangles dialog box as shown and click Process.
| £ Build Triangles I
Data File: | proposed.dat 3!
TIM File: | propased.tin E‘._I

Dizzolve Option: | Side "I
Side Length: ISD.DDDDDD

Step 5. Dismiss the Build Triangles dialog box. When prompted to save settings, push Yes.
Dismiss the DTM Tool Palette.

Step 6. Open the Microstation design file c:\data\geo\vdot\road1\d17682work.dgn.

Note that pattern lines have been placed at the driveway locations. These pattern lines
have the following symbology: LV=51, CO=2, WT=2.

Step 7. Open the Microstation design file c:\data\geo\vdot\road1\d17682driveways.dgn.

Step 8. Select the Existing Ground Cross-sections button from the Road Project: 17682.prj
workflow dialog box.

Create a new run ‘DRIVEWAY’ and click OK.
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Step 9. Fill out the dialog boxes as shown and click Draw.
_ Draw Cross Sections I _ Cross Sections I
Fle Edit Update Options Fle Hdit Update Options
Job Mumber: |1EI1 VI Chain: IM.-’-‘AINLINE vi Ciraw Job Mumber: [101 (x|  Chair: [MaINLINE — [=] Ciraw
" DF Origin ™| DP Origin
l Surfaces I 5 Cell | 1S l
r Pattern Type| Mame | Display Settings | Mathod
By DGH File TI TIMN  propozedtin Lv: Level 1, Coc 4, Les 0 3 Trangles EI

Deszign File: ! d17682work. dgn

:|I‘v'|51

Horizontal: | 1.000000
Wertical: I 1.000000

W Colos: 32—-_g] ¥ Line [ Line Sting
W Styles !D—‘_g] Match | Reset |
W weights 2 El Dizplay |

r Scale Spacing

Murnber of %5 by Colurnn: |4D

Horizontal: I 1000.00
Wertical: IEDD.EIEI

Lw: Level 1, Cor 1, Les 2% 5

TIN  zurvey.tin Triangles
X
- Details™

TIN File: | proposed.tin

Method: | Triangles I

~ Digplap Settings
By Level Symbolagy 'l |

23N I M EEE

4

al

Type: | Line VI
- Filter Tolerances

Huorizontal: W

Warlanoe: |_D“1-.EI-_

r Teut Settings — ;
[T Elevation | 12 [ vaid |

' Proposed Surface Symbology (lv =1, co=4, Ic=0, wt=3)
- Existing Surface Symbology (Ilv=1, co=1, lc=2, wt=5)
Step 10.  Dismiss the Draw Cross-sections dialog box and Save Settings.
' Review the ground lines drawn. Notice that the proposed ground line may not terminate

precisely on the existing ground. This is because elevations are being interpolated
. between proposed cross-sections.

You can tie this down manually or you can use the XS Reports > Closure Report.
Step 11.  Select the Proposed Cross-sections button from the Road Project: 17682.prj workflow

dialog box.

Create a new run ‘DRIVEWAY’ and click OK.

GEOPAK 2004 Edition
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Step 12.  Fill out the XS DGN File category as shown:
| £ Proposed Cross Sections - DRIVEWAY ![:l
Fles
=T #5 DGN File | d17582driveways.dan Files |
Ezisting Ground Tolerance [0100000
Shapes
Shape Clugters
Define DGEM Wariables
Define Yariables
Flot Paranneters _:j
Step 13.  Fill out the Pattern category as shown:
| 2 Proposed Cross Sections - DRIVEWAY HEE|
Hiles
425 OGN File a [T Use Warking Alignment Definition
:
Exizting Ground Ly OGN Fi
gEapesl:l Chair [MAINLINE Sslect |
t
DBEE: Dgie\iriables Horiz. Scale |1D Wert. Scale I 10
[refine Waniables DGM File [d17682work.dgn File |
Plot Parameters - Stk Critera
¥ Lv Mumbers: |51 1
Ird Colars: |2 [
E | =]
E ypes | [a|
Match | Displa_l,l | Resat |
Step 14.  Fill out the Existing Ground category as shown:
| 2 Proposed Cross Sections - DRIVEWAY |
FHles
425 OGN File a [T Use Warking Alignment Definition
Pattern : - :
Eisin Brourd [DGH File |d‘| FEAZ2driveways dan Filez |
Shapes - Search Criteria
Shape Clusters [T LeNames |
Define DGM Variables o
Define Waniables Ly Numbers, I 1
Plat Parameters hd W Calors; 'I
™ Syl |
O e |
I Tvpas: | _I
td atch | Diizplay J Reset |
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Step 15.

Step 16.

Fill out the Shapes category as shown:

£5 Proposed Cross Sections - DRIVEWAY HEE I
Eles
S DGM File - [T Use Working Alignment Definition
Fattem I
Esizting Ground SHapeisss

S hapes

Shape Clusters

Defire DGEN Variables
Define Variables

Flot Parameters _:j

Under the Shape Clusters category, add the Mainline chain and profile to the list box as

was done in previous exercises.

#5 Proposed Cross Sections - DRIVEWAY [_ 1] %] |
Hles
i |
5 DGM File - S .
Patterm _'f_y_EEau
Exizting Ground Thick I

Chain [MAINL| | Tie IlD.DDDDI Frof [ MAINLI ﬁelectl

Define Variables
Plot Pararmeters - Add M odify | Delete_l Up J Diwwn |
~ Side Slope Condition
Define | Madily | Dalgle | Jp | |
r Criteria File
M ame | Description I
i | Cisle | | |

GEOPAK 2004 Edition
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Step 17.

Press the Typical button to access the Typical Section Generator.

Select the Typical ENTR and press Apply.

i- Typical Sections i

BT ERY

Cell Description Job Mumber: 101
DRRNLU NEW LT RECOM RT LILT DES [«] [ Template _ :
DRROW DRA&W RIGHT OF waY LOCATIONS Template Designed to "Work with: Mo Shape Clusters

ExFEAT
ExPYIMT
ROOTMT
UNFYT
UNPYTL
URCST
URCSTL

ENTRANCES |
EXISTING FEATURES

Description !

DRAW EXISTING PAVEMENT

- Range
ROOT MAT

UNDIMIDED MEW PAVEMENT
UNDIMIDED LOCAL MEW PyiT
UNDIMIDED RECOMSTRUCTION
UNDIMIDED LOCAL RECOM

Apply towhale Chain "!

Step 18.

NOTE: Press the Description button and review the documentation.

Your dialog box should fill out automatically and look like the following:

Shape Clusters
Defire DGEN Variables
Define Variablesz

Plat Parameters

Add | [ Maodiiy | [ Delete | | Up |

__Hles
- Chain Tie/FGL Profile |
=5 DGM Fil = = =l -
St JNLINE D Typical |
Exizting Ground Thick !
Shapes

Chain [MAINLT | Tie ] | 000001 Prof [MAINLI | Select !

Do !

- Side Slope Condition

RT
Define ! hd odify I Delete ] Up l Dovan I
r Criteria File
M arne | Description 1
enfrance.x
Add ] Delete _] Up ] D ety
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Step 19.  Select the Define Variables category. Modify the following variables as shown:

Name of Working File d17682work.dgn
Name of Cross-Section File d17682driveways.dgn
Lt Ent Take-Off Align Name EOSL

Step 20.  Select the Plot Parameters category. Double click the sample graphics box under XS
Lines. Setthe symbology as below then click OK.

£ Proposad Cross Sections - DRIVEWAY [ [O1] x] I

i | GEOPAK Set Feature |
- - %5 Lines

5 DBN Fils - —— _—
F'a.ttgrn Level |Lewel 2 >
Exizting Ground
Shapes - Teut _ — Color: [T O ~1
Shape Clusters I Line Text | Saiyte Style: i 0 'I
Define DGM Wanables ; e . I_—_I
Define Variables I Station Text | i Weight i =
Plat Parameters ™ Baseline Marms Test | Sande TR Cancel l

Step 21.  Under the Text section, ensure that Line Text, Station Text, and Baseline Name Text
are toggled off.

Step 22. Toggle off all the options in the Plot section. The dialog box should appear as below.

& Proposed Cross Seclions - DRIVEWAY [_ToTx] |
Fles
- - #5 Lines

ot = [me|

Pattern

Existing Ground ST

Shapes .

Shape Clusters ™ Line Text | Saiire

Define DGN Vanables ; I

Define Variables I Station Text | Sancra
[ Baseling Name Text Savre

1
]
=1

Pavement Thickness 110
Fill Gaps Betwesn Clusters
Transition Definition ___I
Intersect between Clusters
Process Clugters ag Indicated

Remove Skewed Effect

o o e i o

Frocess Only Sections With Existing Ground

At this point we are ready to process the DRIVEWAY cross-sections.
Step 23.  Click Files > Save Settings then click Files > Run.

Step 24. When processing is complete, click Exit to return to the Process Cross-sections dialog
box.

Step 25. Close the Proposed Cross-sections dialog box by using the “X” on the upper right of the
dialog box or by using the Files > Exit pulldown.

When prompted to Save Settings, answer Yes.

Step 26.  Use Cross-section Navigator to review the cross-sections.
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16.3 Plan View Limits of Construction

Step 1.

Step 2.
MAINLINE.

Step 3.

Job 10

Beg Sta
End Sta

200+00.00 R 1
220+00.00 R 1

Cur Sta

Chain [MAINONE | |+ |

200+00.00F 1

Tolerance I 0.750000

|200+00.00 R 1
| 220+00.00 R 1

Plan Dgn | d17682des.don

Files I

Existing Ground Line _xﬁ;‘h_j Display |
Propozed Finish Grade l'"‘. ) JI Display |
Parameters | Radius of Display [5.000000

Tie Dowvan Option MM
E ppy |

Open the Microstation design file c:\data\geo\vdot\road1\d17682xsmainline.dgn.

From the Road workflow dialog box, select Limits of Construction. Create a run called

Populate the Limits of Construction dialog box as shown:

8 P i e MBI
M Ledames [ J
M LvMumbers: [25 _|:|J
i Colors: rEI“2_575-— E.I
ird Stles: [06 Ej
W wiheighta; I|:I15— El
Match | {Displap Reset I

§ =ul

NOTE: The Existing Ground Line symbology should be OK since it was set in the
Working Alignment Definition in Project Manager but the Proposed Finish Grade

symbology will need to be set as shown above.

Step 4.

Click the Parameters button to open the Plot Parameters dialog box. To access each of

the Set Feature dialog boxes, double click on the sample graphics box in each section.
Populate as shown:

Cut

Cut Fill

Tranzition —‘

Parameters I

[T Place Construction Limit | Offset From CL VI

Cancel |

Fill

Transition

| GEOPAK Set Feature I | GEOPAK Set Feature I | GEOPAK Set Feature I

~ Sumbology r Sembology ~ Sumbology
Level |Level 22 ] Level |Level 22 =] Level: [Level 22 ]
Color: [ 2 ] Coor M3 =] Color: [T 4 ]
Style: |------ A B | Stle: [——— 3 [Ed Stle: |—-—-—- 4 B |
W aight; | — ] igight; | m— =] W aight; | — ]
Cancel I Cancel Cancel I
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Step 5. Click OK to close the Plot Parameters dialog box.
Step 6. Click Apply to process the Limits of Construction.

Step 7. Exit the Limits of Construction dialog box and Save Settings. Review the limits of
construction in c:\data\geo\vdot\road1\d17682des.dgn.

Since GEOPAK does not create the Limits of Construction exactly like VDOT would like to see them,
we will use a special application to update them to the correct symbology.

Step 8. From the Road workflow dialog box, select Plan View Design.
Step 9. From the Plan View Design tool palette, select D&C Manager.
Step 10.  Navigate to the category Road Design > Special Applications.
Step 11. Important! Make sure that all of your Limits of Construction are shown in View 1.
Step 12.  Within this category, double-click on the item Update LOC.
Step 13. At the following prompt, click OK.
pompt |

AlIL.O.C. must be displayed in View before processing!

Caticel I

Step 14.  Enter the Job Number as shown and click OK.

Enter GEOPAK Job Mumber:
(101

Canicel I
Step 15.  Enter the baseline name as shown and click OK.

Enter Bazeline Mame:
| MAINLINE

Cancel I
Step 16.  Set the units to English as shown and press OK.

Select Units:
English |

Canicel I
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Step 17.  Set the scale as shown and click OK.

Select Scale
2 -|

Canicel I

Step 18.  Dismiss D&C Manager and review the changes made to the Limits of Construction.

Step 19.  Exit MicroStation.
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CHAPTER 17

Labeling

17.1 Introduction

Objectives

Learn how to label plan information with Plan View Labeler.

Familiarize the user with the Cross Section Labeler.

Project Manager

Plan View Design

Tools

4 i

Plans Preparation

a1 A x| B ] B

Menu Bar Application

GEOPAK Road > Plans Preparation > Plan View Labeling
GEOPAK Road > Plans Preparation > Profile Labeling
GEOPAK Road > Cross Sections > Labeling

17.2 Plan View Labeling

GEOPAK's labeling tools allow a user to place “smart” labels in a MicroStation drawing. These labels
have the ability to calculate XYZ coordinates, station, offset, direction, length, radius, degree of
curvature, etc. of the associated element. When the Plan View Labeling icon is selected, the dialog

box depicted below is displayed.

- Plan View Labeler - Style: . \geopaki\wdot Isf > Unnamed Style
_ Style Fles Options Scale Tools

Text

Job No.: [101 al

Element:  Point

Chain: [MAINLNE =]
TIM File: | &|

Label Feature

¥ f |

—— L
e

| Params. | Shape || Leader | Rotate || Styles |

® Computed Inzerts ) User Inzerts

Computed Test

% Coordinate -
" Coordinate
Z Elevation GFK

2 Elevation TIM

= Elewation Modeler

Station

Fartial Station _:j

Mot Available

Space | Return |
Clear | Drelimit |
Place Label I

The label to be placed is displayed in the box on the right side of the dialog box as shown above.
The Space button places a space in the label at the cursor position. The Return button starts a new
line of text. The Clear button starts a new label. The Delimit button places a line above or below a
line of text. The Place Label button attaches the label to the cursor for placement in the drawing.

The user can select the various tabs to define / modify the label appearance.

GEOPAK 2004 Edition
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17.2.2 Params.

_ Style Fles Options Scale Tools

£5 Plan View Labeler - Style: . \geopak\vdot Isf > StaOff - Active

Text | }

I Shape | Leader | Rotate | Styles |

Sample Dutput

Sta 39+828.579

Off 19.649 RT

- Text Preferences 7 Symbalagy
Height r2"ﬁIZ_IEI_ .Jiftificat.inn: —
Wwidthe [2000 | = .o
Line Sp: [Zooo | (5
Font, [ 3font003 |
Lewvel: m
Color: i. 3 vi
Weight: m
e =

Sta 394828 .57

D e ldemedetee

0ff 19.64% RT

Space | Return |
Clear | Drelimit |
Place Label |

The Parameters tab enables the user set up the text size and symbology for the label.

By Current sets the symbology to the current MicroStation settings. By Element allows the user to
set the symbology by choosing a MicroStation element. Set All sets the symbology for all elements
in the label (text, delimiters, leader lines, etc.).

By Current
=

By Element

9]

D & C Symbology

&

Set All
i

After pressing this button, GEOPAK determines the active
MicroStation symbology (level, weight, color and style) and
populates the dialog.

After pressing this button, GEOPAK prompts to select a
previously drawn MicroStation element, and populates the dialog
with its element symbology.

Pressing this button invokes the Design and Computation
Manager, wherein the desired item may be selected. By double
clicking on an Item, the associated element symbology within the
Design and Computation Manager is applied to the Labeling
dialog.

GEOPAK reads the current settings (level, weight, color and
style) within the dialog, and populates the Parameter, Shape and
Leader dialogs.

GEOPAK 2004 Edition
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17.2.3 Shape
Tewt | Params. | Shape | Leader | Rotate | Styles | ?Efdfszff;iif;t___
r Shape Preferences S ample Output Qff 19 649 RT
o | o] @ ®|
e r“T:,ﬁ_ [Sta 39+828, 572] Space | [ Reum |
Level: [Leveld =1 Off 19.649 RT Clear | Delimit |
Calar: !. a ~] T |
Place Label |
Style: ] bl RN e
Weight: | 2 B3| b= f

The Shape tab allows the user to place a shape around the label, and set the symbology for the
shape.

17.2.4 Leader

i ; Sta 39+828.572:
Te:-tt| Params. | Shape | Le i R S

r Leader Type Terminatar ———— Sample Output QOff 19 549 BT
w1 |
2]« =]

| Rotate | Styles I

- Symbology Gt 39+828.572 Space | | Retum |
bevel fLegvel = Off 19.649 RT tlear | BE |
Color; |. 3 I — =
Shyle: [—_J _.JL?J Place Label I

Weight [—— 2 =] ] =9

The Leader tab allows the user to attach a leader from the label to the point. Different leader types
and terminators can be chosen. The active terminator can also be used.
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17.2.5 Rotate

- Plan View Labeler - Style:
Style Fles Options Scale Tools

_Ageopalkwdot Isf > StaOff - Active

Test || Params. | Shape | Leader | T

g | Styles |
Sample Output

~ Text Angle

B85 Curent Angle;  [0.000

;@l'! Element Angle ‘@ @I

I\_ai Alignment Angle: ! (AL ;I

Sty 39+828.572
Off 19.649 RT

SetAngle By
[ oF |

Element I

ad | ‘

|
Sta 39+820 572

D e ldemedetee
Off 19 649 RT

Space | Return |
Clear | Drelimit |
Place Label |

The Rotate tab allows the label to be rotated.

The rotation can be determined from the current

angle, the angle of the element, or the alignment angle. The angle can also be set by two data points
(first data point set the location, next data point sets the angle) or the active angle.

17.2.6 Styles

Item Selector

[ Labels
1 Line Labels
3 Arc Labels
[=r Paint Labels
[A] MEStaBox
[A] Sta0iff

[ StaOffEleTIN

Update Style... |

Scale:1.00

5|

Style Praview

Sta 39+EE8.572
Off 1%.64% RT

Hode and Shape Only 'I

|
Sta 39+820 572

D e ldemedetee
Off 19 649 RT

Space | Return |
tlear | BE |
Place Label I

The Styles tab allows a user to choose label symbology from a library of pre-defined styles. When
the user chooses the style, all symbology, leaders, shapes, etc. is set up for the user.
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17.2.1 Text

For data to be computed, the job number and the chain need to be selected. If elevations are to be
calculated, a TIN file needs to be chosen.

The Computed Inserts are items that Geopak has the ability to calculate for the chosen item. The
list of Computed Inserts changes with the type of element that is chosen. If a line is chosen, the list
of Computed Inserts will show inserts of bearing, and length. If a curve is chosen the list of
Computed Inserts will change to show inserts of radius, curvature, chord length, etc.

The User Inserts are inserts that a user may use on a regular basis. This list can be customized for
a specific user’s needs.

There are several methods allowing the user to choose the element to use for calculations in the
label.

Select GEOPAK or The icon to allows the user to identify either for labeling.
MicroStation Element

®

3

ek

Data Point Location Selects a location in the design file that may or may not be
associated with an element.

+

2 GPK Point Line Selecting lines or points that have been visualized via COGO.
x/‘. "
3 GPK Point Arc Selection of visualized arcs and points

|4
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17.2.7 Menus

The Style Files menu allows the user to open a new style library. You must be under the Styles tab
in order to open a style library.

_|9Ty¥ﬁ_l&_s Options Scale Tools

AT

c\data\geo\wdot road T\standards\geopalkwdot Isf

In the Options menu, Minimize Dialog Box will minimize the dialog box when Place Label is
chosen. The Use Reference File Coordinates option uses the coordinates from the master plan
view file when placing a label in a plan sheet.

I—Q:_hor_m_ Scale Tools
Minimize Dialog

[V Use Reference File Coordinates
Use DP Hement Association
Label Teols
Label Viewer

Options > Label Tools invokes the tool frame shown below which enables the user to modify
Geopak labels.

Plan View Label Control

]
w2l zle] | mlE] + T 208w A

Options > Label Viewer brings up a dialog box that allows a user to view and place a label.

& Lo view B

Sta 39+E2B. 072
Off 12.64% RT

[ Flace Labal

The Scale > Change Scale menu allows the user to choose a plan scale. All labels will be adjusted
according to the plan scale. The user simply keys in a scale, and chooses a Labeling Style. The
corresponding label will be placed at the correct size for the scale that was chosen.

Current Scale  1.000

Mew Scale | 1.000

Cancel |
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17.3 Cross Section Labeling

The Cross Section Labeling dialog box differs from the Plan View Labeling dialog box only on the

text tab. Cross Section Labeling works with the Cross Section Navigator.

The current Cross

Section Navigator station is shown on the Text tab. The Computed and User Inserts contain
values and phrases related to cross-sections.

#5 Cross Section Labeler - Style: __ \geopak\vdat Isf > Unnamed Style

_ Style Fles Options Scale Tools

~ Mavigatar Station
200+00.00

| Params. | Shape || Leader | Rotate || Styles |

® Computed Inzerts ) User Inzerts

Computed Test
Flan View » Coordinate -

H A

~ Label Feature ———————

Flan Wiew v Coordinate
%5 Elevation

5 Elevation [l Units]
%5 Station

x5 Partial Station

%5 Offsel =]

Mot Available

Space | Return |
Clear | Drelimit |
Place Label |

17.4 Profile Labeling

The Profile Labeling dialog box differs from the Plan View Labeling dialog box only on the text tab.

The Chain and Profile must be defined, in addition to profile settings.

Inserts contain values and phrases related to profiles.

£ Profile Labeler - Style: .. \geopalk\wdot Isf -> Unnamed Style

_ Style Fles Options Scale Tools

The Computed and User

Job oz 701 ey

Element;

Chair: iMAINLINE |
Prafile: [MAINLINE =]

! ] Space | Return |
- Paint Elevation :
Profile Settings | Paint Profile Elewation Clear | Delirmit |
Profile Grade % (& Point
Chain Mame Flace Label |
Prafile Mame _:j
Mot Available

I Params. l Shape l Leader | Fintatel Stylesl

® Computed Inzerts T User Inserts

Computed Text

Prafile Station -
Profile: Partial Station
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LAB 17: Labeling

17.1 Accessing the Labeler
Step 1. Execute C:\data\geo\VDOT\road1\LAB17.EXE.

Step 2. Open the MicroStation file c:\data\geo\vdot\road1\d17682des.dgn.

Step 3. Access Project Manager.

Step 4. Select the icon Plan View Design button from the Road Project: Road1l.prj workflow
dialog box.

Step 5. From the Plan View Design tool bar, select the Plan View Labeler icon.

Plan View Des___ %]

17.2 Using Predefined Label Styles

Step 1. Select the Styles Tab.

Step 2. Traverse with the Item Selector box to locate the following style:
Labels>Point Labels>StaOff. Next, double click the StaOff style.

| 22 Plan View Labeler - Style: __ \geopak\vdot Isf > StaOFf - Active MEE I
_ Style Fles Options Scale Tools

Tent | Params. i Shape I Leader || Ratate | Sl &i §E?d32i?3§;izf;t___
Item Selector Style Previsw Off 19 649 RT
[ Labels al ¥
21 Line Labels e
£ Ao Labels Q‘QJ
[e=r Paint Labels Stg 39+E2E 572
[El NEStaBox _ e Sl | _Retun |
[ sta0i Off 18.649 RT Cear | | Delmit |
& StafElTIN =]
Place Label |
Ipdate Style... I
Scale:1.00

MHaode and Shape Only "l

Step 3. Move back to the Text tab and complete as defined below:
Job No. 101
Chain MAINLINE
TIN File SURVEY.TIN

In the following steps, we will use the Plan View Labeler to label the beginning and ending points for
pavement transitions.
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Step 4. Use the MicroStation pulldown Utilities > Saved Views to access the saved view
“TRAN1".
Step 5. To create a label, select the DP button and then identify the location as shown by the “X”

in the following image. The labeler automatically calculates the information.

| 22 Plan View Labeler - Style: __ \geopak\vdot Isf > StaOFf - Active mE B |
_ Style Fles Options Scale Tools
Tewt | Params. | Shape | Leader | Rotate | Styles | éfdggiﬂgéﬁgi—t———
TS T e — gl ® Computed Inserts © User Ingerts Off 33 .00 LT
Element:  Point Camputed Text
Chain: [MEINCNE =] » Coordinate N
; : 51 I Coordinate
2| ; : 5 Ret
TIM File: | survey.tin a, > Elevation GPE .pace | eturn |
<~ Elevation TIM Clear | Drelimnit |
Label Featurs Z Elevation Modeler
e 3 Station Place Label |
Fartial Station _:j
Not Available
Step 6. Use the Params., Shape, Leader and Rotation tabs to experiment with different labeling
styles.
Step 7. To place the label, return to the Text tab and click the Place Label button.

The label is now attached to your cursor (without the leader for the delimiter).

Step 8. Datapoint at the location you wish the text to be located.
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Step 9. A second datapoint will define the side of the label from which the leader line will

be drawn from the delimiter line to the computed location.

Sto 204+00.00
Off 33.00 LT

Step 10. Repeat Steps 5-8 to label other points of the transition area.

Step 11.  Exit MicroStation.
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CHAPTER 18

Plan and Profile Sheets

18.1 Overview of Features

Feature / Function Drawing of plan or plan / profile sheets.
Tool Plans Preparation
Y ot [ IR N R =
= | ] | S bl
Project Manager (Road) Plan and Profile Sheets
Menu Application GEOPAK Road > Plans Preparation > Plan and Profile Sheets

The main feature of the 2001 Plus application is a simplified user interface, compared to the Classic
application. In this way, users can quickly and easily generate a variety of plan, plan / profile and
tabular data sheets.

In order to maintain compatibility with the Classic application and ease the transition for those users
who want to utilize the 2001 Plus application, 2001 Plus supports importing .dat files utilized in the
Classic application, and converting them to the new Port-oriented format. Dat files were the
equivalent of the Sheet Library in the Classic application.

2001 Plus supports any combination of Ports on a sheet for maximum flexibility.

2001 Plus provides powerful handling of MicroStation reference files. This is accomplished by having
other MicroStation files serve as patterns for the reference file attachments. These are called motif
files.

2001 Plus has the option to automatically make a notch in the clipping shape at layout time to make
room on the sheet for a title block. This is done by putting the clipping shape pattern into the sheet
cell.

Extended Stationing is used as a means to allow sheets to be placed partially off of an alignment or
even completely off of the alignment.

2001 Plus has the ability to place sheets with a Right to Left Station progression, which is opposite of
the standard used in roadway design. This was added for users doing rail design.

A thorough capability is provided to perform sheet numbering. Alphanumeric prefixes and suffixes as
well as changing the start number of the sheets and rearranging the ordering are all supported in
2001 Plus.

2001 Plus supports Profile Stair Stepping. In situations with steep grades or narrow profile ports,
sometimes the profile goes off the top or bottom of the port before it gets to the end of it. To handle
this, users would put a break in the profile port and adjust the elevations to bring the coverage up or
down to where it needs to be. Within 2001 Plus, GEOPAK automatically locates these breaks and
plots the profile clipping shapes in accordance with that. This adjustment carries through, then, to the
sheet design file.
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Profile Gap Equalities -- If a Profile has been plotted with the Gap option turned on, the coverage of
the sheet is now adjusted so that subsequent sheets remain aligned with the grid.

Raster Manager -- Descartes is not supported by the application. Raster Files are now to be
referenced via the Raster Manager application available via Bentley Select.

Tabular Data Application -- Sheet Clip places Clipping Shapes suitable for Tabular Data. However,
the actual placement of the tabular values in the dgn file is now done via the Draw Tabular Annotation
(Sheet Clip Mode) tool. This approach allows the power and flexibility of the Draw Tabular Annotation
application to be used with sheets.

Digital InterPlot — The Digital InterPlot Plot set can be created during the sheet clipping process.

18.2 Invoking The Main Dialog Box

When the GEOPAK User Preferences is set to 2001 Plus and Plan and Profile Sheet tool is selected,
the GEOPAK Sheet Layout dialog box depicted below opens.

F2{Plan Sheet Layout: VDOTENG PSL o =1
Fle Miew Settings Tools

_v” 26,00 ftdin

The dialog box is comprised of the title bar, which displays the current Sheet Library, the main menu
bar, short-cut icons, and the Sheet Name Selector and Plot Scale fields.

The first time the application is invoked, it opens up a default.psl sheet library located in the
\geopak\bin\ folder if the configuration variable isn’t defined.

The Plot Scale will be displayed in the proper units depending on how it is set in the User
Preferences.

18.2.1 Sheet Library

F2{Plan Sheet Layout{ VDOTENG PSL i =1
__Hle View Settings Tools

_:JI 25.00 ftdin

The parameters for each sheet are defined in a Sheet Library. In order to lay out or clip sheets, a
Sheet Library must be attached to the current session. The name of the currently attached Sheet
Library is shown in the title bar. Sheet Libraries have an extension of psl. An unlimited number of
different sheets can be stored within one library. When the user begins the sheet process, they select
the desired sheet layout from the attached library, which loads the associated parameters.

If a different Sheet Library is needed, it can be attached via the menu items Sheet > Library > Attach.
It is also possible to review or make changes to the Sheet Library by selecting Sheet > Library > Edit.
Detailed information on the set-up of the Sheet Library can be found in the online help section entitled
"Sheet Library Set-up."
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18.2.2 Main Menu Bar Overview

FZ{Plan Sheet Layout- VDOTENG PSL
I Hle View Settings Tools I

15l

;Jl 25.00 ftdin

Four options are supported in the main menu bar;

e Sheet

e Tools

e View

e Settings

18.2.2.1 Sheet Menu Options

Five tools are supported in the Sheet pulldown and are detailed in the sub-sections below.

e Library

e Composition
e Layout

e Clip

e Exit

18.2.2.1.1 Sheet Library

The Library file contains the various parameters, cells, and dimensions for creating sheets.

In this

menu option, a new Library can be created, an existing Library can be edited, or the user can define
(Attach) the desired Library. For a detailed discussion of setting up and editing a Library, refer to the

online documentation "Sheet Library Set-Up."

Library Sheet Port

| 22 Sheet Layout: Sheet Library- c:\data\geo\vdot\road \standards\GEOPA. ..

|FLAN

General Settings

Dezcription: | Flan Only Sheet

Grid Aligrment Sheet Stacking Offzets

g_hetj‘ E’*F_T”D]ta““” Vertical [Z300.0000 | Stack Orientation: _Vertical v |
o an
Drawing Ares Harizontal: [~ 0.0000 Max Mumber of Sheets; [1
Offzet fram Cell Origin
Match Lines Cell Library: [sheet2000.cel Q]
Sheet Cell |PLA
Baze Scale: | 100.0000
~ Shest Cell Flacement
Place Sheet Cell Once in a Reference File VI
Shest Cell Referancea File:
| Ql
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18.2.2.1.2 Sheet Composition

This menu item opens the Sheet Composition dialog box, wherein drawing area, overlapping options
and other project specific variables are defined. One sample dialog box is depicted below.

Cilh Yl T

Z_________,—sr ATION AAmge ==

clle
Hmlﬁ"“l

Ciig Vetio! l

b

By Station Bange: Radial

r Clip

800.00 % 521.25

Wertical: | 750

b &xirum Drawing Area:
Harizantal: A0.00

Station Range: | 70000

Active Drawing Area;  wariable 70000 % 44625

18.2.2.1.3 Layout Sheets

The Layout dialog box is utilized to define the GEOPAK Job Number, alignments, and / or profiles for
the desired sheets.

PImShEetLayol.t:LaymlMings |
Job: W E\_I Multiple: Sheets vI
Pot|  Type | Dependency | Alignment | Offset | fohif File |
1 Flan ASligriment rAaINLIME 0.oo Flan-kotif. dgn
4] | ]
Begin Station: m-lm_ Entend: Imﬂ_ _‘ﬁ
End Station; Im- Extend IT _‘ﬁj

Fields are also supported for stationing, if only part of the chain is being utilized for sheet layout.
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GEOPAK"”

Once the sheets have been laid out and any modifications complete, the sheets are ready to be
clipped and drawn for the final production sheets. The Clip dialog box is utilized to complete these

tasks, as detailed below.

Create Digital InterPlot Plot Set — Allows the creation of the Digital InterPlot Plot Set during the

Layout Sheets process.

P'Ian Sheet Layout: Clip Sheets ! 1

- Output File
Directory: | E’.J
Sheet Mame Prefi; [d17662 | d176823.dan
Orientation: | Rotate Reference Vi
Sheets per File: |'I_ todel |-Active v
Sheet Fange Begin: |3 =| End: [B ]

- Labels and Annotations

Shieet Title: [123

Project Mumber: |0123-015-105, C-&01
Match Line; IStatiDn
™ Ausiliary Sheet Annotations Tenrle

ft Rt I tMatch Line

~ ¥ Create Digital InterPlat Plat Set

IPS File: [T \data\gentwdatvoad] Yplotips @
Sheet Type: ! Plan _V_I DpenlnterF‘IntDrganizerl

18.2.2.1.5 Exit

Exits the Plan and Profile Sheets application, but does not close the MicroStation file.

18.2.2.2 Tools Options

Four tools are supported in the Tools pulldown and are detailed in the sub-sections below.

e Modify
e Sheet Number Manager

e Draw Tabular Annotation (Sheet Clip Mode)

e |dentify Sheet

GEOPAK 2004 Edition
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18.2.2.2.1 Modify Sheets

After the sheets are laid out, the user may want to adjust individual sheets to conform to the project
limits, etc. This can be accomplished utilizing the tools in the Modify dialog box, which is illustrated
below.

& Plan Sheet Layout: Job: 101 Chain:

| Shape: [Sheet 3, Port 1 | E'I

["| Slide Preceding Sheets [T Slide Following Shests

Lett Station "I |200+0000R 1 | Extend: IDD.DDDD Dynamic!
Shest Chord Offget! | 0.0000 Dynamicl
Additional Rotation about Left Station; I Q.0000 D_I,Jnamicl

The two icons in the upper left corner are utilized to Slide sheets (along the alignment, rotating,
offsetting) and Modify Drawing Area. The Slide options are illustrated above, while the graphic below
depicts the Modifying Drawing area.

Shape: |Sheet 3, Part 1 3| lfi.!

[T Slide Preceding Sheets [T Slide Following Sheets

- Lateral Dirersions

Hold To: | Left Station VI
Dirawing Showrn; |?DD.EIEIEID Horizontal: I 50,0000

Wertical; | 37.5000

The user can select the sheet to be modified from the pick list or by graphic identification. Sheets can
also follow the movement of the selected sheet, i.e., moving one sheet to left moves all proceeding or
following sheets to the left by the same amount.
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18.2.2.2.2 Sheet Number Manager

After the sheets are laid out, the Sheet Number Manager can be invoked as depicted below,
populated with the current sheets.

PImSI'reetLaymt:SheelM.mhﬁ'Manager !E

Sequencel Sheet!  Alignment | Beqin Station | Extend | End Station | E:-ttend_!
1 3 MAINLINE 200400.00 E 1 —200.0000 205+00.00 B 1 o.oo0o
2 4 MATIHLINE 205+00.00 E 1 0. 0oooo 212+00.00 R 1 0.0000
3 5  HMAINLINE 212+00.00 E 1 0.oo00o0 219+00.00 B 1 o.oo0o 3
4 6 MAINLINE 219+00.00 E 1 0. 0000 222406 .84 R 1 393 . 1629 +
5 3a MAINLIHE 200+00.00 E 1 -200.0000 205+00.00 B 1 o.oono 3
& 4a MAINLINE 205+00.00 E 1 0.oo000 212+00.00 B 1 0.oo0o HE
7 S5a HMHAINLINE Z12+00.00 R 1 0.00oo 219+00.00 R 1 0,0000 =
a pa MAINLINE 219+00.00 E 1 0.0000 222406 .84 B 1 393, 1829 ﬂ
™ Highlight Clipping Shape [T Window Center Clipping Shape

The actual sheet number can be modified, prefix and suffix added, and other labeling options by
utilizing the Edit Sheet Number (fourth icon down in the grouping to the right of the list box).

T
™ Add Prefis: |

Compute Sheet Mumber By:

Starting at Sheet Number ] "i l3

V| &ppend &lpha Suffic T I
Beqining Letter(s): |a Lowercase "I

Cancel I

Another option is changing the order the sheets are drawn.
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18.2.2.2.3 Draw Tabular Annotation (Sheet Clip Mode)

When the Draw Tabular Annotation tool is selected, the Draw Tabular Annotation dialog box is

opened, as depicted below.

File

?Dlaw Tabular Annotation [Sheet Clip Mode]: C:h\datatgecohplankprofil. .. B

Identify Shape (Tabular] | - Station Range

Job:
Chain:

Mame

Delta Elevations
(] Design Suface
[ Ewisting Surface
(] Chanage

B [Hz Details

Frequency

[ End I— I

[ Star: I— I

] Dezign Elements I

Frame Annotation: | 1 vI

Deefinition

Delta 2 of "ExistingS" / "DesignP"

£ of "DezignP"
Z of "Existings"
Station

Yertical Shift: | 0.000000

=

Scale;
0,100

3

Even Stations along Active Chain Every 10000000
Tangent Pointz along Active Chain
Tangent Paints along Profile "DezignP"

=

The user can define the tabular data to be included within the plan /profile sheets.

18.2.2.2.4 Identify Sheet

Select Identify Sheet, then select and accept a previously placed clipping shape.

GEOPAK

determines the settings utilized to place the original sheet and automatically populates the dialog box
with the Sheet Name and Scale. In addition, the Sheet Name, Scale, Sheet Number and Port are

displayed in the MicroStation prompt field at the bottom of the screen.

If the parameters for the

selected sheet are not found within the current library, a warning message is displayed indicating the
sheet is not found, the name of the current library, and the name of the library used to place the

infomation ]

original sheet.

Thig Sheet waz not found in the Active
Library

"'c:hdatahgeatwdaothroad] batandardshGEORPA
FKAWDOTENG. pal”,
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18.2.2.3 View Menu Options

Three tools are supported in the View pulldown and are detailed in the table below.

Filter by Sheet

Name

Filter by Scale

Automatic

Update

The clipping shapes of the currently selected sheet name are displayed. A
MicroStation update view will need to be issued if “Automatic Update” is not
toggled on.

The clipping shapes of the currently selected Scale are displayed. A
MicroStation update view will need to be issued if “Automatic Update” is not
toggled on.

NOTE: “Filter By Sheet Name” and “Filter By Scale” can be used together.

If this is toggled on when “Filter By Sheet Name” or “Filter By Scale” is
selected the view is automatically updated.

18.2.2.4 Settings Menu Options

One tool is supported in the Sheet pulldown and is detailed in the table below.

Sheet
Settings

Layout

When the Sheet Layout Settings tool is selected, the dialog box depicted
below opens. Three settings are supported within the dialog box including
Left to Right or Right to Left layout, Stair Stepping for profiles, and sheet
view attributes.

Sheet Layout Settings

Sheet Layout Progreszion: | Left to Right [Standard) VI

Profile Stair Stepping; | OFf 'I

Sheet View Attributes: | Use Current Design File Vl ¥ Save Full Path

Cahicel |

e Sheet Layout Progression:
Left To Right (Standard)
Right To Left (Rail)

e Profile Stair Stepping:
Off
On

e Sheet View Attributes:
Use Current Design File
Customize With Motif File

GEOPAK 2004 Edition
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18.2.3 Dialog Box Icons

Six short-cut icons are supported for ease of use. These icons correspond to tools located within the
menu bar pulldowns and are detailed in the table below.

Sheet Composition (Sheet > Composition).

Layout Sheets (Sheet > Layout).

Clip Sheets (Sheet > Clip).

== Modify Sheets (Tools > Modify).

.

@l Sheet Number Manager (Tools > Sheet Number Manager).
id ID button (Tools > Identify Sheet).

18.2.4 Sheet Name Selector and Plot Scale

F2{Plan Sheet Layout: VDOTENG PSL i =1
__Hle View Settings Tools

Two parameters are global to the entire application and are shown on the main dialog box:

e The Sheet Name Selector enables the user to select which sheet is to be placed in the next
Layout operation. The drop down list displays all sheets in the currently attached Sheet
Library.

e The Plot Scale text item determines the scale at which sheets will be placed in the
layout.dgn.

18.3 Primary Work Flow

The approach taken by this application is to represent the reference-clipping boundary of each Port
on each Sheet. The clipping boundary is represented by MicroStation Shapes, referred to as Clipping
Shapes.

For each project, there is one design file, which contains all of the Clipping Shapes for a project, for
example, layout.dgn. All design elements exist in files referenced to layout.dgn. It is recommended
that layout.dgn have only Clipping Shapes in it.

The Primary Work Flow consists of two operations:

e Layout of sheets — places clipping shapes into layout.dgn file.

e Clipping sheets - reads the Clipping Shapes from the Layout dgn and creates new design
files which include all required reference files which are clipped at the correct boundaries
along with the Sheet Cell and other annotations.

18-10 - VDOT ROAD 1 Training GEOPAK 2004 Edition



GEOPAK"”

There are two options for Clipping Sheets: Rotate View and Rotate Reference.

When Sheets are clipped using the Rotate View option, the sheet cell and the view are moved and
rotated such that they are coordinately correct with the clipping shape of Port One. This arrangement
allows only one sheet per design file.

When Sheets are clipped using the Rotate Reference option, the sheet cell and view are not rotated.
The reference files are rotated and moved to be in the correct location with respect to the sheet cell.
The arrangement allows multiple sheets to be placed in one design file.

18.4 Ports

Each Sheet consists of one or more Ports. A Port can be considered a window into the design. For
each sheet that is placed into a layout.dgn, each Port on that sheet is placed as a Clipping Shape.

18.4.1 Port Types

There are three types of Ports: Plan, Profile, and Tabular Data. It should be noted the 2001 plus
version of Plan and Profile Sheet Composition does not place tabular data values. The application
places Clipping Shapes designed to include Tabular Data. The actual placement of the Tabular Data
values is accomplished by the Draw Tabular Annotation (Sheet Clip Mode) tool in coordination with
the Plan and Profile Sheet Composition application.

18.4.2 Port Information

Before laying out sheets, each Port must have its Port Information filled out. The Port Information
Dialog boxes are opened by double-clicking the corresponding row in the Layout Dialog box.

Plan Ports only need the controlling chain, an offset value, and the name of the motif file for the given
Port. If the “Use Current Design File” option is selected, Current will be displayed in the dialog box
instead of a Motif File name.

Motif files are used to determine reference file attachment.

Profile Ports require the name of the controlling profile in addition to all the information found in a
profile cell.

Tabular Data Ports require the same kind of information that Profile Ports do, but also may optionally
have the ability to stagger the placement of the ports. This staggering allows the Clipping Shapes to
be longer without conflicting so that they may accommodate margin labels.

18.5 Sheet View Attributes

Two options are supported for Sheet View Attributes:

Use Current Design File — All reference file attachments, active levels, etc., are based on the current
design file. An optional toggle is supported to Save the Full Path of reference files. This toggle is
only for the design file that contains the clipping shapes.

Customize with Motif Files - A blank file is utilized as a pattern file for the reference file
attachments. Also levels can be turned on or off as desired. We call these files motif files.
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18.5.1 Use Current Design File

The user can control reference file attachment without the use of Motif Files by selecting the Use
Current option for Sheet View Attributes. When this option is used, the Current dgn file (in which
clipping shapes have been layed out) is used like a Motif file in that it's reference file attachment
information carries over to each Port during Clipping.

Also the design file containing the clipping shapes will be attached as a reference file for each port to
accommodate users that wish to place there clipping shapes in the proposed design file.

The advantage of Use Current Design File is that the user does not need to concern themselves with
setting up motif files. What they see in the layout design file is what they will get in clipped sheet files.
However, when Use Current Design File is that selected option, it is not possible to have different
reference file settings for different Ports on the same sheet. All Ports must have the same
attachment information and can'’t be customized.

The Save Full Path toggle is used for the Current Design File only when the sheets will be placed in a
different directory than the reference files.

Shoc Loyous Soumgn ]

Sheet Lapout Progression; | Left to Right [5 tandal:_l]ll

Profile Stair Stepping; | Off 'I

Shest View Attnbutes: - Uze Current Design File Vl ¥ Save Full Path

Cancel !

18.5.2 Customize With Motif Files

It is sometimes necessary to have two or more Ports on a sheet, which have differing reference file
attachment settings. This could happen with two Plan Ports, which cover the same area but show
different aspects of the project. For example, the top Port would show the proposed design and the
bottom Port would show traffic control. This could be considered as the two Ports on the same sheet
having different themes or different motifs.

The question arises as to how the various reference file settings are to be controlled for each Port.
This is done by using another design file to serve as a pattern for the reference file attachment
information. For every Port, there would be a motif file specified by its file name. The Ports on each
sheet may have the same or different Motif Files.

During a Clip operation, the reference file attachment information is read from the motif file for each
Port. When a Port is placed into the final sheet file, all reference files which are attached to the
corresponding Motif File are attached to the final sheet design file. All reference level view on/off
settings of the motif file are also applied to the reference file attachment in the final sheet design file.
Note the clipping shapes are still used to define the Clip Boundary of each reference file associated
with that Port.

In the example described above of a sheet with Design and Traffic Control, the top Port could have a
Motif File named design_motif.dgn. The bottom Port could have a Motif File named Traffic_motif.dgn.
At any time before sheets are clipped, the Motif Files (which would normally be blank) must be
opened, desired levels should be active, and the reference files attached. The reference file names
and their paths used for the motif file must match exactly to the reference files and associated paths
in the original file. Therefore, the user will normally set up the motif files on a project by project basis,
unless an organization has a standardized set of file naming conventions and level structure utilized
on every project, where a single set can be developed for the entire organization.
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Shoc Loyous Soumgn ]

Sheet Lapout Progression; | Left to Right [5 tandal:_l]ll

Profile Stair Stepping, | OFF vI

Sheet View Attrbutes: | Customize with Mot Files Vl

Cancel !

18.6 Sheet Composition

When the Sheet Composition tool is accessed, the dialog box depicted below opens.

Gl W DRAWINE smoWy e
I
| DY ZRLAS
I
I
| £ip Vel 1
|

b By BeginStation/OwerLap
By Station Range: Inside Out

[oip : By Station Range: Outzide In
Masir gy Giation Bange: Radial 25
Harizontal | 60.00 Vertical: | 37.60

Drawing Shown: [ 700.00

Active Drawing drea; 700008 44625

Owerlap: I o0 Fived Digtance 'i

The graphic illustrates the various values required in the dialog box. Directly below, four options are
supported, as illustrated in the exploded view above:

e By Begin Station/Overlap
e By Station Range: Inside Out
e By Station Range: Outside In
e By Station Range: Radial
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18.6.1 By Begin Station/Overlap Option

When the By Begin Station/Overlap option is selected, the Clip group box containing the Drawing
parameters, Overlap options and associated fields as depicted in the graphic below:

Cilp Ventloil T

I
|
l
[
[
cilp |
l

Gl W DRAWINE smoWy e

! DY ZRLAS

{ By BeginStation/OverLap V;

r Clip

M asimum Drawing drea:

Horiznntal:l R0.00
Drawing Shown: [ 700.00

Active Drawing drea:

200.00x 521.25

Yertical | 3780

700.00% 44625

Owerlap: I o0

Fized Digtance 'i

Before these options are reviewed, a discussion of the Active Drawing Area, located within the Clip
group box, is warranted. Several dimensions are found within the Clip group box. These include:

Maximum Drawing Area (display only)

Horizontal

Drawing Shown

Vertical

Active Drawing Area (display only, calculated by GEOPAK)

The graphic below illustrates each dimension for the subject sheet. In addition, a portion of the
adjoining sheet to the left is shown in order to depict the overlap. Notice that the alignment is also
displayed from approximately station 289+00 to 292+00.

!

CLIP YERTICAL
=i ==—— (OYERLAP

CLIP HORIZONTAL—— F=—o0

DRAWING SHOWN

—=— =—(LIP HORIZIONTAL
CLIF YERTICAL

}
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First, GEOPAK utilizes the Maximum Drawing Area based on the Sheet Name and Scale selected in
the main Sheet Layout dialog box, in our example, 400.00 x 176.75. Then the Clip Vertical is
subtracted twice, once for the top and once for the bottom. In this case,

176.75-10 - 10 = 156.75

which is shown in the Active Drawing Area. The same method is utilized for the Horizontal
computations. The horizontal clip is subtracted twice, once for the right side and once for the left
side. In this case,

400.00 - 10 - 10 = 380.00

which is shown in the Drawing Shown and the Active Drawing Area.

By BeginStation/Overllap Vi

Clip
Masimum Drawing Area: 40000 17675

Horizantal: 10.00 Wertical: 10.00

Drawing 5 howrn: I 380,00

Active Drawing Area: 383000 15675

Once again referring to the graphic above, GEOPAK considers the Overlap shown on the left side
between the two adjoining sheets. The Overlap toggle has two options as depicted in the exploded
view below:

r Clip

tamimurn Drawing Area; 400.00x 17675

Hnliznntal:l 10.00 Vertical:i 10.00
Drawing Shown: | 380,00

Active Drawing Area; 380.00% 15675

Fixed Distance
Overlap: l h.26

e Percentage
e Fixed Distance

When the Percent option is selected, the designer keys in the desired overlap in percent format in the
Overlap field. Note the percent sign (%) is not required. The Percentage is calculated utilizing the
Drawing Shown value. In this example, the 5.26% overlap is 156.75 feet (5.26% of 176.75).

In our Percentage example, the overlap is 5.26%. Therefore, a 20.00 foot overlap in clip areas is
present between successive sheets.

If the Fixed Distance option is utilized, the Value field is in master units, i.e. feet or meters.
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When placing sheets on a curve, the chord of the curve where it intersects the inside border is utilized
to orient the sheet as depicted in the graphic below:

Poralle! lines

Since the By Begin Station/Overlap Sheet Composition option uses a chord distance to compute
the length of the sheet, in the area of a curve more stationing will be covered. On a Plan/Profile
sheet, this means there will be unequal coverage between the Plan and Profile. With this in mind, it is
recommended that By Begin Station/Overlap Sheet Composition option be used for a Plan only
case.

18.6.2 By Station Range Inside Out Option

The By Station Range: Inside Out option orients sheets between a rounded station interval. This
interval is entered in the Station Range field. When utilizing this option, the Clip group box also has
a slightly different look as seen in the graphic depicted below.

Ciip Yerice' T

|
|
|
|
|
|
aw i
f;{ _z_:_ﬁ_ﬂ__——,g?.&?f A#G:-—-.____‘:: G
|
|
|
|
|
|

clim |
I
Hu’l*—"‘"w |
I
Clig Verdica! l :
______________ jT_ _—— e ——d

{ By Station Range: Inside Out V;

r Clip

Masimum Drawing drea; 80000 % 521.25

Horiznntal:l R0.00 Vertical:l 3780
Station Range: | 70000

Active Drawing Area;  wariable 80000 % 44625

Now the Active Drawing Area is not constant, but displays Variable in the output field.
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The Horizontal keyin has a slightly different meaning which can be best illustrated with an example.
Let's use 500 feet for the Station Range, and 15 feet Horizontal. The dialog box is depicted below.

By Station Bange: Inzide Out Vl

Clip
b awiniun Drawing Area: 1587.50= 475.00

Harizantal: 15.00 ertical: 2000

Station Fange: I 500,00

Active Drawing Area:  wariable 1557 50% 43500

Utilizing the dialog box above, the following sheets are generated.

The first step when the sheets are drawn is to determine the stationing for each sheet. Our first sheet
will be oriented between stations 115+00 to 120+00. GEOPAK then expands the sheet clip area by
the Horizontal keyin distance. Looking at a detail of the beginning of the project, the clip area is
expanded fifteen feet before station 115+00 as seen in the graphic below. Note the inside border is
the dashed line, and station 115+00 and its associated tick mark are shown.

The curve is calculated slightly different. The second sheet in this series is on a curve. The station
range is 120+00 to 125+00. A chord is drawn for the curve between stations 120+00 and 125+00 as
seen in the graphic below.
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Notice that the inside sheet border is wider than the chord. The software will extend the chord the
amount of the Horizontal keyin (in our example, fifteen feet) to establish the vertical edge of the inside
border as seen in the detail below.
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18.6.3 By Station Range Outside In Option

The By Station Range: Outside In option orients sheets between a rounded station interval. This
interval is entered in the Station Range field. When utilizing this option, the Clip group box also has
a slightly different look as seen in the graphic depicted below.

clie

Hyiﬂ"ﬂj

Clip Yadica' T

Z:_‘_ﬂ___ﬂ—_gf,-!?fﬂh-' R.".#GE"—;___'::_

CHa vatice! l

r Clip

By Station Range: Outside In V;

800.00 % 521.25

Wertical: | 750

b &xirum Drawing Area:

Harizantal: A0.00

Station Range: | 70000

Active Drawing Area;  wariable 70000 % 44625

The Outside In option is slightly different as seen in the dialog box below.

By Station Fange: Outzside In Vl

Clip

1577.00x 475.00

Wertical: I 20.00

 awiniun Drawing Area:

Horizontal: I 538.50

Station Fange: I 500.00

Active Drawing Area: 50000« 43500

The Clip Area is no longer variable, but a constant based on the Sheet Size as well as the
Horizontal and Vertical fields. In our example, the same 500 feet is keyed in. When generating the
sheets, GEOPAK determines the center of the sheet, and the corresponding station. In our example
the midpoint of the stationing for the sheet from 120+00 to 125+00 is 122+50. This point will be

placed at the midpoint of the sheet

as depicted in the drawing below:

GEOPAK 2004 Edition
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' EIT] a4 310 |

Since the clip area covers a constant station range, the length of the clipping shape will vary
depending on the curvature of the alignment.

18.6.4 By Station Radial Option

The By Station Range: Radial option orients sheets between a rounded station interval. This
interval is entered in the Station Range field.

SR Yt e T

(AL

| |
| |
| |
' |

l AT ON RAng
A et I,
| |
| |
Hmlﬁ‘“ : i
| |
| |
| |

Ciip Vetioe! l

Bu Station Range: Radial VE

~ Clip
Masimum Drawing drea; 80000 % 521.25

Horiznntal:l R0.00 Vertical:l 3780
Station Range: [ 700,00

Active Drawing drea;  warable FO000 % 44625

An example best describes how this feature works. In the dialog box below, each sheet has a station
range of 500 feet. Based on the station ranges in the bottom of the dialog box, the first sheet would
encompass station 120+00 to 125+00, while the second sheet would include stations 125+00 to
130+00.

By Station Range: Radial vI

Clip

Maximumn Drawing Area: 1577.00 % 475.00

Harizontal: | 30.00 Yertical:
Station Range: | 1517.00

Active Drawing Area: 1517.00= 435.00
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To draw this second sheet, GEOPAK locates the midpoint station 122+50, which in our example is on
a curve. Utilizing the chord of curve as the vertical center, GEOPAK draws the top and bottom of the
clip regions 217.5 feet from the chord, making the clip region 435 feet high. This is computed from
the sheet size of 475 minus the vertical keyin of 20 for the top and 20 for the bottom, resulting in a
435 feet height.

In the next step, GEOPAK moves to station 125+00 and draws the clip border radial to the alignment
at the specified station until it intersects with the previously computed top and bottom clip regions.
The same process is repeated at the other end of the sheet, i.e., 130+00. Therefore, the inside clip
region is trapezoidal as depicted in the graphic below.

—
!
llll\ 122450 )‘
e —T‘ = =={5—= —~
___\_:"1 U- -;:___:I'_:':_'—_-__J'_-_: - =
Ty
\ |
\ o
|II R — i

Since the clip area covers a constant station range, the length of the clipping shape will vary
depending on the curvature of the alignment.
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LAB 18: Plan and Profile Sheets

18.1 Getting Started
Step 1. Execute C:\data\geo\VDOT\road1\LAB18.EXE.
Step 2. Open the Microstation file c:\data\geo\VDOT\road1\d17682work.dgn.

Access Project Manager.

18.2 Plan Sheet Layout Process

Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow
dialog box.

Step 2. Create a run named Plan to set up the plan sheets. Initially, the dialog box will appear
similar to the one shown below.

F2{Plan Sheet Layout: VDOTENG PSL o =1
Fle View Settings Tools

= |[1.00 fdin

Step 3. Select Settings>Sheet Layout. Change “Sheet View Attributes” option to Customize
with Motif Files then click OK. The completed dialog box is shown below.

Sheet Layout Settings

Sheet Layout Progression: | Left ta Right [Standard) Vl

Prafile Stair Stepping: | OFf vI

Sheet View Attributes: | Customize with Motif Files Vl

Cahicel |

Step 4. On the GEOPAK Sheet Layout dialog box, select PLAN from the sheet list then set the
scale to 25.00 ft/in. The GEOPAK Sheet Layout dialog box should appear as below.

F2{Plan Sheet Layout: VDOTENG PSL o =1
Fle View Settings Tools

_vjl 26.00 ftdin
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Step 5.

Press the Sheet Composition icon.
below.

Populate the Sheet Composition dialog box as

CHip Yt e T

| |
| |
| |
| |
i ATIOMN RANG i
1 ‘.’;;—"'ﬂ_ﬂ_sr AT ey :
|
| |
| |
| |
| |
| |

ife
per izt
Ciip Verdioel l
el e s e e e  Eaa a
By Station Range: Radial VE
r Clip

b &xirum Drawing Area:
Harizantal: A0.00

Station Range: | 70000

Active Drawing Area:

800.00 % 521.25

Wertical: | 750

variable FOO.00% 44625

§=ull

Note: The Vertical setting will trim off the top and bottom of the clipping shape so that
plan data will not be placed inside the title blocks on the sheet.

Step 6.

Step 7.

Step 8.

Step 9.

Dismiss the Sheet Composition dialog box by pressing the X in the upper right hand

corner.

Press the Layout Sheets icon.
Project Manager.

The GEOPAK Job number 101 should be set from

Double click on Port 1. Set the Chain to MAINLINE by selecting it from the option list.

Press the Create Motif File icon.

Plan Sheet Layout: Plan Port Data

Chair: [MAINLINE =l

Offzat: | 000

Moif File: |

<

Cancel I Craate Motf File

GEOPAK 2004 Edition
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Step 10.

Populate the Create Plan Motif File dialog box as below.

PImSI’ﬂetLaymi:CreElele Matif Fle .

Seed File, | geotvwdotiroad!standards\GEDPAKYPlan-Motif, dgn gl

Target File; | Plan-batif.dgn ﬂ

Cancel |

§=ull

Note: The Seed File can be selected by pressing the Select Seed Motif File icon then
selecting Plan-Motif.dgn. The Target File name should be entered manually.

Step 11.

Step 12.

Step 13.

Press OK on the Create Plan Motif File dialog box. A file named Plan-Motif.dgn should
be created in the working directory and the Plan Port Data dialog box should appear as
below.

PImS?ﬁetLaym.t:lePm‘lDda I
Chairc: [MaINLINE =] Offset: [ 0.00
Matif File: | Plan-Matif. dgn QI f:ll

Cancel I

Press OK on the Plan Port Data dialog box. The Layout Sheets dialog box should now
appear as below.

| & Plan Sheet Layout- Layout Settings M= |
Job: [T0T Q] | Multiple Shests ]

Part|  Type | Dependency | Aligment | Dffset | fohif File |
1 Flan Aligriment FAaINLIME 0.oo Flar-kotif. dgn

Begin Station: |EDD+DD.DD A1 Extend: | oo ﬁ
End Station: 1222+DE.84 R 1 Extend, I 016 ﬁﬂ

In the Layout Sheets dialog box, set the Extend value for the Begin Station to —200.00.
This will force the first sheet to end at Station 205+00.00. The dialog box should appear
as below. Click the Layout 4 Sheets button to draw the clipping shapes into the design
file.

Jobi [T0T Q| Muliple Sheets > |

Port|  Type | Dependency | Alignment | Dffset | Patif File |
1 Flan Aligrment FAINLIME 0.00 Flan-tatif. dgn

Begin Station: |EDD+DD.DD A1 Extend: | -200.00 ﬁ
End Station: 1222+DE.84 R 1 Extend, I 016 ﬁﬂ
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4 clipping shapes should be placed for the Plan port.
Step 14. Dismiss the Layout Sheets dialog box by pressing the X in the upper right hand corner.

Step 15.  Exit the Plan and Profile Sheet dialog box and save your run. Review the results.

18.3 Profile Sheet Layout Process

Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow
dialog box.

Step 2. Create a run named Profile to set up the profile sheets. The dialog box should appear
as shown below.

F2{Plan Sheet Layout: VDOTENG PSL o =1
Fle Miew Settings Tools

_vJ! 26.00 ftdin

Step 3. Select Settings>Sheet Layout. Change “Profile Stair Stepping” option to On and
“Sheet View Attributes” option to Customize with Motif Files then click OK. The
completed dialog box is shown below.

Sheet Layout Settings

Sheet Layout Progression: | Left ta Right [Standard) Vl

Prafile Stair Stepping. | On vI

Sheet View Attributes: | Customize with Motif Files Vl

Cahicel |

Step 4. On the GEOPAK Sheet Layout dialog box, select PROFILE WITH SUPER from the
sheet list then set the scale to 25.00 ft/in. The GEOPAK Sheet Layout dialog box
should appear as below.

£ Plan Sheet Layout: VDOTENG _PSL HEE

Hle View Settings Tools

& E E %g! E‘ PROFILE wiTH 5UPHE | EE

Shest Mame Base Scale  Description l

PLEN 100.00 Flan Only Sheet
FLANFPROF 100,00 Plat and Profile Sheet

FROFILE WITH SIUFER 100,00 Profile Only Sheet - With Supereleration Diagram
PROFILE ITHOUT SUPER 100.00 Profile Only Sheet - Without Superelevation Diagram
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Populate the Sheet Composition dialog box as

The GEOPAK Job number 101 should be set from

Step 5. Press the Sheet Composition icon.
below.
P‘Ian Sheet Layout: Sheet Composition I
- I
CHip Ykl T
I :
| |
|
,.-—"-! EJ_I_—Sr,ATfoN RAN;E-—-__H :
cife |
per izt i :
| |
- e = Lol
/r
{ By Station Range: Radial V;
r Clip
b axirmum CDrawing Area: 700008 31250
Harizantal: a.oo Wertical: | 0.0o
Station Range: | 70000
Active Drawing Area;  wariable 700.00% 31250
Step 6. Dismiss the Sheet Composition dialog box by pressing the X in the upper right hand
corner.
Step 7. Press the Layout Sheets icon.
Project Manager.
Step 8. Double click on Port 1. Set the Profile to Mainline by selecting it from the option list.
Step 9. Populate the remaining fields on the Profile (Port 1) dialog box by pressing the Identify

Cell button then graphically identifying the profile cell. The dialog box should appear as

below.
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#5 Plan Sheet Layout - Profile (MAINLINE)

ME |

r Profile Drata

Profile: IMAINLINE

L]
=]

Chain: [MAINLINE
Station: W
Elervation: IW
Harizontal Scale: rm_

Vertical Scale: | 5.00
He |2?2D?DS.4‘I
By DP e =
T 1338_?54.91
Equation Treatment | Mo Gap "I

r Profile Cell
Draw Cell at iy |[:

Identify Prafile Port |

Identify Cell

r Matif File

| al g
Cancel |

Note: The X and Y coordinates may be different than what is shown in the dialog box.
They should match the insertion points of your profile cell.

§=ull

Step 10.  Press the Create Motif File icon.
| # Plan Sheet Layoui: Profile (MAINLINE) !I:i
r Prafile Drata
Profile: [MAINLINE =l
Chain: [MAINLINE |
Station; W
Elevation: IW
Horizontal Scale: I_ig.lil_
Yertical Scale: I_E_DD_
| w [Zrzo705.41
ByDP
v, [FaE76d 91
Equation Treatment ND'GaE vI
r Prafile Cel
Draw Cellat3y | Identity Cell | Identity Profile Port |
- Muotif File
|
Canicel I Creallnm‘

GEOPAK 2004 Edition
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Step 11.  Populate the Create Profile Motif File dialog box as below.

[ Plan Sheet Layout- Create Profile Motif File

Seed File, | o\vwdotvioadi hstandards\GEOPAKNProfile-Motif. dgn gl

Target File, | Profile-datif. dgn ﬂ

Cancel |

Note: The Seed File can be selected by pressing the Select Seed Motif File icon then
selecting Profile-Motif.dgn. The Target File name should be entered
manually.

§=ull

Step 12. Press OK on the Create Profile Motif File dialog box. A file named Profile-Motif.dgn
should be created in the working directory and the Profile (Port 1) dialog box should
appear as below.

| £ Plan Sheet Layou: Profile (MAINLINE) A= 1
r Profile Data

Profile: IMAINLINE

=]
=]

Chain: [MAINLINE
Station: IW
Elevation: IW
Horizontal Scale: I_ég‘ljﬁ—
Vertical Scale: I_Eﬁ_
| % [T
By DP
v [3a0se |
Equation Treatment Mo Gap 'I

- Profile: Cell
Draw Cell oty | Identity Call || Ideniity Profile Port |

- Motif File
| Profile-Matif dgn O-.l CI!

Cancel |

Step 13.  Press OK on the Profile (Port 1) dialog box. The Layout Sheets dialog box should now
appear as below.

gﬁmﬂﬁaLaymj:LaynuMings !m
dob: [T0 Q] | Muliple Sheets |

Part|  Type | Dependency | Aligrment | Offset | fohif File |

1 Frofile Aligriment FAaINLIME 0.oo Profile-totif. dgn

2 Tabular Part 1 0.oo

Begin Station: |EDD+DD.DD A1 Extend: | oo ﬂ
End Station: 1222+DE.84 R 1 Extend, I 016 _'fﬁ
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Step 14.

Step 15.

Step 16.

Double click on Port 2. Set the Profile to Mainline by selecting it from the option list.

Populate the remaining fields on the Tabular (Port 2) dialog box by pressing the Identify
Cell button then graphically identifying the profile cell. The dialog should appear as

below.

£ Plan Sheet Layout: Tabular (MAINLINE)

MEH]

r Profile Drata

Profile: IMAINLINE

=

Chair: IMAINLINE

Horizontal Scale: | 25.00

s [Z7avnsan
By DF

&7 | 338764.91
Equation Treatment | Mo Gap "I

Station: | 200+00.00 F 1

=

- Profile Cell

Identify Cell

Draw Cell at i | [

Identify T abular Port

r Clipping Shape Vertical Offzet
[T Offset Altemating Shapes

JEERANCS

r Mutif File

ale)

0K Cancel |

Press the Create Motif File icon.

gP‘Im Sheet Layout: Tabular (MAINLINE)

r Prafile Data

Prafile: [MAINLINE

L=

Chain: [MAINLINE
Station: |2EIEI+EIEI.DD F1
Horizontal 5cale; ! 25.00
= |2?’2D?’I35.41
By DP
¥ |338?E4.91
Equation Treatment Mo Gap vI

L=

r Prafile Cel

Draw Cell at 3. |

Identify Cell | Identify T abular Part

r Clipping Shape Wertical Offset
[T Offset Altemating Shapes

r Matif File

Cancel |

Create Motif File

GEOPAK 2004 Edition
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Step 17.  Populate the Create Profile Motif File dialog box as below.

| Plan Sheet Layout: Create Tabular Data Motif File

Seed File: | vwdothroadlhstandards\GEOPAKAS uperDia-b otif. dgn ﬂ

Target File; ISuperDia-Motif.l:!gn gl

Cancel |

Note: The Seed File can be selected by pressing the Select Seed Motif File icon then
selecting SuperDia-Motif.dgn. The Target File name should be entered
manually.

§=ul

Step 18. Press OK on the Create Tabular Data Motif File dialog box. A file named SuperDia-
Motif.dgn should be created in the working directory and the Tabular (Port 2) dialog box
should appear as below.

- Plan Sheet Layout: Tabular (MAINLINE) [_ [] 1
r Profile Drata

Frafile: [MAINLINE =l
Chairi: [MAINLINE =l
Station: |2DD+DD:DD R1
Hotizontal Scale: I 2500
s [2720705.01
By DP
&7 I 338764.91

Equation Treatment | Mo Gap "l

- Prafile Cell
Draw Cell at2y | Identity Cell || Identity Tabular Port
- Clipping Shape Yertical Qffget
[T Offzet Alternating Shapes Vihancs I 0000
r Motif File

| SuperDia-Matif.dgn Ql Eli

Catcel I
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Step 20.
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The X an Y Coordinates need to be reset in order for the clipping shapes to be placed on
the Superelevation Diagram. Press the By DP button then snap to the line immediately
left of the Superelevation Diagram lines. The dialog should appear as below.

25 Plan Sheet Layout: Tabular (MAINLINE)

MEH]

r Profile Drata

Profile: [MAINLINE =l
Chaire: [MAIMLINE ]
Station: IW
Horizontal Scale; IW
w [Zrao705.41
il | v, [

Equation Treatment Mo Gap 'I

- Profile Cell
Draw Cell at 3. |

Identity Cell || Identity Tabular Port

- Clipping Shape Yertical Qffget
[T Offzet Alternating Shapes Vihancs

r Motif File

| SuperDia-Matif.dgn

alal

Catcel I

Press OK on the Tabular (Port 2) dialog box. The Layout Sheets dialog box should

now appear as below.

gﬁmﬂﬁaLaymj:LaynuMings !m
dob: [T0 Q] | Muliple Sheets |
Part|  Type | Dependency | Aligrment | Offset | fohif File |
1 Frofile Aligriment MAINLIME 0.oo Frofile-Motif. dgn
2 Tabular Part 1 MAIMLINE 0.00 SuperDia-Motif.dgn

Begin Station: | 200+00.00 R 1
End Station: I 222+0684F 1

Ewterd: [ 0.00 ﬂ{
Esterd, [ 016 :2{

In the Layout Sheets dialog box, set the Extend value for the Begin Station to —200.00.
This will force the first sheet to end at Station 205+00.00. The dialog box should appear
as below. Click the Layout 4 Sheets button to draw the clipping shapes into the design

file.

gﬁmﬂﬁaLaymj:LaynuMings

dob: [T0 Q] | Muliple Sheets |

Begin Station: | 200+00.00 R 1
End Station: I 222+0684F 1

Ewterd: [ -200.00 ﬂ{
Esterd, [ 016 :2{

Port|  Type | Dependency | Alignment | Offset | bt File |
1 Profile Aligrment FAIMLIME 0.00 Profile-Motif. dan
2 Tabular Port 1 MaINLIME 0.oo SuperDia-Motif.dgn

GEOPAK 2004 Edition
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4 clipping shapes should be placed for the Profile and Tabular Data ports.
Step 22.  Dismiss the Layout Sheets dialog box by pressing the X in the upper right hand corner.

Step 23.  Exit the Plan and Profile Sheet dialog box and save your run. Review the results.

18.3 Motif File Setup

In the following steps we will set up the Motif Files created in the previous section so that the Plan
view file will be displayed in the Plan Port and the Profile view file will be displayed in the Profile
and Tabular Data Ports.

Step 1. Open Plan-Motif.dgn.

Step 2. Attach d17682des.dgn as a reference file. Do a Fit View and Save Settings if
necessary.

Step 3. Open Profile-Motif.dgn.

Step 4. Attach d17682prof.dgn as a reference file. Turn off levels 30 and 63 in the reference
file. Do a Fit View and Save Settings if necessary.

Step 5. Open SuperDia-Motif.dgn.

Step 6. Attach d17682prof.dgn as a reference file. Turn off level 63 in the reference file. Do a
Fit View and Save Settings if necessary.

Step 7. Open d17682work.dgn.

' Note: Any design file that needs to be clipped to the sheets should be attached to the

< Motif Files (e.g. Survey, Utilities, Contours, etc.).

18.4 Move The Profile Clipping Shape

You should notice that the vertical curve data doesn't fall inside the second Profile Clipping Shape. In
the following steps we will move the Profile Clipping Shape utilizing the Modify tools in Plan and
Profile Sheet Composition.

All work should be done in c:\data\geo\VDOT\road1\d17682work.dgn.

Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow
dialog box. Access the Profile run.
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Step 2. Press the Modify Sheets icon. The dialog box below should appear.

|§ | Shape: [Sheet 5, Part 1 ;IEI
[T Slide Preceding Sheets [T 5lide Faollowing Shests
Left Station "I [200+00.00R 1 | Extend: |-200.000 Dynamic!
™ Babiarm Elasvatiar 995 00 || Dy I

Step 3. Press the Identify button then graphically select the second Profile Clipping Shape. The
dialog box should now appear as below.

|§ | Shape: [Sheet B, Part 1 ;IEI
[T Slide Preceding Sheets [T 5lide Faollowing Shests
Left Station "I [205+00.00R 1 | Extend: | 0.0000 Dynamic!

Step 4. Toggle on Bottom Elevation then enter 2000.00 for the elevation. The dialog box
should now appear as below.

”ﬁ Shape: [Sheet B, Part 1 -] ES!.!

[T Slide Preceding Sheets [T/ Slide Following Sheets

Left Station "l |205+00.00R1 | Ewtend: | 0.0000 D_I,Jnamicl
I3 Bottom Elewation: |2DDD.DD[ D_I,Jnamicl

Step 5. Press Apply. Sheet 6, Port 1 should be moved down so that the bottom of the clipping
shape is at elevation 2000.00.

Step 6. Dismiss the Modify Sheets dialog box by pressing the X in the upper right hand corner.

Step 7. Exit the Plan and Profile Sheet dialog box and save your run.
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18.5 Renumber Sheets

Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow
dialog box. Access the Plan run.

Step 2. Press the Sheet Number Manager icon.

Step 3. Select Sequence Numbers 1 through 4 then press the Edit Sheet Number button.

Sequence | Sheet | Alignment | Beqin Station | Estend | End Station |
1 HATIHLINE n.o0 g1 0.00 E 1
2 2 MATNLIHNE  205+00.00 ¢ 1 0.0000 T 1
3 3 HATHLINE o.00 B 1 00000 T 1
4 4 HAIHLINHE n.00 R 10,0000 2 4 FE 1
5 5 HATHLINE 200400 00 B 1 -20... 205+00.00 R 1
& 3 HAINLINE 205+00.00 E 1 0,.o000 212+00.00 E 1
7 7 HAIHLINE 212+00.00 B 1 0.o00o0 219+00.00 E 1
8 8 HATHLINE 219400 .00 B 1 0.00o00 222+06.84 R 1 3

|

“:IEit Sheet Number

™| Highlight Clipping Shape ™ ‘window Center Clipping Shape

Step 4. Populate the Edit Sheet Number dialog box as below then push

Edil Sheet Number l
I Add Prefis: |

Compute Sheet Mumber By:

Starting at Sheet Mumber 'I !3

[T Append Alpha Suffis:

OK.

Sequence | Sheet | Alignment | Bieqin Station |

3 MATHLINE 1 0.00
4 MATHLINE 1
3 5 MAINLINE 1 0.00
4 £ MATINLINE ¢ 1
5 5 MATHLINE 200+00 . R1 i 205+00.
E = MAIHLINE 205400.00 R 1 0.0000  212+400:00
7 7 MATIHLINE 212+00.00 R 10,0000 219400.00
a 8 MATHLINE 219400.00 R 1 0.0000 222406, 84

d|

Emld-lw%'

-
1

.

R i -
Ly

14

"] Highlight Clipping Shape

[T Window Center Clipping Shape
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Step 5.

Select Sequence Numbers 5 through 8 then press the Edit Sheet Number button.

it Sheet Number

Sequence | Sheet | Alignment | Begin Station | Eutend | End Station | Eutend !
1 3 HAIHLINE 200+00.00 R 1 -20. .. 205+00.00 R 1 O.0000
2 4 HAINLINE 205+00.00 R 1 0.0000  212+00.00 R 1 0.o0000
3 5 HAINLINE 212+00.00 B 1 0.0000 219+00.00 E 1 0.0000 4
4 f HATIHLINE 1 222406 . R 1 s
5 HAINLINE 7 1 7 1 .
3 HAIHLINE 7 1 7 1
7 HATIHLINE 21 21 EI
3 HAINLINE 7 1 T 1 =
Ed
B m

™ Highlight Clipping Shape [T window Center Clipping Shape

Step 6.

Populate the Edit Sheet Number dialog box as below then push OK.

[Edit ShectNumber =~ |
"] &dd Prefis: I

Compute Sheet Mumber By:

Starting at Sheet Mumber 'I !3

V| Append Alpha Suffis: !
Begining Letter(z): ia Lowercaze vI

Cahicel |

The Sheet Number Manager dialog box should appear as below.

(& Plan Sheet Layout Sheet NumberManager M=)

Sequence | Shest | Alignment | Begin Station | Estend | Erid Statian | Estend |
1 3 MATHLINE 200400.00 B 1 -20... 205400.00 B 1 0.0000
2 4 MATIHLINE 205+00.00 R 1 0.0000 212+00.00 B 1 0.0000
3 5 MAINLINE 212+00.00 R 1 0.0000 219+00.00 R 1 0.0000 |4
4 £ MAINLINE 1 222406 R 1 &
MATHNLINE 0.00 R 1 1 0.0000 3
MAIHLINE 1 1 0.0 S
MAINLINE T t 1 {3
MATHLINE vl ¢t 1 jﬂ
a 2]
I Highlight Clipping Shape 7 Window Center Clipping Shape

Step 7.

Dismiss the Sheet Number Manager dialog box by pressing the X in the up
hand corner. Press Yes when prompted to Save Settings.

per right
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18.6 Clip Plan Sheets

You should still be in the Plan

Step 1.

r Output File

Directory: | &l

Sheet Fange Begin: |3

run from the previous section.

P'Ian Sheet Layout: Clip Sheets ! 1

Sheet Mame Prefix ICH TFRAZ00 d17ER2003 dan
Orientation: | Hotate Referance Vi

Sheets per File: |'| Model | Active "I
=| End |B ]

r Labels and dnnotations

Sheet Title: [123

Project Mumber: | 0123-015-105, C-501

tatch Line; IStatinn PN IMatch Line
™ Ausiliary Sheet Annotations L

[T Create Digital InterPlat Plat Set
= il I_ \dabatgea\wdat toadl \plal i

Press the Clip Sheets icon. Populate the Clip Sheets dialog box as below.

§=ull

Note: The Sheet Title field will be used to place the Route Number.

Step 2.
Step 3.
Step 4.

Step 5.

Click the Process Sheets button to create the plan sheets.

Exit the Plan and Profile Sheet dialog box and save your run.

Dismiss the Clip Sheets dialog box by pressing the X in the upper right hand corner.

Open any of the newly created Plan Sheet files to see the resulting sheets.
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18.7 Clip Profile Sheets

The following steps should be done in design file d17682work.dgn.

Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow
dialog box. Access the Profile run.

Step 2. Press the Clip Sheets icon. Populate the Clip Sheets dialog box as below.

P‘Ian Sheet Layout: Clip Sheets ! 1

r Olutput File
Directory: | EJ
Sheet Mame Prefi: [d176820 | d1768203a.dan
Orientation: _Fotate Reference Vi
Sheets per File: |1_ Model: | Active 'I

Sheet Range Begin: |3a >| End |Ga |

r Labels and Annotations

Sheet Title: [123

Project Mumber; | 0123-015-105, C501

Meakeh e I SR I

] Awiliar Sheet Snnotations Lyt
- [T Create Digital InterPlat Plot Set
H I. \datalg vedoload yplak i

Note: The Sheet Title field will be used to place the Route Number.

§ =il

Step 3. Click the Process Sheets button to create the profile sheets.

Step 4. Dismiss the Clip Sheets dialog box by pressing the X in the upper right hand corner.
Step 5. Exit the Plan and Profile Sheet dialog box and save your run.

Step 6. Open any of the newly created Profile Sheet files to see the resulting sheets.

Step 7. Exit MicroStation.
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CHAPTER 19

D&C Manager - Quantities

19.1 Introduction

Objectives

Understand the operational modes of the D&C Manager including
calculating automated quantities.

Project Manager

Plan View Design

Tools
=2
Menu Bar Application GEOPAK Road > Design and Computation Manager

The Design and Computation Manager (D&C Manager) is a tool that enables the user to standardize
graphics elements for drafting and pay item quantities. To review how to access the Design and
Computation manager, see session 7.

One of the major goals of any design project is the cost-effective development of plans production
sheets. This includes construction plans, profile sheets, estimated quantities, and various other
sheets needed to actually construct the design. Although generic MicroStation commands can be
utilized to produce the required sheets, several GEOPAK tools can be used in conjunction with the
Design and Computation Manager and these MicroStation commands to help automate the process.

Other GEOPAK tools are within the Design and Computation Manager and various plan view
functions:

e Controlling Various MicroStation Copy Functions utilizing the Place Influence option and the
Design mode

e Controlling the MicroStation Display Filters (Display mode)

e Changing the MicroStation symbology via GEOPAK Items (Set mode)

e |dentification of plan view areas to incorporate into the automated quantities (Shape mode)
e Plan view quantities (Compute mode)

e Pavement Markings

e Pavement Symbols

19.2 Operational Modes

Several operational modes are supported within the Design and Computation Manager. The Design
mode was discussed in session 7. In this session, the following modes are reviewed: display, set,
shape, compute and pavement markings.

19.2.1 Display

Display mode is used to enhance on screen visualization by enabling the user to manipulate the
display of GEOPAK intelligent elements.
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The feature(s) to be visualized are added to the Collection box — the bottom window of the D&C
Manager dialog box when set to Display or Compute modes. Individual items or entire categories
can be placed in the collection by utilizing the Add to Collection icon as shown below.

E[Hma’dﬂomldimlh’ﬁger !Em
_Fle Edit Seftings Favortes Help
o] o] P
&8 [ hdatahgeotydothoad] kstandalds'\geopakWDDTed Edd Highlighted to the Collection
[ Road Dezign

£ Aligriments

23 Box Culverts

23 Construchion Limiks

=7 Curbing
[ 014414 Curb [CG-2)
0144141 Curb [CG-2) Left
(8 014414R Curb [CG-2) Right
P, 012020 Standard Curb CG-2
[ 0120200 Standard Curb CG-2 Left
A 012020R Standard Curb CG-2 Right
(8 012022 Radial Curb CG-2
(B8 01202201 Radial Curb CG-2 Left -_]
[ 012022R Radial Curh CG-2 Right - =
b = Fxm2020 .. x|

;L@ 012020 Standard Curb CG-2

ﬁ ol om|m:
| |

Three display options are supported for the display of the items in the Collection box.

e Highlight - changes those items stored in the collection area to the MicroStation highlight
color.

e Not - simply turns off the display of the collection items leaving everything else on.
e Only - will turn off everything but the collection items.

Before utilizing the display filters, visualization is enhanced if all the elements on the screen are gray,
or another singular color, rather than the vast conglomeration of color seen on the screen for a typical
project. Therefore, to set the color, select Settings > Display from the menu bar. The Display
Preferences dialog box appears.

gDispla}l Preferences m

[ One Color Display

™| Highlight i Computation

Cancel

19.2.2 Set

The Set mode allows the user to assign attributes from the ddb database to existing graphical
elements in the file. Three methods are available for specifying the graphic elements to be changed:
individual element selection, Complex Chain or MicroStation Selection Set.

When changing individual elements, highlight the desired item in the D&C Manager dialog box. Click
Set, then datapoint the element to modify, then datapoint off the element to accept.

Complex Chain automatically creates a chain from graphic elements and applies the attributes of the
highlighted item in the content box.
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To modify the symbology of many elements to a single item, create a MicroStation Selection Set of
the elements. Next, click Set to transfer the attributes of the item selected in the D&C Manager to the
items identified in the MicroStation design file.

Fle Edit Seitings Favorites Help

i i

& [hdatalgeohvdotiroad]standards geopak WD O T englizh. ddb =]
{7 Foad Design

£ Alignments i

£ Box Culverts

1 Canstuction Limits

{7 Curbing

014414 Curb [CG-2)

01447141 Curb [CG-2) Left
014414R Curb [CG-2] Right
1 tandard Curb CG-2

0120201 Standard Curbs C5-2 Left e
& (11 2020R Standard Cub CG-2 Right | & 012020 Standard Curb CG-2

2022 Radial Curb CG-2
0120221 Radial Curb CG-2 Left
012022R Radial Curb CG-2 Right _v_I

"] Use Complex Chain - Adhos Attributes

19.2.3 Compute

An important, yet time-consuming part of any project is the computation of quantities. Through the
Compute mode of the Design and Computation Manager, GEOPAK offers tools that make the
completion of this task much quicker and easier. In addition, since the software utilizes the plan view
construction drawings to compile quantities, discrepancies between the drawings and the tabulated
guantities are non-existent. Chosen items within either the View or a Fence are calculated

File Edit Settings Favorites Help

& [ Mdatahgeohwdotyoad] standardshgeopak WD O T englizh. ddb ﬂ

= Road Design

3 Alignments

23 Bow Cubserts

23 Construction Limits

[ Curbing

014414 Curb [CG-2)

0744741 Curb [CG-2] Left
14414 Cunb [CG-2] Right

=1
B 0120200 Standard Curk CG-2 Left
(&8 012020R Standard Curb CG-2 Right
M 2022 Radial Curb CG-2
0120221 Radial Curb CG-2 Left
012022F Radial Curb CG-2 Right :_I

!L@ 012020 Standard Cuwrb CG-2
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& Plan Quontity Computation ———_ MEE
Job: Wﬂ Extertz: | Active Dezign File_vi Inzide 'I;i
r Baseline Reference 1
Chain Vi mﬁ__ﬂﬁ ¥ Begin Station; I-D_D:-D_D-Ijﬂ_ 2&
¥ Range: [10000 ¥ End Station: Im ﬁi

¥ Hilite During Computation V! | Compute Luantities i |

Once the MicroStation plan view design file is accessed, the first step is to invoke the Design and
Computation Manager and click the shortcut button at the top of the dialog box to Compute.

The dialog box changes dynamically to reflect the compute operation.

The Design and Computation Manager dialog box is resizable. Within the dialog box, the sash (long,
thin bar between list boxes) enables the user to adjust the partition between the list and collection
boxes while the overall dialog box size remains constant. Simply place the cursor over the sash and
dynamically move.

In addition to dynamically adjusting the main dialog box to reflect the compute operation, the auxiliary
dialog box is invoked as depicted below. Note if the auxiliary dialog box was already invoked from
another operation, it dynamically changes to reflect the Compute operation.

The next step is the selection of the correct item from the hierarchy. GEOPAK computes quantities
only for those hierarchical items that are configured for the computation of quantities.

Two selection methods can be employed. The first method is to select an entire category. GEOPAK
computes quantities for every item found in the selected category as well as any child categories.
This is accomplished by double clicking through the groups until the desired category is contained in
the Content list box. Single click onto the desired category and click the Add to Collection button at
the top of the dialog box.

The second method involves the selection of individual features. This is accomplished by double
clicking through the categories until the desired item appears in the hierarchy list box. When seen in
the hierarchy list box, a single click onto the desired item and subsequent click of the Add to
Collection button places the item in the Collection box.

Several output formats are available as described in the table below.

' NOTE: All Extents options are sensitive to the Inside, Overlap and Clip modes.
L]
Job Number GEOPAK Coordinate geometry database (GPK) file wherein the specified chain is
stored.

Extents > Active If the Active Design File toggle is selected, all selected items that are in MicroStation file
Design File will be computed.

Extents > View If the View toggle is selected, only selected items that can be seen in MicroStation view
one will be computed. If the view includes area outside of the Range, the Range will
override.

Extents > Fence If the Fence toggle is selected, a fence must be placed, and all specified graphical
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features which are inside both the fence and the Range will be tabulated.

Extents > Boundary
Element

If the Boundary Element toggle is selected, all selected items that are in a selected
Boundary Element will be computed.

Extents > Station If the Station Range toggle is selected, all selected items that are within a selected
Range Station Range will be computed.
Extents > Sheet If the Sheet Range toggle is selected, all selected items that are in a selected Plan Sheet
Range Clip Boundary will be computed.

Extents > Selection
Set

If the Selection Set toggle is selected, all selected items that are in a MicroStation
Selection Set will be computed.

Extents > Boundary
Selection Set

If the Boundary Selection Set toggle is selected, all selected items that are in a group of
boundary elements within a MicroStation Selection Set will be computed.

Highlight
Computation

During

When activated, all MicroStation elements utilized in computations are highlighted in the
selected color.

Baseline Reference >
Chain

Requires a minimum of one chain, which must be stored in the specified job number.

Baseline Reference >
DGN

The user can graphically select a DGN Element to be used as a Baseline Reference.

Baseline Reference >
None

When None is selected, nothing is used as a Baseline Reference.

Identify Chain

The Identify Chain Selector allows the user to graphically select the desired chain.

Range

Left and right offset limits (in master units) from the chain where the quantities will be
computed. Any specified item located outside of the limits is not included in the report

Begin/End Station

Station range for computing quantities

Compute Quantities

Commences the computation process.

After the desired quantities have been computed, a second dialog box will be displayed containing
the computed quantities. The dialog box is shown below.

|8 Comutation Fesus______________________EEH|

Item | Description | Quantiy | Unit_ | Expoit I
012020 Standard Curb CG-2 47520 LF i
Export Format: | |tem Report 'I I &I Create 'I Ewpont I

e | T [ _| _.EEM

GEOPAK 2004 Edition
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Several output formats are available as described in the table below.

A more detailed report that lists not only quantity summaries, but also
geometric properties such as plan view coordinates and station/offsets for
located elements. File is in ASCII format.

Quantities Summary listing pay items, descriptions, units and total
quantities for located elements. File is in ASCII format.

Contains the same information as the Item Report, but formatted in tabular
form.

Very detailed information including calculated and rounded quantities,
geometric properties, pay item numbers, descriptions, station / offset
values, etc. The format is the selected database (i.e., Microsoft Access,
Oracle, SQL Server, and dbase.

Quantities Summary listing pay items, descriptions, units and total
quantities for located elements. Format is in CSV format.

A more detailed report that lists not only quantity summaries, but also
geometric properties such as plan view coordinates and station/offsets for
located elements. Format is in CSV format.

A method of grouping various quantities and / or pay items.

Comp Book
Item Report
Item Tables
DBMS

CSV By Item
Csv By
Element

Run

Phase

Quantities can be separated into various phases, as a means to group
various pay items. Default phases include: Design, Preliminary, and
Final. Note the user can add new phases, but must be aware of naming
limitations of downstream applications (i.e., Transport links in Quantities
Manager.)

19-6 VDOT Road | Training

GEOPAK 2004 Edition



GEOPAK”

19.2.4 Shape

The placement of shapes for area quantities is simple and fast when utilizing the shape mode. In

order to place a shape, GEOPAK must identify a closed area.

This area can be defined by

intersecting elements, which do not have to be clipped or shortened to define the closed area. There
are three options for placing shapes depending on the complexity of the plan view and the type of
area where quantities are desired:

e Automatic - best utilized when the elements forming the shape do not conflict with other
elements in the view.

e Semi-auto - utilized when the plan view has more conflicting elements or where the selection

of an area produces very small shapes.

In this method, the user is prompted when each

element is selected to determine the path of the software in producing shapes.

e Exclusive - This option utilizes the automatic option, but in addition, prompts the user for the
identification of an area inside the original shape that is excluded from the area quantity. The
Exclude mode is useful for curb and gutter around a traffic island.

Any of the three options may be chosen during the course of shape placement. To change from one

option to another, simply adjust the option button on the right side of dialog box.

[ Pavemnent
EXFaVE - Existing Pavemient
B ExSHLD - Existing Shoulder Lines
SAWEUT - Saw Cut Lines
900343 Bridge
4 300310 Standard Box Culvert
900344 Edge Of Pavement
900345 Private Entrance
[ 300346 Paved Shoulder
(024400 Obscuring B oadway

1 024410 Demolition of Pavement

(& 024420 Demalition of Pavernent [Rigid)
024430 Demaolition of Pavement [Flesible]
£3 Fipes _:__I

[ Desion and Computation Manoger ——_ MEIE
Fle Edit Settings Favorites Help
e ErE
£ Paved Ditches ;'

| £ 024410 Demolition of Pavement [_ ] x|

Seni-auto I ————
Hesume Tolerance; ID.1EIEIEIEI

GEOPAK 2004 Edition
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19.2.5 Pavement Marking

File Edit Settings Favorites Help

i) 1] Bl2¢] o ol U T R

[ Traffic
23 Existing
2= Proposed
23 Conduit
21 Cable

far Striping
&8 SKIF10 - 10" Skip Line
DASHS - 4" Dash
DASHE - 8" Dash
LIME4 - 4" Line
LIMEE - " Line
@8 LINES - 8" Line
& LIME12 - 12" Line
LIME24 - 24" Line
23 Juriction Boxes _'_I

The Pavement Marking mode allows the user to place pavement marking including striping, and
symbols.

The various tools are detailed in the table below.

Striping Places single or double, solid or skip pavement stripes.
Separation Places traffic separation pavement marking.
P —
SIS
—t
Chevron Diverge Places pavement chevrons in areas of diverging traffic.
=
R
Chevron Merge Places pavement chevrons in areas of merging traffic.

=
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GEOPAK”

19.2.5.1 Single Striping

This dialog box offers predefined configurations for single stripe
and double stripe options to easily control the type of striping
being placed.

[Boawsipng MEIE|
rPatterr | Single Stipe A vI
Single ! ESKIF’1D-1D'Skip Line |

The pay item reflects the currently selected pay item in the D&C
Manager dialog box; however, it may be changed at any time
during the process.

Skip 'I Start on Stripe"
Next, define the start option by selecting Solid or Skip (or a Stipe: 1000 | Skip 7000

combination thereof). If Skip is active, the user must define the
stripe and skip lengths. If an ending stripe is shorter than the
Tolerance value, it will not be drawn.

Tolerance: i 0.00100

- Reference Element

Chain ¥| [MAINONE | =] J]
Begin: [200+00.00 i
End: [222+05 84 @

A beginning and ending point for the limits of striping are
entered from digitized points on the screen.

The lower portion of the dialog box provides tools for identifying Difset: [12.00
the reference element on which the striping will be based.
e

After clicking Draw Stripes, the user must enter a data point on either side of the reference element
to begin striping. Striping is placed at the indicated offset value; the data point controls whether
striping is offset left or right. Striping is placed as a graphic group.

19.2.5.2 Double Striping

The process for Double Striping is the same as Single, except
for having two pay item placement options, Inside and Outside
and a user definable Distance Between Stripes. The user must

~Fattern: | Double StriEe.i\ vI

select either the Inside or Outside button for the highlighted
(D&C Manager) pay item to be displayed in the dialog box.
Separate quantities are calculated for each stripe.

Inside I ;LSKIF'1D-1D'Skip Line |
Diztance Between Stipes: | 5.00
Outzide I %SKIF“ID -10' Skip Line |

The remaining process is the same as described above. Solid/Skip_ | | Starton Stipe ¥ |
Stripe: | 10.00 Skip: | 10.00

Tolerance; i 0.00100
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19.2.5.3 Separation

This option draws pavement markings between two sets of
selected elements. Elements may be either GEOPAK or
MicroStation generated.

Once a pay item has been selected, the user may set the
Distance Between Stripes and the Slash Stripe Angle.
Tolerance functions the same as for striping.

A Begin DP and End DP should be issued before the Reference
DP is identified. The Reference DP must fall between the
beginning and ending DP. It marks the location of the first
pavement marking and determines the direction of the slashed
stripe. All other markings will be based on the first stripe.

Tools for defining the limits of the pavement markings are located
at the bottom of the Separation dialog box. ID Intersection
identifies the elements where the striping will terminate. ID
Location is the set of elements from which the striping begins.

& Do Scporation  WEIE|
ltem | |SKIP10 - 10 Skip Line |
Distane Between Stripes: ﬁW’

Firned "i Slash Stripe Angle: FiE.DL_
Tolerance: Im

~ Begin Point

[ 00000 ;[T 0.0000 |
- Reference / Pivot Paint

s [ ooooo | Y. [ 00000
~ End Point

w. [ ooooo | v [ 0.0000 2]

Side 1: _Single Element ¥ | 3]
Side 2: _Single Element ¥ | 4]

| e

After the Draw Separation button is selected, the user must issue a data point in the graphics file for

the pavement markings to be displayed.

19.2.5.4 Chevron Diverge

Once the pay item and its relative parameters have been defined,
there are three points needed to define the chevron: Gore,
Breaking Line and Point.

The Gore point defines the wide end of the gore.

The Breaking Line point must fall between the two sides of the
gore and sets the location of the point at which the chevron
diverts in a different direction.

The Point represents the narrow end of the gore where chevrons
are to stop.

Use the Side 1 and Side 2 buttons to identify the sides of the
gore. Once the Draw Chevron Diverge button is selected, the
chevrons are displayed.

ltem | |SKIP10- 10 Skip Line |
Digtance Between Chevrons: I 10.00

Tolerance: | 000100

- Gore Point Mwide End of Gore)

wo [ oooon | v [T 00000«
r Breaking Line

% [ Gooon v [ 00000 |
- Diverge Point (Marmow End of Goreg)

% [ Goooo v [ 00000 |«

Side 1: Single Elemnent Vij&ﬂ
Side 2 | Single Element ¥ | ]

|- Braw Chevion Diverge ]
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19.2.5.5 Chevron Merge
This process works basically the same as Chevron Diverge [l e -1x]|

except the two points, Gore and Breaking Line, have been ltem ||5K|P1u-1u'5kip|_ine |
combined into one point that serves both functions.

Distance Between Chevrons: I 10.00

The Gore and Break DP should be located near the wide end ~ Tolerance: [0.08100
of the chevron. It simultaneously sets the beginning of the | [ %ore/ Bresk Pont [wide End of Gere] —
pavement markings and the point at which the chevron will % | 00000 v 00000
break.

r Merge Foint [Narraw End of Gore)
The remainder of the process is as described above. w [ oooon v [ 00000 s

Side 1: | Single Element | 1&]
Side 2. _Single Element ¥ | 4]

[ Braw Chevion Merge |
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LAB 19: Quantities with D&C Manager

19.1 Accessing Plans Production Tools

Step 1.
Step 2.

Step 3.

Step 4.

Execute C:\data\geo\VDOT\road1\LAB19.EXE.

Open the MicroStation file c:\data\geo\vdot\road1\d17682des.dgn.

Access the Road Workflow dialog box in Project Manager.

Click the Plan View Design button. This opens the Plan View Design tools tool
frame. Open Design and Computation Manager by clicking the left most icon.

Plan Yiew Desi._. x|

&< | A

D&C Manager should open up to the standard VDOTenglish.ddb.

Navigate to the category Road Design > Curbing as shown.

File Edit Settings Favorites Help

=R FECRE

[ Road Design
£3 Alignments
23 Bow Culverts
23 Construchion Limits
fa Curhing
014414 Curb [C15-2]

014414R Curb [CG-2] Right

@ 012020 Standard Curb CG-2
0120200 Standard Curb CG-2 Left
[ 012020R Standard Curb CG-2 Right
(&8 012022 Radial Curb CG-2

0120221 Radial Curb CG-2 Left
012022F Radial Curb CG-2 Right

&= Chdatageohwdotvroad] hstandards\ geopak WD O T englizh.ddb

&
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19.2 Compute Quantities
Step 1. Set the current D&C mode to Compute.

Highlight the item 012020 Standard Curb CG-2. This will make it the active item for
computing quantities.

File Edit Settings Favorites Help

i i 2] 1 T

& [ Mdatahgeohwdotyoad] standardshgeopak WD O T englizh. ddb -
= Road Design
3 Alignments
23 Bow Cubserts
23 Construction Limits
[ Curbing
014414 Curb [CG-2)
0144141 Curb [CG-2) Left
014414R Curb [CG-2] Right
072020 Standard Curb CG-2
g 01202001 Standard Curb CG-2 Left
[ 012020R Standard Curb CG-2 Right
012022 Radial Curb C5-2
0120221 Radial Curb CG-2 Left
012022R Radial Curb CG-2 Right _v_I

— =

Step 2. Use the Display options to make sure there are graphics to compute for this item.

By clicking on the icon as shown below, all graphics except the appropriate curb graphics
should be turned off.

Step 3. Populate the supplemental dialog box as shown below.
_ Plan Quantity Computation I
Job: |1D1 gl Extentz:  View Vi Ihzide "I;J

Bazeline Reference 1

Chain | [MAINONE =] [§] W BeginStation: [Z00+00.00 «]
V| Fiange: !1DD.EIEI ¥ End Station: |222+DB.8= ﬁi

! Hilite During Computation VI | Cornpute Luanhties i |

Step 4. Since we are doing the quantities based on what is displayed in View 1, be certain to fit
all graphics in View 1.

Step 5. Click Compute Quantities. Review the output.
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Cmnpdatim Results == 1

Item | Description | Quantity | Unit |

Expart _I

012020 Standard Curb CG-2 475.20 LF

Export Format: _ltem Report VH 3! Create 'l E:-tportl
@ian _I Dizplay |

Dismiss

Step 6.

the Output dialog box.

Now let's see how to compute multiple items at one time.

Returning to the main D&C dialog box, add the curb item to the collection box as shown:

g[)esig'aard(:mrpddim Manager !EE

_Hle Edit Settings Favorites Help

o] 1] ] B ] )

& [Chdatahgeohwdathioad! \standards\genpak'\\-"DDTer{.ﬁdd Highlighted to the Collection

[~ Road Design

£3 Alignments

7 Box Culverts

3 Construction Lirits

[= Curbing

014414 Curb [CG-2)

01441410 Curb [CG-2] Left
014414R Curh [CG-2) Right
1 tandard Curh CG-2

&8 01202001 Standard Curb CG-2 Left
M2020R Standard Curb CG-2 Right

2022 Radial Curb CG-2
20221 Radial Curb CG-2 Left
012022F Radial Curb £G-2 Right _v_l

I 012020 Standard Curh CG-2
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Step 7.

Step 8.

Step 9.

Step 10.

Navigate down and add another curb item to the collection box as shown:

Fle Edit Settings Favorites Help

o e = AS] ki i

0123221 Asphalt Concrete Curb Type MC-3B Left

8 012322R Asphalt Concrete Curb Type MC-3B Right
012323 fizphalt Concrete Curb Type MC-3C

(B8 0123231 Asphalt Concrete Curb Type MC-3C Left

@ 012323R Asphalt Concrete Curb Tepe MC-3C Right

3 012505 Azphalt Concrete Curb Backup Matenal

A 0125051 Azphalt Concrete Curh Backup Material Left
(112505F Azphalt Concrete Curb Backup Material Right

00 Standard Comb. Curb & Gutter CG-5
{8 0126001 Standard Comb. Curb & Gutter CG-E Left
012600F Standard Comb. Curb & Gutter CG-6 Right
(&8 012610 Radial Comb. Curb & Gutter CG-6
M 2610L Radial Comb. Curb & Gutter CG-E Left
i 012610R Radial Comb. Curb & Gutter CG-6 Right

012700 Standard Comb. Curb & Gutter CG-7

@8 012600 Standard Camb. Curb & Gutter CG6
&8 012020 Standard Curb CG-2

Click Compute Quantities. Review the output.

Cumpd:-lion Results == -I

Item | Description | Quantity [Urit | Esport I
012600 Standard Comb. Curb & Gutter CG-E 1133.80 LF
2020 Standard Curb CG-2 475.20 LF

Ewport Format: | |tern Report V“ gi Create 'I
R _! Dizplay |

Next we will export the quantities to an Item Report. Set the Export Format option to
Iltem Report. Enter the output file name item.txt. The dialog should appear as below.

[ & Computation Results MEH|

Item | Description | Quantity | Urit | Export I
012600 Standard Comb. Curb & Gutter CG-6 1133.80 LF
012020 Standard Curb CG-2 475.20 LF
Ewport Farmat: | |tem Report VI I it bt Bj Create "I
Run | Phase | Dasark shimats _! Display |

Click Export. A file named item.txt should be created in the working directory.
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Step 11. Open item.txt using the GEOPAK editor. The file should appear as below.

Hle HEdit Criteria

=[] 4 [B[@] ~[~]

i i
| Fay Items List |
I Date 2372005 4:43:13 PH File Hame.item.t=xt I
_ _ . |
| Item Ho. | Description | Unit | Quantity |
| | | | |
|012600 | Standard Comb. Curb & Gutter CG-6 | LF | 1139.800
|01z2020 | Standard Curb CG-2 | LF | 475 200 |

| |Linez 1 |Cal: 1

Step 12.  Dismiss the GEOPAK editor.
Step 13.  Exit Design and Computation Manager.

Step 14.  Exit MicroStation.
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CHAPTER 20

3D Modeling

20.1 Introduction

Objectives - Create 3D cross-sections from 2D cross-sections
- Interpolate between 3D cross-sections to create B-spline
surfaces.
- Use Drive Through to view the model
- Place pavement markings on the 3D model
Project Manager 3D Models
Tools 3D Tools |
Menu Bar Application GEOPAK Road > 3D Tools > 3D Modeling

GEOPAK 3D Modeling is a process of deriving three-dimensional cross-sections from two-
dimensional cross-sections and interpolating between the three-dimensional cross-sections to create
b-spline surfaces that represent the design.

20.2 Prerequisites

Before a 3D model can be extracted from 2D cross-sections, there are a few prerequisites that must
be met. They are:

2D design cross-sections - The user should have an existing design file where 2D cross-
sections are stored and know which levels contain the existing ground line and proposed
finished grade.

Plan view graphics - The user must also have another 2D-design file containing plan view
graphics. The plan view graphics should include the elements that match the cross-section
features such as EOP, shoulders, etc specified in the Run.

3D design file - A blank 3D-design file must exist to store the 3D cross-sections as they are
generated. Enter the 3D-design file and attach the 2D-plan file as a reference file (the
baseline must be plotted in the plan file). Save the settings of this file with only the Top View
displayed.
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20.3 3D Modeling Tools

From a 3D-design file, access the 3D modeling tools by selecting Project Manager > 3D Models or
by selecting the 3D Models icon.

File

dob: [107 | Q)
Chain: [MAINLINE =] 4]

[ 30 Algnment

3D Cross Sections

Interpolate Bebween Sections

30 Pavemant Markings

The dialog box appears requiring a Job number and Chain name. This session primarily focuses on
3D Cross-sections, Interp Between XS and Pavement Markings. Descriptions of available 3D
modeling tools follow:

o 3D Alignment - draws elements into a 3D file, at correct coordinates, using the specified
alignment and profile.

e 3D Cross-sections - references your 2D cross-section file and create a 3D complex chain to
represent the 3D cross-sections.

e Interpolate Between XS - interpolates between the 3D cross-sections to create B-spline
surfaces.

e Pavement Markings - adds pavement markings to a 3D model. The pavement-marking tool
scans pavement markings in a 2D file and draws the markings in the 3D file based on user
defined parameters.

20.4 3D Modeling Process

GEOPAK opens the 2D cross-section file, scan the cross-sections and create a complex line-string
based on the cross-sections. GEOPAK then returns to the 3D design file to draw the 3D cross-
sections. B-spline surfaces must be created using Interpolate Between XS.

i 3D Cross Sections !El m I
%5 DGM File: | Yedothroadhdl B8 2wsmainling. dgn Files... |
Current Statior: - 200+00.00R 1

Begin Station:  200+00.00F 1 iEI:II:I+I:IEI.DD R
End Station:  220+00.00F 1 l22D_+DD.DD F1

- Level Sumbology Search Criteria

Esizting Graund Line

Propozed Finizh Grade

Apply |
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20.5

20.6

Generate 3D Cross-sections

Enter the 2D cross-section file containing design cross-sections; GEOPAK reads the file to determine
the beginning and ending station of the cross-sections. These stations are automatically displayed in
the dialog box, however, the user may key in a different range.

Define the attribute information for Existing Ground Line and Proposed Finished Grade. If Project
Manager is active, these attributes can be filled out automatically by the Working Alignment.

Select Apply to commence processing.

GEOPAK opens the 2D cross-section file and begins creating 3D complex line-strings from each
cross-section. Each 2D cross-section will highlight as the line string is formed. This gives the user a
brief opportunity to check for errors. When the process is complete, GEOPAK returns to the 3D file to
draw the cross-sections.

A visual inspection of the 3D cross-sections should be performed to verify their integrity. The colors
of the 3D-line string should reflect the same colors as shown in the 2D-design cross-section. If an
error has occurred, the user should return to the 2D-design cross-section file and fix the appropriate
cross-section(s) using GEOPAK and/or MicroStation. Repeat the 3D cross-section process for any
revised cross-sections and review.

Interpolation Between XS

Method: | Longitudinal ™
- Begin Station
Station | | 200+00.00R 1 OF Offzat; |-2EIEI.DDEIEIEI
LF Dffset: [200.00001:
- End Station
Station | [204+25.00F 1 LF Offzet; |-2DD.DDEIEIEI
LF Offzet; I2DD.EIEIEID2E
[T Highlight Applied BreakLines ] Forced Calor, | _]
| Diraw Surfaces i

Two Methods exist for interpolating cross-sections:

e Longitudinal - is used when a 2D-plan view is referenced to the 3D cross-section file. This
is the most common method.

e Surfaces - should be selected when your plan view reference file is a 3D file.
Beginning Station and Ending Station - values will automatically be displayed when each of their
offsets are defined. Offset information must be entered in order and is controlled by successive

activation of the DP buttons. The user must define the Beginning Station offsets by first issuing a DP
for the left and right offset locations. The same process is repeated for the End Station box.

Highlight Applied Breaklines - will highlight the break lines used in interpolation when toggled on.

Select the Draw Surfaces bar at the bottom of the dialog box to begin the interpolation process. The
user is encouraged to process a small range of cross-sections until the entire project has been done.
When GEOPAK interpolates 3D cross-sections, it projects like color to like color between cross-
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sections. All MicroStation elements should maintain a consistent color scheme throughout the
project. For example, within a 2D file, all ditch slopes should be drawn the same color and roadway

lines should also be drawn using one color.

If colors do not correspond, you will get a “Color

Mismatch” error and the process terminates. There are two ways to correct this error:

e Check the cross-sections for an inconsistent color scheme, correct any errors, then
regenerate the necessary cross-sections, or

e Activate the Force Color toggle; this will allow GEOPAK to ignore the color of the cross-
section elements and interpolate using only the specified color.

After interpolation is complete, review the 3D model using GEOPAK Drive Through.

20.7 GEOPAK Drive Through

Project Manager

3D Models

Tools

@

3D Toolz x|

Menu Bar Application

GEOPAK Road > Other Components > Drive Through

GEOPAK Drive Through provides the user realistic visualization of 3D surfaces. When invoked, the
dialog box below is displayed.

| £ Drive Through Window mEE|
Jahe W E\J
Chain: m xE]
Plan iew Offzet: !_D-DF_
Yertical Dffset "! W
Station: W
Step Incremeant: i_EE-DD_
Target Offzet: W

] A80] ] 180
|E"'"[5Eé't'é"§'E5i't'i'r'i§"ﬁi5iﬁi""‘;! Wiew: 1 7]
Apply |

The user must enter the Job Number and a Chain name. The drive through will follow this chain or
may be offset from the chain by entering a value in the Plan View Offset box.

Two options are available to define the distance the driver is from the roadway vertically:

e Constant Elevation will place the driver at a fixed elevation, as defined by the user,
throughout the drive through process.

e Vertical Offset places the driver at a specified distance above the model, meaning the
elevation of the view changes with the elevation of the model.

The Station value automatically displays the beginning station of the selected chain, but may be
changed by user key-in.

Step Increment defines the distance traveled between each camera view.
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Target Offset defines how far down the road the viewer is looking (the focal point).

Pressing the Locate Starting Point button finds the first station on the alignment where a 3D graphic
element is present. This is a convenient way to locate the start of a model.

View indicates the MicroStation view to be processed.

Press the Apply bar to activate the first camera view. Once the first view is displayed, the user may
pan the view by moving the slide bar to the desired angle and pressing the Apply button again.

After viewing the model:

e Restore the view by rotating to the top view.

e Access the Settings > View Attributes dialog box from the MicroStation command window
and toggle Camera off (automatically toggled on during drive through process).

20.8 3D Pavement Markings

This tool places pavement markings in a 3D file by extracting graphic information from the plan view
2D file.

| 3D Pavement Markings !E 1
Fieference File: | d17682des.don Files... |

Search Criteria e

Shipe width: 1 oo Surface Elevation Offzet; | oo

view |1~ [: e |

Note: Pavement markings created by copying parallel a complex element must be dropped before
they can be included in a 3D model.

Enter the name of the 2D graphics file containing pavement markings.
Provide Search Criteria by entering the graphic attributes of the pavement markings.
Stripe Width reflects the actual width of the plan view stripe you want to create.

Surface Elevation Offset is the distance from the B-spline surface the stripe shape is drawn.
Special attention needs to be applied to this value. If the distance is too low, the stripe may fade into
the roadway; if the distance is too high, the stripe may cast a shadow on the road surface when the
model is moved to a visualization software package. It is desirable to place the stripe just above the
surface. Begin by using a value of 0.10; if adjustments are necessary, use small increments.
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LAB 20: 3D Modeling

20.1 3D Alignments
Step 1. Execute C:\data\geo\VDOT\road1\LAB20.EXE.
Step 2. Open the MicroStation file c:\data\geo\vdot\road1\d176823d.dgn

Step 3. Click 3D Models from the Project Manager dialog box and populate the dialog box as
shown. Chain — MAINLINE.

3D Modeling T__. 1

File
dob: [107 | Q)
Chain: [MAINLINE =] 4]

[ 30 Bligrment

3D Cross Sections

Interpolate Bebween Sections

30 Pavement Markingz

Step 4. From the 3D Modeling Toolbox click 3D Alignment. Be sure the chain MAINLINE and
profile MAINLINE are selected. Populate the rest of the dialog box as shown below.

Chain [MAIHNLINE =]
Prafile [MAINLINE |

Dffset [0.0000 | GEOPAK Set Feature |

Harizontal Scale I 10 r Sumbalogy
Vertical Scale [ 10 Level: [Level 57 =]
- Symbology Color: [l 3 ]
Sle: | 0 =]
wieight: | 0 |

Cancel I

Click the Apply button. A 3D alignment is created in your design file.

Step 5. Dismiss the 3D Alignments dialog box.
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20.2 Generate 3D Model

3D Tools (=l

Step 1.

Step 2.

Set the Active MicroStation level to 2 and Save Settings.

cross-section will be drawn on this level.

Step 3.

Populate the dialog box as shown.
Proposed Finish Grade should be set from Project Manager.

Select 3D Cross-sections from the 3D Modeling Toolbox.

Each line representing the

The symbology for Existing Ground Line and
Ensure the settings are

correct then press Apply. The software scans each section and draws the 3D Cross-

sections.

Step 4.

Encomseco  mED|

Current Station:  200+00.00F 1

5 DGM File; | wdottroad! %l 7EEZnzmainline. dan Filez... |

Begin Statior: 200+0000R 1 [200+0000 R 1
End Statiorn:  220+00.00 R 1 I22E!fEIEI.DD_F| 1

Level Symbology Search Criteria

Esigting Ground Line

Froposzed Finish Grade

Ly Mumbers: I_— _J v
Colors: r— _j ™
Styles: I— _I ird

Wieights: I— _l W

| Rezet I

Ly Mumbers: E-H— _J
Colors: rEI..ZvS-E-— _j
Styles: IEIB— _I

Wieights: I|:I15— _l
| Rezet I

Dismiss the 3D Cross-sections dialog box.
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Step 5. Select Interpolate Between XS from the 3D Modeling Toolbox.

Method: | Longitudinal ™ I

- Begin Station

Station | | DP Offset: [00.000005
- End Station

Station | |

; ’ |

[T Highlight Applied BreakLines

Step 6. Attached the Saved View “BEGIN” (Utilities > Saved Views).

Step 7. Set the active MicroStation level to 30 and Save Settings. This will force the B-spline
elements to level 30.
Step 8. Click File > Reference on the Microstation menu bar. Turn on the reference file display
for the design file d17682des.dgn.
Step 9. Fill in the dialog box as shown below and click Draw Surfaces.
_ Interpolation Between 3D Cross Sections E
Method: | Longitudinal 'I
- Begin Station
Station | | 200+00.00R 1 COF Olffzet; |-2EIEI.DDEIEIEI
DP | Offser [20000007:
- End Station
Station | [204+25.00R 1 DF | Ofeet [200.00000
DF | Difset [200.00002F
[T Highlight Applied BreakLines [T Forced Calor [ _]

Draw Surfaces i

' Use the Station button to identify the appropriate 3D Cross-
section. This will fill out all the fields automatically.
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Step 10.  You will see the following warning message. Click OK.

O Color Mismatch 'was Found

Notice that several areas could not be completed because of the color mismatch between
stations 202+00 and 202+25. In the next several steps you'll see how to handle these
situations.

Step 11.  Use the MicroStation pulldown Edit > Undo to delete the elements that were just drawn.

Step 12.  Fill in the dialog box as shown below and click Draw Surfaces. This will complete the
interpolations between 200+00 and 202+00.

_ Interpolation Between 3D Cross Sections 1
Method: | Longitudinal 'I
- Begin Station
Station | | 200+00.00R 1 OF Offzat; |-2EIEI.DDEIEIEI
LF Dffset: [200.00001:
- End Station
Station | [202+00,00F 1 LF Offzet; |-1 9995999
LF Offzet; |139.99998E
[T Highlight Applied BreakLines ] Forced Calor, | _]

| Draw Surfaces i

Step 13.  Fill in the dialog box as shown below and click Draw Surfaces. This will complete the
interpolations between 202+25 and 204+25.

Method: | Longitudinal ™
- Begin Station
Station | [202+25.00R 1 [l Offzet: |-1 9993395
DP Offzet: |199.999935
- End Station
Station | [204+25.00R 1 LP Offzet: |-2_DD.DDDDD
DP Offzet I2D_D.DDDD2E
"} Highlight Applied BreakLines [C] Fomzed Colo i _I
Draw Surfaces i
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Step 14.  Attach the Saved View “COLORL1". Notice that this area was not interpolated because of
a color mismatch. We will handle this area in the next step.

Step 15.  Fill out the dialog box as shown below and click Draw Surfaces.

gha'polation Between 3D Cross Sections !EE
Method: | Longitudinal ™
- Begin Station
Station | [202+00.00R 1 [l Offzet: |?.EIEIEI453
DP Offzet: |199.99998ﬁ
- End Station
Station | [202+25.00R 1 LP Offzet: |?.EIEIE|588
DP Offzet |‘ISS.EIEIEIS_35
"} Highlight Applied BreakLines [C] Fomced Colos I _I
| Draw Surfaces l

Step 16.  Attach the Saved View “COLOR2”". Notice that this area was not interpolated because of
a color mismatch. We will handle this area in the next step.

Step 17.  Fill out the dialog box once again as shown below and click Draw Surfaces.

gha'polation Between 3D Cross Sections !EE
Method: | Longitudinal ™
- Begin Station
Station | [202+00.00R 1 [l Offzet: |-1 9993339
DP Offzet: |-?.939991
- End Station
Station | [202+25.00R 1 LP Offzet: |-1 99.93395
DP Offzet |-8._DDD=-158
"} Highlight Applied BreakLines [C] Fomced Colos I _I
Draw Surfaces l
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Step 18.  Attach the Saved View “HOLE”. Notice that this area was not interpolated because of a
color mismatch. We will handle this area in the next step.

Step 19.  Fill out the dialog box as shown and click Draw Surfaces.

Method: | Longitudinal ™

- Begin Station
Station | [202+00.00R 1 [l Offzet: |-?.999981
DP Offzet: |?.ESS.453
- End Station
Station | [202+25.00R 1 LP Offzet: |-8.000458
DP Offzet I?.EIEISSBE

"} Highlight Applied BreakLines ¥ Forced Color: i2 j

| Draw Surfaces i

Step 20. Dismiss the Interpolation Between XS dialog box.

Step 21.  Dismiss the 3D Modeling Tools dialog box.
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20.3 Drive Through

Step 1. Open the MicroStation file c:\data\geo\vdot\road1\3DModel.dgn
Step 2. Click the GEOPAK Drive Through tool from the Road Tools toolbox.

Step 3. Populate the dialog box as shown below.

£ Drive Through Window [_To] ] |
Job: W 3]
Chair: m _L[E]
Plan Wiew Offzet: rIJ_DF_
Wertical Offset V! W
Station: W—
Step Increment; ﬁ‘ﬁtﬂl_
Target Offzet; W
[0 a0 L1 1 1&0

g 1_‘_;
|

Step 4. Click the Locate Starting Point.

Step 5. Click the Apply button to move through the model. For each click on the Apply button,
the current station is incremented by the value in the Step Increment field.

Step 6. Exit MicroStation.
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CHAPTER 21

LAB 21. Special Reports

21.1 Horizontal Alignment Reports
In this section we will generate a Horizontal Alignment report using Coordinate Geometry.
Step 1. Execute C:\data\geo\VDOT\road1\LAB21.EXE.
Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn.

Step 3. Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 4. Select the Coordinate Geometry icon from the Road Project: 17682.prj workflow dialog
box. The coordinate geometry dialog box shown below should appear.

& Coordnate Geometry_ob- 101 Operatocv0 ______________________HEH

;fﬂit‘ E}@:injerﬁl @u&iﬂl_l@_l@ilﬂ—]r Redefine

Disable Visuglization ¥ |[TFF Festire) | =| Browss | 531231 «| g'ga1e | « |

This dialog box is completely re-sizable, so you can position it where you're most
comfortable.
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21.1.1 Describe Chain

From the COGO dialog window, let's preview the geometry of the chain MAINLINE.

Step 1. Select the COGO Navigator icon 2 Navigator(101) !EH

: Select Tools
q:s;.&

or use the Tools > Navigator option on the | EPment: ':ha'”—l F‘ﬂnthesmbE Element

COGO menu bar to access the COGO Navigator Marme | Feature

dialog box. EBL4E0 DEFALILT_CHAIN

EOSL
. . I bisINLINE DEFALILT CHAIN

Step 2. Set the element option to Chain and highlight the M EF:E«ULT_HAIN

chain MAINLINE. REDEUD
Step 3. Press the “Print/Describe Element” icon.

Step 4. The chain geometry output will be displayed in the main COGO window.

[# Coordinate Geometry Job: 101 Operator: VD !EIH

<5 Ll | A e A s

| Permanent Wisualization * [ OFF [Feature] _I ETDWSE 9312 VI 379912 v| | _I _I |

COGO Keyin: | DESCRIBE CHAIN MAINLINE

'5%"\'

bl

L% 1 DESCRIBE CHAIN MAINLINE

Chain MAINLINE contains:
D500 CUR ML-1 CUR ML-2 D503

Beginning chain HAINLINE description
Feature: DEFAULT CHAIHN

Point D500 H 339.730.60 E 2.717.900.04 Sta 200+00.00

Course from D500 to PC ML-1 5 38" 49' 05.11" E Dist 799 .21

Curve Data

Curve ML-1

Feature: DEFAULT CHAIHN

F.I. Station 209+15.00 H 339,017 69 E 2,718,473 61

Delta = 12® 01' 05.95" {RT)

Legres = Bt A 31 3et

Tangent = 115479

Length = 230.74

Radius = 1,100.00 =]
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21.1.2 Create Output File

Step 1.

Step 2.

Step 3.

Step 4.

In the following steps we will save an output file with the computations of chain MAINLINE.

Access the File Utility dialog by pressing the File Utility icon

=

or by selecting File > File Utility. The dialog below should appear.

File tility BEER

File Mame | Subject l

Load vI [T Allow Commands to be Added

To save an output file with the actual results of the computations, set the option button to Output
on the File Utility dialog. Enter “MAIN" as the Output File name then click Apply.

File kility HE R

File Mame | Subject |
main [Mone ]

Output ~ | Output File: [MAIN

A file named “main101.ovd” will be created in the working directory.
Dismiss the File Utility dialog box by clicking the X in the upper right hand corner.

From the Edit pulldown, select Edit > Clear to ‘clear’ out all the commands that we just previously
executed.

' This will not remove the stored data from COGO.
[

GEOPAK 2004 Edition
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21.1.3 Create Alignment Relation Report (Layout Offsets)

From the COGO dialog window, let's create an Alignment Relation report between chains MAINLINE

and RAMPA.

Step 1. Use the Element > Chain > Layout Offset
option on the COGO menu bar to access
the Layout Offset Chain dialog box.

Step 2. Populate the dialog box as shown.

Step 3. Click “Compute”.

Z5 Layout Offsst Chain [_ [ x|
Baselne: [MAINLINE | ~| ToChain: [RaMPA | =]

Chain [Fadial Projection] |

Even Interval vI |25—
'S gnPor [ |
Beqin Station: Wﬂl
End Station: Wﬁl

Step 4. The offsets between chains MAINLINE and RAMPA will be displayed in the main COGO

window.

Hle Edit Hement View Tools

#5 Coordinate Geometry Job: 101 Operator- VD H[=1 E3

I ﬁgl_l_l_lélilﬁuglﬂl_lguﬁi_lil_l" Besos

i Permanent Visualization ¥ [ OFF [Feature] _I BIDWSE 991234 Vl 379912 'l <<

COGO Keydir: | LAY OFF TO CHA RAMPA CHA MAINLINE EVEN 25 215+25.00 222+06.84 ;I
* 1 LiY OFF TO CH: RAMPA CHA MAINLINE EVEN 25 218425.00 222+406.34
STATION ONH OFFSET DIST STATION ONH DIRECTION FROM
MATINLINE RAMPA POINT TO RAMPA
218425 .00 —24.4335 10+15.22 S B3 24 07.87" W
218+450.00 -26.7663 10+38. 32 S 57T 24 4875 W
218475 .00 -31.0807 10+60.97 S 61 20" 43.05" W
219+00.00 —37. 3066 10+82.91 S 65T 09" 18.94" W
219425 .00 —-45.3480 11+03 .95 S 68° 48' 30.85" W
219+450.00 -55.0210 11423 .76 S 727 300 44 .89 W
219475 .00 —-b6. 2031 11+42 .14 S 767 1e' 29.60" W
220+400.00 -78.7814 11459 .31 S 790 47" 16.14" W
220425 .00 -92.6146 11475 . 26 S 837 03" 05.2e" W
22045000 -107 5682 11+90.02 S 86” 04' 20.87" W
220475 .00 -123.5178 12403 .65 S 88" 51t 42.89" W
221+00.00 -140.3501 12+16 .22 N 88 33* 58 78" W
221425 .00 -157.9631 12427 .80 N g 11' 49.08" W
221+450.00 -176. 2666 12438 .47 N &4® 00' 51.10" W
221475 .00 -195.1807 12+48 .30 N og2* o0' 08.8%" W
222+400.00 -214 . 6355 12457 .37 N 80" 08' 48.e3" W
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21.1.4 Create Output File

In the following steps we will save an output file with the offset list between chains MAINLINE and

Access the File Utility dialog by pressing the File Utility icon

=

or by selecting File > File Utility. The dialog below should appear.

File Utility [x]

[T Allow Commands to be Added

To save an output file with the actual results of the offset list, set the option button to Output on

the File Utility dialog. Enter “OFF” as the Output File name then click Apply.

Dutput vI Output File: [ OFF

A file named “off101.ovd” will be created in the working directory.

RAMPA.
Step 1.
File Mame | Subject
Load vI
Step 2.
£ File Lility
File Mame | Subject
main [Maone ]
off [Mone]
Step 3.
Step 4.

Exit COGO by clicking the X in the upper right hand corner.

Dismiss the File Utility dialog box by clicking the X in the upper right hand corner.

NOTE: When you are prompted to Save the Session, click
“No” since you have already saved your input.

GEOPAK 2004 Edition
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Step 5. Review the output file by opening “main101.ovd” with the GEOPAK Text Editor. The file should
appear as below.

[ Text Etor Crbtavpeo ot Tttt od. =R

Ele Edit CGCitena

O|=(a] & |®=]@] <[~

tupgright: (=) 2004 Bentley Sy=stem=,. Incorporated: 411 rights reserwved:

| »

Froject ; 176832

Subject:

Job No, 101 Qperator: VD

Date ! Monday December 20, 2004 10:13 am

SYSTEM FIX 2 ASEC 2 BEAR PRI 0 HOR HE S5TA 2 FILE: 'HAIN'

* 1 DESCRIEE CHAIN MAINLINE

Chain MAIHLINE contains!
D500 CUR ML-1 CUR ML-2 D503

Beginning chain MAINLINE description
Feature: DEFAULT. CHAIH

Foint D00 N 339,730 .60 E 2.717.500.04 Sta 200+00.00
Course from D500 to PC ML-1 5 38° 49' 05.11" E Dist 759.21

Curve Data

. ———— £ 3
Curve ML-1
Feature: DEFAULT CHAIHN
P.T, Station 208415 .00 H 339,017 69 E 2,718,473 61 =
Delta = 12° 01' 05.95" {(RT)
Degres = LREES: R NG 0 A T
Tangent = L1574
Length = 230,74
Radius = 1.100.00
External = f.08
Long Chord = 230,31
Hid, Crd. = 6. 04
F.C. Station 207+99.21. W 339,107 .30 E Z,718,401.03
P T Station 210429 .95 H 338,914 .33 E 2,718, ,525:82
[0 H 338,418.37 E 2,717,543 ,97
Baclk =5 38° 49' 05 11" E
Ahead =5 287 47' B9 18" E
Chord Besar =5 32° 48' 32.14" E
Course from PT MI-1 to PC MI-2 S 28° 47' 59 1" E Dist 268.49 _J
| |Line: 1 |cek 1

A report of the stored chain which describes its geometry including coordinates, stations,
distances, bearing, curves, and spiral data. Any break in the stationing detected during the
description of the chain will be considered a station equation and numeric regions will be
assigned by GEOPAK starting at one. If the chain contains station equations, they are listed in
the description.
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Step 6.
appear as

below.

& Ton Eaor oottt ioto T RER|

Hle Edit

Criteria

D|=[d] 4 [B[@] -]~

loopyright: (o) 2004 Bentley Systems, Incorporated: All rights ressrved.

Froject | 17e82

Subject:

Job No, 101 Operator: VD

Date! Hondavy December 20, 2004 3:00 pm

SYSTEM FIX 4 ASEC 2 BEAR PRI 0 HOR HE S5TA 2 FILE; 'OFF'

* 1 LAY OFF TO CHA RAMPA CHA MAINLINE EVEN 25 218+25.00 222+06.84
STATION ON OFFSET DIST STATION COH DIRECTION FEOH
HATHLINE RAMPA POINT TO RAMPA

21842500 —24 4335 10415, 22 5 53" 24" 07.87" W
218+50 .00 —26. 7663 10438 32 5 E57° 24' 48.75" W
218475, 00 —31, 0807 10+460.97 5 617 20' 43 05" W
21940000 —37. 3068 10+482.91 S 65" 09' 18.94" W
219425 00 —45 3480 11403, 95 5 68° 48' 30.85" W
219450, 00 —55. 0210 11423 .76 5 72 30' 44.89" W@
219475 .00 —66 . 2031 11442 14 5 76" 16' 29 60" W
220400 00 —-78 7814 11459 .31 5 79° 47" 16.14" W
220425 .00 —-92 614k 11475 . 28 S 837 03' 05.28" W
220450 .00 -107 5682 11+490.02 S5 8p° D4' 20.87" W
220475, 00 —-123 5178 12403 65 S 887 B1' 42 89" W
221+00.00 —140. 3501 12416.22 H 8g°® 33' §g.78" W
221+25 00 —157 9631 12427 .80 H 86°* 11' 49 05" W
22145000 —176 . 2665k 12438 .47 N #4° 00' 51.10" W
221475 .00 —-195 1807 12448 30 H 82* p0' 08.87" W
222400 00 —-214 B3G5 12457 .37 H &0° 08' 48 63" W
| |Line: 1 | [T

The Layout Offset Chain using the Radial Projection option calculates stations on Chain

RAMPA and the radial distance from a specified interval on the Chain MAINLINE. The offset

distances and direction are perpendicular or radial to the Chain MAINLINE.

Step 7. Exit Micro

Station.

Review the output file by opening “off101.ovd” with the GEOPAK Text Editor. The file should

GEOPAK 2004 Edition
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21.2 Vertical Alignment Reports

In this section we will generate a Vertical Alignment report using Coordinate Geometry.

Step 1. Open the MicroStation file c:\data\geo\VDOT\road1\d17682prof.dgn.

' It is not required that this report be run while in the profile file.
It can be run from any MicroStation design file.

Step 2. Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 3. Select the Coordinate Geometry icon from the Road Project: 17682.prj workflow dialog
box. The coordinate geometry dialog box shown below should appear.

[# Coordinate Geometry Job: 101 Operator: VD !EIH

;?%}Eﬁj@~gggngJﬁﬂﬂmee

Disable Wisuslizstion ¥ |[OFF [Feature) J Brnwsel 991234 *| 979912 | < | _I b3 |

This dialog box is completely re-sizable, so you can position it where you're most
comfortable.
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21.2.1 Describe Profile
From the COGO dialog window, let's preview the geometry of the profile MAINLINE.

Step 1. Select the COGO Navigator icon 2 Navigator(101) [_ o x]
Select Tools

S ~ % [lid §||?|
. . Element : | Profi o ey
or use the Tools > Navigator option on the ement: | Pale 7 [ant/Deserbe Semert

COGO menu bar to access the COGO Navigator Mame | Feature |

; DITCHLTT
dialog box. e

Step 2. Set the element option to Profile and highlight the MLGHDND

chain MAINLINE. R&MPA

Step 3. Press the “Print/Describe Element” icon.

Step 4. The profile geometry output will be displayed in the main COGO window.

Z5 Coordinate Geometry Job: 101 Ope.aor_vn [_ o] x]
Fle Edit Hement WView Tools LUk
= -ﬁgl_lsl_iﬁl *’@Uzlwl_lg_lﬁilﬂ_l'“ B
i Permanent Wizualization vEDFF Feature) _I ETUWSE 331234 "i 979912 "l <4
COGO Kewin: |PRINT PROFILE MAINLINE LI
123 1 FRINT PROFILE MAINLINE T
Beginning profile MHAINLINE description:
STATION ELEV GRADE TOTAL L BACK L AHEAD L
VPI 1 200+00.00 2,022.7910
VPI 2 200+50.00 2,.025.8960 6.2100 =
VPI 3 201+00.00 2,027 .7490 3.7060
VPI 4 201+50.00 2.028.2500 1.0020
VPI ) 202+00.00 2.028.1000 —0.3000
VPI ) 202+50.00 2.028.0000 —0.2000
VPI 7 203+00.00 2,027 .5000 -1.0000 _J
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21.2.2 Create Output File

In the following steps we will save an output file with the computations of profile MAINLINE.

Step 1. Access the File Utility dialog by pressing the File Utility icon

=

or by selecting File > File Utility. The dialog below should appear.

File Utility [x]

File Mame | Subject l

Load vI [T Allow Commands to be Added

Step 2. To save an output file with the actual results of the computations, set the option button to Output
on the File Utility dialog. Enter “PROP” as the Output File name then click Apply.
5 File Wtility HE R
File Mame | Subject |
main [Maone ]
off [Mone]
prop [Maone ]

Dutput vI Output File: |PROP

A file named “prop101.ovd” will be created in the working directory.
Step 3. Dismiss the File Utility dialog box by clicking the X in the upper right hand corner.

Step 4. From the Edit pulldown, select Edit > Clear to ‘clear’ out all the commands that we just previously
executed.

' This will not remove the stored data from COGO.
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21.2.3 Create Profile Grade List
From the COGO dialog window, let’s create a profile grade list of the profile MAINLINE.

Step 1. Use the Element > Profile > Elevation option on 1
the COGO menu bar to access the Profile T —

Elevation dialog box.

Even Stations 'I
Step 2. Populate the dialog box as shown. Begin: [200+00.00

End: [222+00.00
Step 3. Click “Compute Elevation”. Even [35 |

Step 4. The profile grade list will be displayed in the main COGO window.

B Coortinate Geometry Job- 101 Operatorv0 ————______________EEIH]|
Fle Edit Hement View Tools
&Iudﬁﬂﬂ@g@ S _ﬂi‘l" Redefine
Tl ]

FEEDEPEL

| Permanent Yisualization  H OFF [Feature) _I Ernwsel 99,1234 'I 979'9.12 Vl

COGO Keyir: | Elevation Profile MAINLINE Even 25 200+00.00 To 222+00.00 .LI
(% il Elevation Profile MAINLINE Ewen 25 200400.00 To 222+00.00 -_J
Elev at 200+00.00 = 2,.022.7910, grade = £.2100, On tang betw 1 & 2
Elev at 200+25.00 = 2,024 3435, grade = 6.2100, On tang betw 1 & 2
Elev at 200+450.00 = 2,025.8960, grade = 6.2100, On tang betw 1 & 2
Elev at 200+75.00 = 2,026.8225, grade = 3.7060, On tang betw 2 & 3
Elev at 201+00.00 = 2,027 7490, grade = 3 .7060, On tang betw 2 & 3
Elev at 201+25.00 = 2,027.9995, grade = 1.0020. On tang betw 3 & 4
Elev at 201+50.00 = 2,028 2500, grade = 1.0020, On tang betw 3 & 4
Elev at 201+75.00 = 2,028.1750, grade = —0.3000, On tang betw 4 & §
Elev at 202+00.00 = 2.028.1000, grade = —-0.3000, On tang betw 4 & §
Elev at 202+25.00 = 2,028.0500, grade = —0.2000, On tang betw § & &
Elev at 202+450.00 = 2.028.0000, grade = —-0.2000, On tang betw 5 & 6
Elev at 202+75.00 = 2,027.7500, grade = —1.0000, On tang betw 6 & 7 _J
Elev at 203+00.00 = 2,027.5000, grade = —1.0000, On tang betw 6 & 7
Elev at 203+25.00 = 2.026.9750, grade = —-2.1000, On tang betw 7 & 8
Elev at 203+50.00 = 2,026.4500, grade = —2.1000, On tang betw 7 & 8
Elev at 203+75.00 = 2,.025.8500, grade = -2 .4000, On tang betw 8 & 9
Elev at 204+00.00 = 2.025.0000, grade = —3.4000, On tang betw 9 & 10
Elev at 204+25.00 = 2,.023.9000, grade = —4 4000, On tang betw 10 & -

11
Elev at Z04+450.00 = 2.022.8350, grade = -4 2599, On tang betw 11 & — -]
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21.2.4 Create Output File
In the following steps we will save an output file with the profile grade list of profile MAINLINE.

Step 1. Access the File Utility dialog by pressing the File Utility icon

=

or by selecting File > File Utility. The dialog below should appear.

File Utility [x]

File Mame | Subject l

Load vI [T Allow Commands to be Added

Step 2. To save an output file with the actual results of the profile grade list, set the option button to
Output on the File Utility dialog. Enter “GRADE" as the Output File name then click Apply.

£ File Lility [_To]x]
File Marme | Subject |
qrade [Maone ]
main [Mone]
aff [Maone ]
prop [Mone]

Dutput vI Output File: | GRADE

A file named “gradel01.ovd” will be created in the working directory.
Step 3. Dismiss the File Utility dialog box by clicking the X in the upper right hand corner.

Step 4. Exit COGO by clicking the X in the upper right hand corner.

NOTE: When you are prompted to Save the Session, click
“No” since you have already saved your input.
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Step 5. Review the output geometry file by opening “prop101.ovd” with the GEOPAK Text Editor. The
file should appear as below.

T T |

Fle HEdit Citeria

O|=(d] 4 [®@[@] |~

lCopyright: (o) 2004 Bentley Systems. Incorporated: All rights reserved. paas
Froject | 17682
Subject
Job No, 101 Cperator: WD
Date ! Monday December 20, 2004 1:17 pm
SYSTEM FIX 4 ASEC 2 EEARE FRI 0 WOR WE STA 2 FILE; 'FROF'
* 1 FREINT FROFILE MAINLINE
Beginning profile MATHLINE description:
STATIOH ELEV GRADE TOTAL L BACK L AHEAD L
VET 1 200+00.00 2,022.7910
VET i 200+50.00 2,025.8360 £.2100
WE'T 3 201+00.00 2,027 7490 3, 7060
VEI 4 201+50.00 2.028.2500 1.0020
VET 5 202+00.00 2,028.1000 —0. 3000
VET b 202+50.00 2,028.0000 —0.2000
WEI 7 203+00.00 2,027 5000 —1.0000
VEI g 203450.00 2,026 4500 —2.1000
VEI 9 203+75.00 2,025.8500 —2.4000
VEI 10 204+00.00 2,025.0000 —3.4000 T
WEI 11 204425 .00 2,023 9000 —4.4000
VEC 204450.00 2,022 .8350 —4.2699 K = 31.4
Low Point 205+83 .61 2,019, 9891
VET 12 206+50.00 2,014.3152 400 0000  200.0000 200.0000
VET 208450.00 2,031.301% g.4931 _J

| |Lire: 1 [T

Geometric data for the profile name, including stations, elevations (including the high point), grade and
lengths (back, ahead and total) for VPC's, VPI's and VPT's.
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Step 6. Review the output geometry file by opening “gradel01.ovd” with the GEOPAK Text

Editor. The file should appear as below.

Fle Edit Crhtena

MR-

Eapgright: (c) 2004 Bentley Sy=tems. Incorporated: 4ll right=s reserved:

Froject 17632

Subject !

Job Ho, 101l Cperator; VD

Date ! Honday December 20, 2004 1:43 pm

SYSTEM FIX 4 ASEC 2 BEAR PRI 0 NOR HE STA 2 FILE: 'GRADE'

| »

* 1 Elevation Frofile MAINLINE Even 25 200400.00 To 222400.00

Elev at 20040000 = 2.022.7910, grade = £.2100, On tang betw 1 & 2
Elev at 200+25. 00 = 2.024.3435, grade = 6.2100, On tang betw 1 & 2
Elewv at 200+450.00 = 2,025 .8960. grade = 6.2100, On tang betw 1 & 2
Elev at 200+475.00 = 2,026.8225, grade = 3 .7080, On tang betw 2 & 3
Elew at 201+00.00 = 2.027.7490, grade = 3.7060. On tang betw 2 & 3
Elew at 201+25, 00 = 2.027,9995 . grade = 1, 0020, On tang betw 3 & 4
Elewv at 201+50.00 = 2,028 2500, grade = 1.0020, On tang betw 3 & 4
Elev at 201+75.00 = 2,028.1750. grade = —0.3000. On tang betw 4 & & |
Elev at 202+00.00 = 2.028.1000, grade = -0 3000, On tang betw 4 & §
Elew at 202+25.00 = 2.028.0500. grade = —0.2000. On tang betw § & &
Elev at 202+450.00 = 2,028 0000, grade = -0 2000, On tang betw 5 & 6
Elev at 202+75.00 = 2,027 .7500, grade = —1.0000, On tang betw & & 7
Elew at 203+00.00 = 2,027 5000, grade = -1 0000, On tang betw 6 & 7
Elev at 203+25.00 = 2,026 ,9750, grade = —-2.1000. On tang betw 7 & 8
Elewv at 203+50.00 = 2,026.4500, grade = -2 1000, On tang betw 7 & 8
Elev at 203+475.00 = 2,025 ,.8500, grade = —2.4000. On tang betw 8 & 9
Elev at 204+400.00 = 2.025.0000, grade = -3 4000, On tang betw 9 & 10
Elev at 204425 00 = 2.,023.9000, grade = —4.4000. On tang betw 10 & 11
Elev at 204+450.00 = 2,022, 8350, grade = —4 2599, On tang betw 11 & 12
Elev at 204475 00 = 2,021 8697, grade = -3 4629, On curve wpi 12

Elew at 205+00.00 = 2.021.1036, grade = -2 6658, On curve wpi 12

Elev at 205425 00 = 2.020.5368, grade = -1 8687, On curve wpi 12

Elew at 205+450.00 = 2,020.1692, grade = —1.0717, On curve wvpi 12

Elev at 205475 .00 = 2,.020.,0010, grade = —-0.2746. On curve wpi 12

Elev at 20640000 = 2.020,0319, grade = 0.5225, On curve wpi 12

Elev at 206425 .00 = 2.020.2622, grade = 1 3195, On curve wpi 12

Elev at 206+450.00 = 2.020.6917. grade = 2.1166. On curve wpi 12

Elev at 206475 00 = 2,021 3205, grade = 2.9137, On curve wpi 12

Elew at 207+00.00 = 2.022.1486. grade = 3.7107. On curve wpi 12

Elew at 207+25, 00 = 2.023.1759, grade = 4 .5078, On curve wpi 12

Elewv at 207+50.00 = 2,024.4025, grade = §5.3049, On curve wpi 12

Elev at 207+75.00 = 2,025.8283, grade = 6.1019, On curve wpi 12

Elev at 208+00.00 = 2,027 .4534, grade = 6.8990. On curve wpi 12 _:J
| |Line: 1 S8

The Profile Elevation tool computes elevations along a profile based on user-defined parameters.

Next, the profile grade is calculated and if the station is on a tangent or curve.

The application reads the Begin stationing, then determines the next even station (divisible by the

Even Station value). For example, the beginning station is 200+00.00 and Even

25 is set. The Even

25 dictates to the software to display the first station as 200+00.00, followed by 200+25.00,

200+50.00, etc.

Step 7. Exit MicroStation.
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21.3 Cross Section Reports

These reports must be run from the proposed cross section
file.

21.3.1 Design Cross Section List

In this section we will generate a Design Cross List using XS List from the Cross Section Reports.

Step 1.

Step 2.

Step 3.

Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsmainline.dgn.

Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Select the Reports & XS Quantities icon from the Road Project: 17682.prj workflow
dialog box. The XS Reports dialog box shown below should appear.

T

User

Clearing |
Closure |
DTH Input |
DT Prop 3D |
HEC-2 |
HEC Ras |
Multi-Lire |
Frofile Grade |
Radial Staking |
RT40 |
Seeding |
Slope Stake |
Staking Detail |
WSPRO |
#5 List |

™ Hilite
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Step 4.

Step 5.
Step 6.

Step 7.

From the XS Reports dialog box, select the User > Preferences dialog box.

|2 Report Header -

=] .3

Clearing |

File

¥ Mumber Page
Tolerance I 0.070000
Fiadiuz of Dizplay Circle: I 4000000

[ Adjust Dutput File Extension &ccording bo Feport

Set th

e tolerance to .01.

Dismiss the Report Header dialog box by clicking the X in the upper right hand corner.

From the XS Reports dialog box, select the XS List report. The Cross Section Report
dialog box below should appear. Job Number, Chain Name, and Station Range should

be populated from Project Manager.
Jab 101 CurSta  200+00.00R 1
Chain [MAINLINE | =
BenSta 200+0000R 1 [200+0000F 1
EndSta 22040000 1 [220+0000R 1
%5 Elements “/@"\vi Dizplay |
Original Crozz Section Ligt Vl [ Pause on Each x5
ASCI File | File |
| Apply I

Click the symbology settings button then populate the Candidate Elements dialog box

as shown.

& Gose Secton vt MBIEA

Job | 101 CurSta 200+00.00R 1
Chain [MEINNE. =] E,"Caﬂdate Hements !. %] I
BeqSta  200+00.00R 1 | 200+0000F 1
EndSta  220+00.00R 1 |22D+DD.DD R1 r‘LV Mumbers: ﬁ]_'
XS Elements T Dizplay | I j
r i—
Original Crozs Section List "I [T Pause onEach x5 r I—-
ASCIIFil File
e | —I tatch I Diizplay I Reset I
[ Apply ]

9=l

Note: The levels for XS Elements should only refer to 2-4. These are the levels that

make up the top of Finish G

rade.

Step 8.

Dismiss the Candidate Elements dialog box by clicking the X in the upper right hand

corner.
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Step 9.

Step 10.

Step 11.
Step 12.

Step 13.

Set the option button to “Design Cross Section List”.

Enter “xs-list.txt” for the ASCII File name.

The Cross Section Report dialog box should appear as below.

£ Cross Section Report [_To] %]

Job [0 CurSta  Z20+00.00F 1
Chain [MAINLINE | |
BegSta  200+00.00F 1 [200+0000R T
EndSta  Z20+00.00F 1 [2z0+0000R T |

X5 Elements - /q“"\i Display |

Design Cross Section List 'l [] Pause on Each x5

ASCH File [ wsfisttat Fil: |

| Apply I

Click Apply. A file named “xs-list.txt” will be created in the working directory.

Dismiss the Cross Section Report dialog box by clicking the X in the upper right hand corner.

Review the Cross Section list file by opening “xs-list.txt” with the GEOPAK Text Editor. The file
should appear as below.

|2 Text Editor: C:\data\geo\vdot\road T\xs-ist it [_To]x]
File Edit Criteria
Ol=(a] & [=[@] ~[~]
Paged 1 [
DESIGH CROSS-SECTION LIST
STATION ELE¥ DIST ELEY DIST ELEV DIST ELEV DIST
HIHEER [Ft) (Ft) (Ft) (Ft) (Ft3 [Ft) (Ft) (Ft)
200400.00 R 1 201575 58 00L 202163 43,001 2021.93 37,001 2022.13 33,001
202239 20.00L 202263 8.00L 2022.43 4.00L 2022.23 0.00R
2022 .63 2 00R 202239 20, 00R 2022.15 32, 00R 2022.13 32, 00R
2071 k3 43 00R 2020 13 FENTiL 2031 3n 71 35R 2031 75 72 29R
2032 .53 74 23R 203286 75.21R 303315 76.21R 203339 77.2IR
2033 76 79 27R 2033 89 80 31R 2034 09 81 34R
200425.00 R 1 2019.01 58 00L 2023.18 43.00L 2023.48 37.00L 2023 .68 33.00L
2023.94 20, 00L 2024.18 B.00L 2023.38 4,001 2022.78 0. 00R
202418 2 00R 2023.94 20.00R 2023.70 32.00R 2023 68 33.00R
2023 18 43 00R 2021 6E 43 00R 033,29 72.27R 2033 74 73 1ER
2034 .53 75 O9F 2034 .87 76 . D8R 2035.18 77 .08R 2035 44 78.09R
2035 85 80 14R 2036 .00 81 18R 203623 82 20R
200450.00 R 1 2021 .59 58 00L 2024.74 43.00L 2025, 04 37.00L 2025 24 33.00L
2025 .50 20.00L 202574 8.00L 202554 4001 2025 34 0.00R
202574 8 00R 2025.50 20.00R 3025.36 32, 00R 2025 24 33, 00R
2024 74 43 00R 2023 24 49 00R M35 32 73 1ER 2035 77 74 11R
2036 .57 7E D4R 203691 77 .03R 203722 78, 03R 2037 .43 79, D4R
2037 92 81 09R 2038 08 82 12R 2038 31 83 14R
200475.00 B 1 2024.07 52.54L 2025 .66 43,001 2025, 36 37.00L 2026 .16 33.00L
2026 .42 20, 00L 2026 GE 8.00L 202646 4,001 202626 0.00R
2026 .66 2 00R 202642 20.00R 202618 32.00R 2026 .16 33.00R
2025 66 43 00R 2024 16 P 2037 04 74 7ER 2037 43 75 B9R
2038.27 77 B3R 2038 .60 78.E1R 2038.90 79.EZR 203916 20.63R
2039 55 52 BAR 2039 RE 83.71R 2039 89 G4 74R 5
| [Line: 1 |cat 1

For each station, the XS List report provides the elevation and offset for each cross section
element identified via user defined search criteria. Offsets to the Left of the centerline contain
an “L" and offsets to the right of the centerline contain an “R”.

' Do NOT dismiss the XS Reports dialog box.
[
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21.3.2 Seeding Report

In this section we will generate a Seeding Report from the Cross Section Reports.

Step 1.

From the XS Reports dialog box, select the Seeding report. The Seeding Report

dialog box below should appear. Most of the dialog box should be populated from
Project Manager.

Step 2.

Jobe | 101

CurSta

Chain [MEINLINE |~ |
BegSta  200+0000FR 1
EndSta  220+00.00R 1

Existing Ground Line

200+00.00 F 1
Report Decimal gj
[T |

cx‘@“..i Display |

Propozed Finish Grade

EJ‘@\I Crizplay |

Candidate Seeding Elements __ AT

I Crizplay |

[T Subtatal Split Slope | 0.0000

|hict Vi Sub Every |.DDDDDD
Scale Factor | 1.00000

ByPazz Seqments |

[ Max Allowable Slope |'I.IJDDD i

IEDDDD Rise:Fun "I
ID.EIEIEIEI

First Sub At I
Label ISF

Additional Distance Wia Station |

[T Pause onEach xS

Additional Diztance ... |

ASLII File |

| Apply

Candidate Elements dialog box as shown.

Step 3.
corner.

Step 4.
Step 5.

Step 6.

Match | Dizplay | Rezet I

Enter “seeding.txt” for the ASCII File name.

Click the Candidate Seeding Elements symbology settings button then populate the

Dismiss the Candidate Elements dialog box by clicking the X in the upper right hand

Click Apply. A file named “seeding.txt” will be created in the working directory.

Dismiss the Seeding Report dialog box by clicking the X in the upper right hand corner.
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Step 7. Review the Seeding Report file by opening “seeding.txt” with the GEOPAK Text Editor.
The file should appear as below.

| 2 Text Editor- C:\data\geo\vdot\road \seeding txt [_[O] x

Fle Edit Crteria
O|=(a] 4@ o~
Page# 1 _‘_!
SEEDING REPORT

NUMBER OF LEFT CUT SLOPES TO BE BYPASSED =10

NUMBER OF LEFT FILL SLOFES TO BE BYPASSED =0

NUMBER OF RIGHT CUT SLOFES TO BE BYPASSED =10

NUMBER OF RIGHT FILL SLOPFES TO BE BYPASSED =10

ROUNDING DISTANCE FROM CUT SLOPE STAKE = 0.00 Ft,

MAXTHUN ALLOWAELE SLOPE FOR SEEDING-SODDING il

ADDITIONAL SEEDING — LEFT  SIDE = 0.00 Ft.

ADDITIONAL SEEDING  RIGHT SIDE = 0.00 Ft.

ADDITIONAL SEEDING IN CUT = 0.00 Ft.

ADDITIONAL SEEDING IN FILL = 0.00 Ft.

SUBTOTALS EVERY 500.0000 Ft BEGINNING AT STATION 200+00.00 R 1 HETHOD INCR

SCALING FACTOR = 1.00000 WITH LABEL [ 5F 1

STATICN SLOPE DISTANCE AVERAGE SLOFE DIST LRE& SF  SUETOTAL A RE A  SF
BT RT T RT 1T RT BOTH LT RT BOTH

{TOTAL)

20040000 R 1 26 12 E1.61 o o o
g Tegandy 25 .85 52.11 B4 1303 1949

200425 .00 R 1 25 58 52 60 646 1303 1949
(¢ 78.18) 25 .46 53.14 637 1329 1966

20045000 R 1 2534 8367 637 1329 1965
{79.01) 22.51 54.55 g3 1364 1927

20047500 R 1 19 .68 55 .43 E63 1364 1927
{7811} 22.32 S6.23 558 1406 1964

20140000 R 1 24 95 57.03 558 1406 1964
[ #1.98) 25 .24 57.23 631 1431 2062

201425 .00 R 1 25 .52 57.43 631 1431 2062
[ B2.98) 25 .85 5705 646 1426 2072

20145000 R 1 2616 6 6 B46 14286 2072
[ 8282 2645 B6 .43 661 1411 2072

201475 .00 R 1 26 74 5620 E61 1411 2072
[ 8294y 28.19 54.12 708 1353 2058

20240000 R 1 29 63 52 .04 708 1353 2058
[ #1.67) 32,74 E1.14 &19 1279 2098

202425 00 R 1 35.85 50.23 819 1279 2097

=
|Line: 1 |Cal 1

The top of the file contains the values from the ByPass Segments and Additional Distances, followed
by a listing of each station, its left and right slope distances (measured along the slope, not horizontal
distance). Utilizing two stations, GEOPAK calculates the average slope distance then computes the
areas.

For each station, the Seeding Report provides seeding slope distances left and right. Then
GEOPAK computes the average slope distance on each side, and uses the results to compute
seeding areas. Areas, in Square Feet, are listed next for the Left side, Right side, and both. Next a
subtotal is listed, in Square Feet, for the Left side, Right side, and both.

At the bottom of the seeding report, totals are provided for the Left side, Right side, and both (in both
Square Feet and Acres).
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21.3.3 Staking Detail Report

In this section we will generate a Staking Detail Report from the Cross Section Reports.

Step 1.

From the XS Reports dialog box, select the Staking Detail report. The Staking Detail

Report dialog box below should appear. The dialog box should be populated from
Project Manager.

Step 2.
Step 3.

Step 4.
corner.

Step 5.

Job 101 CurSta  220+00.00 R 1
Chain [M&INOHE |~ |
BegSta  200+00.00F 1 [ 200+00.00 R 1
EndSta  220+00.00F 1 I 220+00.00 K1
Existing Ground Line A @\ I Display |
Proposed Finish Grade f‘,@ﬂ; I Display |

[T Pauze on Each X5

Federal Highway Format "’

ASCI File |

[ Apphy

Enter “staking-detail.txt” for the ASCII File name.
Click Apply. A file named “staking-detail.txt” will be created in the working directory.

Dismiss the Staking Detail Report dialog box by clicking the X in the upper right hand

Dismiss the XS Reports dialog box by clicking the X in the upper right hand corner.
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Step 6. Review the Staking Detail Report file by opening “staking-detail.txt” with the GEOPAK
Text Editor. The file should appear as below.

| & Text Editor- C:\data\geo\vdot\road 1\siaking-detail xt i

Fle Edit CGCriteria
D=(a] & |a|@] o]~
Paget 1
STAKING DETAIL REFPORT(Ft)
Slope Left Stake Right Stake Slope
STATION CAF DIST ELEV SUPER ADJ, SUPEE  ELEV, DIST CAF
200+00.00 R 1 -2.55:1. F &.88 E8.00 2015.75 0.050 2022.23 0.050 2034.09 81.35 C 0.09 11 .26:1
200+25.00 R 1 —-3.59:1. F 4.18 58.00 201%9.01 0.009 2023.18 -10.116 2022.79 20.99 C 0.52DL -13.00:1
200+50.00 R 1 -4.76:1. F 3,15 58.00 2021.59 0.017 2024 .67 -10,.123 2024.75 20,00 C 0, 15DL -50.00:1
200+75.00 R 1 —-6.00:1. F 1.59 £2.54 .2024.07 -0.009 :2025.86 -10.12% :2025.56 21.69 € 0.140L -22:31:1
201+00.00 R 1 —-6.00:1. F 2.48 57,74 2024.13 0,012 '2026:35 —-10,132 2026.31 22.18 C 0,24DL —22.31:1
201+25.00 R 1 -3,77:1. F 3.98 58.00 2022.86 —-0.007 2026.79 -10.134 2026.39 22.82 € 0.260L -10,23:1
201+50.00 R 1 -2:61:1. F 5.98 58.00 2021.11 0.036 2026.90 -10.135 2027.28 11.08 C 0.09 33.54:1
201+75.00 R 1 -2.03:1. F 7, 40 58.00 2019.82 0.035 2026.87 -10.134 2027 20 11.47 C 0.02 125.87:1
202+00.00 R 1 -2.00:1. F &.78 60.55 2018 .16 0.044 2026.69 -10.133 2027.08 13.31 C 0.04 125.87:1
202+25.00 R 1 -2.00:1. F 9.99 £2.98 201s.90 -0.020 2028.54 -0.020 2037:71 76.91 C 0.20 B il
202+50.00 R 1 -2.00:1. F 9.85 62.0% 2016.9% -0.020 2028.4%9 -0.020 2037.91 7%7.51 € 0.19 5.37:1
202+475.00 R 1 -2.00:1. F 10.08 63.16 2016.51 -0.020 2028.24 -0.020 2041.77 85.81 C 0.18 Spei,
203+00.00 R 1 -2.00:1. F 12.40 67 81 2013 .94 0.059 2025.80 -10.129 2026.50 12.63 C 0.23 20.38:1
203+25.00 R 1 —-2.00:1. F 11.95 66.90 2013.86 —-0.020 2027.46 —0.020 2047.90 99.92 C 0.16 6.69:1
203+50.00 R 1 -2.00:1. F 9.29 61.58 201s.00 -0.004 2025.03 -10.125 2024.74 23.87 C 0.210L -12.38:1
203+75.00 R 1 =2.00:1. F 9.95 62.89 2014.74 -0.020 2026.34 -0.020 2050.91 108.55 © 0.12 8.43:1
204+00.00 R 1 -2.00:1. F 22.98 88.96 2000.86 -0.020 2025.49 -0.020 2050.43 109,19 C 0.14 7.44:1
204+25.00 R 1 -2.00:1. F 20.74 §2.23 2002.04 -0.020 2024.39 -0.020 2048.35 104.57 C O0.16 6.40:1
204+50.00 R 1 -2.00:1. F 18.40 75.31 2003.36 -0.020 2021.84 -0,020 2046.07 99,59 C 0.18 E.B6:1
204+75.00 R 1 -2:33:1. F k.43 51.25 2014.41 -0.020 2020.87 -0.020 2042.48 92.00 € 0.18 5.66:1
205+00.00 R 1 -2.50:1. F &.01 49.00 2014.11 -—0.020 2020.10 -—0.020 2038.75 84.04 © 0.14 7.50:1
205+25.00 R 1 -2.05:1. F 7.31 50.50 2013.26 -0.020 2019.54 —0.020 2035.38 79.9% C 0.14 7.38:1
205+50.00 R 1 -2.00:1. F 8:10 E1.71 2012.10 -0.020 2019.17 -0.020 2032.16 74.07 C O0.16 6.51:1
205+75.00 R 1 -2.00:1. F 8.9 £3.43 2011.07 -0.020 2019.00 -0.020 2027 11 K55.17 C 0.17 6.08:1
206+00.00 R 1 -2.00:1. F 9.19 £3.87 2010.88 -0.020 2019.03 -0.020 2021.05 39,39 C 0.95 2.00:1
206+25.00 R 1 -2:00:1. F 8.82 £3.15 2011.47 -0.020 2019.26 -0.020 2018.82 46.58 F 1.51 —-6.00:1. |~
| |Lire: 1 |Coal 1

For each station, GEOPAK determines the tie down point between the proposed finish grade and the existing
ground.

Referencing this tie down point, the Staking Report lists the left and right offset and its corresponding
elevation, and the slope of the proposed finish grade.

Next, a “C” or “F" is provided if the tie down point is in Cut or Fill along with a vertical distance to the next
break point in the original section.

The centerline elevation (adjusted for pivoting on the inside edge) is given in addition to the superelevation
rate of the pavement.
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21.3.4 Detailed Earthwork Computations

In this section we will generate a Detailed Earthwork Report. An area of top soil removal will be
included in this report. Cross sections that require the top soil removal have been hand drafted using
a unique symbology. This will need to be done on any projects where top soil removal is required.

Step 1. Project Manager should still be invoked.

Step 2. Click Earthwork from the Project Manager dialog box and create a new run named ML?2.
Open the new run.

Bz EEE]

Hles

%S DGEM File
Soil Tepes
E Shapes
Output Format
Add/Sub Vol
Centroid Adj
Skip Areas
Sheet Quant,

Step 3. Populate the XS DGN File section of the dialog box as shown below:

| 2 Earthwork - M12 M= |
Fles

=5 DGM File | 1%d17682xsmainline. don Select I

ol ] g Tolerance [ 0.070000

Ew Shapes

DOutput Format Wertical Search Distance I 500.00
Add/Sub Vol )
Centraid Adj Baszeline lM.l’-‘n.INLINE

Skip Areas : :

Sheet Quant, Begin Station | 20040000 R 1

End Station [Z20+00.00 R 1
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Step 4. In the Soil Types section of the dialog box, create the following classifications and sail
types utilizing the parameters detailed in the table below.

5 OGN File

Soil Tupes
E'wW Shapes
DOutput Format
Add/Sub Vol
Centroid Adj
Skip Areaz
Shest uant,

Clazz | Enisting Ground

E sizting Unsuitablel
Ewigting Unzuitable?
Esigting Unzuitable3
E sizting Lnzuitabled
Fropozed Finish Grade _V_!

r Search Criteria

Sail Type |Earth

r Multiplization Factars

Add

| V| Use 'working Alignment Definition

M Ly Mames:
¥ Ly Mumbers;

Roadvay Excavation I 1.000000 = Calars:
Styles:

=
Subszail Excavation I1_|j|jnnnn r Weights:
™

Fil' [1-000000

Typesz:

1
1
2
5
3

" | e

Dizplay I

I Delete

Modiy |

Class

Soil Type

Search Criteria

Existing Ground

Earth

Working Alignment Definition

Proposed Finish Grade

Earth

Working Alignment Definition

Existing Unsuitablel

RootMat_Cut

LV=29, WT=8, LC=0, CO=3, TYPE=Line

Existing Unsuitable2 RootMat_Fill LV=29, WT=8, LC=0, CO=7, TYPE=Line
Existing Unsuitable3 Top_Saoil LV=29, WT=8, LC=0, CO=0, TYPE=Line
Existing Unsuitable4 Exist_Pavt LVv=59, WT=3, LC=2, CO=88, TYPE=Line
Excavation Limit None LV=25, WT=0, LC=0, CO=55, TYPE=Line

You can manually define the symbologies using the settings in the Search Criteria portion
of the dialog box. When using these settings, there are also three additional buttons to

help you.

Match Prompts you to identify an element. Once you do, it will fill in the symbology
settings with the symbology of the identified element.

Display/Undisplay Highlights all elements in the design file matching the set symbology.

Reset Clears all symbology settings.
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Step 5. In the EW Shapes section of the dialog box, toggle on Draw Earthwork Shapes and
Stratify Shape Color. Populate the Set Feature dialog box with the parameters as
shown below.

Files |} GEOPAK Set Feature |
XS_DGN Fila Wi Diaw Earthwork Shapes - Symbioloay
SD'I TES F'ar_a.meters Level |Lewel 5O |
Output Farrmat | Color: I =l
&dd/Sub Wal Style: | ] ]
Centroid Adj L =
Skip Areas ¥ Steatify Shape Color wieigh: | g =l
Shest uant, Cancel i )
Step 6. Populate the Output Format section as shown below.
gEallhvmrk - ML E
Files
<5 OGN File ™ Accum Adjust Yolume Colurin
Soil Types [T Accum Unadiust Yolume Column
W Shapes [] Calz Orly Between Exc Limits
[[Output Farmat
Add/Sub Val V| End Area Dec Places |1 I
Centraoid Adj
Skip Areas E_xcavation
Sheet Quant. Fill

<l B

NOTE: Use the arrows (< or >) to change the format to Excavation and Fill.

Step 7. In the Sheet Quantities section, toggle on the Write Sheet Quantities File. Name the
file “earth2.txt”. Add the following columns to the file with Decimal Places = 0 and
Total Quantity Length = 10:

Col. Soil Type EW Operation Quantity Type +/-
1 Earth Common Exc End Area +
1 RootMat_Cut Common Exc End Area +
1 RootMat_Fill Common Exc. End Area +
1 Top_soil Common Exc. End Area +
1 Exist_Pavt Common Exc. End Area +
2 Earth Fill End Area +
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Step 8.

Step 9.

Step 10.

Step 11.

Step 12.

[Beathwoc- w2 MEA|

Hles
-5 DGM Fils ¥ “wirite Sheet Quantities File
Soil Tupes :
B Bhass ASCI File [earthe.tat _Select |
Output Farmat Calurnn _]_J Decimal Places _D_! Total Quantity Length 10 I
AdddSub ol
Centroid Adj Col. Soil Type E'w Operation I
Skip Arsas 1 Common Exc End Area +
Sheet Quant, 1 Foothat_Cut  Common Exc End Area +
1 Foottdat_Fill  Common Exc End drea +
1 Top_Soil Carnrian Exc End Area +
1 Ewigt_Pavt Common Exc End Area +
2 Earth Fill End Area +
Enist_Pavt I Common Exc I End Area | __+]
bdd | | Delste | | Modfy |

Using the Files > Run pulldown, run the earthwork for the proposed cross sections.
Place your output into a log file as shown in the dialog box below and Pause on Each
Section.

- To Log File ‘

ToLogFile 'I |earth2.lng

¥ Pause On Each Section

Click Apply.

Review the earthwork quantities. Toggle off “Pause On Each Section” then click
“Continue”.

After the process has completed, click “Exit”. Files named “earth2.log” and
“earth2.txt” will be created in the working directory.

Dismiss the Earthwork dialog box by clicking the X in the upper right hand corner.
When prompted to Save Earthwork Settings, click “Yes”.
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Step 13.

Review the Detailed Earthwork Report file by opening “earth2.log” with the GEOPAK
Text Editor. The file should appear as below.

f Text Editor- C:\dala\geo\wdot\road T\earth2 log [ _ (O] 1

Fle Edit Critera
D||a] &|m|@] <]~
EEGINNING EARTHWORKS COMPUTATION :_]
1
Material Hamne End Area=z Unadju=sted Adjusted Hult Haz=
Station Yolumnes Volumes Factor Ordinate
fe=q. ft.) focu, wvd.) {ouw. vwd.) _J
200400 .00 EARTH
Excavation 418 .6 i i 1.00
Fill 130.6 I I 1.00 ]
TOP_SOIL
Excavation 60 .6 ] ] 1.00
Fill 0.0 a a 1.00 0
Ha=z=z ordinate for TOF _SOIL = 0
EXTIST_FAVT
Excavation 10 .4 ] ] 1.00
Fill 0.0 ] 1] 1.00 0
Ha=z=z ordinate for EXIST_FAVT = 0
200+25.00 EARTH
Excavation 121 4 189 389 1.00
Fill 4.4 100 1a0 1.00 288
TOF_SOIL
Excavation 609 SR 1) 1.00
Fill 0.0 1] 1] 1.00 289
Has= ordinate for TOF _SOIL = 56
EXIST FPAVT
Excawvation 10.4 10 10 1.00
Fill 0.0 I a 1.00 289
Haz= ordinate for EXIST FAVT = 10
Lime: 1 Cal: 1

The earthwork report consists of four major parts:

¢ Individual cross section quantities

e Grand Total Summary

e Balance Point Summary (Included only if there are balance points)

e Centroid Adjustment Summary (Included only if the centroid adjustment option is active.)

Each station is listed in numerical order (including regions), regardless of the order in the cross
section design file. Then for each material type, each type of excavation and fill is listed, followed by
the end areas in master units (either square feet or meters). Then unadjusted and adjusted volumes
follow. The last two columns are the multiplication factor used to generate the adjusted volumes from
the unadjusted volumes, and the mass ordinate, which is the cumulative total of the adjusted

volumes.

Step 14.

Dismiss the GEOPAK Editor dialog box by clicking the X in the upper right hand corner.
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Step 15. Review the Sheet Quantity Earthwork Report file by opening “earth2.txt” with the
GEOPAK Text Editor. The file should appear as below.

Fle HEdit Criterna

Ol@(a] 4 [w(@] o]~
000000000000 1111111111 2222222222 =
200+00. 001 458 i h
200+25 . 001 463 84
200450001 481 66
200+75. 001 541 19
201+00.00-1 521 36
201+25 . 00-1 511 58
201+50.00-1 446 108
201+75 . 001 410 121
202+00. 0071 311 137 |
202+25 . 001 232 176
202+50.00-1 264 157
202+75 . 001 448 146
203+00.00-1 600 204
203+25 . 00-1 773 177
203+50.00-1 937 122
203+75 . 001 1027 120
204+00. 0071 1041 284
204+25 . 001 953 340
204+50 001 B55 269
204+75.00-1 726 a8
205+00. 001 564 113
205+25.00-1 433 159
205+50 . 001 30z 205
205+75. 001 39 287
206+00. 001 4 333
206+25 . 001 f 406
206+50 001 I 456
206+75.00-1 0 624 -
| [Line: 1 [T

The earthwork component of GEOPAK produces the ASCII text file as a byproduct of the
standard earthwork volume calculation run. The first line of the ASCII file is a series of
0's, 1's, 2's, etc. denoting the columns.

GEOPAK automatically provides the column denoted by 0's. This column is where the

station is written by GEOPAK.

Column 1, 2, etc. contains the earthwork quantities as per the settings in Step 7. The
earthwork quantities will be placed on sheets using settings in the Cross Section Sheet

tool.

Step 16.  Dismiss the GEOPAK Editor dialog box by clicking the X in the upper right hand corner.

Step 17.  Exit MicroStation.
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21.4 Cross Section Reports Using Visual Basic Applications

' The dialog box to access Visual Basic Applications can be

invoked from either the MicroStation pulldown menus by
selecting Utilities > Macro > Macros or entering vba run in
the Keyin Browser.

These reports must be run from the proposed cross section
file.

21.4.1 Grade and Superelevation Report

In this section we will generate a Grade and Superelevation Report utilizing a custom Visual Basic
Application.

Step 1. Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsmainline.dgn.

Step 2. Access Project Manager. It should automatically access the Road workflow dialog box
since we “remembered” the options in Exercise 2.

Step 3. From the MicroStation pulldown menu select Utilities > Macro > Macros. The dialog
box below should appear.

Macros. ﬁ

M acro name:
ImodGrade.-’-‘mdSuperF! eport GradedndSuperRepart

modGradesndS uperR eport. GradedndSuperBeport

modB 0w Report. RO0WHE eport

modSlopeStakeReport. SlopeStakeReport Bian vl i

Edit I

Macrazin. | <Al Standard Projects» ‘:j

Description:

Step 4. Select modGradeAndSuperReport then click Run.

Step 5. Populate the Grade and Super Report dialog box with the information below:
Job: 101
XS Chain: MAINLINE
Report Chain: MAINLINE

Report Profile: MAINLINE
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Step 6. Toggle on Superelevation then select C:\data\geo\vdot\road1\mI3_shapes.inp. The
Grade and Super Report dialog box should appear as below.

Grade and Super Report m
Job: |101 vl ¥S Chain! ||'~f1.-5.INLINE vI Event Locations:

POT 200 +00, 00 &
Report Chain: |r~’IAINLINE vi YPI 200+00.00
WPC 20445000

Report Profile: |I'~"IAINLINE > i TRMNEMD 205+00.00

TRNEND 205+400.00
V¥ Superelevation SAG 205+33.61

Superelevation Shape Input File: I HbEs a+area

: TRNBEG  206+47.33
IC: \data'geowdotroad1\ml3_shapes.inp il WPI 206+50.00
CRWINRN  207+15.60
Pavement Line Symbology: [— CRWNRN  207+15.60
CRWNRYV  207+25.34
1 | cRwnry 20742534
i CRWNRY 20748332 L~

| Generats Report

Step 7. Click Generate Report.
Step 8. In the Save Report As dialog box enter GradeAndSuperReport.doc then click Save.

Step 9. When the dialog box below appears, click Yes.

Open Microsoft Word ﬂ

\!JJ Would you like to view C:\dala‘geo‘\wdotwoad 1\Grade And SuperReport doc

No |
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Step 10. Review the Grade and Super Report below then exit Microsoft Word.

Fle HEdit View Insedt Fomat Tools Table Window Help

DEHe @RIYR|I =B -« & B el

[x] i h R R O R A PR ID SRR I SRR SO IR I ST 5

75%

200+00.00 POT -781 D.0€21 —0.0200 -0.0Z00 35.100 20.900
200+Z5.00 X3 -343 0.0€21 —0.0EZ00 -0.0Z00 35.100 20.900 !
Z00+50.00 X3 -B8¢€ 0.0€21 —-0.0Z00 -0.0Z00 a5.100 20.s00 :
200+75.00 X3 -Bz3 0.0371 —0.0200 -0.0Z00 as5.100 20.800
Z01+00.00 x3 -74% 0.0371 -0.0Z00 -0.0Z00 35.100 30.800 :
2031+25.00 X3 -poo 0.0100 —0.0200 -0.0Z00 35.100 20.900
X3 -250 0.01i00 -0.0200 =-0.0200 a5.100 30.900 i
X3 =175 —-0.0030 -0.0Z00 -0.0Z00 a5.100 30.800
X3 -100 -0.0030 —0.0200 -0.0Z00 a5.100 20.800 :
X3 -0s0 =0.00z20 =0.0200 =0.0200 a5.100 30.%00 -
X3 -ooo =0.0020 =0.0Z00 =0.0Z00 25.100 30.900
X3 7.750 =0.0100 -0.0200 =-0.0Z00 as5.100 30.900 i
X3 7.500 =0.0100 =0.0200 =-0.0200 35.100 30.900
X3 -975 =0.0210 =0.0Z00 =-0.0200 35.100 30.900 i
X3 Z€._450 =0.0210 =0.0200 =0.0200 a5.100 30.%00 -
X3 -850 -0.0240 -0.0200 -0.0200 a5.100 20.900
x3 -ooo =0.0340 =0.0200 -0.0200 35.100 30.900 :
X3 -s00 =0.0440 =0.0200 =0.0200 32.850 Z8.€50
VEC -gas -D.042¢ -0.0200 -0.0200 a0.€e0e 2€.392 -
X3 -870 -0.034¢ -0.0200 -0.0200 28.350 24.150
X3 -104 -0.02&7 -0.0200 -0.0200 2€.100 21.900 :
205+25.00 X3 -537 -0.0187 -0.0200 -0.0200 2€.100 2i.s00 =
205+50.00 X3 -1€9 -0.0107 =0.0200 -0.0200 2€.100 21.900
205+75.00 X3 -go1 -n._oo027 -0.0200 -0.0200 2€.100 21.900 -
206+00. X3 -0az 0.0052 =0.0200 -0.0200 2€.100 21.900
20&+25.00 X3 -2€2 0.013z —0.0Z00 -0.0200 2€.100 21.800 :
Z20&+50.00 VPRI - €82 0.p0212 —-0.pics -0.0200 2E.4£3 21.%00 :
20E+75.00 X3 -azo 0.0291 =0.0120 -0.0200 2&.878 21.900
2a7+00.00 x3 148 6.0371 -0.004€ -0.0200 132.5€0 21.800 =
207+425.00 X3 -17¢ 0.0451 0.0028 -0.0200 101.258 21.900
207+50.00 X3 -402 0.0530 0.01i02 -0.0200 50.933 21.800 i
207+75.00  xa 828 D0.0610 0.0275 -0.0200 38.815  21.800 ;
Zoe+p0.00 X3 -453 0.0&50 0.0249 -0.0249 ag.100 21.800 V.
Z0B+25.00 x3 -278 o.o770 o.p32a -0.0323 a8.100 21.800 +
208+50.00 VET -302 0.0e4s 0.0370 -0.0370 38.100 21.800 @
¥

=wfEl=w 4] | »

Station — Cross Section Station.

Event — Cross Section or Critical point.

Fin. Grade Elevation — Profile Grade Elevation.

Grade - % of grade at each station.

Cross Slopes — Slope of Pavement at each station.

Offset — Offsets to each edge of pavement at teach station.

Step 11.  Dismiss the Grade and Super Report dialog box by clicking the X in the upper right
hand corner.
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21.4.2 ROW Report
In this section we will generate a Right Of Way Report utilizing a custom Visual Basic Application.
Step 1. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn.

Step 2. From the MicroStation pulldown menu select Utilities > Macro > Macros. The dialog
box below should appear.

Macros. [ x|

Macro name:

IdeGrade.-’-‘«ndSuperHepolt.Gladaﬁ.ndSuperHeport
Cancel I

modGradesndSuperBeport GradedndSuperHeport
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Edit |

Delete I

Macrozin: | <Al Standard Projects> __'_j
[ezcription:

Step 3. Select modROWReport then click Run.
Step 4. Populate the Right of Way Report dialog box with the information below:
Job: 101
Chain: MAINLINE
Beginning Station: 200+00.00
Ending Station: 222+06.84
Station Increment: 25
Beginning Point Number: D6000
Step 5. Click Generate Report.
Step 6. In the Save Report As dialog box enter ROWReport.doc then click Save.
Step 7. When the dialog box below appears, click Yes.
Open Microsoft Word

L]
11) Would you like to view C:\data‘\geo\wdotwroad 1\ROW Report _doc
=

N |
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Step 8. Review the Right of Way Report below then exit Microsoft Word.

@Howmpon.doc Microsoft Word !EII:I
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Point — COGO points stored in Coordinate Geometry

Station — Cross Section station at Incrementation or Critical Points.
Offset — Offset from Centerline to Right Of Way line.

North — Northing Coordinates of the stored point.

East — Easting Coordinates of the stored point.

Step 9. Dismiss the ROW Report dialog box by clicking the X in the upper right hand corner.
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21.4.3 Slope Stake Report
In this section we will generate a Slope Stake Report utilizing a custom Visual Basic Application.
Step 1. Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsmainline.dgn.

Step 2. From the MicroStation pulldown menu select Utilities > Macro > Macros. The dialog
box below should appear.

Macros. [ x|

M acro name:
ImodGrade.-’-‘mdSuperF! eport GradedndSuperRepart

modGradesndSuperR eport GradedndSuperE eport

modR 0w R eport. B OW R eport
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Edit I

Macrosin: | <Al Standard Projects> _:j

Description:

Step 3. Select modSlopeStakeReport then click Run.
Step 4. Populate the Slope Stake Report dialog box with the information below:

Job: 101

Chain: MAINLINE
Step 5. Click Generate Report.
Step 6. In the Save Report As dialog box enter SlopeStakeReport.doc then click Save.
Step 7. When the dialog box below appears, click Yes.

Open Microsoft Word

'-!KJ Would you like to view C:\data‘geo\wdotwoad 1\Slope Stake Report .doc

o |
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Step 8. Review the Slope Stake Report below then exit Microsoft Word.

@ SlopeStakeReport doc - Microsoft Word
i Fle Edit View Inset Format Tools Table Window Help
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LCP — Left side catch point.

LSP — Left side shoulder point.

REOP — Right edge of pavement for the left roadway.
LHP — Left hinge point.

MAINLINEPG - Profile Grade Line.

LEOP - Left edge of pavement for the right roadway.
RSP — Right side shoulder point.

RHP — Right hinge point.

BSR - Begin slope rounding.

1/4 — Quarter of slope rounding.

1/2 — Half of slope rounding.

3/4 — Three quarters of slope rounding.

RCP — Right side catch point.
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Step 9. Dismiss the Slope Stake Report dialog box by clicking the X in the upper right hand
corner.

Step 10.  Exit MicroStation.
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